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1 Introduction

1.1 About This Document
This document is about the Wavestore suite of software. It doesn’t cover the hardware on which the
software may be running. Separate documentation is provided for the various hardware ranges avail-
able.

The first part of the document explains the basics of theWavestore system and how to get started.

The next part focusses on the main user interface and how to use an already configured system. This
covers theMain Screen, the Find Screen,making and playing back exports, etc.

Next there is a reference section about theSetupScreens. This covers eachSetupScreen and explains
what each itemon each screen does.

Then there is a section for ”Common Setup Tasks and Concepts”. Since some common tasks require
several steps of configuration across multiple screens, this section consists of walkthroughs for those
common tasks, alongwith some sectionswhich explain important concepts in theWavestore system.

1.2 About Wavestore
TheWavestore Video Management Software (VMS) provides the perfect hybrid digital video recording
solution for userswhomaywish to deploy a combination of analogue, IP, megapixel, HD, HD-SDI, ther-
mal, panoramic and 360 degree cameras. Robust and reliable, the Wavestore VMS is able to meet the
requirements of virtually any video surveillance project, including airport, casino, bank, retail, commer-
cial, industrial, homeland security and government applications.

Wavestore VMS is ONVIF Profile S certified, ensuring compatibility and compliance with this industry
standard as it evolves, and enabling industry consultants, systems integrators, installers and end-users
to select conformant cameraswith the knowledge that compatibility is assured.

High performance and flexible recording
Easyto install andoperate, theWavestoreVMSsoftware isable tosimultaneously recordupto254chan-
nelswith a combination of H.265, H.264, MPEG-4, MJPEG, JPEG2000orMxPEGcompression formats.
Up to 8 HD-SDI cameras can be specified at the time of the order. Up to 255 servers per location are
supported, and options to support unlimited sites and unlimited users are available.

TheWavestoreopenarchitecturedesignenablesstraightforward integrationofvideoanalyticsand third
party technologies, includingCommand andControl, PSIM, Perimeter Intrusion Detection (PID), Build-
ingManagementSystem(BMS), AccessControl, PeopleCounting, retail analytics, licenceplate recogni-
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tion, Electronic Point of Sales (EPOS) and Scanning systems. Biometric Facial Recognition systems are
also available, delivering high integrity solutions to assist in identifying various individuals; whether VIPs,
regular customers, staff or black-listed persons.

Easy to use
Wavestore remote viewer client software (WaveView) allows users to securely monitor real-time live
images or retrieve recorded video over the network, whilst multiple recorders can be configured into
a server group to support large and distributed video surveillance applications. Image authentication
and encryption are also available.

Simpledraganddropfunctionalityenableseachuser tocreateuniquemultipledisplaypreferences,whilst
the Wavestore VMS software delivers an extremely fast search facility to allow users to quickly review
recorded images of any occurred event.

Ultra reliable
TheWavestoreLinuxbasedserverdesigndeliversahigh integrityand resilient recordingplatform,whilst
the uncomplicated viewer client software (WaveView) can be operated fromWindows (8.1 and later, or
Server 2012 or later) and Linux operating systems. A mobile client is also available for Android and iOS
platforms.

Wavestore servershavesingle, dual or triple redundantpower supplies options andareprovidedwithup
to three year full return to basewarranty.

Server and Client configuration
Installed in about 10 minutes on the server system drive, the Wavestore VMS software manages the
video, audioandmetadata informationthat issent fromthecamerasanddevicesconnectedtotheserver
and records onto the storage hard drives.

TheWavestore viewer client software (WaveView) is pre-installed onto the server andprovides awealth
of tools for accessing cameras and devices, streaming video and managing events. It can operate on
multipleoperatingsystemsand ismultithreaded toallowmaximumperformanceonmultipleCPUcores
when displaying video streams.

WaveView can also be installed onto a PC to connect to aWavestore server over a TCP/IP network and
manyof the server configuration tasks (e.g. user administration) can beperformed remotely,with only a
small number required tobecarriedouton theserver itself. IfmultipleWavestoreserversareconfigured
together as a server group, the operator can easily access via WaveView all cameras and devices from
any of the serverswithin the server group (See figure 1.1).

IfmultipleWavestore servers are configured together as a server group, the operator can easily access
viaWaveView all cameras and devices from any of the serverswithin the server group.
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Figure 1.1: Typical SystemConfiguration

Key Features

Video Management Software (VMS)

Video standards NTSC, PAL, HD-SDI and IP

Video resolution QCIF, CIF, 2CIF, DCIF, D1, 720p, 1080p, VGA, megapixel, multi-megapixel, custom
Analogue rate at D1 Up to 25/30 fps (PAL or NTSC) per input; up to 1600/1920 fps per recorder IP
andHD rates: high image rate streams supported, camera dependent

Still image BMP/JPEG/PNG formats

Record type Continuous, schedule, motion, alarm, event and digital input trigger

Recording tracks 3 independentvideotracksassignable todifferentHDDs, eachwith independentset-
tings plus aMetadata track

Overwrite modes Configurable auto deletion and overwrite function by time or disk allocation

Privacy Mask Configurablemask to avoid viewing sensitive areaswithin a camera view

Time zone regional setting available

Languages multiple languages supported

Operating system embedded Linux platform
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Client Software (WaveView)

Remote users 2 to unlimited concurrent users

Operating Systems Windows (8.1 and later, or Server 2012 or later) and Linux (Red Hat and Debian
based systems)

Mobile client support for Android and iOS devices

Find and display instantaneous and simultaneous display of live and recorded images

Video displays user configurable by image size, aspect ratio and position

Video displays layouts standard and customisable layoutswith saving option per user

Playback, Search and Export

Playback options linear and logarithmic search optionswith variable speed sliders

Playback speed up to 8192 times the normal view rate

Playback mode multi-way (play, rewind, jump, fast-forward and frame-step multiple cameras simul-
taneously)

Playback display synchronise and replay all camera images

Slowmotion playback available

Search options date, time, annotations, motion, alarm, events

Search mode full speed, full frame search

Export mode exportmultiple cameras simultaneously, including linked audio

Live video export available

Export devices CD, DVD, USB, HDD

Advanced exports ability to transcode video and audio data to large number of alternative formats (i.e.
AVI,WMV,MPEG,MP4)

Security

Password profile multiple protection levels

Cameras and displays accessible on a per-user basis

Configuration files save and restore capability for any recorder in the group

Digital watermarking image authenticationwith real time checking

Encryption up to 4096 bit encryption

Diagnostics remote and secure diagnostics, repair functionality available –Optional

Remote administration remote control via TCP/IP network, including restart and rebooting

Automatic system restart after power loss (when power resumes)

Monitoring full systemmonitoring, including SMART disk healthmonitoring –Optional
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Failover ability to switch to a standby recorder upon the abnormal termination of another recorder in
the same system–Optional

Watchdog function auto-reboot of system in case of system failure

Redundant recording NAS, SAN and RAID options

Events and alarms

Advanced events shows a real time streamof incoming events and alarms on themainwindow

Event detection any third party technologies events and alarms, video loss, darkening, motion within
image, cameramovement, camera tamper, digital input, login succeeded, logindenied, fault,warn-
ing

Event management customisable display and sound, definable search, and instant response options

Event actions recordonevent, textoverlay, boost recordingrate, triggeroutput, spotmonitor, PTZcam-
era on preset, notify client, run script, emails, flashing light, sound alerts

Event notification viaWaveView, email or TCP/IPmessage

Other features event logging, enable and disable on schedule

Motion Mask/Areas of interest configurable areas to target analogue analytics

Licensable Features

De-warping for any 360 degree cameras provides customisable linear viewsof live andarchived im-
agesand theability to recall a total fieldof viewand followsubjectsas if trackingwithaPTZcamera,
creating ad hoc video clips around the occurred events

Interactive Maps configurablemap screen for finding and interactingwith cameras and devices

HTTP proxy server enables direct interfacewith cameraswhen on a different network

Optional modules

Third party integration ability to translate any third party events and trigger a wide range of definable
actions based on customisable rules

Facial recognition ability to interfacewithbiometric facial recognitionsystemstodynamicallycompare
images of individuals from incoming video streams against specific databases and immediately
send alertswhen a positivematch occurs

Intelligent Video Analytics (IVA) ability to integratewith any video analytics allowing specific types of
events and activities to be recognised automatically and promptly alarming the operator directly
within the user interfacewhen an event occurs

People counting delivers accurate metrics to monitor people flow, people tracking and queue man-
agement, efficiently improving customer service and sales performance

Point of Sales (POS) ability to display text from POS devices alongside associated video images pro-
viding transactions search options

Automatic Number Plate Recognition (ANPR/LPR) ability to register the arrival time of service vehi-
cles and permit access to authorised vehicles to restricted areas
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2 Getting Started

2.1 Basic System Configuration
TheWavestore system consists of twomain components:

• Wavestore server software, responsible for managing and recording streams from input devices
(audio and video)

• WaveView client software; provides a user interface to the Wavestore server software, for func-
tions such as Live View/Search/Playback, and also server configuration

AWavestore server usually runsboth theWavestore server software, and theWaveViewclient software,
although in some circumstances, a textual client is offered instead ofWaveView.

WaveView can also be installed on Linux andWindows PCs, and used to access networkedWavestore
servers. WaveView running on the Wavestore server box can also be used to access other Wavestore
servers in the samemanner.

Servers are shippedwith both theWavestore server andWaveView client programs pre-installed, with
onlyminimal configuration required before the server is ready for use.

Certain server configuration tasks can only be undertakenwhenworking on the server box itself (client
connects to the local host), but themajority of configuration taskscanbecarriedout oneither the server
box or a client software PC.

When installing a remote client, it is recommended to use the same base version ofWaveView client as
the server, or higher. By ”base version” we mean the first two numbers in the version, for example the
base version of ”6.14.51” is ”6.14”. So for example if the server is running version 6.16, theWaveViewclient
version should be 6.16 or higher.

2.2 Login Screen
Following themenu path File→Connect calls up the Login Dialog Box, which allows the operator to log
in to aWavestore Server or Server Group as follows:
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Figure 2.1: WaveView Login Dialog

• in the server field

– if you areworking directly on theWavestore server box, enter ’localhost’

– if you areworking remotely from a client PC, enter the IP address or hostname of the server

• in the user field, enter a valid user name (for example ’install’)

• in the password field, enter the corresponding password for your selected user. The default pass-
word for the install user is ’a’.

• if you are connecting to a server that is part of a server group ( section 6.8 - Server Group), leave
the ’connect to server group’ option checked; your client will connect to all of the servers within
the server group

Figure 2.2: Entering data inWaveView login screen

A user will become locked if the password was entered incorrectly 5 times in a row. In this case the
username will be locked for 30 minutes, and all attempts to log in will be rejected with ”Locked” error
message. Eitherwait for 30minutes or log in using another username.

In the event that the configured IP address on the server clasheswith the IP address of another device
on the network, you will not be able to login on the server box using the server name ’localhost’. In the
’Server’ field, replace ’localhost’ with the IP address 127.0.0.1, and login as above.

Upon first login for any given user, that user may be forced to change their password. If the user does
not do so and attempts to cancel the password change, theWaveView applicationwill exit.

Section 6.2.2 - Network describes how to reconfigure the server IP address in the Network menu, if
required.

The ’Open Export’ button is used to open a locally saved export file for playback, as described in sec-
tion 5.1 - Playing Back Exported Files on a PC fromDVD/USB device.
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For aWaveView installation onWindows PC, the Login Dialog box can be associatedwith a CSV file (on
a local PCor networked resource) that can act as a server ’address book’. This file can contain user con-
figureddetails such as site location, IP address, andoptionally login details such asuser nameandpass-
word.

This feature canbeuseful for a client installation that is used to connect toWavestore servers atmultiple
sites.

A CSV file can be created usingMicrosoft Excel; an example is shown below:

Figure 2.3: Example CSV file

Onceassociatedwith theCSVfile,WaveViewwill use thedataonLine 1ascolumnheadings in theServer
Search screen, as shown below.

To associate the CSV file withWaveView, click on ’Search’ on the Login Dialog screen, and in the Server
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Search screen that appears, click ’Browse’, and locate your savedCSV file:

Figure 2.4: Browsing to locate CSV file

The contents of theCSV filewill nowbe loaded byWaveView:

Figure 2.5: CSV File loaded intoWaveView as ’address book’

You can search the listmanually to select a server by using the side slider bar, or by entering text into the
’Search’ field:
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Figure 2.6: Searching address book for text ’liverpool’

You can also click on the category headings to sort the listed sites according to the data in the selected
column:
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Figure 2.7: Sorting address book using ’Location’ data

Once you have located the server that you require, double click on the server entry in the list, and the
fields in the LoginDialogbox (includingUserNameandPassword if this data is containedwithin theCSV
file) will be auto populated.

Figure 2.8: Auto population of Login Dialog

Click onOK to connect to the server.

Once theClient has connected to the server(s), theDevice Treewill appear showing a representation of
the connectedWavestore server(s), with any active audio/video channels that the user has permission
to access.

If you are connecting to a new server, no audio/video channels will be displayed in the Device Tree until
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these channels have been configured and enabled (see section 9.3 - Configuring Analogue Cameras,
or section 9.1 - Configuring IPCameras).

Figure 2.9: Main operating screen showing Device Tree

2.3 Shutting down the Server
ToshutdowntheWavestoreserver, followthemenupathView→Setup→Server→ShutdownSystem:
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Figure 2.10: Shutting down the server fromWaveView

It is acceptable to shut down theWavestore server (either in an emergency or for routinemaintenance)
by switching the server offusing the switch on the rear of the chassis, by removing the power lead or by
switching themains supply off at the power outlet.

The Wavestore software is designed to be robust when power fails unexpectedly, and no data is lost
(other than the last second or two which might not have been flushed to disk). The Wavestore server
will recover and fully check its storage in less than a secondwhen power is reapplied. There is no need
for external UPS devices.

If yourWavestore server is connected to an external RAIDdevice, then other shutdown rulesmight ap-
ply to this RAID device. Many RAID boxes do require UPS protection, andmust be powered down in an
orderly fashion.
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3 Main Screen

TheMain Screen (menu path View→Main) is shown below:

Figure 3.1: WaveView Live Screen

Pull DownMenus File/View/Tools/Help. See section 3.1 - Pull DownMenus.

Device Tree Displaysa listof theconnectedWavestoreservers,withactiveaudio/videochannels. Seesec-
tion 3.8 - Device Tree.

Event Controls Start/Stop operation of configured Event Rules. See section 6.12 - Event Rules.

Playback Controls Used to control playback of Video Displays. See section 3.10 - PlaybackControls.

PTZF Controls Used for control of Pan/Tilt/Zoomcameras. See section 3.12 - PTZFControls.
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Live Event Stream (Licensed upgrade) Licensed upgrade; displays events from connected devices.
See section 3.18 - Live Event Stream (Optional Licensed Upgrade).

Display Area Video Displays from system cameras can be added here. See section 3.2 - Display Area.

Display Area Toolbar Used forcontrolling individualVideoDisplays. Seesection3.3-DisplayAreaTool-
bar.

Status Indicator Normally displays Green, changes to Red when a connected server has reported a
fault – clickingon this iconwill causes anewwindowtoopendisplaying theSystemLog (Seesec-
tion 3.21.1 - System Log)

Themain screencontains ”dockable” panelswhichcanbedragged fromtheir dockpositions tobecome
floating panels. These panels can also be closed if not used.

If any or all of the panels ”Event Control”, ”PTZF Controls”, ”Playback Controls” are closed, they can be
reopened by right-clicking on the ”Device Tree” heading.

If the ”Live Event Stream” panel is closed, it can be reopened by clicking the dots at the bottom of the
Video Display Area and dragging upwards, then right-clicking on the space below.

OnceVideoDisplayshavebeenadded to theDisplayArea, theMain screenwill typically appear asbelow.

Figure 3.2: WaveViewMain Screenwith Video Displays Added

The Display Area can be freely configured, with amixture of Live and Playback camera views if desired.
Multiple instances of the same camera can be displayed, showing playback from different dates/times
simultaneously.
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3.1 Pull Down Menus
The pull downmenus contain the following items:

3.1.1 File Menu

Connect Open the LoginWindow in order to establish a new connection to aWavestore.

Disconnect Disconnect from the currently connectedWavestore Server, Server Group, or Export File.

Open Open an Export File.

Quit Exit theWaveView clientSoftware

3.1.2 View Menu

Main TheMain Screen containing the Display Area

Setup For configuring theWavestore Server or Server Group, including...

• Administration of User Logon ID/password

• Recording settings for Audio and Video Devices

• SpotMonitor output fromServer for analogue cameras

• Server Time/Date and Time Zone

• Server IP settings

• Email of event notifications

• Schedules (can be attached to User logons/Camera Recording)

• CustomChannel TreeGroups of cameras

• Upgrade of server software

• Event Rules associating input devices/eventswith output devices/events
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• I/O Devices (digital inputs, relay outputs etc.)

• Notification Targets formessages sent by the server

• Configuration of Video Storage Hard Drives

Find Search and Export Recorded Footage

Map ViewCameraMapsConfigured on the Server (LicensedOption)

3.1.3 Tools Menu

Preferences ConfigurationOptions relating to the client PC. See section 3.22 - Preferences.

Client Log Log of Eventswithin theWaveView client. See section 3.21.3 - Client Log.

Change Password Allows password of the current user to be changed.

CopyWaveView to Creates a separate copyof the program in a user nominated folder (for playback of
exported files). See section 3.24 -CopyWaveView.

System Log Log of Events on the connected Server(s). See section 3.21.1 - System Log.

Server Maintenance For advanced configuration use as directed byWavestore staff. See section 3.25
- ServerMaintenance.

Connections List of Clients currently connected to the servers (User ID and IP Address). See sec-
tion 3.23 -Connection List.

Network Tools Allows network connectivity to other devices to be checked. See section 3.20 - Net-
work Tools.

Execute Command Used for Advanced Functions under direction ofWavestore staff

File Manager Allows uploading, downloading, and deletion of files to and from the servers in the server
group. See section 3.26 - FileManager.

Status Summary Providesasummary, includingthumbnails, ofall cameras in theservergroup. Seesec-
tion 3.27 - Status Summary.

23



Server Statistics Provides visual representation of statistical data relating to server performance, such
as network throughput and disk activity. See section 3.28 - Server Statistics.

3.1.4 History Menu

Undo Reverts the last change to the layout in the currently selected Video Display Area

Redo Re-applies the last ”undone” change to the layout in the currently selected Video Display Area

Note that the layout history is limited to 50 layout change operations.

3.1.5 Window Menu

Eachentry in thismenucorrespondstoanelement in theUIwhichcanbeshownorhidden. Forexample
the ”Live Event Stream” can be hidden tomakemore space for themain Video Display Area.

Also it allowsmultiple Video Display Areas to be enabled or disabled.
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3.1.6 Help Menu

System Info...

The ’System Info’ window gives information about the client PC and the connected servers and their
licences.
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Download Diags...

This window provides an easy way of obtaining lots of information about the current Client PC and all
connected servers. It allows downloading all the information into a single zip file which can be passed
to our technical support team.

It is possible to select ”All Servers” (the default) or just a single server. Click ”Output file...” to select a des-
tination path for the zip file whichwill be written. Click ”Download” to start downloading the files for the
server.

Thismay take some timedependingon thebandwidth available betweenclient and server(s). The client
diagnostic information should be very fast since it is only copied locally.

About...

This window provides information about theWaveView client application and its licence, as well as any
third party libraries used to build the product.

3.2 Display Area
Right-clicking the Display Area calls up the contextmenu, containing the following options:
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Figure 3.3: ContextMenu

Show Group Playback Slider - asdescribed in section3.15 -QuickSearchControls usingTimeSlider.

Lock Aspect Ratio - Causes all Video Displays to be fixed to their true aspect ratios (width and height)

Show Subtitles - Video Displays subtitles toggle option (on/off)

Setup Subtitles - Opens the Setup Subtitles screen

Setup Slider – allows configuration of the actions and appearance of the Time Slider used for quick
search at the lower edge of each Video Display

Figure 3.4: Slider Settings Box
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Clear Layout - Removes all Video Displays from the Display Area.

Select All - Selects all Video Displayswithin the Display Area.

Save Layout - Saves the current camera layout under a specified name. See section 3.7.1 - Saving and
Loading Layouts.

Load Layout – Allows a previously saved camera layout to be loaded. See section 3.7.1 - Saving and
Loading Layouts.

Full Screen - Expands the Display Area to full screen display (to exit from full screen display, right click
to call up theContextMenuonceagain, and toggle theFull ScreenoptionOFF, or click the ”Exit Full
Screen” button at the topwhich is visiblewhen themouse ismoved)

Lock –Controls the size of the Video Displays

Display Areas - Allows newVideo Display Areas to be added and removed

Restore Toolbars - Useful if all toolbars have been hidden,makes them all visible again

Many of these functions can also be carried out from the Display Area Toolbar (details in section 3.3
- Display Area Toolbar below).

3.3 Display Area Toolbar

Figure 3.5: Display Area Toolbar

TheDisplayArea toolbars are split in three sections, eachofwhich canbedisplayedor hidden (right click
on the Toolbar to configure).

Figure 3.6: Display Area Toolbar displaymenu

The toolbar icons are as follows:

Export Toolbar
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• Mark ’Start Time’ for Export icon – selects the start time for a quick export from the Main
screen

• Mark ’End Time’ for Export icon – selects the end time for a quick export from the Main
screen

• Export icon – calls up ExportWindow

• Go to ’Start Time’ icon –moves the current playback position to the selected ’Start Time’

• Go to ’End Time’ icon –moves the current playback position to the selected ’End Time’

Main Toolbar

• Full Screen Display icon - Clicking on this icon removes all menus and toolbars from the
screen, and expands the camera view(s) to fill the entire screen.

• Clear Layout icon - TheClear Layout icon removes all cameras from the Display Area.

• Select All icon – selects all Video Displays

• Save Layout icon -Clicking on the Save Layout icon allows you to save a configured layout
of camera displayswith a friendly name (e.g. Car Park Cameras) for quick recall. Note that layouts
cannot be saved if the configuration is locked - i.e. an installer or administrator is currently editing
the system settings. In this case an errorwill be displayed.

• Load Layout icon – loads a previously saved Layout of cameras

• DisplayConfiguration icon -Clicking on this icon allows you to select the configuration
of the camera display from the following selections:

– Free - Switches the Display Area to freely configurablemode

– 1, 2x2, 3x3, 4x4, 3x2, 4x3, 5x4, 5x3 - Switches to a fixed, preset layout of displays

– Custom Layout - Switches to a previously saved custom layout

• LockLayout–Toggleoptionto lock/unlockthecurrentpositionsof thevideodisplays. When
the ’unlock’ option is selected, youcanclickanddragavideodisplay toanemptyposition in thedis-
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play grid (if a fixed Display Configuration e.g. 2x2 has been selected). If the Display Configuration
setting is configured as ’Free’, the video display can bemoved to any position.

The same action can be carried out even if the Lock layout option is in the ’Lock’ state, by holding
down theCTRL keywhile you click and drag the display.

• Undo Layout - returns to the previous layout

• Redo Layout - re-applies a layout after an undo operation

• Toggle option to lock/unlock the aspect ratio of the currently selected video display.

• Adds a horizontal row of video displays to the current layout

• Adds a vertical column of video displays to the current layout

Video Toolbar

• SetupSubtitles icon-TheSetupSubtitlesscreenallowsconfigurationof thesubtitleswithin
all Video Displays of the current Display Area.

When clicked, a new window appears showing the subtitle template with a variety of ’tags’ ar-
ranged to reflect the current subtitle settings (e.g. Server/Camera name, time stamp, frame rate
etc.). These can then be amended as required.

• Subtitles icon -Clicking on this icon allows you to toggle the video display subtitles on/off.

• Talkback status icon – displays the status of the Talkback channel from a microphone on
the client device, to a speaker on the server or camera. Talkback for any channel is switchedon/off
by clicking on the Microphone icon on the Video Toolbox ( section 3.6.2 - Video Display Toolbox).
When talkback is active on any channel, the statuswill show as Red.

This iconcan alsobeusedas aglobal on/off toggle switch for theTalkback feature, to activate talk-
back for any configured camera channels.

3.4 Working with Video Displays

3.4.1 Video Displays from Standard Cameras
ToaddacameraviewtotheDisplayArea, firstlyselectwhichCameraViewtypeyouwant touse (Free/Custom/1/2x2/3x3/4x4/3x2/4x3/5x4/5x3)
by right clickingon theDisplayArea tocall up theContextMenu (Figure5.1), and then leftclickingonyour
desired selection (e.g. ’2x2’ in this example). You can also do this by click thedropdownboxon theVideo
Display Toolbar.
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You can also click on the ’Add Column to Grid Layout’ or ’Add Row to Grid Layout’ button on the Video
Display Toolbar (see section 3.3 - Display Area Toolbar above) To create a Video Display, double click on
theCamera Name in the Device Tree and it will appear in the next free space in the Display Area.

Alternatively, click and drag the camera name from theDevice Tree to the position that youwant on the
Display Area (e.g. Camera 3):

Figure 3.7: DraggingCamera 2 fromDevice Tree onDisplay Area

Repeat for any other cameras that you require:
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Figure 3.8: Camera 4 added fromDevice Tree to Display Area

To select a Video Display for user control (for PTZ control/playback etc.), click on that camera view so
that the camera view frame is highlighted blue, as shown in Figure 5.7 (the top left camera is active in
this case).

Figure 3.9: Camera 2 active for PTZ control/playback

You can now use the Playback controls to pause the Live stream, and search the recorded footage for
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this camera:

Figure 3.10: Camera 2 paused

When addingVideoDisplays for other cameras, theywill inherit the playback state of any selectedVideo
Displays. For example, if you have a Video Display playing back recordings and it is selected, if you drag
and drop or double-click a different camera in the Device Tree, the new Video Displaywill begin playing
back from the same time point (as long as there are recordings for that period).

To ”solo”, or enlarge, an individual Video Display (e.g. Camera 3), double click on the Video Display; the
displaywill now fill the entire Display Area.
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Figure 3.11: Camera 3 view enlarged

To ”unsolo”, or return to the previous layout, double click on theCamera Display again.

Figure 3.12: Exiting Full Screen View
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3.4.2 Dewarped Video Displays from Hemispheric Cameras
This section explains how to interact with fisheye lens cameras and assumes that the cameras have
already been suitably configured by the system administrator.

Wewillwalk through ”cloning adisplay” anddewarping thecloneddisplay, although thecloning step isn’t
actually necessary. The benefit of cloning displays is that only one video stream is transmitted over the
network and decoded, yet it can be viewed several times with different dewarping settings. This also
means that playback control will affect all the cloned displays.

Double-clicking the name of the hemispheric camera in the Device Treewill create a newVideoDisplay
of the rawwarped stream from that camera in the Display Area...

Figure 3.13: Calling up Video Display from360°Camera

Clickon the ’AddColumn toGrid’ button layout tochange thedisplayconfiguration. Thiswillmakespace
in the Display Area for another Video Display.
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Figure 3.14: AddingColumn to display grid layout

Hover yourmouse over the top of the Video Display, so that the Video Display Toolbox appears.

Figure 3.15: Calling up the Video Display Toolbox
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Click on theClone button on the Video Display toolbox to create a clone of the original Video Display.

Figure 3.16: Clone button

These twodisplaysbothdisplay the samevideo stream, andare timesynchronised. Anyplaybackcom-
mands (Pause/Rewind/Fast Forward)will affect both displays.

Figure 3.17: CreatingCloned Video Display

OntheclonedVideoDisplay, positionyourmouse in the toprightof thedisplay tocall up theVideoDisplay
Toolbox.

Figure 3.18: Video Display Toolbox
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Figure 3.19: Dewarping button

Click on the Dewarping button and choose ”Default”.

The dewarped image can be manipulated by clicking and dragging the mouse to perform Pan and Tilt
operations, and scrolling themousewheel for a Zoomoperation. Note that this requires the layout to be
locked, otherwise clicking and dragging the Video Display will move it within the layout. The layout can
be lockedwith the padlock icon in the Display Area Toolbar, or temporarily toggled by holding the CTRL
key.

It can sometimes be useful to see an indication of the dewarping operation. Clicking the ’Contours and
Tracking’ icon in theDisplayAreaToolbarwill enable amodewhereby thedewarped areas of the original
image are highlighted in red, as shown below...

Figure 3.20: Contours and Tracking button

Figure 3.21: TheContours and Tracking Feature

You can create a virtual PTZ tour in a dewarped virtual camera view, by clicking in the centre of that view,
and then then dragging the mouse pointer outside that camera view. The view will pan in the same
manner as a physical PTZ camera.
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3.4.3 Panoramic Video Displays from Hemispheric Cameras
CreatingaPanoramicview isverysimilar tonormaldewarping,withacoupleofkeydifferences. Primarily
the use of free layouts, and selecting ’Panoramic’ instead of ’PTZ.

In this sectionwe’llwalk throughanexample of howyoumightwant to set upa layoutwith apanoramic
camera.

Start with an empty 2x2 layout and double-click on the name of the hemispheric camera in the Device
Tree to add it to the Display Area.

Figure 3.22: Video Display of rawwarped stream from360° camera

Position yourmouse over the top of the Video Display of your camera, so that the Video Display Toolbar
appears. Then click theClone icon to create a clone of the original Video Display.
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Figure 3.23: CreatingCloned Video Display

Nowchange the layout from ’2x2’ to ’Free’ and drag the cloned VideoDisplay to the bottom left position.

Figure 3.24: Positioning displays in a free layout
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On the cloned Video Display, click the Dewarping icon and select ”Panoramic”. The cloned video display
will nowdisplay a panoramic section of the original raw image.

Resize the bottomVideo Display so that it takes up thewidth of the Video Display Area.

It’s also useful sometimes to enable the ’Contours and Tracking’ feature from the Display Area Toolbar.

Figure 3.25: Contours and Tracking button

The panoramic area will now be shown on the original warped image. The panoramic image can be
adjusted by clicking and draggingwith themouse and using themousewheel to zoom.

Figure 3.26: Panoramic Displaywith Contours and Tracking

Clicking on the ’Contours and Tracking’ button againwill remove the green setup graphics.

3.4.4 Keyboard Shortcuts
Opening many cameras with an appropriate layout size

Holding Shift whilst double-clicking either a server name, or a Channel Group name, will cause
the layout grid dimensions to change to a ”best fit” size, and open all the cameras on that server or
within that Channel Group. For example, if you have a Channel Group containing 9 cameras, a
3x3 grid layout will be opened containing all 9 cameras. The same happens when dragging and
dropping the server name orChannel Group namewithShift held.
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Opening cameras with the keyboard
HoldCtrl andpress the forwardslashnumpadkey / toopen thecameraselectionoverlay. Keeping
theCtrl pressed, enter the desired camera number, then pressEnter.

Opening saved layouts with the keyboard
Hold Ctrl and press the asterisk numpad key * to open the layout selection overlay. Keeping the
Ctrl pressed, enter the desired layout number, then pressEnter.

Next and previous camera
HoldingCtrl and pressing + or -will switch to the next or previous camera.

Locking and unlocking the layout
Pressing Ctrl will temporarily toggle the layout lock/unlock button. This is particularly useful for
modifying grid layouts. For example if a dewarped camera is in a layout and the layout is locked,
clicking and dragging in the video displaywill operate dewarping PTZ on that camera. If, however,
youwant tomove the camera to a different slot in the grid, holdingCtrl will temporarily unlock the
layout and allowing clicking and dragging tomove the display.

3.4.5 Using Multiple Video Display Areas
WaveView supports the use of up to 4VideoDisplay Areas simultaneously. The default VDA is known as
VDA1. VDAs 2, 3, and 4 can be opened using theWindow menu.

By default, newly opened VDAs are arranged as tabs above VDA1, but they can be detached andmoved
to the desired location, such as a separatemonitor.

Bydefault, double-clicking items in theDeviceTreecauses those items (e.g. camerasor audio channels)
to open in VDA1, however they can be dragged and dropped to any VDA. Also, it is possible to choose a
different default VDA for double-click opening in theSystem Settings preferences (see section 3.22.1 -
SystemSettings). Similarly, double-clicking anevent in the LiveEventStreamopens that event onVDA1
by default, but the desired default VDA can be configured in the same preferences.

There is also per-user configuration option for automatically opening a layout on each of the VDAs. This
has to be configured for the desired user by an install-level or admin-level user. See section 6.1 - Users.
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Video Displays can even be dragged and dropped between VDAs as long as neither VDA is locked.

3.5 Setup Subtitles Menu

Figure 3.27: Subtitle Setup submenu

The Setup Subtitlesmenu allows the default subtitles that appear on individual Video Displays to be re-
configured or removed.

Thismenu contains individual configuration for each of the subtitle positions on the display, such as po-
sition, font, size and displayed text.

The Presets section allows you to select from a list of commonly used configurations.

If youwish to configure a custom subtitle configuration for that position, click in the text box (light grey
section), and you can add/remove the sections that you require.

TheHelp button opens awindowshowing the list of available tags, alongwith a description of each. You
can copy and paste from thiswindow into the text box for each position.

The functions of the remainingmenu buttons are as follows:

• The Restore Defaults button sets the subtitles to the default settings

• TheOK button accepts the current setting and closes the Setup Subtitleswindow

• TheCancel button cancels all changes and closes the Setup Subtitleswindow

• The Apply button saves the current setting but keeps the Setup Subtitleswindowopen

• The Help button gives a full list of the Subtitle options available

• The Use Subtitles embedded into video option can improve the clarity of the displayed subtitles, if
the client PC has a low quality graphics card
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3.6 Video Displays
A single Video Display shows a single video stream and plays any associated audio stream. When the
mouse is hovered over the top right corner of the Video Display, the Video Display Toolbox is shown
which provides access to various tools and settings for that Video Display. The Video Display contains a
subtitles area, alongwith Video Status Iconswhich indicate the current state of the video stream.

Figure 3.28: Video Display

3.6.1 Hot-Spots
If configured, Hot-Spots associated with a Video Display will be shown when the mouse is over that
Display.
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Each Hot-Spot will highlight when the mouse is hovered over that Hot-Spot. A tooltip will show the
name of the Hot-Spot if themouse is stationary over the Hot-Spot.

Left-clicking themouse activates the action associatedwith the Hot-Spot.

For details of configuring Hot-Spots, see section 6.5 - Hot-Spots.

3.6.2 Video Display Toolbox

Figure 3.29: Video Display Toolbox

TheVideoDisplay Toolbox appearswhen themousepointer is placed in the top right hand corner of the
Video Display, and shows a number of icons used for performing operations on the currently selected
Video Display(s) (highlightedwith a Blue frame).

•

Snapshot captures the currently displayed image and displays it in a newwindow, allowing edit-
ing, export and printout.

•

Video Resolution allowsyoutochangethecurrent ’requested’viewingresolution (Low/Medium/High)
to improve the image rate on a slow network connection.

•

Create Annotation - A section of Video Footage can be marked with annotations, so that it can
be easily located at a future date.

•

Dewarping - Enables dewarping of fisheye and panoramic cameras. Only present if configured
for the current camera.

•

Clone Video Display - a new Video Display, time synchronised to the original display, will open in
the Display Area, a useful feature when viewing different saved views from a hemispheric
camera. Only supported for hemispheric cameras.

•
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Metadata Display –opensanewwindowdisplayingMetadataassociatedwiththiscamerachan-
nel (if configured)

•

Talkback –click to toggleon/off (ifTalkbackhasbeenconfigured for thischannel). The iconcolour
changes toRedwhenTalkback is active. Note that this controls captureof audio fromthemi-
crophone and transmission to the target device. When playing back recordings, the talkback
audiowill always be played if recording for that Talkback track has been enabled.

•

Mouse PTZ – click to toggle on/off (if PTZ has been configured for this camera). See section 3.6.3
-Mouse PTZControl.

•

Close – closes the Video Display

3.6.2.1 Snapshot Window

When the Snapshot button is clicked, the currently displayed image is captured and displayed in a new
window, allowing the user to:

• Edit the image using the following commands (click and drag on the image to select an area, then
select your desired command from either the pull downmenus or the toolbar)

– Crop

– Sharpen

– Blur

– Mosaic

– Desaturate

– Invert

– Equalize

– Brightness +/-

– Contrast +/-

– Gamma +/-

• Resize the image

• Save a copy of the still image (if permitted) in BMP, JPG or PNG format

• Print the image

Note that the ”Export” user permission controlswhether the current user is permitted to save the snap-
shot.
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Figure 3.30: Snapshot Screen

Following themenupath Image→SubtitlesSetupallowsyou toconfigure theappearanceandposition
of the subtitles on the image.

Figure 3.31: Snapshot Screen – Setup Subtitles submenu

The setup subtitlesmenu allows you to configure, reposition or remove the subtitles from the selected
position on the image.
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3.6.2.2 Create Annotation Window

Clicking on the ’CreateAnnotation’ icon calls up theAnnotationwindow; a user can addnotes of interest
toabookmarkasectionof footage. Tocarry thisout, enter thestartandendtimesof therequiredfootage,
and any annotation that you require.

Figure 3.32: Annotation Setup

3.6.3 Mouse PTZ Control

When thismode is enabled, PTZ cameras can be controlled using themouse. Left click and drag to pan
and tilt the camera, use themousewheel to zoom.

Some cameras also support drawing a box on screen tomove the camera and zoom to the desired re-
gion. This is performed by clicking themiddlemouse button and dragging a box to highlight the desired
area.
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3.6.4 Video Status Icons
The Video Status Icons (lower right of Video Display) indicate the state or features of the current video
stream, as follows:

3.6.4.1 Audio Icons

•

Audio Available Icon - If this icon ispresent, anaudiochannel is associatedwith this videochan-
nel. The audio can be heard if this Video Display is set to AudioMaster.

Hovering yourmouse pointer over the Audio Available Iconwill cause additional icons to dis-
play as follows:

•

Audio Mute This iconmutes the audio from this channel

•

Audio Enable This icon enables the audio from this channel.

•

Solo Audio Clicking this icon instructs WaveView that it should only plays the audio associated
with this VideoDisplay. Thiswillmute any audio streams fromVideoDisplays alreadyplaying.

3.6.4.2 Authentication State icons

If Image Authentication has been activated on the server (see section 6.2.7 - Image Authentication),
theAuthenticationStateIconshowstheImageAuthenticationstatusof thecurrentstream in the lower
right corner of the Video Display. The available states are:

•
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Authentication checked andOK

•

Authentication not checked. This can happen if playing back close to the current time, e.g. 1 sec-
ond from live. This is because the authentication data is only recorded every few seconds. It
canalsohappen if signaturestreamrecordingwasnotenabledat timeof recording thevideo.

•

Authentication checked and failed

If ImageAuthentication has not been enabled for the server, no AuthenticationState iconwill be visible.

3.6.4.3 Encryption State icons

The server can be configured to encrypt one or more of its video channels. The Encryption State Icon
showswhether encryption is currently enabled for this camera.

The available states are:

•

Encrypted

•

Unencrypted

If you connect to a channel for which encryption has been configured on the server, you may see the
followingmessage, if a Private Key to decrypt the channel has not been loaded:

Figure 3.33: Encryption Key prompt
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To load your Private Key in order to decrypt the stream, click on ’Load Key’.

Figure 3.34: Loading Private Key

Other Text Information is displayed in the Video Display such as Server Name, Camera Name, Time
Stamp, Time Zone, frame rate and file size of the image. The Subtitle Settings control which of these
text items are displayed.

3.7 Layouts
A Layout consists of various cameras in various positions in the Video Display Area, along with various
properties for each of those cameras.

It is possile to save Layouts with a name so that they can be easily recalled later. It is also possible to
create sequences of layouts to create a cycled display.

Layouts are, by default, private to the user who created them. However they can also be marked as
”shared” so that other users can see them.

It isalsopossible toconfigureauto-loadingofaparticularLayoutorLayoutSequence foreachuserupon
login. However note that this has tobeconfiguredbyan ”admin” or ”install” level user for ”user” level users.
See section?? -??.

The following properties are savedwith a layout:

• The layout name

• Whether aspect ratio should be preserved for the cameras in the layout

• Whether subtitles should be shown for the cameras in the layout

• The cameras to display and their positions

• The resolution (high or low) for each of the cameras

• The digital zoom level and position for each of the cameras
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• The fisheye dewarping position for each of the cameras - if applicable

• Whether the dewarping ”contours and tracking” feature should be enabled or disabled

• Whether a particular camera is a clone of another

• Audiomode (for audio channels only), e.g. mute, solo, or enabled

In server groups, the layouts are saved to all servers. When loading, they are read from the first con-
nected server. Any level of user can save a layout.

3.7.1 Saving and Loading Layouts
Layouts can be saved by right-clicking the Display Area and choosing ”Save Layout...”, or by clicking the
Save Layout button in the Display Area Toolbar...

The Layout canbegiven anameandoptionallymarked as ”Shared” so that other users can see this Lay-
out. Saving, overwriting, or deleting shared layouts is only possible for userswhohavebeengranted this
permission.

Layouts can be loaded by right-clicking theDisplay Area and choosing ”Load Layout...”, or by clicking the
Load Layout button in the Display Area Toolbar...

A list of saved layouts is presented, with the Shared Layouts shown first. Note that shared layouts and
personal layouts each have their own list of IDs, so it’s possible to seemultiple layoutswith the same ID,
where one is shared and the other isn’t.

The ”NameFilter” box at the top allows layouts to be searched. Simply start typing to filter the list to only
layouts containing that text.

Layouts can also be deleted fromhere.
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To load the Layout, either double-click it’s entry in the table, or click once and click Load.

When layouts are loaded, theywill inherit the playback state of any selected display in the Video Display
Area. For example, if an existing display is currently playing back from 10 minutes ago, the newly dis-
played layoutwill load at that time point and continue playing.

3.7.2 Triggering Layout Sequences
Layout Sequences allow layouts to be automatically loaded consecutively with configurable durations
for each one. They are configured in the Setup Screens by an ”install” or ”admin” level user.

Layout sequences are triggered from the Load Layout dialog, which can be accessed either by right-
clickingtheDisplayAreaandchoosing ”LoadLayout...”, orbyclickingtheLoadLayoutbutton in theDisplay
Area Toolbar...

At the bottomof the Load Layout dialog, a drop-down list of configured LayoutSequences is presented.
To start a Layout Sequence, choose the desired sequence and click Start.
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Once the Layout Sequence has startedmany of the facilities relating to the Display Area are unavailable
until the sequence is stopped. TheDisplay Area Toolbar has a newStopbuttonwhichwill be present if a
Layout Sequence is running.

3.8 Device Tree

Figure 3.35: Device Tree

The Device Tree displays the currently connected Wavestore Servers, with enabled Audio and Video
Channels listed beneath.

The Filter box at the top allows the user to start typing the name of a server, channel, or view, and only
itemsmatching that textwill be shown.

The icon to the right of the filter box allows expanding or collapsing all the items in the tree.

Right clickingon theDeviceTree text allowsyou to view the select variousdisplay options for theDevice
Tree:

• Display either Channel Tree (all channels) or Camera Group Tree (if this option has been config-
ured)

• ShowChannel IDs

• ShowDisabledChannels
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• ShowServers

• ShowServers IDs

• Show Views (saved ’virtual camera’ dewarped or panoramic views from panoramic cameras are
shown)

These settings are automatically saved so they are preservedwhenWaveView is restarted.

When ”ShowServers” is disabled, only the cameras and views are displayed. If using a server group it is
sensible togive camerasunique ”sort IDs” across thegroup, otherwise theorderingof camerasmaynot
be as expected. See section 9.21 - Sort IDs formore information.

Double-clicking on a Channel Name on the Device Tree, causes the video from that Channel to be dis-
played in the Video Display Area. Alternatively,

Multiple-cameras can be selected and then dragged onto the Video Display Area. Holding CTRL and
left-clicking selects individual cameras, whereas holding SHIFT selects a range.

If the VideoDisplay Area is currently viewing oneVideoDisplay only, the VideoDisplay is switched to the
newly selected channel. Otherwise a new Video Display (containing the new Channel) is added to the
Video Displays that are already displayedwithin the Video Display Area.

Double-clicking on a Channel Group name on the Device Tree, causes the video from the cameras in
that Channel Group to be displayed in the Video Display Area.

3.9 Status Indicator
TheStatusIndicatorprovidesaquicksummaryof thestatusofall servers in thegroup. Itchangescolour
to show the worst status of all servers in the group. For example if all servers are OK except one has a
Fault status, it will show red for the fault status.

The Status Indicator can be clicked to jump to the SystemLog to inspectmore details of any issuewith
the servers in the group.

The possible statuses are as follows:

Recording
The systemhas no detected issues and is recording from at least one camera.
Shows a green Status Indicator and transparent background for the server name in the Device
Tree.

Unlicensed
The server doesn’t currently have a valid licence and therefore is not recording.
Shows an amber Status Indicator and amber background for the server name in the Device Tree.
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Server awaiting restart
The server currently requires a restart to apply recentlymade configuration changes.
Shows an amber Status Indicator and amber background for the server name in the Device Tree.

Recording not enabled
The server is functioning correctly but no recording is occurring.
Shows an amber Status Indicator and amber background for the server name in the Device Tree.

Standby
Used as part of the Failovermechanism, this server is acting as a Standby server.
Shows an amber Status Indicator and amber background for the server name in the Device Tree.

Starting
The system is starting up.
Shows an amber Status Indicator and amber background for the server name in the Device Tree.

Fault
This server has a problem. Inspect the System Log to find out details of the problem.
Shows a red Status Indicator and red background for the server name in the Device Tree.

Failed
This status is shown when a Force Failover event occurs. This means that an event rule has put
this server into a ”Failed” state, and caused failover to occur.
Shows a red Status Indicator and red background for the server name in the Device Tree.

Theserver status is also indicated in theDeviceTreeas thebackgroundcolour for theservername. Hov-
ering themouse over the server name also provides details of the status, as shown below.
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3.10 Playback Controls

The playback controls affect any currently selected Video Display (highlighted with blue frame) in the
Display Area, and operate as follows:

Play/Pause Starts/pauses playback of the stream

Rewind/Frame Step Back A single left-click steps back a single frame. Holding the left mouse button
starts Rewind; the speed of Rewind increases the longer themouse button is depressed.

Fast Fwd/Frame Step Fwd Asingle left-click stepsback a single frame. Holding the leftmousebutton
starts Fast Forward. The speed of Fast Forward increases the longer the mouse button is de-
pressed.

Beginning of Archive Jumps to the oldest recording on the currently selectedChannel and Track

Stop Exits playback to return to Live View

End of Archive Jumps to the latest recording on the currently selectedChannel and Track

Go to field Allows you to access a specific point in time by directly entering Date and Time

Playback Speed slidebar Clickanddrag theslidebar tochooseplaybackbetween0.1x -4.0x real time.
Note that themaximum isconfigurable, see section3.22.5 -Playback. Alsonote that fast playback
requires a powerful PC and the videomay jump if the system is not powerful enough. Thismech-
anism is not a substitute for the Fast Forward operation.

Track Selection buttons 1/2/3 Allows you to select a recording track for the selected video displays.

After selecting a track (either 1, 2 or 3), all playback operations described abovewill affect this track only.
The textdisplay in the toprighthandcornerof theVideoDisplay indicateswhether thestatusof thevideo
streambeing viewed (Live/Play/Paused).
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3.11 Events Control

TheEvents control allowsEventRules tobe startedor stopped (in the caseof an ”On/Off” typeofManual
Trigger), or triggered (in the case of a ”Pulse” typeManual Trigger).

Thedrop-down list consists of the namesof all Event Ruleswhere theCauses contain aManual Trigger.
When a rule is selected, if the Manual Trigger in the rule is an ”On/Off” type, then On and Off buttons are
presented,whichcanbeused toactivateanddeactivate theManual Triggerwithin theevent rule. If it is a
”Pulse” type (in otherwords ”instantaneous”), then a single ”Pulse” button is provided to allow theManual
Trigger to be triggered.

See section 6.12 - Event Rules formore details on configuring such rules.
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3.12 PTZF Controls

Figure 3.36: PTZControls

The PTZF Controls Panel allows control of configured Pan/Tilt/Zoom cameras. These controls will be
disabled if:

• The active camera is not a PTZ camera

• The current user does not have permission to control PTZ actions on this camera

Available controls are:

• Pan left/right

• Tilt up/down

• Zoom in/out

• Focus in/out

• Iris open/close

• Movement SpeedControl slider

• Shift left/right - for rail mounted cameras

• Wash

• Wipe

• Lamp toggle
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• Go to/Setup a Preset Position (see section 3.12.1 - Setting PTZ Preset positions)

• Start/Setup a Tour (see section 3.12.2 - Setting PTZ Tours)

3.12.1 Setting PTZ Preset positions
Access the Live Screen by following themenu path View→Main, and open a Video Display for the PTZ
camera by.

Using the PTZF controls, move the camera to the desired position.

Figure 3.37: Live View screen showing PTZ controls

In the Preset section, use the arrow keys to call up the Preset number that youwant to assign, and then
click ’Set’.

If you want to check the position of saved Preset, move the camera to another position, use the arrow
keys to call up your desired preset position, and then click ’Go’.

3.12.2 Setting PTZ Tours
Use the arrow keys to call up the Tour number that you want to assign, and then click ’Set’. The Tour
configurationwindowwill now appear, showing preset views currently configured on the server.
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Toconfigure thefirst positionon the tour, draganddrop theoneof thePreset views into thefirstwindow
in the Tour section.
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Use the Dwell Time and Tour Speed settings, to configure how long the camera should remain at that
preset position, and the speed at which it will move to the next Preset position. Note that the Speed
setting is only supported on a limited number of cameras.

Repeat the above steps for the remaining preset positions that youwish to add to the tour.
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Ifyouwant the tour tooperatecontinuously (cycling fromthe lastPresetpositionback to thefirst), select
the ’Cycle’ option.

Finally click on ’Save’ to return the Live View screen.

To start the tour operating from the Live View screen, use the arrow keys to call up the number of your
desired tour, and then click ’Start’.

3.13 Smart Search Control
The Smart Search control allows a post-recording search of a period of recordings based uponmotion
or video analytics data. This section documents how to perform the Smart Search, assuming the cam-
erashavebeenappropriately configured. Seesection9.8 -ConfiguringSmartSearch for informationon
how to configure cameras for Smart Search.

Note that Smart Search is also available in the Find screen, however the Main screen implementation
supports theMultipleplaybackmode,whereastheFindscreendoesnot. This isbecausetheFindscreen
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is intendedtoshowall camerasat thesamepoint in time, but theMultipleplaybackmoderequiresshow-
ing the cameras at different points in time. Also, analytics searches are only currently supported in the
Main screen.

TheActions... menu can be used to perform the various relevant operations.

The New Search... option opens a wizard to build a search query. The remaining options are used to
control playback of the results.

3.13.1 Performing a Smart Search
The first page allows the following to be selected:

• The time range for the search

• The type of search

• The camera(s) to be searched

The Search Type selector will only contain search types available for the currently selected camera. If
no cameras are selected, it will show the aggregate of all search types available for all cameras. For any
camera which is currently unavailable for selection for the current search type, a tooltip is available ex-
plainingwhy, visible by hovering themouse over the camera name.
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Once the desired parameters for the search have been set, clickingNext >will advance to the next page
in the searchwizard.

The options available for each search type are discussed below.

Motion Search

Motion Search performs a historical search based on themotionwithin the scene.

A mask, or area of interest, and a sensitivity can be specified for the search. The default sensitivity is
often appropriate. The last sensitivity andmask is recalled on aper-camerabasis to helpmake repeated
searches easier.
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When the mask and sensitivity have been set and the Finish button is clicked, the search will be per-
formed.

The search is performed on4 second blocks of recordings and so the resultswill always have durations
which aremultiples of 4 seconds. Thismeans that,whenplayingback the results, the lead-in before the
actualmotion occurs could be 0 to 4 seconds.

Metadata Search

This search type allows searchingmetadata. Thismetadata is normally configuredwhen installing pur-
chased integrationmodules and instructions for setup are includedwith the integrationmodule.

When performing a search, firstly the Protocol should be selected. This will be something like Point-of-
Sale or License Plate Recognition. Next, the desired field type should be selected. This might be ”Price”
for Point-of-Sale, or ”Plate” for LPR. Next, the query type should be selected. For text fields thismight be
something like ”Contains” or ”is equal to”. For numerical fields, queries such as ”is greater than” or ”is less
than” are available. Finally, the search data should be entered.

Multipleconditionscanbespecifiedbyclicking the ”+”buttontoaddanotherquery. Thesearchwill return
results thatmatch all queries.

Object Properties

Thisanalyticssearchallowssearchingofanalyticsobjectdata tomatchvariouspropertiesof theobjects.
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It is possible to search on the object speed, beinggreater than or less than the specified value. Theunits
can bem/s (metres per second),mph (miles per hour), or kph (kilometres per hour). Alternatively, if
’Any’ is selected, the speed is not checked in the search.

It is also possible to search on the object class and, optionally, subclass. The availability of the subclass
option is dependent on the source of the analytics data for the current camera.

For theclassandsubclassmatching, it ispossible toprovideaminimumprobability for theobjectmatch-
ing that class.

If supportedbytheselectedcamera, it isalsopossible tosearchbySegmentColour. Asegment isapart
of the object, e.g. Torso, Lower. Either select a colour, or select the checkerboard to indicate no colour.
For each segment, a probability of that colour can be specified.

Once the desired parameters have been chosen, clickingNext >will perform the search.

Line Crossing

This searchallowsdetectingobjects crossinga line, in either directionor both. Theobject properties can
also bematched.

Thefirst pagepresented is the sameas theObject Properties search type. To search for anyobject, just
click theNext > button.

The second page allows configuration of the line.

Lines which have been previously configured can be selected from the drop-down list, but not edited.
Alternatively, ”Custom” can be selected and then the line can be edited as follows:

• Click and drag a circular end-point of the line tomove that point

• Click and drag on the line tomove thewhole line

• Double click the arrow to change the direction of the arrow.

Once the desired line has been configured, clickingNext >will perform the search.

Box Entry

This search allows detecting objects entering a region. The object properties can also bematched.

Thefirst pagepresented is the sameas theObject Properties search type. To search for anyobject, just
click theNext > button.
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The second page allows configuration of the box.

Boxeswhich have been previously configured can be selected from the drop-down list, but not edited.
Alternatively, ”Custom” can be selected and then the box can be edited as follows:

• Click and drag a circular end-point of the line tomove that point

• Double-click on an edge of the box to add another point

• Double-click a circular end-point to remove it

• Clickwithin the box and drag tomove thewhole box

Once the desired line has been configured, clickingNext >will perform the search.

Box Exit

This search is the same asBox Entry except it detects objects leaving the region instead of entering.

Box Entry or Exit

This search is the same asBox Entry except it detects objects leaving the region aswell as entering.

Object In Box

This search is the same as Box Entry except it returns results for the duration that the objects were
inside the the region.

Object Removed

This search allows detection of objects being removed from the scene. For this search type, the ’zone’
is optional.

Thefirst pagepresented is the sameas theObject Properties search type. To search for anyobject, just
click theNext > button.

Thenextpage isusedtoconfigure thezone. Onlyobjects removedfromwithin thezonewill bematched.
The zone configuration page is the same as described inBox Entry.

Object Idle

This search is the same asObject Removed except it returns results for when an object becomes idle,
i.e. notmoving, instead ofwhen the object is removed.
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Crowd

This search allows detectingwhen a certain number of objects arewithin a certain zone.

The first page presented is similar to theObject Properties search type. To search for any object, leave
the settings as default.

This page also allows choosing theCrowd Count, which is theminimumnumber of objects within the
zone to trigger amatch.

There is also a checkbox for ’Use Entire Scene’. If checked, the page to configure the zone is skipped.
Otherwise, the next page allows configuring a zone, in the sameway as described forBox Entry.

3.13.2 Reviewing Smart Search Results
When the searchhas completed, the results are shown in theplaylist. Theway the results arepresented
can vary dependingon the typeof searchperformed. Also, theplaylist canbeundockedandwill provide
extra columns, giving extra detail about the results of the search.

All searches give:

• A start time

• A duration

• A ”loop” control

Many analytics searches will present the results in a tree-like structure grouped by the Object ID. This
is because there may bemanymatches for the same object and the playlist entry represents the time
duration for thematches for that object.

A Crowd search will show the crowd count for the results. Again these will be in a tree-like structure
grouped together if the crowdcount is the sameand the result iswithin a fewseconds of the last result.
Note that small changes in the crowd count are ignored. For example if there are many results with a
crowd count of 4, with one result of 3 in themiddle, the 3will be grouped inwith the results for 4. This is
to prevent briefmiscounts of the crowd resulting in separate playlist items.

Each item in the playlist has a button to control whether the itemplayback should be looped.
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Now that there are results in the playlist, the Actions... button allowsmore operations to be performed.
These are described below:

Play Sequential
This sets theDisplayArea layout to ”1”, for a single camera. It thenplays the items in theplaylist one
by one. They are not set to loop sowhen each one finishes it will play the next.

Play Multiples
This fills the current layoutwith cameras from the playlist and automatically adds new ones each
timeone is closed. It defaults to a 2x2grid, but if there is already agrid selected (e.g. 4x4) itwill use
that. The cameras are looped by default so theywill repeat until closed.

Stop Playback
This stops the playback of the playlist.

Reset Playlist
This sets all the items in the playlist back to the ”unplayed” state.

Clear Playlist
This removes all items from the playlist.

During playback, unplayed items are shown with bold text, items being played are highlighted in blue,
and played items are shown in normal textwith no highlighting.

As well as the Sequential and Multiples playback modes described above, it is also possible to simply
double-click an item to open it from the playlist.

3.14 Layouts Control
The Layouts control provides convenient access to the layout load dialog. See section 3.7 - Layouts for
details on its use.
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3.15 Quick Search Controls using Time Slider

Figure 3.38: Video Display showing Live View fromCamera 3

If you move the mouse pointer over the lower edge of an individual camera view, a quick search time
sliderwith playback controls appears as shown below.

Figure 3.39: Video Display showing Live View fromCamera 3with time slider bars
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Thedarkgreybar represents the footageon theselected recording track for this camera (oldest footage
at the left, most recent footage on the right). The grey bar will contain gaps for any periods when the
channel was not recorded by the server (e.g. a channel configured forMotion Detect recording).

The light grey slider shows displays the current position on the recorded track The quick search play-
back control buttons (either end of the time slider) allow you to pause or resume playback, frame step
forward/backward (quick click), and also fast forward and rewind (click and hold).

Clicking and dragging on the light grey slider gives the user control of the current playback position on
the recorded track.

Figure 3.40: Searching usingGrey Time Slider bar

To carry out a more detailed search, hover your mouse pointer over the blue time slider, and roll the
mousewheel forward.

Rolling themousewheel forward/backwardwill zoom in/out on the timeperiod; as youdo this, the scale
of the time incrementswill change, as below:
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Figure 3.41: Time Increments on Blue Time Slider bar changed by rollingmouse

WheelClickingonapoint on theeither sideof thegrey slidermoves thecurrentplaybackposition to that
point in time.

Figure 3.42: Time of displaymoved forward fourminutes by clicking on Time Slider bar

If youwish to look at footage from another camera at the same point in time, youmay need to first re-
configure your display type (e.g. from a single camera display).
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You can do this by using the drop downmenu on the Display Area Toolbar:

Figure 3.43: Changing display configuration using drop down list

Alternatively you can click on either the ’Add Row toGrid layout’ or ’AddColumn toGrid Layout’ buttons
on the Video Display Toolbar:

Figure 3.44: Changing display configuration using ’Add Row toGrid Layout’ button
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The Video Display configurationwill now change:

Figure 3.45: NewDisplay Configuration

To add the video, first check that the current Video Display is selected so that the frame is highlighted
blue (clickwithin the Video Display if not), and pause playback.

Next, double-click on the name of the camera in the Device Tree that youwant to add to the display.

The new camerawill nowbe added to the display:
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Figure 3.46: Camera 7 added to display (in PlaybackMode), paused at same time asCamera 3

To return a Video Display to Live View, just click on the Stop iconwithin that display.

Figure 3.47: Camera 3 paused in Playbackmode, Camera 7 in Live Viewmode
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3.16 Quick Export for Single Camera Channel
If the Video Display that you areworkingwith is a dewarped view from a hemispheric camera (see Ap-
pendixB), youcanpan/tilt/zoomwithin theVideoDisplayduringplayback to trackapersonorobject, and
thesemovementswill beshown in theexportfileoncecreated, if youselectanyexport formatother than
theWavestore Native format (WSB), for example AVI orWMV.

AWSB format exportwill contain the fullwarpedvideostreamfor that camera, andanydewarpedviews
that have been saved for that camera.

Please note that the permissions of the user making the export may conditionally limit the functional-
ity of the exported data. For example, if the current user does not have permission tomake transcoded
exports (e.g. converting to AVI), anyWSB exportmade by that user will contain that permission setting,
meaning that the resultingWSB export cannot be subsequently converted to another format. This de-
sign is intentional, to prevent a possible workaroundwhere a user couldmake an AVI by first creating a
WSB export then opening the export and converting it to AVI.

If there is a critical need tooverride these settings, staffatWavestore Limitedcandoso, but it is not trivial
and a feemay be charged.

3.16.1 Quick Export for Standard Camera
Once we have identified required footage using the Search function, we can carry out an export for a
single camera from the Live Screen as follows:

Figure 3.48: Quick Export – Playback paused at the start of required footage

Click on the ’Mark Time for Start of Export’ button (green flag icon) on the Video Toolbarwhen you have
reached the start point of the footage that you require (use the Pause function if necessary).
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Figure 3.49: Quick Export –Mark ’Start Time’ for export

If you move the mouse pointer over the lower edge of an individual camera view, you can see that a
green arrow is now shown on the time slider, showing the Start Time for the export.

Figure 3.50: Quick Export –Green ’Start Time’marker on time slider

You can now resume playback of the footage until the desired end point of the Export is reached. Click
on the Red Flag on the Video Display Toolbar.
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Figure 3.51: Quick Export –Mark ’End Time’ for export

If youmove themouse pointer over the lower edge of an individual camera view, you can see that a red
arrow is now shown on the time slider, showing the End Time for the export.

Figure 3.52: Quick Export – Red ’End Time’marker on time slider

Click on the Export button on the Video Toolbar (filmstrip icon) to call up the ExportWindow:
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Figure 3.53: Quick Export – Export button

The ExportWindowwill now appear:

Figure 3.54: Quick Export – Exportmenu

Browse to your desired Export Path by clicking on the ’...’ button, and then select your desiredContainer
Format (full details of the export procedure are described in section4.9 - Exports). TheWavestoreWSB
formatwill be selected by default.
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Finally click Start; the progress bar will fill during the export, with an acknowledgement message dis-
played once the export is completed.

Figure 3.55: Quick Export – Export completionmessage

Once you have completed the export, youwill be prompted to add a copy of theWaveView software to
the export folder. This software can be used to playback the export file from themedia. It is not neces-
sary to first install the software onto the PC being used to play the export file.
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Figure 3.56: Quick Export – prompt to addWaveView

To add a copy of the WaveView software, click on ’Yes’ You will now be prompted to confirm the folder
whereWaveViewwill be saved.

Figure 3.57: Quick Export – selecting destination folder forWaveView

Browse to your desired folder, and then click ’Select Folder’. A progress bar will now fill from left to right
and a confirmationmessagewill appear once complete.
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3.16.2 Creating aQuickExport trackingaPerson/Object in aDewarped
Camera View

If the Video Display that you are working with is a dewarped view from a hemispheric camera, you
can pan/tilt/zoom within the Video Display during playback to track a person or object, and create a
transcoded export file (e.g. WMV) showing your trackingmovements (pan/tilt/zoom).

Once you have reached the desired start time for your export, pause Playback first.

Figure 3.58: Quick Export from dewarped camera view– Playback paused at the start of required
footage

Click on the ’Mark Time for Start of Export’ button (green flag icon) on the Video Toolbarwhen you have
reached the start point of the footage that you require (use the Pause function if necessary).
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Figure 3.59: Quick Export fromdewarped camera view –Mark ’Start Time’ for export

If you move the mouse pointer over the lower edge of an individual camera view, you can see that a
green arrow is now shown on the time slider, showing the Start Time for the export.

Figure 3.60: Quick Export fromdewarped camera view –Green ’FromTime’marker on time slider
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If you move the mouse pointer over the lower edge of an individual camera view, you can see that a
greenarrow isnowshownonthe timeslider, showingtheStartTimefor theexport. Youcannowresume
playback of the footage, clicking and dragging using themouse to track the target person/object:

Figure 3.61: Quick Export fromdewarped camera view – tracking target person/object

You can use themousewheel to zoom in/out on the target during playback:
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Figure 3.62: Quick Export fromdewarped camera view – tracking target person/object

You can now resume playback of the footage until the desired end point of the Export is reached. Click
on the Red Flag on the Video Display Toolbar.

Figure 3.63: Quick Export fromdewarped camera view –marking end time of export
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If youmove themouse pointer over the lower edge of the camera view, you can see that a red arrow is
now shown on the time slider, showing the End Time for the export.

Figure 3.64: Quick Export fromdewarped camera view – Red ’End Time’marker on time slider

Click on the Export button on the Video Toolbar (filmstrip icon) to call up the Exportmenu:

The Exportmenuwill now appear:

87



Figure 3.65: Quick Export – Exportmenu

Browse to your desired Export Path by clicking on the ’...’ button, and then select your desiredContainer
Format (full details of the export procedure are described in section4.9 - Exports). TheWavestoreWSB
formatwill be selected by default, change this to AVI orWMV.

Finally click Start; the progress bar will fill during the export, with an acknowledgement message dis-
played once the export is completed.
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Figure 3.66: Quick Export – Export completionmessage

Once you have completed the export, you can playback the export using a suitable media player e.g.
WindowsMedia Player/VLC.
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Figure 3.67: Playback of Tracking Export usingWindowsMedia Player

Theexportfilewill showtheexact trackingmovements thatyoumade,whilstviewingthecamerabefore
carrying out the export.
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Figure 3.68: Playback of Tracking Export usingWindowsMedia Player

This export option is only applicable when using AVI or WMV formats. A WSB export will contain the
entirewarped image, alongwith any dewarped views that have been previously saved for that camera.
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Figure 3.69: Playback of Tracking Export usingWindowsMedia Player

3.17 Quick Export for Multiple Camera Channels
Oncewehave identified required footage using theSearch function,we can carry out a export from the
LiveScreenofmultiplecamerachannelsas follows: Configure thedisplayso that it contains thatcamera
channels that you require.

Select the cameras that you wish to export by clicking to making their displays active so their frame is
highlighted ’Blue’ (either by clicking ’Select All’ on the video display toolbar, or by holding downCTRL on
your keyboard and clicking on the individual displays that you require).
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Figure 3.70: Quick Export – ’Select All’ option for Video Displays

Right click to call up on the Display Area to call up the Context menu, and left click to select the ’Show
Control Toolbar’.

Figure 3.71: Quick Export – ’ShowControl Toolbar’ enabled onContextMenu

AControl TimeSlider Toolbarwill nowappear at the lower edge of the screen. Use themouse to control
the playback of the video displays using the Control Time Slider Toolbar as described in section 3.15
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-Quick SearchControls using Time Slider. You should see that all selected displays are synchronised.

Figure 3.72: Quick Export – Control of Video Displays usingControl Time Slider Toolbar

Click on the ’Mark Time for Start of Export’ button (green flag icon) on the Video Toolbarwhen you have
reached the start point of the footage that you require (use the Pause function if necessary).

Figure 3.73: Quick Export – Selecting Start Time for Export
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Once you have reached the desired end time for your export, click on the ’End Time for Export’ button
(Red Flag icon on Video Toolbar). Youmaywish to pause Playback first.

Figure 3.74: Quick Export –Mark ’End Time’ for export

Click on the Export Dialog button on the Video Toolbar (filmstrip icon) to call up the Export dialogmenu:

Figure 3.75: Quick Export – Export button
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The Exportmenuwill now appear:

Figure 3.76: Quick Export – Exportmenu

Browse to your desired Export Path by clicking on the ’...’ button, and then select your desiredContainer
Format (full details of the export procedure are described in section4.9 - Exports). TheWavestoreWSB
formatwill be selected by default.

Finally click Start; the progress bar will fill during the export, with an acknowledgement message dis-
played once the export is completed.

Once you have completed the export, youwill be prompted to add a copy of theWaveView software to
the export folder.

This software can be used to playback the export file from the media. It is not necessary to install the
software onto the PC that is being used to play the export file.
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Figure 3.77: Quick Export – prompt to addWaveView

To add a copy of theWaveView software, click on ’Yes’ Youwill nowbe prompted to confirm the location
whereWaveViewwill be saved.

Figure 3.78: Quick Export – selecting destination folder forWaveView

Browse to your desired folder, and then click ’Select Folder’. A progress bar will now fill from left to right
and a confirmationmessagewill appear once complete.

Section 5 - Playing Back Exported Files gives details on how to play back .WSB export files using a PC.
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3.18 Live Event Stream (Optional Licensed Upgrade)

Figure 3.79: WaveView Live ViewScreen showing Live Event Stream

TheLiveEventStreamprovides a list of incomingevents (updated in real time). TheEvent types that are
displayed can be filtered, and their properties (colour of text and/or background, sound notification) can
be edited; section 3.22 - Preferences gives full details on how to configure.

It should be noted that the events are not saved locally (on the PC runningWaveView); they are stored
on theWavestore server itself.

TheLiveEventStreampanel canbeminimizedandmaximizedbyclicking the↓arrow icon. Whenmax-
imized, it shows a tablewith the following columns:

Time
Shows the date and time of the event

Id
Shows a unique ID corresponding to this event

Status
Can be ’On’, ’Off’, or ’Pulse’

Text
Any associated text for this event

Cause
The cause of the event being triggered, e.g. Motion, Login, Darkening, Video Loss, Input

Source
Anassociatedparameter for the event; formotion this could be a cameranumber, for digital inputs
this could be the input number
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Server
Server that is the source of the event

Right clickingon thecolumnheadings in theLiveEventStreamdisplays amenuwith toggleoptions that
controls the columns displayed.

Figure 3.80: WaveView Live ViewScreen, ColumnSelectionMenu

Clicking anddraggingon the columnheadings allowsyou to change theorder that they are displayed in.

TheEvents themselvesthataredisplayedcanbefiltered, andtheirproperties (colourof textand/orback-
ground, soundnotification) can be edited; section 3.22 - Preferences gives full details on how to config-
ure.

It should be noted that the events are not saved locally (on the PC runningWaveView); they are stored
on theWavestore server itself.

We can playback or export associated with an event by right clicking on an event in the list, and then
selecting the desired option from themenu that appears as below:
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Figure 3.81: WaveView Live ViewScreen, ColumnSelectionMenu

Selecting ’Play Video Clip’ will close any Video Displays currently shown, and open a new single Video
Display playing footage associatedwith the event you have chosen.

Figure 3.82: WaveViewLive ViewScreen, Playing Back VideoClip fromEvent List

If you select the ’Export Video Clip’ option, the video clip will be saved to: C:\Users \[username] \Wave-
storeExports \EventClips Events on the list can be acknowledged by clicking them. These Events will
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no longer showup in the summarywhen the Live Event Streampanel isminimized.

Whenminimized, a summary is displayedwhich shows:

• The number of unviewed events

• The date and time of the last event

• The type (cause) of the last event

Figure 3.83: WaveViewLive ViewScreen, Event Listminimised

We can also search for Individual Events by following the Individual Events by following themenu path
View→ Find→Search→ Events
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Figure 3.84: Event Search Dialog screen

3.19 Maps
WaveView provides map functionality to allow cameras and alarm devices to be visualised on one or
more interlinked images. TheMaps are configured if theMap Setup screen and viewed via the ”View→
Map”menu.

If no map data exists, the Map Viewer will display an explanatory message. It is not possible to create
map content fromwithin themap displaywindow.

In the Map Viewer there are fewer controls and slightly different mouse interactions to the Map Setup
screen. Essentially, controls relating to editing themap are not present.

The controls that are present are:

Current Area Dropdown
This dropdown list shows the current area and allows the selection of other areas.

Toggle Rubber Band
Whenenabled, left-clickingthemouseanddraggingdrawsarectangulararea. Whenthe leftmouse
button is released, any cameras within the rectangular area will be shown on the Video Display
Area. When disabled, left-clicking the mouse and dragging can be used to pan around the map
areawhen zoomed in.
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ToolTips Enabled
When enabled, hovering over item shows additional information about that item. Hovering over a
camerawill show a live stream from the camera.

Note that cameraswhich are open in the Video Display Area are highlighted on themap.

LeftDouble click on a camera to view that camera in theWaveViewDisplay Area.

Cameras also show their status by changing colour to orange or red depending on the status. Hover
over a camera to view details of the status.

3.20 Network Tools
TheNetwork Toolsmenu (menu path Tools→Network Tools) contains the following items:

Figure 3.85: Network Toolsmenu

• Ping

• Trace Route

• DNS Lookup

Thesecommandscanbeusedto test/troubleshootconnectivity tonetworkeddevices, suchasIPcam-
eras andNTP servers.

Enter the IP address or host name, and then click ’on the function that youwish to use.

Informationwill be displayed in theOutputwindowbelow.

3.21 Log Files
The Wavestore has a number of log files. Since it is a client-server architecture, there are separate log
files for the server andclient. Sincemost clientmessages appear on the screen, it’s rare youneed to look
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at the information in the client log. However, most things the server reports have nowhere to go other
than the system log, and so this is the principle log of the system.

Historically a lot of information was in the system log, and this has been broken out into a number of
alternative log files. There’s now a separate log for each disk or disk array, for each camera or capture
device, and for a number of other special items. These alternative logs are available in the ”Extra Logs”
tab of the System Log screen.

3.21.1 System Log
The server System Log can be accessed by the menu path Tools→ System Log, or by clicking on the
Server status indicator (see section 3 - Main Screen), and can give valuable diagnostic information re-
garding the status of the server.

This log file can be saved to a USB device from the server, or to a local drive on a connected client.

In the case of a server group installation, the System Log for any of the Server within the group can
be accessed by clicking on the grey server icon (server name is beneath this icon – default setting is
’Wavestore’) in the top left corner of the System Logwindow, and selecting from the drop downmenu.

The server name can be changed by following the menu path View → Setup → Server → Name (see
section 6.2.1 - General).

System LogMessages are colour coded and start with a letter according to their type:

Information: ’I’ Black

Start-up: ’S’ Green

Fault: ’F’ Red

Warning: ’W’ Orange
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Login: ’L’ Dark Blue

Configuration: ’C’ Pink

Debug: ’D’ Light Blue

Users can filter certain types ofmessage by checking/unchecking the relevant box.

Messages other than debugmessages are intended to be readable by a typical user and will be trans-
lated into the selected language.

Debug messages might contain less readable internal states. See also the ’Alternative log’ files section
below.

The Server Log can be backed up to a USB device/local drive by clicking Save, and browsing to the de-
sired location.

Common system logmessages include:

• SWavestore server starting - shown at startupwith the server software version.

• S Shutdown - shows when the system shut down. If it shut down unexpectedly, this message
will be producedwhen it restartswith the correct time of shutdown.

• I IP Address - gives the address of the principle network interface in the system.

• I Licence: - shows the licence loadedwith the abbreviated licence flags.

• I NTP: Time synchronised (stratum4) - shows that time synchronisation has occurred. The stra-
tum shows howmanymachines are in the chain between this device and the time source.

• I Authentication disabled - this refers to videowatermarking authentication not being enabled.

• L User install logged in from - showswho logged in and fromwhich IP address.

• L User install from ... disconnecting - showswhen that user disconnects.

• CUser install set ... - showsconfiguationparameterswhichhavebeenchanged, format is thesame
as the advanced configuration screen.

• C User install reset - shows configuation parameterswhich have been removed.

3.21.2 Extra Logs
For detailed debugging of problems, there are now separate logs for each disk or disk array, for each
camera or capture device, and for a number of other special items. These items used to be in themain
system logwhen ’debug’ optionwas selected, but nowhave beenmoved out into their own log files.

These alternative logs are accessed using the ”Extra Logs” tab of the System Logwindow.

It’s important tohavedetailed logswhenthingsgowrong: it’sclear that thecamera isn’t streamingvideo,
but why? By looking in the log file for the specific camera we can find all the infomration wewant (and
rather a lotwe don’t want). By having a separate log for each capture device (and each disk) then issues
related to one device do not get confusedwith another.

Serious information like faultmessageswhenacamera isn’t streamingare still reported to themain sys-
tem log as before, but the full debugging information is in the alternative log file.

To access an alternative log file, go to Tools→ System Log... then click the Extra Logs tab.
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Log files for cameras configured by the new setup screen (not using any legacy methods) are called
C followed by the camera number, so C2 is the log file for camera 2. If there are multiple streams for
camera2, theyhave lettered suffixes, so theremight be files calledC2b C2c for secondand third streams.
Auto-configurationofONVIFcameras fromversion6.14onwardshavesuffixauto, eg,C2auto. Talkback
devices have suffix tb in V6.14, eg C2tb.

Legacy camera capture devices (configured by version 6.12 or before) such as ONVIF capture devices
are named after the capture device (not the camera) using the same convention used in the system
log or the Cameras setup screen, for example the third capture devicewhich is an ONVIF type is called
ONVIF3.

Log files for disks or disk arrays are named after the disk letter, eg, DiskD for Disk or Disk Array D.

To view a specific log file, select it from the drop-down list and click Download. By default, the last 1000
linesof the log file aredownloaded, showingcommands sent and replieswithout thedetail of everybyte
sent over thenetwork. For thedetailed debug information including all the networkdata, check the ”De-
bug” checkbox and click Download.

Again this is only the last 1000 lines. This detailed version includes network data transmission in lines
beginning > for data sent and < for data recieved. Only textual data is shown; not every byte of binary
data is listed but a summary of the number of binary packets is shown.

To obtain the full log (not just the last 1000 lines), select the ”All line” radio button.

These might be lengthy and take a while to download (tens of seconds or a few minutes). If you are
submittingoneof these logs toour technical support team,pleaseobtain the full logwithDebug included
unless otherwise asked.
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3.21.3 Client Log
TheClient Log can be accessed by themenu pathWindowsClient LogClient Log, and give information
regarding the user activities on theWaveView client software.

This log file can be saved to a USB device from the client PC.

Figure 3.86: WindowsMenu, Client Log screen

LogMessages are colour coded according to their type:

Warning: Orange

Information: Green

Fault: Red

Users can filter certain types ofmessage by checking/unchecking the relevant box.

The log can be backed up to a USB device/local drive by clicking ’Save’, and browsing to the desired lo-
cation.

Note that theClient Log isnot translated intonon-English languagesand isonly intended fordiagnostics
byWavestoreGlobal Limitedtechnical staff.

3.22 Preferences
The WaveView client software screen can be personalised using the Preferences screen (menu path
Tools→ Preferences).

This screen allows the following preferences to be set for the local Client software installation (not the
server itself):
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The screen has various submenus as follows:

3.22.1 System Settings

Figure 3.87: PreferencesMenu, System submenu

Language The language to use for the user interface. By de-
fault, WaveViewwill attempt to detect the language
automatically from the operating system. Note that
it isadvisable to restartWaveViewafterapplying this
setting.

Mirror layout This it not editable, but showswhether the user in-
terface will be switched from left-to-right to right-
to-left.

Timezone This setting determineswhether the user interface
will show timestamps in the server’s timezone, the
client’s timezone, or UTC. When set to ”Server”, the
client will use the timezone of the first connected
server.
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Default Display Area AllowschoosingwhichDisplayArea (VDA) tousewhen
double-clicking to open cameras in either the De-
vice Tree or Live Events window. If the requested
VDAisnotopenwhentheoperationsareperformed,
any other VDAwill be used.

Request compressed configuration from server By default, the server’s configuration is transmitted
in compressed form.

Keep annotations on the server for Defines how long annotations should be preserved.

Refresh period for client cache Determineshowfrequently theclientchecksforan-
notations. If there are lots of annotations and they
are requested frequently, this could cause perfor-
mance issues.

Don’t ask to exit WaveView DetermineswhetherWaveViewshould ask ”Are you
sure youwant to exit?” when closing.

Maps - Download Directory Specifiesthe locationof thetemporarymapsdown-
loaddirectory forstoringmap images. Note that this
should be set to a dedicated temporary path, and
not a directory containing other user files as exist-
ing datamay be overwritten. See section 6.7.7 - for
more information.

Joystick device Allows manual selection of a specific joystick. The
defaultsettingwill automaticallydetecta joystickde-
vice and choose the first one found.

 

3.22.2 Audio and Talkback

Figure 3.88: PreferencesMenu, Audio submenu

This screen allows selection of the audio input and output devices. Audio input devices are used for the
Talkback functionality and audio output devices are for playing audio.  

109



3.22.3 Events

Figure 3.89: PreferencesMenu, Events submenu

This screen provides a wealth of options relating to event handling. Note that the live event stream is
licence controlled and so these options are only relevant if using a suitably licensed system. The options
are described below:

Live Events

Enable live event streams If enabled, WaveView will pull a stream of
events fromeachconnectedserver for dis-
play in the Live Event Stream on the main
screen.

Clear live event streams when new server is connected WhendisconnectingfromaWavestoreserver
and thenconnecting toanewone, it isoften
desirable to clear the old events. That will
happen if this option is enabled.

Maximum events buffered This sets the maximum number of events
tobestored inmemory. Increasingthisnum-
ber increases thememory usage of Wave-
View.
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Event request on server connection

Request old events when new server is connected WhenWaveViewdisconnects fromaserver,
it makes a record of the last event seen. If
this option is enabled, whenWaveView re-
connects to that sameserver itwill request
all events since that previous connection.

Show event request on connection inside top level view This is a diagnostic tool used when exam-
ining issues with requesting events. Gen-
erally not needed in everyday use.

Limit time of events in request (in minutes) When requesting old events, only request
thosewhich are not older than the number
ofminutes specifiedhere. The limit is 2880
minuteswhich is 48 hours.

Limit count of events in request When requestingoldevents, only request a
maximumof this number.

Event Filter

This area allows detailed configuration of the types of events that will be shown in the Live Event View.
It is described inmore detail below.

Properties associatedwith each event type can be edited to change the appearance (text/background
colour in the Live Event Stream), and also assign a notification sound for that event type.
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Figure 3.90: PreferencesMenu, Events submenu, configuring Properties for Event

To add a new Event to this list, click on your desired Event in the Available Event Types list (the event
namewill highlightDarkGrey), then click on ’->’ arrowkey; the event namewill nowappear in theFiltered
EventTypesbox. Toadd removeanEvent fromtheFilteredEventsTypes list, clickonyourdesiredEvent,
then click on LEFT ARROW key.

Event Handling

If the systemhas the ”LiveEventsStream” licence feature activated, a user canmanually export footage
for an event (e.g. Digital Input) by right clicking on that event in the LiveEventStreamwindow (see sec-
tion 3.18 - Live Event Stream (Optional Licensed Upgrade)).

Exports arecreated in thenativeWavestore ”WSB” format, andcan thenbeplayedbackusing theWave-
View software. The exports are saved to C:/Users/username/WavestoreExports.

The ’Event Handling’ options determine how these exports aremade:
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Seconds before event Whencreating anexport fromanevent in the LiveEventView, this specifies the
length of time before the event that the export should start.

Seconds after event Whencreating anexport fromanevent in the LiveEventView, this specifies the
length of time after the event that the export should end.

Default track Whencreating anexport fromanevent in the LiveEventView, this specifies the
default recording track to use.

3.22.4 Logging

Figure 3.91: PreferencesMenu, Logging submenu

TheLoggingsubmenucontrolswhichmessagetypesarewrittentotheClientLog(Debug/Error/Information/Warning).

We can also configure which folder on the local PC the logmessages are written to, and the size of the
folder thatwill be allocated to thesemessages.
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3.22.5 Playback

Figure 3.92: PreferencesMenu, Playback submenu

The Playback Preferencesmenu has the following settings:

Enable Live Buffering Whenthisoption isdisabled, live imagesareshownas
soon as possible. This means that latency is kept to
aminimum, but canmean that live viewing isn’t very
smooth. Enablingtheoption introducessome latency
but smooths the live streaming. It is generally advis-
able to disable this when using PTZ cameras as la-
tency canmake themhard to control.

Low resolution if grid’s dimension greater than WaveViewwill requesta lowresolutionstreamforeach
camera when a grid layout has a dimension greater
than this number. This only applies for certain cam-
era types andwhendual-streaming has been set up.

Underflow Handling This determines what the client should do when it is
struggling to keep up with the video. For example if
the CPU can’t decode the video fast enough, or if the
network can’t deliver images fast enough.

Underflow Threshold This setting determines when the playback mech-
anism will jump forward to the expected time if it is
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struggling to keep upwith playback.

Maximum Speed Slider The Main Screen has a slider for fast playback. The
default maximum speed for this is x4.0. This setting
allows themaximumspeed tobechanged. Note that
fast playback requires a powerful PC and the video
may jump if the system is not powerful enough. This
mechanism is not a substitute for the Fast Forward
operation.

I-Frame Only Threshold When doing fast-playback on theMain Screen using
the fast-playback slider, high playback speeds may
result in jerky playback. To remedy this the software
will switch toonlyplaying i-framesonce theplayback
speed exceeds this threshold.

Timeline Refresh Interval Dictateshowfrequently thetimeline in theFindScreen
is refreshed. On particularly highly loaded systems,
thismightbeuseful to reduce theamountofdatabe-
ing sent across the network.

Downgrade resolution when panning This feature,whenenabled, improvestheperformance
ofpanningadewarpedcamerabytemporarily reduc-
ing the display resolution. This allows for smoother
panning.

3.22.6 Security

Figure 3.93: PreferencesMenu, Security submenu
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Thisscreencurrentlyhasoneoption; ”Checkserverpublickeywhenconnecting”. This is asecuritymea-
sure designed to protect against ”Man in the middle” attacks. Each Wavestore server has a unique key
which is generated when the software is installed. When WaveView connects to a server for the first
time, it stores that key. If the same server is connected to at a later time and the key is different, this
suggests either that the Wavestore software has been re-installed, or that somebody is attempting to
intercept the communications, inwhich case it is inadvisable to continue the connection.

Note that older servers (prior to version5.52) hadan issuewhere the keywould changewhen the server
is restarted, therefore a warning message will appear on every connection between server restarts. It
is advisable to upgrade those older servers, but this preference option can also be disabled to prevent
WaveView fromperforming the check.

3.22.7 Connection

Figure 3.94: PreferencesMenu, Connection submenu

This screen contains advanced options relating to the connections betweenWaveView and each con-
nectedWavestore server.

Timeouts

Asdescribed in thewarningmessage, it is stronglydiscouraged tomodify the timeout valuesunlessun-
der the guidance of an official technical support representative. The default values are carefully chosen
toworkwell in the vastmajority of cases.

Login

This sectionhasoneoption-Hide ”Connect toServerGroup” checkbox. If enabled, thecheckboxon the
Login Dialog to allow connection to a server group, rather than an individual server, will be hidden. This is
useful if certain clients should only be allowed to connect to one server at a time.

3.23 Connection List
OnceaWaveViewclienthasestablishedaconnectiontoaWavestoreserver,wecanviewa listofall active
client connections to that server by following themenu path Tools→Connections

Click to select the server that you wish to interrogate in the column on the left; information on all con-
nected users (Client IP address, and user logon ID)will then be displayed:
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Figure 3.95: ToolsMenu, Connection list
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3.24 Copy WaveView

Figure 3.96: ToolsMenu, CopyWaveView

Selecting this optionwill send acopyof theWaveViewprogramfiles to a selected folder onyour PC. This
feature is useful if you have exported aWSB export file which youwish to play back on another PC that
does not haveWaveView installed.

Simply browse to your desired destination folder, and then click ’Select Folder’ to start the copyprocess.

Note that the files are copied from your local WaveView installation. They are not transferred from the
server.

3.25 Server Maintenance
The ServerMaintenancemenu is used to set up various systems and services on theWavestore server.

Menu entries can be selected by double-clicking the entry, or single-clicking the entry to select it then
clickingOK. ClickingClosewill return to the previousmenu.
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Figure 3.97: ToolsMenu, ServerMaintenance submenu

SSH Tools Note: This option will only function if you have installed the ’wavestore-ssh-tools’ software
package. This package is not normally distributed due to export laws, however you can obtain it by con-
tacting your support representative.

The SSH Tools allows configuration of the Secure SHell service which is used for remote support by
Wavestore support representatives. In normal usage these options should be left as the defaults, how-
ever aWavestore support representativemay ask for some settings to be changed for the purposes of
remote diagnosis and investigation.

Themenus allow:

• Enabling and disabling the service

• Switching between securemode and passwordmode

Securemode requires a special key to log in, and onlyWavestore support representatives have this key.
Therefore this is the preferred setting. Passwordmode is less secure and should therefore only be en-
abled under guidance from aWavestore support representative.

Configure 3Ware RAID 3dm2 utility

When aWavestore is suppliedwith RAID (Redundant Array of Independent Disks), it is usually provided
by a 3Ware RAID card - this is a physical device in theWavestore server. In order to manage the RAID
system there is aweb interfacewhich is disabled by default.

This menu option allows enabling and disabling of the 3Ware RAID service. When enabled, the RAID
utility can be accessed from a web browser (either from the server itself, or a PC) using the following
URL: https://[serverIPaddress]:888

Default login details for the 3wareGUI are ID: Administrator, Password: 3ware

An example of typical RAID setting to use on aWavestore server is shown below:
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Figure 3.98: 3ware RAID array – example configuration

RunHardwareDetectionWhenaWavestorehasnewcapturehardware installed, e.g. an analoguecap-
turecardoraudiocard, itwill automaticallydetect thatnewhardware ispresentandrun its ’hardwarede-
tection’ process. Thismodifies the server configuration to ensure that the appropriate number of video
and audio channels are available for configuration in theCameras setup screen.

In rare circumstances it may be necessary to force the detection process to run and this menu option
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provides that facility.

Configure server graphics driversThedefault graphicsdrivers onanyWavestore shouldnormally per-
formwell out-of-the-box. However sometimes, for either performance or compatibility reasons, itmay
bedesirable to install the proprietary graphics drivers from the appropriatemanufacturer, eitherNVIDIA
or AMD (formerly ATI).

Thismenuoption allows theproprietary graphics drivers to be installed or uninstalled remotely. This can
be useful when doing remote upgrades ormaintenance, although it’s advisable to have someone avail-
able to check that thegraphical interface isworking after anychange. A reboot is required after installing
or removing proprietary drivers. Removing the proprietary drivers causes the system to fall back to the
default drivers.

3.26 File Manager

Overview
TheFileManager is used touploadanddownloadfiles toor from individualWavestore serversor a server
group. An ”install” level user is required to performall the operations, althoughother user-levels can view
the files.

Currently there are 3 types of files shown:

Audio Thesefiles areusedwhencreatingEventRulesused to trigger a sound tobeplayedby theserver
- either via an audio output or by transmitting to a network camera with audio output. Any audio
file uploaded should be rawPCMA (8kHz PCMA-law)with a ’.pcma’ suffix.

Lua These are scripts which are used by integration modules - used to integrate Wavestore with 3rd
party devices.

Map These are image files used by the Map system. It’s not normally required to upload or downlod
them fromhere, it’s performed automaticallywhen setting upmaps using theMapSetup Screen.
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However they are shown here for diagnostic purposes.

Usage
The available files are represented as a ”tree” where the top level consists of the servers in the server
group. The second level is the file type, and the third level is the files of each type.

To download a file, simply select it and click ”Download...”. This will ask the user where the file should be
saved.

Similar, to remove a file, simply select it and click ”Remove”.

When uploading a file, it is necessary to prepare a zip file containing the file or files to be uploaded. There
are restrictions on the valid file names and types as follows:

• The file namemay only contain characters ’a-z’, ’0-9’, ’-’, ’_’, and ’.’

• The file namemust end in one of: ’.lua’, ’.pcma’, ’.jpeg’, ’.jpg’, ’.png’, ’.svg’, ’.bmp’, ’.gif’, ’.wsb’, ’.conf’, ’.pdf’,
’.txt’, ’.devdb’

• The filemust be 2Gigabytes or smaller in size

To upload the zip file, first decide if the file should be uploaded to an individual server or thewhole server
group. By default ”Server group” is selected. Clicking the ”Server group” drop-down list allows selecting
an individual server.

The next step is to click ”Upload new files...”, then to select the zip file prepared earlier. Upon receving the
zip file, theWavestorewill analyse the contents andmove the contained files to the appropriate location.
e.g. audio files of the correct type will be moved to the ”audio” directory, and image files of the correct
typewill bemoved to the ”map” directory.

3.27 Status Summary

Overview
The status summary screen provides quick access to server group devices. It will show a list view of all
devices connected to all servers in a group and status information for each device.

To open the screen, select Status Summary from the application Tools Menu. The screenwill open in a
separatewindow so that it is possible to continueworking in themain application.
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Figure 3.99: Status Summary Screen

Channel Status Fields
The status of each channel is shown in the table. Possible states are True and False and a description of
each status field is given below:

Recording Whether recording is active for this channel on any recording track.

Darkening The image from the camera is unusually dark andmight indicate tampering.

Signal Loss There is a problem receiving data from this channel.

Channel Types
If the device is a camera and is functioning correctly, then a thumbnail capture from the camerawill be
shown in the status summary table. Otherwise, one of the following icons indicates the channel type
and status:

• Audio Channel

• Audio Channel with Signal Loss

• TalkbackChannel

• TalkbackChannel with Signal Loss

• CameraChannel (Loading)
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• CameraChannel with Signal Loss

Channel Information Fields
Server Name The name of the server in the group towhich the device is connected.

Channel Name The name of the channel associatedwith the device.

Channel ID Numeric code identifying the channel on the server.

Sort ID This is the customnumber assigned to a channel (used to allowcustomnumbering schemes).

IP The IP address of the camera, if applicable.

Track List
Active tracks will be listed below the state fields with the start and end timestamps for the recording
duration. If a track has a customname, it will be shown instead of the track number. Disabled trackswill
not be shown.

Filtering
It is possible to apply a filter to the table, and see only those channelswith a particular status by toggling
the state of the check-boxes at the top of the window. Filtering is disabled by default and all channels
will be shown in the table.

The filter value of each field is show in the status bar of thewindow, alongwith the number of channels
which pass the filter and appear in the table.

The possible states of the check-boxes are shown below:

Tick The field does not participate in the filter.

Mark Only channelswith the fieldmarked as Truewill be shown.

Blank Only channelswith the fieldmarked as Falsewill be shown.

Table Export
The contents of the table can be exported to a CSV (comma-separated-values) file to be viewed with
external software. The entire contents of the table will be exported andwill include all channels from all
servers in the group, even when filtering has been applied to the view. There is some extra information
in the exportedCSV file such as the duration of recording for each track.

To export the table to a file:

• Select Export from the Filemenu in the Status Summarywindow.

• Browse to the save path.
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• Press save.

3.28 Server Statistics

Overview
The server statistics screen displays graphs of statistics, to allow the client tomonitor hardware perfor-
mance and other server information.

To open the screen, select Server Statistics from the application Tools Menu. The screen will open in a
separatewindow so that it is possible to continueworking in themain application.

Operation
The server statistics screen can display one ormore graphs.

If using a server group containingmore than one server, the server forwhich to display statistics can be
selected on the top button bar.

The + and - buttons at the bottom of the screen can be used to insert new graphs or remove existing
ones.

The chart drop-down list is used to select which statistics are displayed on the graph. One graph is al-
ways displayed. When the screen is opened the graph defaults to the first entry in the chart drop-down
list.

The filter text box can be used to filterwhich statistics are shown in the drop-down list.

Statistics in the list have data points usually sampled every 15minutes. The time range for all graphs can
be set by adjusting the date and time and selecting a duration.
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Hovering over the graph line displays a tooltip giving the value of that data point and the time it occurred.
If the data is numeric then the range of values contained in the statistics is also displayed.
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4 Search/Playback/Export usingFindScreen

The Find screen (menu path View → Find) allows you to search and play back footage stored on the
server.

Thisscreendisplaysasearchable timelineof recordedaudio/video, forall recordingtracks foreachchan-
nel.

If the client software is connected to a number of Wavestore servers that have been configured as a
Server Group, we can search footage on any of the servers in the group.

The Find screen allows easy navigation within the archived video, exporting of video in multiple for-
mats, an annotation facility for sectionsof video footage, andsearchingusingfilters suchannotation and
events. The screen is similar to the main screen Display Area, the main difference being that all of the
Find Screen Video Displays are time synchronized with each other; playback of a single Video Display
cannot be controlled independently.

The time displayed in all of the Find Screen Video Displays is based on the position of the current time
marker (blackverticalmarker)on thepurple timelinebars. This time isalsodisplayedontheCurrentTime
Indicator.

The Find screen contains the following items:

• Display Area

• Horizontal Timeline Bars (marked in purple)

• Pull DownMenu Bars

• Archive Range section

• Selection Range section

• Current Time Indicator

• PlaybackControls

• Video Display Toolbar
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Figure 4.1: Find Display Area

4.1 Pull Down Menus
The Find screen pull downmenus contains the following items:

File Menu

Close Closes the Find Screen

ViewMenu

Track 1 Toggle option to display recorded footage fromTrack 1 in the time line (default - On)

Track 2 Toggle option to display recorded footage fromTrack 2 in the time line (default - Off)

Track 3 Toggle option to display recorded footage fromTrack 3 in the time line (default - Off)

Show Time Grid Toggle option to display a grid is shown under the time line (default – On)

Show Annotations Toggle option to display any annotationsmarked into indicator beneath each cam-
era channel timeline
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Figure 4.2: Find Screen – ViewMenu

Annotation Menu

New Opens theCreate Annotationwindow

Edit Opens the Annotation Edit window

Search Menu

Events Opens the Event Searchwindow (optional licensed upgrademodule)

Metadata Opens theMetadata Searchwindow (optional licensed upgrademodule)

4.2 Time/Date Displays

4.2.1 Archive Range
The archive range displays the time and date range of the recorded footage currently stored on the
server.

Figure 4.3: Archive Range

4.2.2 Selection Range
The selection range displays the section of footage selected for export.

Thedata in thesefieldscanbeconfiguredbyhighlightingwith themouse, andentering the requireddata
with the keyboard.
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Figure 4.4: Selection Range

Alternatively we can click and drag on the timeline bars to select the required From time, then click the
Double left arrow icon, and repeat for the To time (click onDouble right arrow icon).

The finalmethod that can be used is to configure the Selection Range is to click and drag theGreen and
Redmarkers on the Time Line, to set the From and to times.

4.2.3 Current Time Indicator
The current time indicator displays the currentmaster time for all individual VideoDisplays in theDisplay
Area.

Figure 4.5: Current Time Indicator

Whenanew time is entered in this box, all VideoDisplays in theDisplayAreawill display footage from the
new time that has been entered.

4.3 Play Controls
ThePlayControls in the Find screen behave in the sameway as on themain Live Viewscreen (see sec-
tion 3.10 - PlaybackControls); the only differences being that they control all of the individual VideoDis-
plays, and that live view is not available.

4.4 Search/Playback
When the Find screen is first opened, the Display Area has no camera views configured, as shown in
Fig 6.1. To select a display configuration or a custom view, right click on the Display Area to call up the
ContextMenu:
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Figure 4.6: ContextMenu

TheContextMenu offers the following options:

Camera View Configuration

Show Control Toolbar Quick Search Toolbar described in section 3.15 - Quick Search Controls using
Time Slider

Show Audio Toolbar described in section 3.3 - Display Area Toolbar

Lock Aspect Ratio Causes all Video Displays to be fixed to their true aspect ratios (width and height)

Show Subtitles Video Displays subtitles toggle option (on/off)

Setup Subtitles Opens the Setup Subtitles screen

Setup Slider allows configuration of Time Slider used for quick search at the lower edge of each Video
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Display

Clear Layout Removes all Video Displays from the Display Area

Select All Selects all Video Displayswithin the Display Area

Save Layout Saves the current layout - see section 3.7.1 - Saving and Loading Layouts

Load Layout Switches to a previously saved layout - see section 3.7.1 - Saving and Loading Layouts

Full Screen Expands theDisplay Area to full screen display (to exit from full screen display, right click to
call up the Context Menu once again, and toggle the Full Screen option OFF, or click the ”Exit Full
Screen” button at the topwhich is visiblewhen themouse ismoved)

Camera View Selection

Free Youmay add views from asmany cameras as youwish

1, 2x2, 3x3, 4x4, 3x2, 4x3, 5x4, 5x3 - Switches to a fixed, preset layout of displays

Double-clicking on the timeline of a CameraChannelwill cause the associatedChannel to be displayed
in the Display Area, as shown below.

Figure 4.7: Single CameraChannel displayed in Find screen

Whenyouclick onaCameraChannel timeline, if theVideoDisplay is currently viewingoneVideoDisplay,
the Video Display is switched to the newly selected channel.

Alternatively, if you have configured a multichannel display (e.g. by selecting the 2x2 option from the
ContextMenu), a newVideo Display containing the newChannel is added to the Video Displays already
displayedwithin the Display Area.
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Figure 4.8: Four camera channel display in Find screen

4.4.1 Using the Time Line to Search
The time line is displayed horizontally, with oldest recordings to the left.

There is a row per server, and a row per channel on each server. Clicking the ”-” button (sometimes
shownas ”+”) togglesexpandingorcollapsingeachserver, to showorhideall thechannels for that server.

The purple bars next to the server name indicate areas where recorded events exist. Underneath the
server name, there is a row for each recording track, although by default only Track 1 is shown for each
camera.

The black vertical marker indicates the current point in time for playback. Gaps in the time line indicate
that no recordings are present for that time period (e.g. a camera channel recording onMotion Detect).

Searching on the time line can be carried out as follows:

• Left-clickanddrag thehorizontal bars tochange thecurrent timeposition, anddisplay the relevant
video in the Video Displays
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Figure 4.9: Clicking andDragging Track on Timeline

• Double left-click themouse on the horizontal bar associatedwith a track to show the associated
Channel in the Display Area

• Hover themouseover oneof thehorizontal bars to see theprecise timeat that point in the record-
ings

Figure 4.10: TimeDisplay onCameraChannel Timeline

• Click the ’span’ drop-down box to change the size of the timeline view; this allows a timeline of
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varying durations (from2minutes up to 60days) to be displayed. Alternatively, while hovered over
the time ruler, use themousewheel.

Figure 4.11: Find Screen Time Spanmenu

Figure 4.12: Find Screen Time Span reset to 2minutes
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4.4.2 Time Line Markers
The Find time line has 3markers:

Figure 4.13: Time LineMarkers

• ’Current position’marker (Black) – this indicates thecurrent position in time that is beingdisplayed
on the video display; instead, click and drag the time line relative to thismarker

• ’Start’ and ’End’markers (Green/Red respectively) - thesemarkers set the area of interest for cre-
ating exports, or searching the Event Track; click and drag to a required time using themouse, or
alternatively this can be set to the current time position being viewed by clicking on the « icon in
the Selection submenu

4.5 Annotation

4.5.1 Creating an Annotation
The Annotation feature allows you tomark footage of interest, for quick recall at a later date.

To create Annotations for footage, or search for those previously created, first click on the ’Annotations’
button to call up the Annotation Edit screen.

To create a note...

• Select the desired channel and associated record tracks

• Select the time range

• Check the ’Locked’ box if youwant to prevent the associated recordings frombeing overwritten.

• Enter some associated text

• Click ’OK’

The ’Lock’ mechanismmarks the associated recording region as being unavailable for overwriting. This
is useful to preserve important incidents but be careful when using this feature, it means that less disk
space is available for new recordings. If too many recording regions are locked, the desired recording
durationmay not be achieved.
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Figure 4.14: AnnotationMenu

In theViewmenu, enable the ’ShowAnnotations’ option, and theannotationwill nowbeshown inyellow
beneath the recording track.

Figure 4.15: Annotation Track now visible
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4.5.2 Working with Annotated footage
Follow themenu path Annotation→ Edit and the Annotation Edit boxwill appear:

Figure 4.16: Annotation List

To edit an annotation, highlight an entry in the list and click ’Edit’. To playback annotated footage, you can
highlight an entry from the list and click ’Show’.

Alternatively, we can carry out a search on the annotation text by entering ’*searchterm*’ in the Search
field.

Click ’Enter’ to generate a list of Search results:

Figure 4.17: Annotation Search Results

By default, all cameras are shown and searched. It’s possible to limit the search to a single camera. To
do so, click the ”Camera..” button and select the desired camera. To revert to searching all cameras, click
the ”Clear” button.

To delete an annotation, select the note of interest and click the ’Delete’ button. Note that the ’locked
region’ associatedwith the annotation is automatically unlockedwhen the annotation is deleted.
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Figure 4.18: Find Screen TimelineMarkers

4.6 Searching Events

Figure 4.19: Find Screen

Follow themenu path Search→ Events:
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Figure 4.20: Find Screen SearchMenu

The Event Search boxwill now appear:

Figure 4.21: Find Screen Event Search Box

Configure the parameters for your search (Time Range/Event Type). Note that, although seconds are
not shown, they are assumed to be zero, e.g. ”13:00” is really ”13:00:00”.
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Figure 4.22: Configuring Search parameters

You can configure the Search results box to display that data that you’re most interested in (right click
on the column headings to display the toggle options):
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Figure 4.23: Configuring display of Search results

Click on Search and your resultswill be displayed.

Figure 4.24: Search Results
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Double click on a Search result to playback that event, or right to display other options (e.g. Export).

Figure 4.25: Playback of Event

4.7 Searching Metadata
Followmenu path Search→Metadata, and the FindMeta screenwill open:
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Figure 4.26: Metadata box

Enter theFromandTo times for your search, the text that youwish to search for, the associated channel
(if applicable), and then click Search. In the example below, we’ll search for POS transactions involving
Crew ID ’47’ on the camera channel ’Checkout 2’.
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Figure 4.27: EnteringMetadata search details

Click ’Search’, and a list of resultswill nowbe generated:  
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Figure 4.28: Metadata search results

This list of results can be exported as a CSV file by clicking the ’Export’ button, and browsing to your
desired location.
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Figure 4.29: SavingMetadata search results

4.8 Smart Search
Wavestore has a facility to perform a post-recording search of a period of recordings based uponmo-
tion. Seesection9.8 -ConfiguringSmartSearch for informationonhowtoconfigurecameras forSmart
Search. This section documents how to perform the Smart Search, assuming the cameras have been
appropriately configured.

Performing the Search
Performing the search consists of the following steps:

• Selecting the desired date/time range

• Selecting the desired cameras

• Drawing amask (area of interest) for each selected camera

• Setting the desired search sensitivity for each selected camera

To select the desired range, either drag the red andgreen vertical bars on the timeline, or use the ”Selec-
tion” widgets in the side-pane. This is described inmore detail in section 4.2.2 - Selection Range.

To select the desired cameras, hold the CTRL key and click on the horizontal tracks in the timeline. If
multiple recording tracks are enabled for each camera, only one needs to be selected.
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Nowclick the ”Smart Search” button tomove to the next step.

Figure 4.30: Export selection

TheSmart Searchwindowwill appearwith a grid displayed over a snapshot of the current camera’s live
image. Draw amask on the image by clicking the leftmouse button and dragging the desired area. The
green highlighted area is the areawhichwill be searched.

Use the slider to adjust the sensitivity.

If multiple cameras were selected, click Next to go to the next camera and set up another mask and
sensitivity. Otherwise, the ”Next” buttonwill become a ”Finish” button, which initiates the search.

Using the Search Results
Once the search is complete, the areas ofmotionwill be highlighted in pink on the timeline, and a playlist
of periods ofmotionwill appear in the side pane.
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Figure 4.31: Smart Search Results

Theplaylist allowsskippingbetweenareasofmotion, bydouble-clicking thedesired item. Each itemcan
be put in a loop by clicking the loop icon next to the playlist item.

Note that the camera(s) displayed are not dependent on the search results. So it is possible to perform
a search on one camera, then view the periods ofmotion on a different camera, or several cameras.

The playlist and areas of motion are cleared either when a new search is performed, or when the Find
screen is closed.

4.9 Exports
Please note that if you are saving an export to a DVD/USB device directly on the server itself, you must
first ’mount’ the device on the server before proceeding with the export, this process is fully described
in section 4.9.3 - Exporting directly to DVD fromWavestore Server and section 9.17 - Accessing a USB
disk on theWavestore server.

Please note that the permissions of the user making the export may conditionally limit the functional-
ity of the exported data. For example, if the current user does not have permission tomake transcoded
exports (e.g. converting to AVI), anyWSB exportmade by that user will contain that permission setting,
meaning that the resultingWSB export cannot be subsequently converted to another format. This de-
sign is intentional, to prevent a possible workaroundwhere a user couldmake an AVI by first creating a
WSB export then opening the export and converting it to AVI.

If there is a critical need tooverride these settings, staffatWavestore Limitedcandoso, but it is not trivial
and a feemay be charged.
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4.9.1 Exporting footage to a Windows PC running WaveView client
software

TheWavestore server can directly export footage to aDVDor USBdevice, or over a network connection
to a PC.

Footage can be exported in a variety of formats; the Wavestore Native format (.WSB) is supported as
standard, andanoptional licensedupgradeoffers transcodingoptions toother formats suchas .AVI and
.WMV.

Wavestore Native format is the recommended choice for exports, and provides support for both en-
cryption and image authentication.

To create an Export, wemust first select the Export start and end times.

Figure 4.32: Export selection

This can be carried out either by clicking and dragging the Search timelines to set the red/green ’Start’
and ’End’ markers (click the ’«’ iconwhen the timeline is positioned on the desired time in each case), or
by entering text in the Selection ’Start’ and ’End’ boxes, to set the required date and time for precisely.

Figure 4.33: Find Screen TimelineMarkers

To select an audio/video channel, left-click on the timeline bar corresponding to that device. To select
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multiple cameras, hold down the ’CTRL’ key and left click the required camera channels of choice to
add/remove them from the current selection (selected cameraswill be highlightedwhite).

Once the selection has beenmade, click the ’Export’ button to open the Export Screen.

Figure 4.34: Export Screen for .WSB export

The export screen offers a number of configurable selection options:

Name/Template Allows an export name or template to be specified

Export Path The folder or directory into which the export file(s) will be saved – please note that if you
are saving an export to a DVD/USB device directly on the server itself, you must first ’mount’ the
device on the server. Once you have saved the file, you must then ’eject’ the device before it can
be removed. The procedure for this is described in section 4.9.3 - Exporting directly to DVD from
Wavestore Server.

Container Format format to be used for the download e.g. AVI,WMV,WSB (nativeWavestore format)

Include Audio Selects whether audio should be included if any audio channel is associated with the
selected video channels.

• Skip audio formissing video toggle option

• One video track per archive/file -Chooseswhether tracks should bemerged as a single file or ex-
ported as individual files. Note that using this optionmeans that only one camera canbe viewedat
a time later.

• IncludeWaveView playback software toggle option

• Keep/Remove Encryption – in the event that the downloaded channel has been configured with
encryption active

• (Re)encryptwithpassword–restrictsaccesstotheexport throughuseofuserconfigurablepass-
word (you’ll be prompted to enter a passwordwhen this option is selected)

If your client installation is licensed with the transcoding option, you can select an alternative export
format (e.g. AVI).

Once you have selected the format, select ’Show Transcoding Settings’, and the screen shown below
will appear allowing you to select transcoding options as you require:
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Figure 4.35: Export Screen showing options for Transcoding

Some points to note:

• When creating an export using AVI container format, selecting the ’Do NOT Transcode’ option
(Videosubmenu inTranscodingsection) for thefootagetype(s) thatyouaredownloading (MPEG4,
MJPEG or H.264)will result in higher image quality.

• Certain codecs impose limitations on footage that has been recorded at a low frame rate; in this
case you should select theWMV container

• Variable framerates are not supported so, if the source video has varying framerates, the resulting
exportmay appear to speed up and slow down.

• Compression or Bit Rate can be setmanually if required, based on the following: Bit Rate = (Com-
pression/100) xW x H x BPP (Bits per Pixel) x Frame RateWhere BPP = YUV420 : 12 and YUV422 :
16 Bit Rate Tolerance = Bit Rate/4

Subtitles on the export can be configured as you require by clicking on ’Show Subtitles Settings’, and
then configuring as you need:
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Figure 4.36: Export Screen showing Transcoding and Subtitle settings

Some experimentation may be required to optimise the size of the subtitles in the export; this can be
configured in the Font Size setting (Subtitles submenu)

If the export operation is being carried out froma remote location usingWaveViewclient software, then
footage can only be saved either to the hard disk of the PC, or to a connected USB device.

It is then possible to burn the export file to CD/DVD, by using standard CD/DVD burning software (e.g.
Nero/Roxio) to copy the archive directory.

Browse to your desired Export Path by clicking on the ’...’ button, and then select your desiredContainer
Format.

Finally click ’Start’; the progress bar will fill during the export, with an acknowledgement message dis-
played once the export is completed.
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Figure 4.37: Export completionmessage

Section 8 gives details on how to playback exported files using a PC.

4.9.2 Exporting still images to aWindowsPC runningWaveViewclient
software

Single still images can be backed up from the server as follows:

• Select your desired channel for playback by double clicking on the timeline for that channel

• Pause playback using the playback controls

• Clicking on the Snapshot button on the Video Toolbar calls up the Snapshot screen

We are able to carry out image manipulation/editing in the Snapshot screen as required (full details in
section 3.6.2.1 - SnapshotWindow).
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Figure 4.38: Still Image Export

Finallywe can save the image to a storage device, oncewe have selected a save path and file name.

Figure 4.39: Still Image Export
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4.9.3 Exporting directly to DVD from Wavestore Server
• Follow themenupathView→Find toaccess theFindScreen, andconfigure the requiredCamera,
Start and Stop times as described in section 4.9.1 - Exporting footage to a Windows PC running
WaveView client software; for Still Images refer to section 4.9.2 - Exporting still images to aWin-
dows PC runningWaveView client software.

Figure 4.40: Export CameraChannel, Start and Stop times configured

• Click on the ’Export’ button to call up the Export Window, configure the file name as you require,
and accept the default Save Path, so that the export is saved in theWavestoreExports folder:
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Figure 4.41: Export Screen

• Clickon ’Start’ to begin theExport; a progressbarwill nowappear, andfill as theexport progresses:

Figure 4.42: Export Completion Bar shows 100 percent

• Once the export has completed, a confirmationmessagewill appear:
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Figure 4.43: Export CompletionMessage

• Move themouse pointer into the top left corner of the screen, so that the Accessories Toolbar ap-
pears:

Figure 4.44: Accessories Toolbar

• Click on theCD/DVD icon to launch the K3BCD/DVD burning software:

• If asked about ’Konqueror integration’ click the ’Enable Konqueror integration’ option.

• Click on ’NewData DVD’ project:
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Figure 4.45: Configuring K3B Export screen

• Browse to select the file(s) that you wish to export, and click to select so the filenames appear in
the ’Current Projects’ window:

159



Figure 4.46: Selecting File for Export

• On the DataDVD0 tab, click on Burn, a new ’DVD Project’ windowwill appear:

Figure 4.47: Configuring Export

• Click on ’Burn’, and in thewarning that appears, click on ’Cut volume descriptor in the Joliet tree’:
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Figure 4.48: File Name length selection

• The progress barswill now fill, as the DVD is burnt:

Figure 4.49: DVD burn progress bar

• Once the DVD is burnt, a completionmessagewill display:
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Figure 4.50: DVDBurn completionmessage

• Click onClose to close thewindow:

Figure 4.51: Closing K3B Project

• Click on ’Discard’ to empty the temporary buffer, the K3Bwindowwill now close:
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Figure 4.52: Exiting tomainWaveView screen

4.9.4 Exporting to USB devices from the Wavestore Server
Before exporting to a USB device, it is necessary to ”mount” the USB device. This is described in sec-
tion 9.17 - Accessing a USB disk on theWavestore server.

You can now export footage and still images from the Find screen to the USB device (menu path View
→ Find), the procedure for this is fully described in section 4.9.1 - Exporting footage to a Windows PC
running WaveView client software; for Still Images refer to section 4.9.2 - Exporting still images to a
Windows PC running WaveView client software.. Firstly select your Camera Channel, Start Time and
Stop Time:
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Figure 4.53: Find screen - configuringCameraChannel, Start Time and End Time

• Click on Export:

Figure 4.54: Find Screen – Export Screen

• Click on theBrowse(...) button to open the File Directory for browsing:
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Figure 4.55: Find screen – Browsing directories to set Export path

• Click on theUP ARROW KEY button to browse up one level to the ’home’ directory:

Figure 4.56: Find screen – Browsing directories to set Export path

• Click on theUP ARROW KEY button to browse up one level :
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Figure 4.57: Find screen – Browsing directories to set Export path

• Click on the ’↑’ button to browse up one level to the ’media’ directory:

Figure 4.58: Find screen – Browsing directories to set Export path

• Click on the nameof the USBmedia (in this case ’WAVESTORE-6’); files contained on this USBde-
vicewill nowbe displayed:
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Figure 4.59: Find screen –Contents of USB device displayed

• Select the save path folder on the USB device, then click on ’Choose’.

The Open Directory window will now disappear. Configure the file name/container format etc. as re-
quired.

Figure 4.60: Find screen – ExportWindow

• Click on ’Start’; the export progress barwill now fill to 100%.
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Figure 4.61: Find screen – Export completed

• Repeat for any other files that you require.

• Once completed, youmust then ’eject’ the device before it can be removed from the server. Close
the Find screen, and on themainWaveView screen, move themouse pointer into the very top left
cornerof thescreen, sotheAccessoriesPanelappearsat thetop leftof thescreenasshownbelow:

Figure 4.62: Accessories Toolbar

• Click on the File Manager Icon (third icon), and the File Manager window will open, with the left
column in thewindow showing connected devices on the server and network, including the USB
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device.

Figure 4.63: WaveView screen showing FileManagerwindow

• On the device tree on the left, click on the USB device so it is highlighted blue:

Figure 4.64: FileManagerwindow showing contents of USB device

• Click on the ’eject’ icon next to the nameof theUSBdevice to eject the device. TheUSBdevicewill
nowdisappear from the FileManager displaywindowwill nowdisplay as below:

169



Figure 4.65: FileManagerwindowwith USBDevice now removed

• You can now remove the USB device.

170



5 Playing Back Exported Files

5.1 PlayingBackExported Files on a PC fromDVD/USBde-
vice

If the PC that you are using already has theWaveView client software installed, launch it as usual, either
from the Start Menu or by double-clicking the desktopWaveView shortcut.

Alternatively, if the DVD/USB device contains a copy ofWaveView, open the device on your PC:

Figure 5.1: Browsing to locate export file

Double click on the file named ’play.bat’. The WaveView program will launch, and open the export file
as below. You may be prompted to enter a Password, if this option was selected when the export was
originally created:
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Figure 5.2: Entering Decryption Password

The configured name of the original source Wavestore server, and also details of the camera channels
that are contained in the export file, will nowbe displayed in the Device Tree section.

Figure 5.3: Device Tree showing camera(s) contained in export

Double click on the camera channel(s) that you require; and click on ’Play’ to commence playback:
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Figure 5.4: Playback of export file

The Playback controls can be used as described in section 3.10 - Playback Controls and section 4 -
Search/Playback/ExportusingFindScreen tocontrol playbackof the footage, create further export files,
and save still images.

5.2 PlayingBackExportedFiles onaWavestoreServer from
a DVD

• Insert the DVD into the server, and move the mouse pointer into the very top left corner of the
screen, so the Accessories Panel appears at the top left of the screen as shown below:
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Figure 5.5: WaveView screen showing Accessories Panel

• Click on the FileManager icon (third icon across), and the FileManagerwindowwill open,with the
left column in the window showing connected devices on the server and network, including the
DVD. The right hand section of thewindow shows the files and folders contained on the selected
device.

Figure 5.6: WaveView screen showing FileManagerwindow

• On the device tree on the left, click on the DVD; files contained on the discwill nowbe displayed:
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Figure 5.7: File Managerwindow showing contents of USB device

• The DVD is nowmounted on the server. You can now playback footage files on this disc. To open
a file, first disconnect from any servers that you are connected to (menu path File→Disconnect).
Click on ’Open Export’ in the Login Dialog box,

Figure 5.8: Login Dialog box

• and theOpen dialogwindowswill appear as follows:
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Figure 5.9: Open file dialog

• Click on themedia folder:

Figure 5.10: Browsing forWSB file

• Click on the name of the disc containing your footage:
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Figure 5.11: Browsing forWSB file

• Click onOpen:

Figure 5.12: Find screen – Browsing directories to set Export path

• Click on the file name, and then clickOpen. The server and camera name(s) relating to the footage
will nowbe displayed:
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Figure 5.13: WSB file opened

• Double click on the camera name(s) that youwish to view (full details of the Playback controls are
described in section 4.4 - Search/Playback):

Figure 5.14: Camera opened

• Once you completed playback operations, follow the menu path File → Disconnect to close the
file.
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Figure 5.15: ClosingWSB file

• You can noweject the DVD using the push button on the front of the DVD drive

5.3 PlayingBackExportedFiles onaWavestoreServer from
a USB device

• Insert the USB device into the server, andmove themouse pointer into the very top left corner of
the screen, so the Accessories Panel (containing the Internet, DVD burn and File Manager icons)
appears at the top left of the screen as shown below:
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Figure 5.16: WaveView screen showing Accessories Panel

• Click on the FileManager icon (third icon across), and the FileManagerwindowwill open,with the
left column in thewindow showing connected devices on the server and network, including your
USB device. The right hand section of the window shows the files and folders contained on the
selected device.

Figure 5.17: WaveView screen showing FileManagerwindow

• On the device tree on the left, click on the USB device; files contained on the disc will now be dis-
played:
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Figure 5.18: FileManagerwindow showing contents of USB device

• The USB device is nowmounted on the server, and you can now playback footage files from this
device. To open a file, first disconnect from any servers that you are connected to (menu path File
→ Disconnect). Click on ’Open Export’ in the Login Dialog box, and the Open dialog windowswill
appear as follows:

Figure 5.19: Browsing for USB device

• Click on themedia folder:
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Figure 5.20: Browsing for USB device

• On the device tree on the left, click on the DVD; files contained on the discwill nowbe displayed:

• Click on the name of the device containing your footage:

Figure 5.21: Browsing for USB device

• Click onOpen:
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Figure 5.22: Open export directory

• Click on the file name, and then clickOpen. The server and camera name(s) relating to the footage
will nowbe displayed:

Figure 5.23: Main screenwithWSB open

• Double click on the camera name(s) that youwish to view (full details of the Playback controls are
described in section 3.10 - PlaybackControls):
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Figure 5.24: Camera opened fromWSB file

• Once you completed playback operations, youmust then ’unmount’ the USB device before it can
be removed from the server. Close the Find screen, and on themainWaveView screen, move the
mouse pointer into the very top left corner of the screen, so the Accessories Panel appears at the
top left of the screen as shown below:

Figure 5.25: Accessories Toolbar

• Click on theFileManager Icon (third icon across), and theFileManagerwindowwill open,with the
left column in the window showing connected devices on the server and network, including the
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USB device.

Figure 5.26: WaveView screen showing FileManagerwindow

• On the device tree on the left, click on the USB device so it is highlighted blue:

Figure 5.27: FileManagerwindow showing contents of USB device

• Clickon the ’eject’ iconnext to thenameof theUSBdevice tounmount thedevice. TheUSBdevice
will nowdisappear from the FileManager displaywindowwill nowdisplay as below:
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Figure 5.28: On the device tree on the left, click on the DVD; files contained on the disc will now be dis-
played:

• You can now remove the USB device from the server.
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6 Setup Screens

TheWavestore Server is configured using the Setup Screen as shown (menu path View→Setup).

Figure 6.1: Accessing SetupMenu

Themain Setupmenuwill now appear, displaying various submenus as shown below:

Figure 6.2: Setup Screen Sub-menus

If the horizontal size of your WaveView client window is too narrow to view all the submenu icons, you
canmove left/right though the icon list by positioning yourmouse pointer at the left or right hand end of
the list.

Click on any of the sub-menu icons to enter amenu.

To save any configuration changes you make in the Setup menus, click on the ’Save’ icon (top right of
screen).

If youwish to discard the changes that you havemade, click on the ’Reset’ icon.

If at any point youwish to exit from the Setupmenu, follow themenu path View→Main.

At the top left of themain area is the Server Selector:
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Figure 6.3: Server Selector

Clicking on this icon allows selection of a particularWavestore serverwithin a Server Group. If the cur-
rently selected setup page applies to thewhole server group, then this iconwill be disabled.

Forsetupscreenswhichpertain toaservergroup, if thereare inconsistenciesbetweentheconfiguration
on different servers within the group, a Conflict Resolution tool will appear asking for the operator to
choose the serverwith the correct configuration. Thiswill then be synchronised to all the servers in the
group. This is discussed inmore detail in section 9.15 - Server GroupConfigurationConflict Resolution.

Note: When entering a setup screen, the WaveView client will lock the configuration on the server or
servers. If the setup screen in question pertains to the whole server group, all servers in the group will
be locked. If the setupscreenonlypertains to a single server, only the selectedserverwill be locked. This
lock means that no other users can edit the configuration whilst you are editing it. The lock is released
upon leaving the setup screens or by changing servers if on a setup screen that only pertains to a single
server.

If the configuration is locked upon entering the setup screens, an error message will be shown which
details the user and IP address of the user holding the lock.

The ”BreakLock” buttoncanbeused todeny theother user of theconfiguration lock and take it for your-
self. That other user will then be unable to save their changes and likely have to redo any configuration
that theywere in the process ofmaking.
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6.1 Users
Click on the Users icon to enter the User Settings screen.

Note: The settings in this page apply to all servers in the server group.

When the server is in its default statewhennew, the only user on the system is an ”install” level userwith
username ’install’ and password ’a’.

Toaddanewuser ID, click ’Add’, andenter the requiredname in thenamefield. Thenclick ’ChangePass-
word’ and set a password for the user. Itwill not be possible to log in as that user until a password is set.

To erase a user ID, highlight the user name and click ’Remove’.

If youwish to edit the settings for a user, click on thenameof that user in theUsers list, and youcannow
edit settings for that user ID such as user level, password etc.
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6.1.1 User Type, Level, and Preferences

Wecan configure the following options to apply to individual users:

Name The user name. Note that it is case-sensitive.

Type The type of user as described below:

User Type Description

Standard
• The default, and recommended type of user. This user has access to all
servers in the server group.

Local
• A user which only access to one server in the server group. The server is se-
lectable.

Active Direc-
tory / LDAP • This user is treated as a group rather than a user. Youwill not be able to log in

as this user but the permissions set here will be inherited by any users who
are amember of a groupmatching this user name in an Active Directory. See
section 6.6 - Active Directory ® formore details.

Level The user’s level. This gives some default permissions as described below:
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User Level Permissions

install
• Full access to all server functions

admin
• Configurable permissions for live view, search, playback, export
• Able to create and edit admin and user level operators (but not install users)
• Limited access to server configuration screens

user
• Configurable permissions for live view, search, playback, export
• No access to server configuration

Change Password Allows changing of another user’s password. This is not always permitted, for ex-
ample if the selecteduser is of ahigher level. Note that thecurrently logged-inuser cannot change
their own password here. To do so, use the Tools→ Change Password menu.

Can change password Gives the user permission to change their own password

Force user to change password on next login Theuserwill be forcedtochangepasswordonthenext
login, but not on subsequent logins

Load layout/sequence at login Select toeither loadapreviouslysavedLayoutorLayoutSequence(see
section3.3 -DisplayAreaToolbar), or select ’Automatic’ to reload the layout thatwasbeing viewed
when the user last logged out. This can be configured on a per VDA (Video Display Area) basis.

6.1.2 Restrictions

Max Bandwidth Permitted bandwidth for the user’s connection

Logoff Time Sets amaximumduration for the user’s logged in session

Inactivity Logoff Time Sets amaximum inactivity duration before the user is automatically logged out

Login restricted to IP This allows restricting this user’s login to one ormore IP addresses. Substrings
canbeused, forexample ”127. [::1]” (without thequotes)matchesonly localconnections, or ”192.168.
[fd01::” matches only IP addresses startingwith those values.
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Permitted Cameras Controls permissions forwhich cameras (andother channels) this user is permit-
ted or denied access to...

It is possible to choose either an ”allow list” or ”deny list”mode via the drop-downselection. These
are shown as ”All cameras permitted except selected...” and ”All cameras denied except selected...”.
This selectable behaviour is useful when the system is being extended with new cameras as it
affects default visibility of newly added cameras. Thismode is available per-user.

The cameras selected in the user interface are either permitted or denied to the user based upon
themode selected.

Login Schedule Access to the server can be limited to times defined by a schedule (configured in the
Schedulesmenu - see section 6.10 - Schedules)).

6.1.3 General Permissions

Playback Permission to Search andPlayback recorded footage. Note that this option should always be
enabledwhen using encrypted recordings otherwise live viewwill not function correctly.

Restrict playback to last N minutes Ifenabled, playback is restricted the lastNminutes. Older record-
ings cannot be viewed by this user.
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PTZ (and Priority) Priority level for PTZ control, if enabled. 1 is the lowest priority and 5 is the highest. If
multiple users attempt to control the camera at the same time, the user with the highest priority
will have control.

See through Privacy mask If enabled, privacymasks are not enforced for this user.

ViewMaps Permission to use theMaps functionality.

Post events ExternalsystemswhichsendeventstotheWavestoremustprovideausernameandpass-
word. This permission controlswhether a user is allowed to send events from theoutside. For se-
curity reasons it is advisable to leave this disabled (the default) unless a particular mechanism for
sending events is being set up.

Show/Hide subtitles Controlswhether the user is allowed to showor hide the subtitles.

Edit subtitles Controlswhether the user is allowed to configure subtitle settings.

6.1.4 Admin Permissions

Figure 6.4: Admin Permissions

These permissions are only available for ”admin”-level users. ”install”-level users always have these per-
missions and ”user”-level users can never have them.

Restart / Reboot servers Allows aWavestore to be restarted (software restart) or rebooted.

Shutdown servers Allows aWavestore to be shut down.

Edit Maps Allows the user to edit the systemmaps.

View System Log Allows access to the System Log.

View Connected Users Allows access to a list of currently connected users.
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6.1.5 Export Permissions

Figure 6.5: User Permissions for Export

Export Controlswhether users are allowed to create exports. EitherWSB format or transcoded to an-
other format. If this option is disabled then other export permissions are not available as they are
not relevant.

Decrypt for Wavestore archive (wsb) If the source video is encrypted and the userwants to decrypt
the video beforewriting it to aWSB export file unencrypted, this permissionmust be granted.

Re-encrypt with password for wsb If thispermission isgranted, theusercancreateaWSBexport file
with password protection.

Transcoding/exporting If this permission is granted, theuser canwrite to formatsother thanWSB, e.g.
AVI orMOV.

Decrypt for transcoding If this permission is granted and the source video is encrypted, the user can
decrypt the video beforewriting it in another format, e.g. AVI orMOV.

6.1.6 Other Permissions

Figure 6.6: Other Permissions

Write shared layouts Determineswhether the user canwrite, overwrite, and delete shared layouts

Permit ONVIF login Controls whether external systems should be able to login as this user using the
ONVIF protocol. Note: this is less secure than the defaultWavestore password system, see tech-
nical note below.

Technical note regardingONVIFLogin:ONVIFmandateseither ’WS-UsernameToken’or ’HTTPDigest’
login, andbothof theserequire thedevice tostore thepasswordsusingreversibleencryptionsotheycan
the retrieved to validate the login password. Normally the Wavestore server uses a muchmore secure
password storage (a one-way hash with 10,000 iterations) which is not reversible and can be use for
thevalidationof thepasswordusing thesecureWavestoreprotocol login, but this cannotbeused for the
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ONVIF-mandated loginprocedurebecause it is not reversible. Therefore, allowingONVIF login reduces
the security of the login for the associated user.
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6.2 Server
The ’Server’ setup screen contains a list of selectable sub-sections to configure various aspects of the
currently selected server.

These are detailed in the following sections.

6.2.1 General

Server Information

TheGeneral submenugivesserver informationsuchasservername, status, IPaddressandserversoft-
ware version.

Note that the IP address shown is the address thatwasused to connect to the server. The servermight
have many IP addresses. Full details of the network configuration can be inspected in the Network
Setup screen - see section 6.2.2 - Network.

A ’friendly’ server namecanbe configuredby clicking in the ’Name’ field in theGeneral panel, and replac-
ing ’Wavestore’ with the newname. It is recommended to give each server an individual ’friendly’ name,
to prevent confusionwhen viewing cameras or configuration information from different serverswithin
a group (e.g. connected devices, system log).

Figure 6.7: Server Setup Screen -General Page
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Server Administration

The Server Administration submenu allows the server to be shutdown, the Server software program
to be restarted, or the server completely rebooted. During the last operations, the client software will
disconnect temporarily, and then reconnect once the server is back online.

6.2.2 Network
The Network setup page allows configuration of network interfaces as well as creating secondary and
bond interfaces. This section explains how this configuration can bemade.

The default configuration for all network interfaces is use DHCP (automatic IP address allocation). If a
DHCP server is available, an IP address will be automatically obtained and this will be displayed in the
”Current Interface Status” for the selected interface as shown below:

Figure 6.8: Confirming server IP address allocated by DHCP server

If theWavestore server cannot find a DHCP server on the local network, it will have no IP address.
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If youwish tomanually configure the IP address for a network adaptor on theWavestore server, click to
select the adaptor youwish to set up, and select ’Manually Configure’.

A server may have multiple network adaptors, for example if the case of a server that has one adaptor
connected to IP cameras, and the second adaptor connected to the site LAN/client PCs etc. Each net-
workadaptoronyourserver is representedbyantabwithanetworknameassociated, eg,enp3s0. These
nameswill vary dependingon thehardware: see the hardwaredocument for details of the namesof the
ports on the back of themachine. Select the adaptor that youwish to configure, by clicking on the tab.

The settings for this adaptorwill nowbe displayed.

Select ’Enable’ to allow the network adapter to be used, otherwise it is diabled and is not assigned an ip
address and behaves as if it is not present.

The ’Use JumboFrames’ tick boxenables a larger networkMTUsizeof 9000bytes. Normal framesize is
quite small for modern fast gigabit networks, and jumbo frames are a way of making frames larger and
more efficient, but this is not fully standardised and therefore this option is not enabled by default.

The ’Slave to’ box allows bonding (see section below). Leave as None for normal operation.

To set an IP address, tick the ’Manually Configure’ tick box, and enter the IP address, subnet mask and
gateway for your server in the relevant fields.

The ’Current Interface Status’ box displays various information about the currently selected interface.
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Figure 6.9: Manually configuring IP address

Note thatWavestore servers use TCP port 8601 to communicate. If it is necessary for a client outside a
firewall to contact a serverwithin a firewall, for example connecting to servers on a site over the internet,
then port forwarding for port 8601must be configured on the firewall/router at the site.

Static Routes

Static routes can be configured for each interface using the provided table. Each route should define an
Address, SubnetMask, andGateway.

The static route is for traffic to the range defined by Address/Subnet Mask which will be initially routed
to the address specified byGateway. For example:

• Address: 192.168.1.0

• SubnetMask: 255.255.255.0

• Gateway: 10.2.1.250

This routewoulddefinethatall requests tothe192.168.1.0networkshouldbesentvia theaddress10.2.1.250.
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Secondary Network Addresses

A single network interface can have more than one network address. This might be useful if it needs
to connect to cameras two separate subnets, for example 192.168.x.x and 10.1.x.x. It can also be used
for ’Failover’ where eachmachine has a physical address which os fixed, and in addition has a separate
logical addresswhichmoves to a newmachinewhenwhen thatmachine fails.

To add a secondary interface address, first enable the tab for the interface adapter required and then
click the ’Add secondary interface’ button.

The tab for the secondary interface is displayed and can be configured. Secondary interfaces endwith
:1, for example, enp3s0:1. The secondary interface can be enabled and set up as if it was a normal net-
work interface.

It is not normally required to enter DNS or Gateway settings for a secondary interface, as it will use the
settings from the primary interface.

If desired to remove a secondary interface, select the appropriate tab and click ’Remove interface’.

Port Bonding

Inmany cases it is desirable to treat all the network interfaces on themachine as a single interfacewith
a single IP address. If one network interface fails or the cable is broken, the otherswill continue towork.
And if all are working, they share the data between themwhich increases the total network bandwidth
linearly.

To set upBonding, first add aBond interface by clicking the ’Addbond interface’ button, then click on the
tabwhichwill have a name like bond0 to select it.

The bond interface can be enabled and set up as if it was a normal network interface and it can have an
IP address assigned.

All physical interfaces which are to be bonded to bond0 need to have their ’Slave to’ set up to bond0. If
youmakeaphysical interface a slave to aBondmaster, thenyoudonot assign an IPaddress to it, it is just
treated as a data path for themaster bond interface.

If you have a number of network interfaces on the hardware, it’s possible to set some interfaces as
bonded, and keep others independant. It’s also possible to set multiple Bond interfaces, depending on
your network requirements.

Wavestore default bonding is ”round-robin” or ”Static” mode which shares the load over all the opera-
tional links in both directions. This is widely used and the network links should be configured at both
ends as bonded (trunked). This is sometimes known as Static trunking or Static bonding.

Moreadvanced informationandtrouble-shootingtips relatingtoportbondingcanbefoundontheWave-
store knowledgebase.

6.2.3 Licensing
EachWavestore server requires a valid licence to enable all system functionality.

There are twomainways of licensing aWavestore server:

• By entering a valid Server Licence,which is a string of text. Thismethod does not require an inter-
net connection.
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• By obtaining a licence subscription. Thismethod does require an internet connection.

Figure 6.10: Licensing Setup Page

A licence of either type is specific to a particularWavestore server’s MachineIDwhich is unique to each
server and cannot be edited.

In the Licensing setup screen, theManually configure licence option allows the Server Licence to be
manually entered. If using Subscription Licensing, select the Enable fetch from licence server option.
TheWavestore server will then automatically retrieve an up-to-date licence when required. The Fetch
licence button can be clicked to force theWavestore server to check for a new licence immediately.

Whenusing a textual Server Licence, it is recommended tomake anote of the licence in case a software
reinstallation is required in future. A charge may apply for reissuing a Wavestore licence if the original
licencedetails are is lost. If the licence is lost, please contactWavestoreGlobalwith the followingdetails:

• Wavestore Server Serial Number

• Machine ID

TheWavestoreservermusthaveavalid licencebeforetheservercanbeconfiguredfor recording. Charge-
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able licence upgrades can be requested to increase functionality of the server (e.g. increase number of
IP camera channels or client software connections); in such cases the licence is field upgradeable, and
the server does not have to be returned toWavestore.

This licence controls the following settings:

• Number of simultaneousWaveViewClient Software connections to the server

• Number of AnalogueCameraChannels

• Number of IPCameraChannels

• Number of EMS (Encoder andMulti-Sensor) CameraChannels

• LicensedSoftwareFunctionssuchasAdvancedExports, LiveEventsStream,Maps,ServerGroups,
integrationmodules, Metadata support etc.

• ”Upgrades until” - this is the date after which it will no longer possible to upgrade the server to a
later version. Note that for some older servers this may show a version number instead of a date.
Licence upgrades can be purchased to extend the upgrade period of the server.

6.2.4 Time & Region
The Time and Regionmenu allows the configuration of the server time, time zone, and time synchroni-
sation to another device (e.g. Wavestore server or NTP time source).

We recommend that you configure the server time and date before you start recording footage from
audio/video devices. Alternatively, if youmake a large change in the time/date, reformat the server hard
disks after you have carried this out.
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Region Settings

Figure 6.11: Time and Region settings

The server hardware’s own internal clock is set to the UTC time zone (BIOS settings). Using theWave-
store software, we can apply an offset for the local Time Zone, including local daylight saving changes;
you should carry this out prior to setting the time.

To configure, select the region that you require from the dropdownmenu, then click ’Save’. Youwill now
be prompted to restart the server.

Once the server software has restarted, confirm that the correct time is displayed in the ’Server Time’
field. If not, you can adjust the time as described below.

Time Settings – Manual

Before adjusting the time, confirm that the correct Time Zone has been selected (as described in sec-
tion 6.2.4 - ). Enter the current time, click the ’Set Time’ button, then click on ’Save’

For a small change in time (less than 29 minutes), the server time will slew slowly by approximately 1
second perminute, until the desired time is reached. This ensures the time stamp on the footage never
jumps, whichwould be confusing, and in particular it never jumps backwards.

This behaviour occurs irrespective of the time source: it behaves the samewhen using NTP andwhen
setting the timemanually.
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Figure 6.12: Time and Region settings – Slewing of server time after time has been setmanually

For a larger timechange (greater than29minutes), itwould take too long to slew the timesoa time jump
will be required. It is unlikely that thiswill benecessary innormal operation; indeed if youneed tochange
the time by several hours then it probably indicates you have selected an incorrect time zone.

Time Settings – Jumping time

A time jump forwards of more than 29minutes must be handled specially, and jumping backwards by
more than 29minutesmight lose footage because footage is indexed by time and that time is overwrit-
ten.

The system has protection against time jumping backwards. On restart, if time has jumped back, it will
automatically jump forwards to 1minute after the time of last recording, to prevent overwriting of video
footage. This probably isn’t quite the correct time, but if the jumpwas caused by a reboot then the time
will be close and can easily be slewed to the correct time.

There is no protection against time jumping forwards over a reboot because time does that continu-
ously (if the time appears to have jumped forwards by 1 day, perhaps theWavestore server was simply
switched off for 1 day).

Occasionally itwill benecessary todeliberately jump the timebackwards. Thiswill lose footagebecause
the footage recorded after new ’current’ timewill become inaccessible.

The ”slewtimefast” commandhasbeenadded toslewforperiods longer thanhalf anhourwithout losing
any footageor switchingoff. However this does takea long time, typically 10 times the time tobeslewed.

Also, commands ”jumptime” (forwards)and ”jumptimeback-delete” (backwards, deletingonly theperiod
being overwritten by the time change) are available.

To jump time forwards (the easy case):

• Change the hardware clock to the correct time (e.g. change by 1 hour) (Typically usingWaveView
Set Time; disable NTP for this).

• Execute Command: jumptime

• Timewill change immediately, givinganapparent timegap in the footagebutall footage is recorded
and none lost.
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• Faultwill be logged in the system logbecause the time jumpdoesnot represent normal operation.
Clear Fault to clear.

• If desired, enable NTP.

To jump time backwards immediately:

• Change the hardware clock to the correct time (e.g. change by 1 day) (Typically using WaveView
Set Time; disable NTP for this).

• Execute Command: jumptimeback-delete

• Timewill change immediately, overwriting the footagewhichhada timewhich isnow in the future.
FOOTAGEWILL BEDELETED!!

• Faultwill be logged in the system logbecause the time jumpdoesnot represent normal operation.
Clear Fault to clear.

• Restart the server if needed (it will prompt you to do this) as certain timers will be upset by this
jump.

• If desired, enable NTP.

To slew the timewithout losing all footage:

• Change the hardware clock to the correct time (e.g. change by 1 hour) (Typically usingWaveView
Set Time; disable NTP for this).

• Execute Command: slewtimefast

• Do not reboot, but leave the system running. It will slew at a rate of 1:10. So a 1 hour slewwill take
10 hours, and a 24 hour slewwill take 10 days. Note that the desired target slew timewill be reset
multiple times by this mechanism. If a reboot or restart is necessary, reset the correct time and
issue slewtimefast again after the restart/reboot.

• If desired, enableNTP. It is possible todo this before theslewhascompleted; itwill be ignoreduntil
the time is almost right.

Time Settings - NTP

NetworkTimeProtocol (NTP) canbeused to synchronise the server timewith anetworked timesource.
All Wavestore servers are NTP time sources, so for example a systemwith 6 servers can have 5 servers
set to synchronise to Server 1, and that server can synchronise to an upstream time source.

To configure NTP, check the ’Use anNTPServer’ radio button, enter the IP address of the time source in
the box provided, and click ’Save’ to confirm your changes. Multiple IP addresses can be added sepa-
rated by spaces, and theywill be tried in sequence until a good one is found.

It is alsopossible touseahostname insteadofanIPaddress, however it is recommendedtosynchonise
to a local time source if possible.
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Figure 6.13: Time and Region settings – NTPServer option selected

Synchronising with GPS clock

TheWavestoreservercanalsobesynchronisedwithaGPSclockoveraserial link, usingNMEAprotocols.
Thiswill normally connect to a USB port on the server, possibly via a USB-RS232 converter.

To set this up, use the IO/Devices screen andAdd anewdevice on the appropriate serial port usingPro-
tocol NMEA.

Synchronising with IRIG-J

TheWavestore server can also be synchronisedwith a IRIG-J clock over a serial link.

To set this up, use the IO/Devices screen andAdd anewdevice on the appropriate serial port usingPro-
tocol IRIG.

6.2.5 Storage
The Storage screen is used tomanage hard disks and other storage devices. The screen displays vari-
ous statistics about the available devices such as size, percentage used, drivemodel and serial number,
format status and device letter. The screen also allows various operations to be performed on these
devices including...

• Formatting storage devices

• Assigning ”Drive letters” to storage devices

• Creating RAID arrays from individual disks

• Configuring network storage devices

• Switching all disks to read-onlymode (all recording stopped) – to protect critical footage and pre-
vent it frombeing overwritten

The subject of configuring storage is quite in-depth and can vary depending on the storage technology
used. Therefore the section 9.13 - Configuring Storage Devices offers in-depth information for each
supported storage system.
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Note that admin-level users can inspect the settings, and perform the ”AddSwappedDrives” operation,
but cannotmodify the storage configuration since this is a critical operation that can result in data loss,
therefore is only available to install-level users.

The restof thissectionwill explain thevariousUIelementsandbuttons in theStoragesetupscreen, then
walk through configuring simple Direct AttachedDisks.

Storage Screen Buttons

Herewewill explainwhat each of the buttons in the Storage setup screen does:

Drive Letter Selection
Eachstoragedisk or ”volume” has adrop-downmenu to allowaDrive Letter tobe assigned. These
are used to refer that device elsewhere in the software. For examplewhen choosingwhich disk a
camera should record to.

Flash Good Drive LEDs
This function will cause the system to attempt to flash the disk activity on LED(s) on the disk, or
disksif it is an array of disks. This helps identify faulty or missing disks as their LEDs will not be
flashing.

Auto Assign Drives
This function is used to quickly assign drive letters to a large number of disks. Select the desired
drives and click the button. Holding Shift or Ctrl when selecting the disks allows selecting a range.

Add Swapped Drives
This button is used when attempting to re-incorporate disks. For example if a disk was removed
and re-inserted it may show as Unformatted. Similarly if a RAID array has a failed disk and it is
replaced, this buttonwill incorporate the replacement drive into the array.

207



Create Drive Array
This button allows RAID arrays to be created. These could be HyperRAID or MegaRAID arrays.
Setting up such systems is described in section 9.13 - Configuring Storage Devices.

Refresh List
This causes the Wavestore to refresh its list of available disks. This operation is performed when
first entering the Storage screen, but refreshing is useful if a disk has been physically inserted or
removed, or its state has possibly changed and needs to be checked again.

Note that occasionally after amajor change, the disk subsystemwill not have fully restartedwhen
the display is automatically refreshed, and somedisksmight be shown as ”MISSING”. Clicking on
”Refresh List” a few seconds laterwill show the correct state.

Attach Network Storage
This button launches a newdialog allowing network storage devices to be searched for and con-
nected to theWavestore. Supported types include:

• iSCSI - see section 9.13.3 - Configuring iSCSI Storage Devices

• NFS - see section 9.13.4 - Configuring NFSStorage Devices

• AWS (AmazonWebServices) - see section 9.13.5 - Configuring AWSStorage Devices

• Microsoft Azure - see section 9.13.6 - Configuring Azure Storage Devices

Switch all disks to read-only mode
Thisoption,whenenabled,meansthatnorecordingordeletionwill occuronanydisk in thesystem.
This is useful if there is amajor incident and the entire system needs to be stored away for future
use.

Forexample, if thesystem isset to record fornomore than31days (using the ’Maximum’ recording
mode) and itwereswitchedoffandput into storage for twomonths,when it is switchedonagain it
will immediately delete the footagewhich is older than31days. Enabling this optionprevents such
a problem fromoccurring.

Configuring New Storage Volumes

Before a hard disk (or other storage device) can be used, the disk needs to be formatted, and a device
letter allocated to it.

WhenWavestore servers are supplied new, all disks are preformatted and assigned letters, but it will be
necessary to reallocate the drive letters if the server software is reinstalled at a later date, or if an addi-
tional/replacement hard disk is installed in the server.

It is alsonecessary tocarryout thisprocedure if a removablestoragedevice is tobeusedwith theserver.
A drive letter must be allocated to the device after it has been attached to the server, before the device
can be used recording footage.

We’ll looknowat the steps required to configure anewly installeddrive, so that it canbeused for record-
ing.
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In the screenshot abovewe have four devices...

• 3 storage disks, s01 to s03,marked as Unconfigured

• 1 ”System” disk. This contains the operating systemand is split into partitions. The arrow to the left
causes the item to expand and show the partitions. This disk is shown for completeness but we
won’t use this for storing video.

Firstlywe need to assign some drive letters to these disks and Save the changes...

In this casewe assigned D, E, and F. It’s convention to start at D for historical reasons.

209



As you can see, these disks are marked as Unformatted. So we can select all 3 and click the Format
button.

Check that the correct disks and listed and click Format to perform the operation.

The ”Force” option can be required when formatting disks that aren’t already empty or LASS format-
ted, for example disks that are formatted for use with Windows or Linux. This is to prevent accidental
formatting of a diskwhich isn’tmeant to be LASS-formatted, for example the operating systemdisk.

Once the drives have been formatted, they should show as Formatted in themain UI.

The volumes are now ready for use, and can have recording tracks allocated to them.

6.2.6 Email
The Wavestore server can be configured to send an email to configured recipient(s), in the event of a
configured Event ( section 6.12 - Event Rules) being triggered.
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The Email setup screen is accessed by the menu path (View→ Setup→ Email). In order to configure
the Email functionwe need to enter the following details:

Server This is the hostname or IP address of the SMTP server. This field is required.

Port This is the port number of the SMTP server. Default is 25.

Sender This is theemail address tobeusedas thesender. i.e. the ”from”address. This field ismandatory.

User This is the username for authenticationwith the SMTP server. Notmandatory.

Password This is the password for authenticationwith the SMTP server. Notmandatory.

Use SSL Enables SSL mode if checked. Default is disabled. Normally not needed as security is auto-
negotiatedwith the commonly used STARTTLSmechanism.

Throttle Count Provides a throttling mechanism to prevent lots of repeated emails being sent to the
same sender. See below formore details. Default is 10.

Throttle Duration Duration in minutes for checking whether to throttle email sending. See below for
more details. Default is 60minutes.

Debug Will log extra information to the System Log to help diagnose issues if enabled. Default is dis-
abled.

The throttling mechanism requires two parameters to be set - Throttle Count and Throttle Duration.
Count is the number of emails and Duration is the time period for the count. So for example if Throttle
Count is 10 and Throttle Duration is 60, 10 emails within an hour will be permitted, but an 11th will be
discarded. Throttled emails are not counted so emailswill eventually be allowed through again.

The throttlingmechanism takes into account:

• TheCause of the event (e.g. Input, Motion)

• TheSourceparameter (whichmightbecameranumber forcertaineventssuchasMotionorDark-
ening, input number for Input events, etc.)

• The email Recipient

So for example if Input 1 is triggered many times and throttling occurs to prevent a recipient receiving
toomany emails, Input 2may still trigger an email to that recipient since it is a different event.

For this mechanism to work, all sent emails are logged in a database. The database is trimmedwhen it
reaches a certain size but doesn’t take upmuch space and can easily stored a few tens of thousands of
records. To force deleting the database, use theWaveView ”Execute Command” tool to run ”clear-tmp”.

To configure email recipients, click ’Add’ and enter the destination email addresses as required.
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Figure 6.14: Email ConfigurationMenu

6.2.7 Image Authentication
TheWavestore Server offers an Image Authentication function (sometimes known as ’watermarking’)
that canbeused to ensure that an imageor set of imageswereoriginally recordedonaparticularWave-
store server, and have not been subsequently tamperedwith.

WhenAuthentication isenabled, theVideoDisplaywill showtheauthenticationstatusof thevideostream.

Authentication is only possible on recorded images, not live. There is a short delay before recorded im-
agescanbeverified; in thesecases, theVideoDisplaysmayshowtheorange ’Authenticationnotchecked’
icon.

Authentication is also possible on exported videowhen played through theWaveView client software.

Configurationof ImageAuthentication requiresenablingSignatureStreamRecording, anduseof aDig-
ital Certificate. There are two types of digital certificatewhich can be usedwithWavestore...

Self-signed
Available on servers running v6.20 or later. These certificates are automatically generated when
authentication is enabled and are the easiest way to get up and running. However they are con-
sidered less secure thanCA-signed certificates.

CA-signed
These certificates are generated and digitally signed by a Certificate Authority (Wavestore Global
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Limited). For these certificates it is necessary to generate a ”certificate request” and send it to
Wavestore Global Limited to request an official digital certificate. A charge may apply. The digital
certificate can then be installed.

Signature Stream Recording

Data relating to ImageAuthentication needs to be recorded to theWavestore server. To enable this, en-
able the ’Signature StreamRecording’ checkbox.

The default recording settings are to use the same settings as the first CameraGroup. That is, the same
target disk and recording duration. An alternative CameraGroup can be chosen.

Alternatively, choose ”Use these settings:” and specify the desired disk and duration to keep the record-
ings.

Certificate

The ’Certificate’ sectionof the ’ImageAuthentication’ setuppageshowsdetails of anycurrently installed
digital certificate.
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If it is a self-signed certificate then it will show ”(self-signed)” after the certificate expiry date.

To switch fromaself-signedcertificate to aCA-signedone, the followingprocedure should be followed:

• Complete the ’Organisation’ and ’Server location’ fields.

• Save the changes.

• Click ’Save Request’ to create the certificate request.

• Save the file and email it to support@wavestore.com.

• Once a reply is received containing theCA-signed certificate, choose ’LoadCertificate’ and select
the certificate file.

Please note that once the Image Authentication Certificate has expired, a new certificate must be ob-
tained and loaded in the samemanner.

6.2.8 Encryption
TheWavestore uses encryption for three purposes:

Password protection
A oneway encryption is used to protect passwords

Command protection
Sensitive commands sent over the network are encrypted

Video protection
Thesystemcanencryptvideoandaudio fromcaptureuntil playbackusingend-to-endencryption

These are largely distinctmethods of encryption. The one-way password encryption is performed us-
ing a secure one-way hash function and is transparent to the user.

Commands sent over the network are encrypted using RSA public key encryption for negotiation and
then AES128 for content encryption, and this too is transparent to the user. It is similar to using HTTPS
to access yourweb server.

Video and Audio can be encrypted at the point of recording. It remains encrypted on disk, when sent
over thenetwork, andwhenbackedup toabackupdevice. It is decryptedonly at thepoint of viewingon
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theWaveView client. This is not transparent to the user as it requires key distribution, and it is described
in the next section.

Video Encryption

TheWavestore server can encrypt recorded video and audio, such that it can only be viewed by users
that hold a special ’private key’.

The configuration steps required to enable this functionality are as follows:

• Generate a key pair - creating a public key and a private key

• Load thepublic keyonto theWavestoreserver (menupathView→Setup→Server→Encryption).

• Enable Signature StreamRecording as described in section 6.2.7 - .

• Enable encryption for each individual channel that youwish to encrypt.

• Distribute the private key to anyWaveView client that is required to access the video and audio.

The Encryption setup screen shows the public key so that it can be copied or checked if necessary.

WhenWaveViewclient (running either on the server itself, or a client PC) first detects encrypted footage,
the operator is prompted to load the private encryption key. If this key is valid, the videowill be displayed
(or audio played). Otherwise it will not be possible to view/listen to the encrypted footage.

Details of how to load theprivate keyonto theWaveViewclient, in order to access encryptedaudio/video
streams, is contained in section 3.6.4.3 - Encryption State icons.

6.2.9 Analytics Engines
TheWavestorecan interface toexternalVideoContentAnalyticsengines. TheWavestorewill sendvideo
to the device and retrieve analytics metadata, which can be used to monitor for events in real-time via
theWavestore event system, or do retrospective Smart Search operations.

The Analytics Engine setup screen allows an external analytics device to be configured.
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Type
Selects the type of analytics engine thatwill be connected to.

Automatic
If enabled, cameras on the Wavestore will be automatically mappd to channels on the analyt-
ics engine. Otherwise, each camera on the Wavestore should have its corresponding Analytics
Channel ID on the analytics device configured in theSetup→ Cameras screen.

IP/Host
The IP address or hostname of the analytics engine.

Username
The username used to interfacewith the analytics engine.

Password
The password used to interfacewith the analytics engine.

To assignWavestore cameras to the analytics engine:

• Go toSetup→ Cameras→ Camera Groups.

• For anyCameraGroups youwould like to interfacewith the analytics engine, underAnalytics, se-
lect the Analytics Engine by its ID, and optionally setwhichStream should be sent to the engine.

• If not usingAutomaticmode, underSetup→Cameras→Cameras→General, set theAnalyt-
ics Channel to the ID of the channel on the engine.

The Analytics Engines setup screenwill showhowmany channels are assigned to each engine.
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6.2.10 Spot Monitor Sequences
Certain analogue compression cardsmay have one or more spot monitor outputs. These can be con-
figured to display different cameras in a sequence from the various video inputs on that card.

TheWavestore also supports the concept of Virtual SpotMonitorswhich allows switching of any cam-
era in the system to a ”virtual camera”. So that camera can be displayed in WaveView and it will switch
its contents to the source camera. Creating ’Virtual Spot Monitors’ is described in section 9.10 - Con-
figuring Virtual SpotMonitors.

As anexample, a sequential displayof camerascanbeconfiguredviewingcamera 1 for2 seconds, cam-
era 3 for 2 seconds, camera 5 for 5 seconds, and camera 11 for 5 seconds; then returning to the start of
the sequence (camera 1) and so on. Dwell time can be configured individually for each camera selected,
and camerasmay be repeatedwith different dwell times in each instance.

TheSpotMonitoroutputcanalsobeconfiguredtoreact todigital inputs/motioneventsetc.; this iscarried
out in the Event Rules section (see section 6.12 - Event Rules).

To create a Spot Monitor Sequence, navigate to its setup screen - View → Setup → Server → Spot
Monitor Sequences’.

In the screenshot above we have selected the spot monitor channel 6. We can select a different spot
monitor to configure if desired by using the drop-downmenu.

Under the spotmonitor select is the list of camerason this server. Note thatwecanonly usecamerason
the current server. For analogue spotmonitor outputswe can only use analogue inputs from the same
capture card.
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To create a sequence we simply drag and drop cameras from the Device Tree into the Sequence area
on the right. Clicking on a camera channel displays the image from that camera.

The duration that each camera channel will be displayed can be configured using the up and down ar-
rows.

It is also possible to select either theHigh or Low resolution streams (corresponding toStreams 1 and2
in the Cameras setup screen). If the selected stream is not available, the server will try to use the other
one.

When using IP cameras with codecs that use I-frames and P-frames, such as H.264, the camera will
onlyswitchwhenanI-frame is receivedwithindwell time. Thetimer is resetwhenthecamera isswitched
to, meaning that these ’dwell times’ are less precise the larger the interval between I-frames.

The ’Message’ checkbox defines if subtitles should appear on the spotmonitor output, but only applies
to analogue spotmonitor outputs.

The ’Rollover’ option is usedwhen events are triggering spotmonitors to showcameras. If the current
spotmonitor is showingacameradue toanevent andanother eventoccurs, theeventwill be forwarded
to theselected ’Rollover’ spotmonitor. Ifno ’Rollover’ spotmonitor isprovided, thecurrentspotmonitor
will showthecameraassociatedwith thenewevent immediately. This canbecascaded for anynumber
of Virtual SpotMonitors.

To remove a configured sequence, click on ’Clear’.

Once the sequence has been configured, click on ’Save’, and the spotmonitorwill display the saved se-
quence.
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6.2.11 I/O Devices
TheWavestore Server can be interfacedwith peripheral I/O devices such as:

• input/output devices that can be configured in the Event Rules menu (see section 6.12 - Event
Rules) e.g. to control recording on the server, and/or activate an output.

• external control device

• NMEA devices (e.g. GPRMCclocks for time synchronisation)

• Supported IPcameras that notifyWavestore server of detectedevents (e.g. MotionDetected) us-
ing proprietarymessage formats (e.g. HTTP/CGI)

• Supported POSDeviceswewish to record data (e.g. transaction details) from, for usewithMeta-
data recording

Figure 6.15: I/O Devices screen

To configure a device, click on ’Add’, and then select the correct Protocol for your device.
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6.2.11.1 Configuring Stretch Alarm Boards as Input/Output devices

If your server is fittedwith aStretchVRC7008ALMAlarmboard, these devices are auto detected by the
server software, and no configuration is required for them in the I/ODevicesmenu.

In theEventRulesmenu, inputs/outputsonconfiguredI/Odevices listed in the formatDeviceNameand
ID: Input/Output Number, e.g. Stretch 1:1. Inputs/Outputs on the Stretch alarmboard are automatically
detected by the server and numbers assigned to each input output. If you have additional I/O devices
(e.g. WavestoreUSBAlarmBoard), numbersneedtobeassignedtothese inputs/outputsmanually,make
sure that each input/output has a unique number assigned that does not clashwith any input/output.

The eight digital inputs on the VRC7008ALMboardwill appear in the Event Rulesmenu as follows:

Figure 6.16: I/O Devices, Stretch AlarmBoard Inputs

The eight relay outputs on the VRC6008-ALMboardwill appear in the Event Rulesmenu as follows:

220



Figure 6.17: I/O Devices, Stretch AlarmBoard outputs

6.2.11.2 Configuring 16 input USB Alarm Boards as an I/O device

Configuration for a USBAlarmBoard is carried out as follows:

• Click on ’Add’ and enter the name for your newdevice

• In the Protocol field, select ’WaveAlarm’

• In the Port section, select Alarm-x-y.z from the dropdown list (e.g. ALARM-2-1.5 in the example
below)

• In the Baud section, select ’9600’

• In theGeneric settings section, assign a range of numbers to the sixteen Inputs; each USBAlarm
Boardmust be assigned a unique range of input numbers that do not clashwith any other Alarm
Devices

• In theGeneric settingssection, assigna rangeofnumbers to thesixteenOutputs; eachUSBAlarm
Boardmust be assignedaunique rangeof output numbers that donot clashwith anyotherAlarm
Devices

An example configuration is shown below:
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Figure 6.18: I/O Devices screen – USBAlarmBoard configuration

In the Event Rules screen, the USB alarm boardwill appear as follows in the Event Cause submenu:
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Figure 6.19: I/O Devices screen – USBAlarmBoard digital inputs

In the Event Rules screen, the USB alarm boardwill appear as follow in the Event Action submenu:

Figure 6.20: I/O Devices screen – USBAlarmBoard relay outputs
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6.2.11.3 Configuring 20 input USB Alarm Boards as an I/O device

Configuration for a USBAlarmBoard is carried out as follows:

• Click on ’Add’ and enter the name for your newdevice

• In the Protocol field, select ’WaveAlarm’

• In the Port section, select one of the USB ports (e.g. ’usb1’); each USB Alarm Board must be as-
signed a unique port number that is not being used by any other USB devices (e.g. USB Alarm
Board/RS485 PTZ adaptor)

• In the Baud section, select ’9600’

• In the WaveAlarm settings section, assign a range of numbers to the twenty Inputs; each USB
Alarm Boardmust be assigned a unique range of input numbers that do not clashwith any other
AlarmDevices

• In the WaveAlarm settings section, assign a range of numbers to the twenty Outputs; each USB
AlarmBoardmust be assigned aunique rangeof output numbers that donot clashwith anyother
AlarmDevices

An example configuration is shown below:

Figure 6.21: I/O Devices screen – USBAlarmBoard configuration

In the Event Rules screen, the USB alarm boardwill appear as follows in the Event Cause submenu:
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Figure 6.22: I/O Devices screen – USBAlarmBoard digital inputs

In the Event Rules screen, the USB alarm boardwill appear as follow in the Event Action submenu:

Figure 6.23: I/O Devices screen – USBAlarmBoard relay outputs
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6.2.11.4 Configuring an SOM Device as an I/O device

SOM protocol is used to interface the Wavestore server with the SOM1 module available from CPC. It
supports 4 event outputs only.

For full detailsof support forSOM(SerialOutputModule)protocoldevices, pleasecontact theWavestore
Support Team.

Figure 6.24: I/O Devices screen – SOMprotocol device

6.2.11.5 Configuring an NMEA Device as an I/O device

NMEA protocol is used for GPS system integration. It is primarily used to set the system time from the
GPS. It can also generate positional text event inputs and set the system time.

To set the time: chosewhich of theNMEAcommandswill be used to set the time. Multiple fieldsmaybe
comma separated but omitted or empty ones are treated as any permitted, but non-empty fieldsmust
match. Typically an RMCcommandwill be used: $GPRMC

Most GPS deviceswill output RMC commands. But in some cases it might be desirable to synchronise
to the time or position using another command, so flexibility is provided.

An option is available to allow bad checksums for the few NMEA devices which do not provide correct
checksums.

An ’Accurateafter’ parameter specifiesnumberof fixesbeforeafixareconsideredaccurate. Default 750.
Before this, anerror of 16s is assumedbecauseof thedifferencebetweenGPSandUTCtimescales. This
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correction isonlybroadcastevery12.5minutesandtherefore for the initial 750fixes the time information
might not be in UTC.

A ’delay’ parameter specifies delay from timestamp to the ’$’ of the command being received. Default 3,
which assumes the ’$’ is sent within a millisecond of the time being computed, and since the ’$’ takes
2ms to be sent at 4800 baud, the total is 3ms. This parameter can be used for fine tuning when the
actual delay is known.

For location information, the same RMC command used for time can be used but it might be neces-
sary to reject these unless the third field is an A, hence use $GPRMC,,A for this event command field if
positional events are required.

First Input: the INPUT event to triggerwhen location information arrives.

Fields: the fields which need to go to the TEXT field of INPUT. Field 0 is command name, field 1 the one
after, etc. Checksum is treated as just another field. If multiple fields are included, the comma or star
separator between themwill be included. To get entire line (all fields including checksum but excluding
newline at end), use fields 0 to 99. If using the RMCcommand, use fields 3 to 6 to get the position.
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Figure 6.25: I/O Devices screen –NMEA protocol device

6.2.11.6 Configuring an IRIG Device as an I/O device

IRIG protocol is used for Time integration.

To configure an IRIG device, configure protocol as ’IRIG’, with baudrate ’2400’.
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Figure 6.26: I/O Devices screen – IRIG protocol device

6.2.11.7 Configuring an IP Camera as an I/O device

An example of IP camera configuration is shown below:
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Figure 6.27: I/O Devices screen –HTTPNotification from IP camera

In this case, the IP cameras has been configured (using aWeb Browser) to send HTTP Notifications of
Motion Events to the Wavestore server. The Wavestore server has also been configured to record the
Video Stream from the camera.

TheDigital Input ID assigned to this I/ODevicemustmatch theSort ID associated the camera channel
in the Devices menu. An integration module has been entered, to enable parsing of the data from the
camera.

Actions required on the Wavestore server (e.g. record video from a camera, on an enabled track for an
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enabled camera channel, when an digital input is received) can be configured in the Event Rules screen
(see section 6.12 - Event Rules).

In this example below, the server is configured to record video from the ’Checkout 1’ camera to Track 1,
when the HTTP notification is received from that camera.

Figure 6.28: Event Rules screen –Motion Recording onHTTPNotification from IP camera

6.2.11.8 Configuring a POS Device as an I/O device

An example of POSDevice configuration is shown below:
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Figure 6.29: I/O Devices screen – POS device sending UDP format data

In this case, the POS terminal is sending transaction data over the UDP transmission protocol to UDP
port number 4001. An integration module has been configured to enable parsing of the data from the
POSDevice. The data stream from the POSDevice has been assigned digital input number 21.

Actions required on the Wavestore server (e.g. record metadata from an external input, on an enabled
Metadata track for an enabled camera channel) can be configured in the Event Rules screen.

In this example below, the server is configured to the Record Metadata from input 21, on the Metadata
track for the ’Checkout 2’ camera:
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Figure 6.30: Event Rules screen – RecordingMetadata fromPOSdevice

For further details, please contact theWavestore Support Team.

6.2.12 PTZ Profiles
The ’PTZProfiles’ screen allows the configuration of collections of settings for PTZcontrol. Each individ-
ual cameracan thenbeassignedaprofile touse in the ’Cameras’ setupscreen. Thisoften isn’t necessary
for IP cameras since the ’Auto’ setting can handlemost IP cameraswithout requiringmanual configu-
ration.

PTZ Profiles are always required for analogue PTZ camera configuration.
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To begin, click the ’Add’ button to add a new profile with default settings. Then configure the following
settings as required:

IO Port
This is thecommunicationdevice tobeused. Itmightbe ’COM1’ to ’COM4’ for aserial port, or ’usb1’
to ’usbN’ for a USB serial device. For IP cameras it should be ’HTTP’.

Protocol
This is the communications protocol to be used. The list contains a large number of IP protocols
aswell as some analogue serial protocolswhich are found at the end of the list.

Use Custom Attributes
These are serial settings used only for analogue PTZ communication. The required settings will
depend on the cameras in use and should be supplied by the cameramanufacturer.

Use Custom Setting
These settings affect the speed and duration of PTZ nudge commands. These settings are rarely
required.

Once the settings have beenmade and saved, the PTZ Profilewill be available for selection in the ’Cam-
eras’ setup screen.

6.2.13 Miscellaneous

ONVIF Services
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This option allows the server’sONVIF services to be enabled or disabled. By default on new installations
they are disabled by default. Enabling them allowsONVIF functionality such as network discovery and
re-streaming of video.

Camera Name Synchronisation

In the Cameras setup screen, it is possible to pull camera names from the cameras, or push the lo-
cally configured names to the cameras. There aremultiple placeswhere these camera namesmight be
stored on the camera. This setting determines which location should be used when pushing or pulling
camera names.

Discover Scope Name
This is the name presented by the camera when scanning the network during a Discover opera-
tion. Some camerasmay not allow this to be overwritten.

Hostname
This is thecamera’s hostnameand is only available after correctly adding thecamerawith thecor-
rectusernameandpassword. Note thathostnamesmaynot includespaces. Theywill be removed
automatically if pushed to the camera.

Overlay Name
This is thecameranamestored in thecamera’s internal settingsand is only available after correctly
adding the camerawith the correct usernameandpassword. Support for reading andwriting the
Overlay Name is only available for supported cameras. Please check the camera compatibility list
for details of supported cameras.

Event Stream Recording

A recording track can be configured to record events which occur on the currently selected server.
Event search can only be performed if this recording track has been enabled.

To record these events, ensure the ”Event Stream Recording” checkbox is checked. It is possible to ei-
ther:

• Use the Disk and Recording Duration settings from aCamera Group (selectable but uses the first
group by default)
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• Manually specify the desired Disk and Recording Duration

Metadata Stream Recording

Arecording trackcanbeconfiguredontheserver itself (notassociatedwith individualcamerachannels),
for applications such asGPS data input.

To record this data it is possible to either:

• Use the Disk and Recording Duration settings from aCamera Group (selectable but uses the first
group by default)

• Manually specify the desired Disk and Recording Duration

Track Names

Each of the three Recording Tracks can be given a ’friendly’ name. This will be used in the UI in certain
places such as the Find Screen.

To configure, click in the text field, enter the text you require, then click Save.
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6.2.14 Configuration Editor

Figure 6.31: Configuration Editor

The ’Configuration Editor’menu contains a representation of the rawconfiguration file of theWavestore
server.

The Search dialog box allows the user to quickly find a configuration section by entering text, and then
clicking on the ’»’ button.

The configuration file can be edited manually, saved for future use (onto removable media, or a net-
workedWaveViewPC), or overwritten by an imported file.

If required, the server configuration settings can be restored to their default state (click ’Load Default’).

Saving and Loading Server Configuration File

It is goodpractice to back up the configuration file beforemakingmajor changes to the configuration of
the server (click ’Save to File’).
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Asavedconfigurationfile canbeuploadedonto theserver at a laterdate if required (click ’Load fromFile’).

When loading a configuration file, several options are provided to prevent unique server settings being
overwritten:

Current ’install’ User Login Details

Network Settings

Licence

Disk Assignments

SystemMonitoring Settings (fans, temperatures, etc. usually specific to themodel of hardware inuse)

If attempting to loador save on theWavestore server itself, itmaybenecessary to ”mount” aUSBdevice
- see section 9.17 - Accessing a USB disk on theWavestore server.

Loading a Backup Configuration File

The Wavestore automatically performs a backup of the configuration early every Monday morning. It
alsomakes a backupwhenever a configuration file is loaded andwhen amajor version upgrade is per-
formed. Amaximumof 50 backups are stored, with the oldest being deleted once the limit is reached.

When the ’Load Backup’ button is clicked, a list of all the available backups is presented. The user can
then select a configuration backup to restore.

6.2.15 Configuring Wavestore server for use as proxy server
If theWavestoreserver isconfiguredwithmultiplenetworkports, it canbeuseful toconfigure theserver
as anHTTPproxy server, so that a networked PC (e.g. a PC connected to the ’eno1’ port) can access de-
vices (suchas IPcameraor iSCSI storage) that are connected toother networkports on theWavestore
server. This supports HTTP and HTTPS proxy. See the theWavestore knowledgebase article on proxy
formore information.

To enable this function, additional configuration is required in theConfiguration Editor.

Right click on any of the existing configuration headings in square brackets, and click on ’Add Section’:
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In the dialog box that appears, enter ’ONVIF’ as the new section name, then click OK:

Thenewsectionwill appear at thebottom, so scroll to find it if necessary. Right-clickon thenewSection
Name that you have created, and left click on ’Add Parameter’:
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Enter ’HTTPproxy=y’ as the newparameter, then click OK.

Click ’OK’, and click ’Save’ to confirm your changes.

Restart the server software (menu path View→Setup→Server→General→Restart Process)

Toconnect to the IPdevices fromyourPC, using theWavestore server as aproxy server, you’ll also need
to reconfigure yourwebbrowserwith the IP address details of theWavestore server Ethernet port that
you connect to from the PC.

When you connect for the first time, you’ll also be prompted to enter a validWavestore user ’install’ level
logon ID and password.
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6.3 Cameras
TheCameras setup screen allows for rapid discovery and configuration of cameras, audio and talkback
(also known as ”backchannel”) devices.

Wavestore allows allocating cameras to ’Camera Groups’ so that configuration changes can be easily
managed for large collections of cameras, rather than having to change every camera individually.

This section describes the process of discovering and adding cameras, as well as configuring them ei-
ther individually or via CameraGroup settings.

6.3.1 Discovering and Adding Cameras
Uponentering the ’Cameras’ screen, theWavestorewill start a process of searching the network for any
available IP cameras. Once fully received this list will not be refreshed for another 30 minutes, or until
WaveView is restarted, or Refresh is clicked.

The Discovered Cameras can be sorted by name or IP address tomake it easier to find the desired de-
vice. The names are provided by the cameras themselves and the information available can vary by
manufacturer, manywill report themanufacturer andmodel.

Thepreferreddefault shownIPAddresscanbeselected in thebottom-rightpartof theDiscoveryCam-
eras tab. Options are IPv4 or IPv6. If IPv6 is selected, the default address for a camera will show its
configured IPv6 address. If a camera doesn’t have an IPv6 address it will fallback to displaying its IPv4
address. By double-clicking on a camera’s address field it’s possible to see all the available IP addresses
for the camera, including link-local addresses, and select the desired one.

Note that IPv6 is not currently supported formulticast.
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To add a camera, simply click and drag it from the right-hand pane to the left. Use Shift+click to select a
range, or Ctrl+click to select multiple individual items. The left arrow button can also be used instead of
dragging and dropping.

When added, cameraswill be assigned to the first CameraGroup automatically. If there are no existing
Camera Groups, a new one will be created and the user is prompted for a username and password to
be used to access the cameras. If the cameras have different usernames and passwords, these can be
specified per-camera later.

Anotherwayof adding a camera is using the + (plus) button. This simply adds anew row to theCameras
table. The IP Address andGroup can then bemanually specified.

It’salsopossible toaddmultiplecamerasbyprovidinganIPaddressrange. Todothis, click the ’++’button.
The following dialogwill appear:

It ispossible tospecify theCameraGrouptowhichthecameraswill beassigned, andthestartandendof
the IP range. If the range consists ofmore cameras than the server can support, or if the range appears
to be invalid, the dialogwill provide a suitablewarning.

If it is necessary to addmultiple channels for onedevice, or to usedigital inputs/outputs from thedevice,
hold the Shift button whilst clicking the + (plus) button. This opens a new panel which allows the extra
details to be specified:

Cameradetailscanalsobe imported fromaspreadsheet in theCSV(Comma-SeparatedValues) format.
See section 6.3.4 - ImportingCamera Settings.
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Once cameras have been added, the table on the left can be used to:

• Edit the camera name.

• Edit the IP address and port of the camera.

• Change the assignedCameraGroup of the camera.

• Change the Sort ID of the camera - see section 9.21 - Sort IDs.

• Enable/Disable the camera.

To change the assigned Camera Group, either left-click the group name to select from a list of existing
groups, or right-click formore options. The right-clickmenu has several options:

Change Camera Group - choose an existing group to re-assign the selected camera.

Change Camera Group - Create New Group -thiscreatesanewgroupwithdefaultsettingsandprompts
the user for a username and password to use for the cameras in this newgroup.

Change Camera Group - Clone Group - this creates a new group with the settings copied from the
selected existing group. This is useful when you need to split a group into multiples with slightly
different settings.

Remove Cameras - removes the currently selected camera or cameras.

Camera SetupWeb Page - opens up the default browser using the currently selected camera’s ad-
dress. Alternatively, if theGateway Proxy feature is enabled for the associatedCameraGroup, the
URL usedwill be the appropriate one to route traffic via theWavestore gateway proxy feature, re-
moving the need for direct network access to the camera.

Synchronise Camera Names -allowspushing localcameranamestotheselectedcamera(s), orpulling
the names from the selected camera(s). See section 6.2.13 - .

Selecting an individual camera in the camera table causes the right-hand pane to show the settings for
the individual camera. This is covered in section 6.3.3 - Individual Camera Settings.

Clicking the ’Camera Groups’ tab in the left-hand pane opens the ’Camera Groups’ settings which are
covered in the next section.

Multiple selection is possible by clicking and dragging down the camera number column. Alternatively
Shift + click and Ctrl + click can be used. This allows changing camera groups for multiple cameras at
a time, or removing multiple cameras. It’s also possible to use the delete-key to remove the selected
cameras.

The camera table can also be sorted by different properties by clicking the column header of interest.

6.3.2 Camera Group Settings
TheCameraGroups screen allows editing settings for Camera Groups aswell as adding and removing
groups.

Note thatwhen settings are changed for existing cameras,where possible theywill continue streaming
with the old settings until the new settings have been configured in a separate profile. Then streaming
is switched over to the new profile with the new settings. When this happens, the subtitles will show
”Reconfiguring”.
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The ’Add’ button creates a newgroupwith default settings. The ’Remove’ button removes the currently
selected groups. Multiple groups can be selected and removed at the same time either by clicking and
draggingon thegroupnumber column, or byusingShift + click orCtrl + click to domultiple selection. It’s
also possible to use the delete-key to remove the selected cameras.

The ’Clone’ button causes a newgroup to be createdwith a copy of the settings from themost recently
selected group.

The ’Remove’ and ’Clone’ optionsarealsoavailable throughacontextmenubyright-clickingonacamera
group in the table.

Change the name of the group by selecting it in either the table or in the right-hand pane.

The right-hand pane shows the amount of cameras that belongs to the selected group. In the example
above, 17 cameras belong to the ’Group 1’-group.

EachCameraGrouphas aType. Thedefault Type is Autowhich allows theWavestore to try to automat-
ically detect the device and use the optimal settings.

The various types are described below:
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Auto
This is an IP device type where the Wavestore will try to auto-detect the best method of com-
munication. TheWavestore will also try to configure the device with the desired video streaming
settings.

Important Note: Auto-configureworkswell when oneWavestore configures one ormore cam-
eras, but notwhen a camera is sharedbetweenWavestore systems (or otherONVIF clients) each
of which will attempt to reconfigure the camera and might alter or delete profiles or encoders
which another system is using. Ifmore than oneWavestore or other ONVIF clientwill access the
camera: select ONVIF protocol as the Camera Group type on theWavestore and enter a manual
profile, orRTSPprotocolwithanappropriate request string. Also, donotadd thesamecamerawith
the same subunit to the sameWavestoremore than once in Auto-configuremode. If a copy of a
channel is required, use VirtualSpotMonitor.

ONVIF
This is an IP device typewhich uses theONVIF standard for communication and setup.

ONVIF-Multicast
This is an IP device type which uses the ONVIF standard to stream from a device in Multicast
mode.

RTSP
This is an IP device typewhich uses the RTSP communication protocol to pull data.

HTTP
This is an IP device typewhich uses the HTTP communication protocol to pull data.

MxPEG
This is an IP device typewhich communicateswithMobotix cameras, retrieving video in theMx-
PEG format.

Ampleye
This isanIPdevicetypewhichcommunicateswithAmpleyecameras, retrievingvideo in theJPEG2000
format.

VirtualSpotMonitor
This is a special capture type used for the Virtual SpotMonitor featurewithinWavestore.

Audio
This capture type communicateswith an analogue audio capture card. Possibly the audio inputs
and outputs on themotherboard, or a PCI or USB audio interface.

Stretch
This isacapture typeused tocommunicatewithananaloguecapturecard, usuallyprovidingvideo
and audio. There are various ”sub-types” which correspond to the model number of the capture
card.

File
This is a capture typeused toplayback a videoor audio file in a loop. See section 9.6 -Configuring
a File PlaybackCamera.

Backup
This is a special capture type used for Failover servers. See section 6.9 - Failover.
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All the various options are explained below. Not all options are available for all types, in which case the
supported types are listed.

If there is a problemwith a particular option, it will be highlighted with a red colour. The reason for the
error can be found by hovering the mouse over the option. See example below where the drive letter
doesn’t exist. Please note that this is currently only implemented for some of the parameters.

Alsonote that someother optionswill be higlightedwith a yellowcolourwhile they are fetching formore
data from the server.

General

Username
The username to be used to authenticate with the camera or device. Note that if the username
is modified, it is necessary to re-enter the password. The user specified must have permissions
to configure the camera if the ”Auto” group type, or the ”Auto-configureCameraStreams” options
are to be used.

Not applicable for ”VirtualSpotMonitor” and ”Backup” group types.

Password
The password to be used to authenticatewith the camera or device.

Not applicable for ”VirtualSpotMonitor” and ”Backup” group types.

Alternative Credentials
Allows other username and password combinations to be provided. These will be tried if the pri-
mary username and password fails to authenticate.

Not applicable for ”VirtualSpotMonitor” and ”Backup” group types.

Video
Enables streaming of video from this device. Default is On.

Only applicable for ”Auto”, ”ONVIF”, and ”RTSP” group types.

Audio
Enables streaming of audio from this device.
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Not applicable for ”ONVIF-Multicast”, ”VirtualSpotMonitor”, ”Audio”, ”Stretch”, and ”Backup”
group types.

Talkback
Enables sending audio to this device. Sometimes alternatively called ”backchannel”.

Not applicable for ”ONVIF-Multicast”, ”Ampleye”, ”VirtualSpotMonitor”, ”Audio”, ”Stretch”, and
”Backup” group types.

Talkback Type
Allows choosing themethod of sending audio to the device. The default is Auto and will work for
most devices.

Only applicable for ”ONVIF” and ”RTSP” group types.

Request
Note that certain group types have a Request field under theStream 1/2/3 section. TheRequest
parameter under the General section is used to allow options to be set for the streaming. For ex-
ample thismightbe to force ”HTTPTunneling” or transmissionoverUDP.Thedefault emptysetting
should be used in the vastmajority of cases.

Not applicable for ”Auto”, ”RTSP”, ”VirtualSpotMonitor”, ”Audio”, ”Stretch”, and ”Backup” group
types.

Use SSL
If enabled, causes the Wavestore server to communicate with the device using Secure Sockets
Layer.

Not applicable for ”ONVIF-Multicast”, ”VirtualSpotMonitor”, ”Audio”, ”Stretch”, and ”Backup”
group types.

Encrypt Recordings
If checked, this channel will be encrypted during recording. This will only work if the Wavestore
server has been correctly configured for encryption. See section 6.2.8 - Encryption.

Smart Search / VMD
Enables the capture and recording ofmetadata relating to the amount ofmotion in the video. This
can be used for either server-side or camera-sidemotion detection togetherwith Smart Search.
See section 9.8 - Configuring Smart Search formore details.

Only available for ”Auto”, ”ONVIF” group types. For ”Stretch” group types this feature is al-
ways on and so is not configurable.

Pull Point
If enabled, theWavestoreserverwill ”subscribe” to theeventstreamof thedevice. Thismeans that
the camera will notify the Wavestore of any events it detected such as motion or video analytics
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events.

Only available for ”ONVIF” group type. For ”Auto” type, event streaming of some kind will
be enabled if possible.

Auto-configure Camera Streams
This settingmeans that theWavestore will attempt to create push stream settings to the device,
for example by creating ONVIF Profiles for ONVIF devices. Rather than having video stream set-
tingsconfiguredandstoredonthecamera, thesettingswill bemadewithinWavestoreandpushed
to the camerawhen necessary.

Important Note: Auto-configureworkswell when oneWavestore configures one ormore cam-
eras, but notwhen a camera is sharedbetweenWavestore systems (or otherONVIF clients) each
of which will attempt to reconfigure the camera and might alter or delete profiles or encoders
which another system is using. Ifmore than oneWavestore or other ONVIF clientwill access the
camera: select ONVIF protocol as the Camera Group type on theWavestore and enter a manual
profile, orRTSPprotocolwithanappropriate request string. Also, donotadd thesamecamerawith
the same subunit to the sameWavestoremore than once in Auto-configuremode. If a copy of a
channel is required, use VirtualSpotMonitor.

Only available for ”ONVIF” group type. For ”Auto” type, this is implicitly On.

Rotate
Requests the camera to rotate to the transmitted image. Default is 0, no rotation. Other allowed
values are 90, 180 or 270, representing degrees clockwise.

Only available for ”Auto” and ”ONVIF” group types. This functionality is available on most,
but not all, ONVIF-compliant cameras. If the camera doesn’t support it, the ”Cxauto” cam-
era log will say ”Image rotation not supported!”, where ”x” is the camera number. These are
available under ”Tools > System Log... > Extra Logs”.

Input Select
Allows switching between the ”line” and ”microphone” inputs on the audio device.

Only available for ”Audio” group type.

Volume
Set the input capture volume for the audio device. The volume starts from0 and themaximum is
100.

Only available for ”Audio” group type.

Analogue Format
This is thevideostandardused forcapturingvideo. ForStandardDefinitiondevices it is usuallyPAL
or NTSC. High Definition capture devices havemore options such as 1080p60, 1080i50, 720p60.
These are all standard formats for High Definition video.
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Only available for ”Stretch” group type.

Stream 1/2/3

Note that Stream3 is only available for the group types RTSP, ONVIF, and Auto.

Profile
The name of the camera Profile which will be used for streaming video. This list is populated by
querying the first camera in this CameraGroup.

Only available for ”ONVIF” and ”ONVIF-Multicast” group types.

Request
Allows a specific request string to be provided for each of the 2 possible streams. This is used to
make requests to the camera to retrieve video. The string can either be enteredmanually or a pre-
set can be chosen from the drop-down selector which contains request strings for many major
cameramanufacturers.

Only available for ”RTSP” group types.

Encoding
This is the video encoding to be used. Selectable between ”Auto+”, ”Auto”, ”H264”, ”H265”, and
”JPEG”. ”Auto+” will favour H.265, then H.264, then JPEG. ”Auto” will favour H.264 then JPEG.

Only available for ”Auto” and ”Stretch” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

Audio Encoding
This is the audio encoding to be used. Selectable between ”Auto”, ”AAC”, and ”G711”. ”Auto” will
favour AAC, thenG.711.

Only available for ”Auto” and ”Stretch” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

Capture Rate
This is the rate, in ”images per second” thatwill be used to encode the video stream.

Only available for ”Auto” and ”Stretch” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

GOP Size
GOP is Group Of Pictures. In certain compression formats such as H.264 and H.265, there are ”i-
frames” which are full images, followed by a number of ”p-frames”, which are essentially contain
only the differences between this frame and the previous one. The GOP size dictates howmany
frames there are in a group. So for example, a GOP size of 5 would suggest 1 i-frame followed by
4-pframes, and then the same repeated.
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Only available for ”Auto” and ”Stretch” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

Resolution
The resolutionatwhich thevideowill beencoded. ”Full”means thehighest available resolution, but
other available resolutions are usually specific industry standard terms. A custom resolutionmay
be specified. If the precise resolution is not supported by the camera, Wavestore will attempt to
choose the closest availablematch.

Only available for ”Auto” and ”Stretch” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

Quality Mode
Thisdictates the typeof compressionavailable. Theseareexplained inmoredetail later in this sec-
tion.

Only available for ”Stretch” group type.

Constant Quality This is thedefault, andrecommendedsettingformostuses. Thevideoencoder
tries to keep thevideoquality at the same level. This has thebenefit of ensuring
thatnomatterhowmuchactivityordetail there is in thescene, thevideoquality
will remain. The disadvantage is that high levels of activity or detail can cause
the bitrate to increase, meaningmore storage and bandwidth is required.

Constant Bitrate Thevideoencoder attempts to keep thebitrate at a roughly constant level. The
advantage of this is that it makes it easier to calculate the storage and band-
width requirements. The disadvantage is thatwhen there is increased activity
or detail in the scene, the image qualitywill actually reduce in order to keep the
data rate at the desired level.

Variable Bitrate Thevideoencoderallows thedata rate tofluctuatearound the ”Averagebitrate”
setting, butwhen there is increased detail or activity, the data rate is allowed to
increase up to the configured ”Maximum bitrate” setting. Similar to Constant
Quality, this setting has the disadvantage of a varying data rate meaning that
the required storage and bandwidth varies depending on the scene content.

Average Bitrate
This is the average bitrate to use for the encoding (in Kilobits per second). It does not applywhen
theMode is Constant Quality.

Only available for ”Stretch” group type.

Maximum Bitrate
This defines themaximum bitrate to be used for encoding. When the group type is ”Stretch”, this
setting is only applicablewhen theMode is set toVariableBitrate. Note that forONVIF IPcameras,
this feature is optional andmaynot have the desired effect. In that case theQuality setting can be
used to reduce the bitrate per camera if desired. See the ”General” settings under section 6.3.3.
A per-camera Quality setting is often the better option to ensure that the video quality does not
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degrade when there is lots of activity, which may happen if attempting to stay below a specified
maximumbitrate.

Only available for ”Stretch” and ”Auto” group types, and ”ONVIF” group type when ”Auto-
configure Camera Streams” is set to ”Yes”.

All Tracks / Track 1-8

Wavestore uses a systemof different ”recording tracks”. Tracks 1 to 3 allow recording the video streams
with different settings. Track 4 is for general metadata associatedwith the camera. Track 5 is currently
unused. Track6 is forSmartSearchmetadata, Track7 is forAudio (input), andTrack8 forTalkback (audio
output).

The ’All Tracks’ option is a shortcut for making settings that apply to all recording tracks (1 to 8). If the
individual tracks have been configured with different settings then that setting will show as ”various”
under ”All Tracks”.

The available settings are described below:

Disk
Hard disk where the recording will be stored. This is chosen from a list of disk letters which are
configured in the Storage page under the Servers setup creen.

Disk 2
An optional secondary hard disk for amirror of the recordings.

Recording
Duration, in days, that footage is to be stored. The ”Mode” can be either:

• Approximately – once the hard drive is full, and the server is about to start overwriting older
footage, server uses the value entered for ’Time Period’ to determine howmuch of the hard
drive space to allocate to each camera/recording track. As an example, let’s take the example
of a Hard Disk that is being used to store footage from two cameras. Camera A is configured
set to record for ’Approximately 15 Days’, and Camera B configured to record for ’Approxi-
mately 5 Days’. When we compare the storage duration for the two cameras, we can see
thatCameraA is required to store footage for three times theperiod ofCameraB, soCamera
Awill be allocated three asmuch as space on the hard drive; so in the case Camera Awill be
allocated 75% of the hard drive, andCamera Bwill allocated the remaining 25%of the drive.

• Maximum - this option sets a hard limit, afterwhich footagewill be deleted; as an example, if
this option is enabled, with Time Period set as ’7 days’, and the Wavestore server then left to
record for a few days, on Day 8, the footage fromDay 1will be deleted in increments.

Stream
Selectswhich Stream (1 or 2)will be recorded.

Recording Rate
Selects the recording framerate. The default and recommended setting ”Same as Capture Rate”
means that all received frameswill be recorded. For H.264, H.265, andMPEG-4 streams this set-
ting should generally be left as the default. If it is set to a lower rate than the rate the camera is
outputting thenonly ”i-frames” - the full images -will be recorded. See section 9.12 -H.264, H.265
and Framerates formore information.
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Boost Rate
Recording framerate to use when a ”boost” event action occurs, as configured in the Event Rules
menu ( section 6.12 - Event Rules).

As with the normal recording rate setting, this option isn’t always well-suited to use with H.264,
H.265, and MPEG-4, due to to the presence of P-frames. See section 9.12 - H.264, H.265 and
Framerates for amore detailed explanation.

Recording Mode
A variety of recordingmodes are available...

Normal Normal continuous record (when schedule is on). Schedulemay
be set andwill affect the recording. Pre Record setting is not ap-
plicable.

Event Normally no recordingbutEventRules can trigger recording. Pre
Record parameter may be set if needed. Schedule may be set
andwill affect the recording.

Normal + Event Continuous recording when schedule is On. Event recording if
event rules triggered and schedule is Off. Schedule and/or Pre
Recordmay be set. Schedulewill not affect event recording.

Framerate Boost on Schedule Normal recordingwith boosted frameratewhen schedule is On.

Motion Ifsupportedbythedevice,motionwill trigger recording. PreRecord
parameter may be set if needed. Schedule may be set and will
also affect the recording. Requires ”Smart Search / VMD” to be
enabled except for the ”Stretch” group type.

Normal + Motion Continuous recordingwhen schedule is On. If supported by the
device,motionwill trigger recordingwhenschedule isOff. Sched-
ule and/or Pre Record parameter may be set. Schedule will not
affect motion recording. If desired to have a separate schedule
for motion, use Normal + Event mode. Requires ”Smart Search /
VMD” to be enabled except for the ”Stretch” group type.

Schedule
Recordingof theTrackcanbecontrolledbyaconfiguredSchedule (seesection6.10-Sched-
ules). This setting allows a schedule to be chosenwithinwhich recordingwill be enabled.

Pre Record
When using event ormotion recording, this value specifies the number of seconds to record
before the start of the event.

Pre Boost
Whenset to a value other than ”Never” this setting causes the framerate of recordings before
an event to be ”boosted”, that is increased. For example, if set to 5 seconds, when an event
triggers a framerate boost, 5 seconds of recording before the event will have the increased
framerate. Note that the duration specified here is only approximate.

Post Motion
WhenrecordingonMotion, thisvaluespecifies thenumberof seconds to recordafter theend
of the Motion event. For Event recording, the equivalent Post time is specified in the Event
Rule so that different values can be used for different event types.
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PTZ Options

Enable
Allows PTZ to be disabled for this camera group. Particularly useful when using the ”Auto” group
type because it’s possible that PTZ functionality might be available on the camera and automati-
cally detected, but not desired.

Profile
Allows specifying the PTZ Profile to be used to control this camera, where a ”PTZ Profile” is a col-
lection of settings. The default ”Auto” setting will generally manage to automatically set up most
IP cameras. For some IP cameras, and all analogue cameras, it will be necessary to set up a PTZ
Profilewhich can be done under Server setup screen. See section 6.2.12 - PTZ Profiles.

Pan Reverse
Reverses Pan Left/Right commands for this camera.

Tilt Reverse
Reverses Tilt Up/Down commands for this camera.

Warning Options

GOP Check
It is generally recommended to use a GOP size (Group Of Pictures) of 64 or lower in order to get
the best performance fromWavestore. By default, the System Log will provide warnings for any
streams which exceed this recommendation. This setting allows the check to be disabled to si-
lence thosewarnings.

Analytics

This section is only present if an Analytics Engine has been configured. See section 6.2.9 - Analytics
Engines.

Analytics Engine
The ID of the analytics engine towhich streams from cameras in this group should be sent.

Stream
The Stream ID to send to the analytics engine.

Advanced

This section is only present if the contained options are relevant to the current camera group type.

EMS Licensing
Treat cameras in this group as Encoder/Multi-Sensor devices. Normally such devices are auto-
detected so this setting wouldn’t be necessary, but if the device is not correctly detected as an
Encoder or Multi-Sensor devices, this option forces it to be detected as such. When enabled, the
Wavestore server will prefer using an EMS channel licence and allow up to 4 lenses per licence to
be added.

Gateway Proxy
Enables camera Gateway Proxy feature for cameras in this group. When enabled, theWavestore
acts as a gateway (or HTTP reverse proxy) to allow access to the camera; the camera web page
can be accessed via theWavestore IP address and port 1000+n (http) or 2000+n (https)where n

253



is the camera number. It can also be accessed by right-clicking the camera in the tablewithin the
”Cameras” tab of theCameras setup screen and selecting ”Camera SetupWeb Page”.

6.3.3 Individual Camera Settings

The camera table in the left pane hasmultiple columnswhich are detailed below:

ID (Non-editable) This shows theChannel ID of the camera on this row.

Name (Editable) This is the name of the camera.

IP (Editable) This is the IP address or hostname of the camera.

Subunit (Editable) This field should normally be left as 1, but can be changed to select a lens for amulti-
lens camera, or a channel within amulti-channel encoder.

Group This is the CameraGroup towhich this camera is assigned.

Sort ID This ID is used to provide custom sorting within the UI, e.g. in the Device Tree on the main
screen.

Enabled This determineswhether the camera is enabled or disabled.

Status This shows thestatusof thecamera. See section 15-AppendixE -CameraStatuses for details
of available statuses.
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When a camera is selected in the left pane of the Cameras setup screen, the camera-specific settings
(as opposed to camera group settings) become visible in the right-hand pane.

The camera name can be changed by selecting it in the right-hand pane.

There are 3 tabs available:

General
Commonly used per-camera options.

Mask options
ForconfigurationofMotionDetectionMasks, PrivacyMasks, andsensitivities forMotionDetection,
Darkening Detection, andCameraMovement detection.

Dewarping options
For configuring dewarping settings for fisheye and panoramic cameras.

These sections are described in detail in the following sections...

General

• General

Username (override group)
A username to use for authentication with the device. Overrides the username configured
for the camera group. Note that, whenmaking this setting, the Password setting below also
needs to be provided.

Password (override group)
A password to use for authentication with the device. Overrides the password configured
for the camera group. Note that, whenmaking this setting, the Username setting above also
needs to be provided.

Linked Audio
Allows selection of a separate audio channel to be associated with this video channel. If set
to Auto then the same channel will be used for video and audio if Audio is set to ”yes” for the
camera group.

Linked Talkback
Allows selection of a separate talkback channel (also known as ”backchannel”) to be associ-
atedwith this video channel. If set to Auto then the same channel will be used for video and
talkback if Talkback is set to ”yes” for the camera group.

PTZF Address
Sets thePTZAddress for this camera. Generally only ever neededwhenusing analoguePTZ.

PTZF Idle Action
Allows configuration of an action for a PTZ camera to take when nobody has controlled the
camera for a period of time. Possibly actions are ”GoToPreset” and ”Start Tour”. For example,
”Go To Preset 4 After 90 Seconds”.

Metadata Visualisation
Allows selecting a ”metadata visualisation” to be associated with this camera. Default visu-
alisations are provided as well as any which have been configured in the Metadata Display
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setup screen. Metadata Visualisations are usually used in conjuction with Integration Mod-
ules, such as a Point of Salemodule. In this case, configuration instructions for theMetadata
Visualisation are providedwith the IntegrationModule.

Analytics Channel
Only available for cameras in a groupwith anAnalytics Engine assigned. Allowsselecting
a channel ID on the Analytics Engine towhich this camerawill bemapped.

Maintenance Mode
Puts this camera into ”Maintenance Mode” until the specified date. Whilst in this mode, the
camera will not report faults as F faults in the system log, nor will it set FAULT on the status
indicator or remotemonitor. Useful if a camera is known to be problematic but an immediate
fix isn’t possible, to prevent leaving thewhole system in Fault state.

• Imaging

Stream 1 Quality
Allows configuration of the image quality for stream 1. Higher values mean reduced video
compression and higher image quality, but also higher data rates. Higher data rates equate
tomore network bandwidth usage (whenusing IP cameras) and alsomore disk space used.
Oftenthe imagequalitycanbereducedtoquitea low levelbeforeanyvisibleartifactsbecome
apparent so it is recommended to avoid the temptation of setting this value unnecessarily
high.

Stream 2 Quality
Allows configuration of the image quality for stream2, if enabled.

Saturation / Brightness / Contrast / Sharpness / Hue / Noise reduction / Deinterlace / Median filter

Adjusts various properties of the image.

Only available for cameras that belong to a ”Stretch” group type.

Mask options

TheMaskOptions panel is only available for video channels. It serves several purposes:

• Configuration ofMotion DetectionMasks

• Configuration of PrivacyMasks

• Configuration of sensitivity for Motion Detection, Darkening Detection, and Camera Movement
detection

Note that PrivacyMasks are available for all video channels. MotionMaskswill only have an effect for:

• Analogue video channels

• IP video channelswith ”Smart Search / VMD” enabled

CameraMovementdetection (server-side) issupported foranaloguevideochannelsandIPvideochan-
nelswhen ”Smart Search / VMD” is enabled.

Darkening detection is supported for analogue cameras and for ONVIF IP cameras that have the ability
to detect a darkening event and provide this via theONVIF PullPointmechanism.
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Privacy Masks allow an area of the image to be blocked, often used for privacy reasons. The ability to
ignore privacymasks is configurable on a per-user basis in the Users Setup Screen.

TheMotionMask is used to determine if themotion triggers aMotion event (see below formore detail).
There are also Sensitivity settings for motion detection, darkening detection, and camera movement
detection. The higher the sensitivity themore likely that each of those eventswill be detected, but if the
sensitivity is too high then false alarmsmay occur.

The various settings and buttons are described in detail below:

Adjust Mask Themask is only shownwhen this checkbox is enabled. Note that if themask has
not yet been configured, i.e. it is an empty mask, nothing will appear on the video
image. When this setting is enabled, themask can be drawn onto the video image
by left-clickingwith themouse. MotionMasks are shown in green, PrivacyMasks
are shown as a dark area on the image.

Motion / Privacy This radio button determines whether a Motion or Privacy mask is being config-
ured. These options are only available if AdjustMask is enabled.

Show grid If enabled, a gridwill be shown to assist with drawing themask.

Showmotion If enabled, areaswheremotion is detectedwill behighlighted inblueon the image.
This can be used to help adjust the sensitivity to the appropriate level. See notes
below onmotion outside themask area.

Undo Reverts the lastmask editing operation

Redo Re-applies a previously undonemask editing operation

Clear Clears the entiremask

Fill Fills the entiremask
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Sensitivity Sets the sensitity formotion detection.

Darkening level Sets the sensitivity for ”darkening” detection. ”Darkening” is when the camera is
obscured in someway. TheWavestore server candetect this and trigger anevent.

Camera movement Sets the sensitivity for ”camera movement” detection. This is to detect when the
camera has been moved to face in another direction. The Wavestore server can
detect this and trigger an event.

Note that the systemwill detectmotion over the entire image. The server saves this detectedmotion (if
the track is enabled) for later use, for example by Smart Search.

The Motion Mask is used to determine if this motion triggers a Motion event, which might perform an
action like starting recording or alerting a user to an intruder. The Motion Mask is used as the video ar-
rives from the camera to decide if the Motion event is triggered. The mask does not affect the motion
detected, and inparticular it doesnot affect themotion stored for later processing, for examplebySmart
Search, where you choose amask at the time of search.

Sowhenyouviewmotionon the setup screen, youwill seemotiondetectedboth inside andoutside the
mask area. This is normal, as themotion is being shownwhere it is detected.

Dewarping options

TheWavestore server is compatible with a wide range of hemispheric (360°) and wide angle cameras.
These cameras stream raw ’warped’ images of the area surrounding the camera. The true proportions
of the objects being viewedmaybe altered on these raw images, and straight lines of objects viewedby
the camerasmay appear to be curved.

The warped images are recorded by theWavestore server, but can then be ’dewarped’ by aWaveView
client (either on the server boxor aPC, for LiveVieworPlayback), so that the viewedobjects appearwith
their true proportions and straightened line edges. Thismode of operation is known as ’Post Recording
Dewarping’, andany360°camerasusedwith theWavestore servermustbeconfigured for thismodeof
operation, rather than ’Pre Recording Dewarping’ mode (also supported by some cameras), where the
image ’dewarping’ is carried out on the camera itself, before the images are streamed to the server.

Individual dewarped views can be configured and saved on theWaveView client software. The field of
view and level of digital zoom for these views can be freely configured by the user, effectively creat-
ing one or more ’virtual’ cameras. These views can be created tomonitor Live footage, or playback raw
’warped’ footage that has been previously recorded. In this way, a single 360° camera can be used to
replacemultiple standard cameras.

Initial setupofHemispheric/WideAngle camera is performed in the samewayas for a standard IPcam-
era. Note that if a camera has just been added, it is necessary to save the camera configuration before
dewarping canbe enabled, since the softwareneeds to be receiving video in order to properly configure
the dewarping parameters.

Some additional configuration is necessary as follows:
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Figure 6.32: 360° camera configuration screen

In the Dewarping Settings submenu, check the ’Use DewarpingOptions’.

Next, choose the appropriate dewarping engine:

Default engine
This is theWavestore engine for dewarping and is suitable formost fisheye camera types.

Oncam engine
This engine is for use with cameras manufactured by Oncam and offers the Oncam experience
within theWavestore software.

Immervision engine
This engine is for cameras which use Immervision Panamorph lenses, which should be speci-
fied in the camera’s documentation, and offers the Immervision experiencewithin theWavestore
software.

Depending on the engine chosen, different optionswill be presented.

Default Engine

To set up the camera for the Default Engine click the ’Set or Change Geometry’ boxes. A red circular
graphicwill now appear on the rawwarped camera image as shown below:
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Use the mouse controls (click and drag/roll mouse wheel) to change the size and position of the circle
until it neatly surrounds the non-black area of the camera image. This setting ensures that the appro-
priate lens correction is applied to the image and also restricts the viewing areawhen dewarping.

The next step is to select the orientation of the camera according to the position of the cameramount.
Wavestore allows any orientation, although the most common are Ceiling (90◦), Wall (0◦), and Table (-
90◦).
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The View Angle can also be changed if it is known to be something other that the default 180◦ . Simply
check the ”ViewAngle” box and set the value.

It is also possible to create saved ”Dewarp Views”. To do so, click either ”Dewarped” or ”Panorama”, de-
pending on the type of view desired. This will open a new window showing the video in dewarp or
panoramamode. Use themouse controls in the videowindow to pan/tilt/zoom to the desired position...

To save theView, enter aname in the ”Viewname”boxandclick ”Addview”. To removeasavedview, click
the third drop-down box, select the view, then click ”Remove Selected View”.

Note that only a few views can be saved. Normally this is around 4 per camera but the precise number
depends on the length of view name, so short names should be preferred.

Oncam Engine

Configuring a camera to use the OncamEngine is quite simple. Just choose a desired dewarping ”View
type” and select an orientation of either Ceiling,Wall or Table, then save the changes.

Thecameradisplay should shouldnowshowthedewarpedview. Theviewcanbecontrolledbyclicking
and draggingwith themouse and using themouse-wheel to zoom.
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To save a dewarped view, move the image to the desired orientation, enter the name in the ”Enter view
name...” box, then click Add.

To remove a view, select it from the ”Select view” drop-downmenu, then click ”Remove”.

Immervision Engine

To configure a camera to use the Immervision Engine, it is necessary to determine the lens type. This
information should be available from the cameramanufacturer.

Choose the lens type from the ”RPL” drop-downmenu, then select an orientation of either Ceiling, Wall
or Table, then save the changes.

Thecameradisplay should shouldnowshowthedewarpedview. Theviewcanbecontrolledbyclicking
and draggingwith themouse and using themouse-wheel to zoom.
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To save a dewarped view, move the image to the desired orientation, enter the name in the ”Enter view
name...” box, then click Add.

To remove a view, select it from the ”Select view” drop-downmenu, then click ”Remove”.

6.3.4 Importing Camera Settings
Certaincamerasettingscanbe imported fromaspreadsheet tomakeadding largenumbersofcameras
convenient.

Thespreadsheetshouldbe inCSV (Comma-SeparatedValues) format. Mostpopular spreadsheetsoft-
ware can export in this format.

To perform the import, right-click on the Camera Table and select ”Import from CSV...”. Then choose
your CSV file and click Open.

The importmechanism can import:

ID The channel ID

Name The channel name

IP The IP address or hostname for the channel

Subunit The Subunit for the channel (often used to select a lens for a multi-lens camera, or a channel
within amulti-channel encoder)

Sort ID The Sort ID for the channel, used to display cameras in an abritrary order on themain screen.

Group The name of theCameraGroup to assign

Only the ID field ismandatory.
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The first row of the CSV file should be the headings. The headings are case-insensitive and multiple
alternatives are permitted. Here are the permitted alternative headings:

ID ”id”, ”no”, ”no.”, ”camera”, ”channel”, ”camera id”, ”channel id”, ”camera no.”, ”channel no.”

Name ”name”, ”camera name”, ”channel name”

IP ”ip”, ”ip address”, ”host”, ”host name”, ”hostname”

Subunit ”subunit”, ”sub unit”, ”sub-unit”, ”lens”

Sort ID ”sort id”, ”sortid”

Group ”group”, ”camera group”, ”channel group”

Here are some important notes about the behaviour of the import process:

• If no ID column is present in theCSV file, the importwill be rejected.

• If thereareduplicateIDs, thefirstonewill beaccepted. Therestwill be rejectedandanerrorshown
detailing the duplicate IDs.

• If there are any invalid IDs, e.g. text instead of numbers, thesewill be rejected and an error shown
detailing the rowswithin theCSV filewhich had these invalid IDs.

• If there are toomanyentries, the importerwill addasmanyaspossible andshowanerror detailing
the ID of the first entry thatwas rejected. Subsequent entrieswill also have been rejected.

• If a channelwith the given ID already exists, it will be overwrittenwith the imported settings, oth-
erwise a new channel will be created.

• If noName is provided, a default name is used, unless the channel alreadyexists, inwhich case the
Name is not changed.

• If no IP is provided, it is left blank, unless the channel already exists, in which case the IP is not
changed.

• If noSubunit is provided, or the provided value is invalid, the default Subunit of 1 is used, unless the
channel already exists, inwhich case the Subunit is not changed.

• If no Sort ID is provided, or it is invalid, the Sort ID is set to the same as theChannel ID, unless the
channel already exists, inwhich case the Sort ID is not changed.

• If theGroupName isnot found, or ismissing, a default existinggroup is assigned, unless thechan-
nel already exists, inwhich case theGroupName is not changed.

Here is a brief example CSV file:

ID,Name,IP,Subunit,Group,Sort ID
1,Camera 1, 192.168.0.1,1,Group 1,1
2,Camera 2, 192.168.0.2,2,Group 1,2
3,Camera 3, 192.168.0.3,1,Group 2,3
4,Camera 4, 192.168.0.4,2,Group 2,4

If the import procedure completes and the results are unexpected, click Reset to return to the previous
settings, and check theCSV file is correct.
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6.4 Main View
The ’Main View’ setup screen contains a list of selectable sub-sections to configure various aspects of
behaviour relating to theMain View screen.

These are detailed in the following sections.

6.4.1 Channel Groups
Note: The settings in this page apply to all servers in the server group.

TheCustomChannel Tree allows auser to group frequently used cameras together, so that they canbe
quickly accessed.

Right-clicking on theDevice tree allows the user to switch between theChannel Tree View (all cameras
listed) andGroup Tree view (only cameras that are part of a group are listed).

We can create a camera group as follows:

• Followmenu pathView→ Setup→Main View→ Custom Channel Tree

• Either right-click on the right-hand pane and choose ’AddGroup’, or click on the ’Add’ button.

• Enter a name for the new camera group that you are creating, then click ’OK’.
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There are now twoways to add a camera to a group...

• Click on the name of the camera group in the right panel, so that it is highlighted, then click on the
camera in the left panel that youwish to add to the group.

• Then click on theRight Arrow button between the two panels.

...or...

• Drag one ormore camera names from the left panel onto the nameof the group in the right panel.
To selectmultiple cameras, hold CTRL and left-click to select individual cameras, or Shift to select
a range.

• Repeat for any other cameras/groups as required:

• Click on ’Save’ to store your changes on the server.

The cameras in the Camera Group panel on the right can be dragged and dropped into new positions
as desired. Above each of the two panels, there is a button to collapse all or expand all groups.

Some considerations to note:
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• When an ”admin”-level user is configuringCameraGroups, theymay have not have permission to
access all cameras. Non-permitted cameras are not shown in the existing Camera Groups but
those groups can still be edited.

• Anycamerawithin aCameraGroupwhichexistsonaserverwhich isno longer in theservergroup
will not be shown in the setupscreenor in themain screen, butmaystill exist in theCameraGroup
configuration until that group is deleted.

Once saved, the custom groups can be accessed by any client. To display the Camera Groups in the
Main screen, right click on the Device Tree:

• Select theGroup Tree View option:

The Device Tree preference (Channel Tree View or Group Tree View)will be rememberedwhenWave-
View is exited and restarted. It is possible to double-click on theGroup name to open all the cameras in
the group in a suitably sized layout.

6.4.2 Metadata Display
Thisscreenallowsthecustomisationofmetadatavisualisations, suchasvideoanalyticsboundingboxes.
Visualisationsareassignedtocameras in theCameraSetupscreen-seesection6.3.3-IndividualCam-
era Settings. Normally it’s sufficient to use the default settings for any given visualisation, however this
screen allows a copy of the default to be created, named, and configured. Once saved, it can then be
assigned to a camera.
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To create a new visualisation, click Add, then choose the Type and give it a name. By default, the newly
created visualisation will have the default settings which should be reasonable, so the settings can be
tweaked from that point as desired.

Once complete, click Save to store the visualisation settings to the server. Note that, if returning to the
main screen to check how the settings look, it is necessary to reopen the camera to obtain the newset-
tings.

6.4.3 Layout Sequences
Layout Sequences allow layouts to be automatically loaded consecutively with configurable durations
for each one. They are configured in this screen. See section 3.7.2 - Triggering Layout Sequences for
details about their use.
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Layout Sequences can only be created fromShared Layouts, which any user can create from theMain
Screen.

The Add button can be used to create a new Layout Sequence. By default it will be empty, but layouts
can then be added to the sequencewith the ’Add Layout’ button.

For each step in the sequence, a Layout can be selected and a duration, in seconds, specified.

Once complete, click Save to store it to the server. It will then be available for use in theMain Screen.
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6.5 Hot-Spots
The Hot-Spots setup screen allows configuring regions to be overlaid on cameraswhich allow clicking
to switch to other cameras or trigger Event Causes. For example, if several cameras cover a long cor-
ridor, a Hot-Spotmight be configured on each camera at each side of the image to allowmoving to the
cameras further along the corridor in each direction. Or a Hot-Spot might be configured to trigger an
eventwhich locks and unlocks the door.

Hot-Spots are unique to each camera. Each Hot-Spot can have a configurable region, colour, icon, and
action to performwhen clicked.

To add a Hot-Spot, first select a camera, then click ’Add’. A new Hot-Spot will be added with a default
name, region, and colour.

It is recommended to set a suitable name for theHot-Spot as thiswill be shownas a tooltipwhenusers
hover their mouse over the Hot-Spot. Therefore, the name should ideally describe the action that will
occurwhen the Hot-Spot is activated.

It is necessary to choose at least one action to performwhen the Hot-Spot is clicked. The actions are
Switch Camera and Trigger Event Cause, and are detailed later in this section.

It is possible to add more actions by clicking the green + button at the bottom of the existing actions.
Actions can be removedwith the red - button.

In themain screen, when viewing a camera, if the Hot-Spot hasmore than one action available, the de-
sired action can be selected from amenu by right-clicking the Hot-Spot.
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Once the actions are configured, it is likely to be desirable to configure the region where the Hot-Spot
will be shown on the camera. The region can be edited as follows:

• Click and drag a circular end-point of the line tomove that point

• Double-click on an edge of the region to add another point

• Double-click a circular end-point to remove it

• Clickwithin the region and drag tomove thewhole region

The colour of the Hot-Spot region can be configured by clicking the ”...” button next to the ’Colour’ indi-
cator.

Anoptional iconcanbeselectedbyclicking the ”...” buttonnext to the ’Icon’ indicator. Thiswill openanew
dialogwith a choice of icons to use. Choose ’None’ if an icon is not required - although this is the default.

Note that the selected icon is not shown in the Hot-Spot region on this screen, butwill be shownwhen
thecamera is viewed in theMainScreenor FindScreen. The icon is scaled automatically to a reasonable
size.

At this stage, clicking ’Save’ will make the Hot-Spot available.

For a givencamera, it is possible to ’Add’moreHot-Spots, ’Copy’ existingHot-Spots, and thenedit them,
and to ’Remove’ Hot-Spots. It is also possible to use the up and down arrows to change the order of the
Hot-Spots. This has no effect on the behaviour in the rest of the software and is only present to help
make configuration easier if configuringmanyHot-Spots.

Each Hot-Spot can also be disabled by unchecking the ’Enabled’ box. This allows a Hot-Spot to be dis-
abledwithout having to delete it, which itmight be useful if the target camera is temporarily offline.

6.5.1 Switch Camera action
For theSwitchCamera action, it is simply necessary to select the target camerabyclicking theSelect...
button and choosing the camera from theCamera Tree. Only one camera can be selected.

6.5.2 Trigger Event Cause action
The Trigger Event Cause allows the Hot-Spot to be configured such that it can be used to trigger a
newly created Event Cause. ThisEvent Cause can then be used to create an Event Rule, which allows
one ormoreEvent Actions to be triggered.
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The Trigger Event Cause Hot-Spot action has several parameters which need to be configured. They
are as follows:

Event Cause Name Thenameof the newEvent Cause to be created. Details about valid cause names
are provided below.

Device ID Themain parameter for the Event Cause. Its meaning varies depending on the Event Ac-
tion usedwithin anyEvent Rule later configured. For example, it could be a camera number if the
Event Action is to be ”record” or ”boost recording rate”, door control panel number for ”Door Un-
lock”, etc.

Sub Device ID A sub parameter for the Event Cause. For example it mightmean the ”recording track”
when configuring an Event Rule to record a camera.

Type Configureswhether the new Event Cause should be of ”Pulse” type, meaning it is an instaneous
event, or ”On/Off”, meaning it has a start and an end.

Label Configures the text to show on the Hot-Spot in the main screen. For example if the new Event
Causehas type ”On/Off”, youmightwant the text to show ”Start/Stop”, ”Open/Close” or something
else.

The following characters are allowed in Event Cause names:

• 0-9

• A-Z

• a-z

• /

• _

• Space (” ”)

• Anyunicodecharactergreater than0x80exceptunicodecharacters0x2423and0x2080to0x2089.

Therefore any Unicode (or ASCII) character under 0x80which is not in the permitted list above, is not
permitted. This includes certain punctuation characters such as these: !”#$%&’()*+,-{|}
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6.6 Active Directory ®
Note: The settings in this page apply to all servers in the server group.

Wavestore supports Active Directory via LDAP for authenticating users,meaning that it’s not necessary
to create andmanage users separately on theWavestore. Users can be configuredwithin theAD server
to be amember of aWavestore group. TheWavestorewill then use the permissions for the groupwhen
that user logs in. The permissions themselves are configured on theWavestore and there can bemany
groups. For example, a typical setupmight be as follows:

• In the Active Directory there are 2 users, ”Andy” and ”Brenda”.

• TheAdministratorcreates2groups inActiveDirectory. Onecalled ”DVRUsers”andonecalled ”DVRAd-
mins”. (Note that the group namesmust start with ”DVR”).

• Still within AD, the Administrator makes ”Andy” a member of ”DVRUsers”, and ”Brenda” a member
of ”DVRAdmins”.

• Now moving to the Wavestore side, the Administrator creates two new users in the Wavestore
Users Setup screen (Setup → Users), one called ”DVRUsers” and one called ”DVRAdmins”, each
configuredwith appropriate permissions.

• The Administrator then configures theWavestore to use the Active Directory server by setting its
hostname or IP address, domain, and any other required information.

• Now, when Andy logs in, he can use his normal domain username and password and it will be
checkedagainst theADserver. Ifsuccessful, Andy is logged inwiththepermissionsof theDVRUsers
group.

• If Brenda logs in, she inherits the permissions of the DVRAdmins group.

• When newemployees join, the Administrator simply needs to create them in Active Directory and
add them to the desired ”DVR” group.
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Figure 6.33: Active Directory Setup Screen

The available parameters are as follows:

Enable Active Directory for user login This enables and disables the AD functionality.

Host This is theIPaddressorhostnameof theActiveDirectoryserver.

Port (optional) This is the port number for LDAPcommunication, the default is
provided as 389 (TCP).

Host2 (optional) This is the IP address or hostname of a secondary AD server
whichwillbeused if theprimaryADservercannotbecontacted.

Port2 (optional) The port number for the secondary AD server.

Domain This is the Windows domain in which the AD server and users
reside.
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6.7 Maps
WaveView provides map functionality to allow cameras and alarm devices to be visualised on one or
more interlinked images. TheMaps are available to users on themain screen, and this section describes
how to configure them.

The map system is designed around the concept of ”Areas”. Cameras, Event Items, and other devices
are all added onto ”Areas”. A background graphic can be loaded onto an areawhichmight be a floor plan
or perhaps a photo of the front of a building.

Of course, the Areas don’t have to represent physical things. They could just be used to create custom
views of different cameras.

The area size is defined either by the loadedbackgroundgraphic or, if none loaded, by the position of the
cameras dragged onto it. TheCameras and Event Items can be scaled on a per-area basis so that they
appear a sensible size.

Map Setup Controls

The rest of the controls in the top-left of the screen allow various operations for editing themaps.

The first control is a drop-down list of available Areaswhich allows selection of other areas, once added.
Thiswill be empty if no areas are yet configured.

Under the area selector, there is a set of push button controls. Under these buttons is the Device Tree,
labelled ”Available Channels”. Cameras can be added to the current area by dragging them from the list
onto the area.

In general a leftmousebuttondrag is used tomoveobjects about. A leftdouble click on anobject allows
the setting of the object name or parameter. A right click brings up a context sensitivemenu.

Right-clickingthemapareaallowsaddingCameras, EventItems(iconsrepresentingeventsbeingOnor
Off), Alarm Zones (zones representing events, whichwill highlight whenOn), or Area Link Zones (zones
which can be clicked to jump to a differentMap Area).
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The other controls, as follows:

Add an Area
This creates anewAreawith adefault nameof ’MapArea ’ followedbyanauto incrementingnum-
ber. Youmust have at least one area to drop cameras onto.

Remove Area
This deletes the current area plus all its associated objects.

Remove all Areas
Removes all map configuration.

Add a camera
Adds a camera to the centre of the current area. The camera can be selected and configured later.

Remove all cameras
Removes all cameras from the current area.

ToolTips Enabled
If enabled, when the mouse is hovered over a camera, a thumbnail view of the camera is shown
alongwith details of the camera.

Whenanarea isadded, it isautomaticallyselectedsothat itspropertiesarevisible in thebottomleftpanel.
Similarly, selecting a Camera or Event Item on themap shows the available properties for that element
in the bottom-left panel. These property panels are described below.

6.7.1 Configuring Zones
As stated above, the right-click drop-down menu allows adding various items to the map, including
”AlarmZones” and ”Area Link Zones”. Both of these ”zone” itemsconsist of configurable polygon shapes.

Whenanewzone is added, it is added as a squarewith four ”handles”. Tomove ahandle, simply click and
drag. To add a newhandle, and therefore a newpoint in the polygon, double click on one of the edges of
the polygon. To remove a handle, right-click it and choose ”Remove this handle”.

6.7.2 Area Properties

This panel allows editing properties relating to the area.

276



Name
Allows editing the name of the areawhichwill be shown in the drop-down area selector.

Image
Clicking the icon allows the loading of an image file to become the background for the area. The
SVG image format is supported which allows smooth scaling even when zooming in a long way.
Non-scalable formats (png, jpg, gif and bmp) are also supported. There are currently no checks to
limit the size of the loaded graphic.

Camera Scale
Allows resizing the cameras so that they are at an appropriate scale for the area image.

Event Item Scale
Allows resizing the event items so that they are at an appropriate scale for the area image.

6.7.3 Camera Properties

This panel shows various properties relating to the camera, although only theChannel ID is editable.

Server Name
The name of the server onwhich this camera exists.

Channel Name
The name of the camera.

Channel ID
The ID of the camera, which can be edited.

Camera Status
The current status of the camera.

6.7.4 Event Item Properties
AnEventItemrepresents thestateofanevent. It canbeassigned toanyEventCauseandEventSource
on any server.
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Name
The name of this item.

Server
The server onwhich the event beingmonitored exists.

Cause
The Event Causewithwhich this Event Item is associated.

Source
TheDeviceIDandSubDeviceIDassociatedwiththeEventItem. Forcamera-basedEventCauses,
such as Motion, this is usually just a Device ID matching the camera ID. Other Causes might re-
quire a Device ID and SubDevice ID, e.g. a door controller and door number.

6.7.5 Alarm Zone Properties
AlarmZones have the same properties as Event Items. The only difference is that they are displayed as
shapes instead of icons.

6.7.6 Area Link Zone Properties
Area Link Zones only have one property: ”LinkedArea”. This is the area that this zonewill switch towhen
clicked.

Mouse Controls
On Areas

• Use themousewheel to zoom in and out.

• LeftClick and drag to pan aroundwithin the area, when zoomed in. reposition areas.

• Double LeftClick to rename areas.

• Right Click to bring up a contextmenu.

On Cameras
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• LeftClick on camera body to select that camera.

• Left click and hold on camera body and drag to reposition camera.

• Left click and hold on FOV (Field Of View) ’fan’ (a dotted line will extend from the fan), and move
mouse up and down to alter FOV angle.

• Left click on dotwithin FOV ’fan’ and drag up and down to rotate camera.

• Right click to open the contextmenu.

Note, you can only do one of these at a time. As soon as youmove themouse in one axis, movement in
the otherwill be ignored.

On Event Items

This is the same as for cameras, except that there is no FOV control.

6.7.7 Settings
Themap settings are as follows:

Custom Camera Icon
Click the folder icon to choose a different default icon for the cameras. To reset to the default icon,
ensure that the ’Use Default’ switch is to the right.

Notes About Image Files
The software supports loading of SVG, JPEG, JPG, andPNG image files asmaparea images. The fileswill
be uploaded to the server so that they are available for other map users to view. Once they have been
uploaded to the server, the original source images may be deleted and the images will still be visible in
themap viewer until they are removed or changed on the server. See section ofMap Local Storage.

If an image fails to load because it has been removed from the server without deleting the associated
map objects, then a place-holder graphicwill be displayed instead.

Map Local Storage
Map image files are stored on the server andmust be downloaded to the local system in order to display
them. To avoid unnecessary downloading of data from the server, map image files are stored in a local
temporary directorywhich the software tries to automatically keep synchronised.

The location of this temporary directory can be changed by the user (see section 3.22.1 - System Set-
tings). The software will overwrite and delete files in the temporary directory without warning, so it is
suggested that if a non-default location is chosen it should be a directory solely for this task. The user
may safely delete files stored in this directory as thiswill not interferewith the operation of the software.

It is possible tomanually update themap image files using the software FileManager.

If manymap layouts are created andmodified, it may be necessary to clean the files. Themap files are
listed in a section in the filemanager and can be deleted or replaced individually, if required.

If a file is removed from the server when it is being used by amap layout, then the softwarewill display
an error image. This can be fixed bymanually changing the image associatedwith the area.
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The contents of the local cache directory are kept synchronizedwith the contents of themap directory
on the server.

If a server is part of a group, changes to themap layout will be copied across all servers in the group so
that the samemap layout is visible nomatter what server the software is connected to. Image files are
stored and copied to all servers in a server group.
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6.8 Server Group
Note: The settings in this page apply to all servers in the server group.

Individual Wavestore Servers can be configured as a server group, allowing users connecting using
WaveView client software to access cameras connected to any of these servers. This feature is only
available in certain licence levels.

Administration of any of the connected servers can also be carried out from a single Client.

All of the servers intended to be part of a Server Groupmust first be configured to be connected to the
same LAN subnet (contact your IT administrator for assistance if necessary).

When a server group is being created the WaveView client will attempt to connect to each new server
addedusing the login credentials used for the current connection. Those login credentials need tobean
install-level user on each of the target servers.

Usually thismeansensuringthateach individualserverhasan install-leveluserconfiguredwiththesame
password, then logging in to the first server with those credentials before adding the others. It may be
advisable to check that you can log in to each server before creating the group.

The procedure for creating a Server Group is as follows:

• Login to the server nominated to be the first server in the group. Ensure to use the IP address or
hostname that you want to be entered in the server group configuration - this could be a Private
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IP address, potentially a secondary address if the server is a Logical Server in a Failover group, or a
Public IP address.

• Go to the ’Server Group’ setup screen. You should see the IP address or hostname of the first
server automatically entered.

• Click the ’Add’ button.

• In the IPaddress field that appears, click the ’Enter host here’ text, thenenter the IPaddressof the
next Wavestore server to be added to the group. As noted above, this could be either a Private IP
address (potentially a secondary address if the server is a Logical Server in a Failover group), or a
Public IP address.

• Repeat for any further servers as required.

• Click ’Save’ when finished.

If any of the servers fail to be added, it’s sensible to abandon the changes, log out, then attempt to log
in to that server directly using the same login details. That way you are likely to get more specific error
messages aboutwhy the connection failed.

Youmaywish to synchronise the time on all of the servers in the group to the same time source (either
once of the servers, or an external NTP time source.

Central Event Server
The ”Enable CESMode” checkbox is used to enable the Central Event Server feature. This is described
inmore detail in section 9.18 - Central Event Server.

Note that for this feature towork, the IPaddressesprovided in theServerGroup listmustbecontactable
by each other. This is because the servers communicate between each other to pass events.
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6.9 Failover
The Failover Setup Screen is used to configure the list of physical servers in a failover group. These
concepts, aswell as a full guide to configuring failover for a group ofWavestore servers, are explained in
more detail in section 9.19 - Failover. This section covers this particular setup screen only, but failover
requires several setup steps.

Figure 6.34: Failover Setup Screen

The list of physical servers is configured by using the Add andDelete buttons and entering the IP ad-
dresses in the table.

As each physical server is added, WaveView will attempt to connect to the address and, if success-
ful, check that DHCP is not enabled for any network interfaces since this can cause problemswith the
failovermechanism. Awarningwill be shown if the connection or DHCP check fails.

283



6.10 Schedules
Note: The settings in this page apply to all servers in the server group.

The Schedulesmenu allows the system administrator or installer to create schedules that can be used
to control server functions, such as Recording or User Logon.

There is an ”invisible” schedule numbered zerowhich implies ”always on”, therefore it is not necessary to
create a schedule for this purpose. All settings, such as recording and user logonwill use schedule zero
by default. Schedules should only be createdwhen it is intended that something should be disabled at
a certain period of the day orweek.

Onceaschedulehasbeendefined, it canbe linked tomultiple functionssuchascamera recording, event
rules, and user login permissions.

To create a new schedule for a camera, follow the menu path View→ Setup→ Schedules. Under the
Schedule List (left side of screen), click ’Add’ to create a new schedule:
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With the new schedule highlighted dark grey in the Schedule list, you can now configure items on the
newSchedule such as Description, On/Off Times andDays etc.

Schedules can be configured with multiple On and Off times, for example, ’On’ at 02:00, ’Off’ at 04:00,
then ’On’ again at 14:00 and ’Off’ again at 16:00, forMonday, Tuesday and Friday. To configure this, select
the timesusing theOn/OffTimecontrols, then select the requireddays in theWeekDayspanel and then
click ’Add’.

The dates and timeswill then appear under the schedule in the schedule list.

Individual items can be removed from the schedule by selecting them in the schedule list and clicking
Remove. Alternatively the complete schedule can be removed by clicking to highlight, then clicking Re-
move.

Toconfigureaschedulewhich runsovernight fromoneday toanother, these iscreated in twosegments;

• Segment 1 is setwith ’Off’ time to be 24:00,

• Segment 2 is set with ’On’ time to be 00:00 the following day. For example, for a schedule to run
fromMonday 2200hrs to Tuesday 1000hrs, configure as follows:

• Monday 22:00→ 24:00

• Tuesday 00:00→ 10:00

Repeat this process for any other required schedules and click ’Save’ to save the changes.

To attach a schedule to a Camera Group for Recording, follow the menu path View→ Setup→ Cam-
eras. Select the ’CameraGroups’ taband thenselect theCameraGroup towhichyouwant to assign the
schedule.

Each Camera Group has multiple recording tracks so the schedule can be assigned to ’All Tracks’ or a
specific track. Under the desired track, or ’All Tracks’, expand the ’RecordingMode’ option and then click
themenu next to ’Schedule’ as shown below.
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Finally click on ’Save’ to confirm the changes that you havemade.
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6.11 Upgrade Server
Note that from version 6.10 onwards it is necessary for theWavestore to be suitably licensed for an up-
grade to the target version. The section 6.2.3 - Licensing explains how to check your ”upgrade bundle”
version number. From WaveView version 6.8 onwards the Upgrade screen will warn if attempting to
upgrade to a version later than permitted by the licence.

The Upgrade Setup Screen (menu pathView→ Setup→ Upgrade) allows theWavestore server soft-
ware to be upgraded to the latest version.

Note: Upgradeswill be applied to all connected servers in the server group and can be carried out from
a networked PC or laptop, or on the server itself.

If upgrading from a remote PC, it is recommended to update the WaveView software on that PC first,
before upgrading the servers.

There are twomethods of upgrading the system to a new version:

File Upgrade
The systemwill be upgraded using an ISO filewhich has been downloaded. No internet connec-
tion is required.

Network Upgrade
The systemwill download updates from the internet. Therefore, the Wavestore servers must be
connected to the internet.

6.11.1 Performing a File Upgrade
To upgrade from an ISO file, the ISO first needs to be ”mounted” or written to a USB memory stick or
DVD. If the ISO is on a Windows PC, the easiest method is simply to mount the ISO. This is done by
right-clicking the ISOfile and choosing ”Mount”. The ISO is then available as a separate disk (e.g. ”F:”), as
if a pre-written USB stick or DVD had been inserted.

If it is necessary to upgrade theWavestore by connecting to it directly rather than from a remote client
PC, itwill be necessary towrite the ISOfile to aUSBmemory stick orDVD.OnWindowswe recommend
the use of a program called Rufus. See section 14 - Appendix D -Writing an ISOwith Rufus.

Before performing the upgrade, navigate to the Server setup screen (View→ Setup→ Server) and in-
spect the ”Distribution” field. This is displayed on the ”General” tabwhich is the default.

If the distribution contains ”el7” rather than ”el7a” it is recommended to perform the upgrade twice. The
first upgradewill update theWavestore software but not the operating system. The secondwill update
the operating system. This is only ever necessary once. Subsequent upgradeswill only need to be per-
formed once.

If in doubt, performing the upgrade twice is sensible. If there is nothing to upgrade on the second pass
it will complete very quickly.
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Figure 6.35: Upgrade Server Screen

To perform the upgrade, first browse to the location of the upgrade file (’upgrade.txt’).
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Figure 6.36: Upgrade Server screen – browsing to locate ’upgrade.txt’ file

Once you have located the ’upgrade.txt’ file, select it then click on ’Open’.

TheSelect Upgrade File fieldwill now show the upgrade file that you have chosen.

If performing a downgrade, ensure the ”Enable downgrading” checkbox is checked. Only enable this
checkbox if deliberately downgrading to an earlier version.

Click on ’Upgrade’, and the Informationwindowwill showprogress of the upgrade, as the upgrade files
are copied across to the server:
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Figure 6.37: Upgrade Server screen – upgrade files being copied to the server

Once all the files have been checked and copied, the upgrade processwill start. The systemwill tell you
towait and thismay take a fewminutes.

Whilst the upgrade takesplace, recording continues. However once theupgrade is complete, the server
will either do a software restart or a reboot, depending on what is necessary to complete the upgrade.
Obviously recording is interrupted briefly at this time. Downgradeswill always perform a reboot.
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Figure 6.38: Upgrade Server screen – upgrade completed

6.11.2 Performing a Network Upgrade
Servers running version 6.38 or later can be upgraded over the internet. Each server in the server group
will need to be connected to the internet.

Note: If any server in the server group does not support network upgrades, network upgrades will be
disabled for thewholegroup. In thatcase itwill benecessary to log in toeachserver (whichdoessupport
network upgrades), and perform the upgrade individually.
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To perform a network upgrade, enter the version to which the servers should be upgraded in the ’Up-
grades To’ text box, for example ’6.38’, then click ’Upgrade’.

The process performed by each server is:

• Check that the requested upgrade version is available

• Download the packages (i.e. components) for the upgrade

• Install the packages
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The progress of the upgradewill be reported in the ’Information’ panel.

6.11.3 Potential Issues
If the upgrade fails, it will usually either show a failure message in the Upgrade screen, or a message
saying ”the upgrade completedwithout sending a status reply”.

In this case, gatheringmore information depends on the currently running version.

For servers running version 6.24 or later, this information is available inWaveViewby navigating to Tools
→ System Log, clicking the ’Extra Logs’ tab, then choosing ’Upgrade’ from the drop-down box, then
clicking ’Download’.

For servers running version 6.16 or later, a more detailed log of the upgrade is available by following this
procedure:

• Select Tools→ Execute Command...

• Run the command alog -a Upgrade

• Send this output to our support team for assistance

For servers running version 6.14 or earlier, the information is in the system log, available inWaveView by
navigating to Tools→ System Log.
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The possible errors are listed belowwith an explanation ofwhat to do:

Upgrade failed: installing package XXX needs nMB on the / filesystem

Certain upgrades such as to v6.16 require a large amount of temporary space on the operating system
diskand thoseoriginally installedwithanearly versionofWavestore (version6.10orearlier)maynothave
enough space to complete a full upgrade.

Itmaybepossible to free up space on the systemusing the filemanager although this requires physical
access to the server. Using the client display on the server itself, move the mouse to the top-left of the
screen and a toolbar should drop down. Choose the icon which resembles a filing cabinet. If there are
any large files in there, deleting themmay free up enough space to complete the upgrade.

If the above stepsdonotwork, itmaynot bepossible toperform theoperating systemupgradewithout
a re-installation. Re-installation requires being on-site andusually takes around20minutes. Performing
the re-installation creates a larger partition so that future upgrades do not have this issue.

SSDwearing out too fast

Thismessagemay appear in the log because some upgrades perform a large amount of writing to the
operatingsystemdisk. Unlessyouaregoing todoa full systemupgradeeveryweek, this is not aconcern
and can be ignored, and the SSDwill still last formany years.

Note that the message is a check on rate of wear, not an indication it is worn out. If you want to see
howmuch life left (in percentage terms), in WaveView go to Tools → Execute Command and run the
command ”ssd”.
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6.12 Event Rules
Note: The settings in this page are independent for each server in the server group.

The Event Rulesmenu can be reached by themenu path Tools→Setup→ Event Rules.

This menu allows the server to be configured with Event Rule(s) to react to ”event causes” (e.g. video
loss, digital input, motion event), by triggering ”event actions” (e.g. send email, move PTZ camera, trigger
digital output).

Note that inversion6.20anewEventRulessystemwas introduced. Theoldandnewevent rulesengines
are not compatible. When aWavestore server is upgraded to version 6.20 and has existing event rules,
the Event Rules setup screenwill show ”Using legacy Event Rulesmode” at the top. The old systemcan
still be used, but to enable usageof thenewengine it is necessary to removeall existing event rules, then
exit the Event Rules screen and re-enter it.

In the new event rules system, event logging occurs to a special Events log file. This can be viewed
using the Extra Logs tab of the System Log window. It is listed as ”Event” in the drop-down selector.
See section 3.21.2 - Extra Logs.

6.12.1 Creating and Editing Event Rules
Event Rules can be added by simply clicking the Add button under the Rules list. Existing rules can be
removed or copied by selecting them in the Rules list and clicking Remove or Copy.

Existing event rules can be edited simply by selecting them in the Rules list.

Newly added event rules have a single Event Cause set to ”None”. All rules need at least one Cause and
Action.
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Causes can be editing by double-clicking, or right-clicking and choosing ”Edit...”.

Multiple Causes can be added by adding logical operators. These logical operators can be added by
right-clicking aCause and choosing ”AddOperator...”.

The logical operators are:

Logical OR
The output is True if either or both inputs are True.

Logical AND
The output is True if both inputs are True.

Logical XOR
The output is True if either inputs are True, but not both.

When a logical operator is added, a new ”None” cause is automatically added.

BothCauseandActionscanbetriggered for testingpurposes. Causescanbetriggeredbyright-clicking
on them and choosing the desired type from themenu. Similarly, Actions can be triggered by selecting
them and clicking the ”Trigger...” menu. When triggering aCause or Action you can select:

On
Turn theCause or Action to the ”On” state.

Off
Turn theCause or Action to the ”Off” state.

Pulse
Trigger theCause or Action instantaneously.

Causes can be removed but logical operators cannot be directly removed. To remove a logical operator
it is necessary to remove one of the 2Causes connected to it.

Note that,whenusing theCentral EventServer feature, andwheneditingServer 1, it is possible to select
the Server for each Cause and Action. For example, Motion on Camera 3 of Server 2 could be used to
trigger Output 1 on Server 3. See section 9.18 - Central Event Server.
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6.12.2 Event Causes

EventCauses are the conditions for a rule to be triggered. Thedifferent types ofCause are documented
in this section.

Causes can be triggered as a ”Pulse” -meaning they are instantaneous, or ”On/Off” -meaning they have
a start and an end.

Text Match

Each Event Cause can have Text associated with it. TheWavestore event rules system can do pattern
matching on this text so that Causes only triggerwhen thosematches occur.

These matches can be simple sub-string matches to some provided text, a sub-string match within
an uploaded file, or more complex matching of fields in ”metadata”. Metadata is usually supplied when
causes are triggered by devices configured viaWavestore IntegrationModules.

For sub-stringmatches, select ”Text contains...” and provide the text tomatch in the text box.

297



Formetadatamatches, it is necessary to select:

The Metadata Protocol These are usually configured automaticallywhen an IntegrationModule is in-
stalled. An examplemight be ”Point of Sale”.

The Metadata Tag These are also configured automatically by Integration Modules. They are fields
within a particular metadata protocol. For ”Point of Sale” these might be ”Item” or ”Price” for ex-
ample.

The Condition This is the type of match to perform. It can be ”exists” to check if a Metadata Tag is
present. Alternatively it can be ”equals”, ”is greater than”, or ”is less than” to perform a comparison.
For all conditions except ”exists”, a value should be provided in the text box provided.

Formatching against entries in a file, select ”Named TableMatch”, then choose the desiredmatch file.

Multiple matches can be added by clicking the plus (+) button. In this case, all the conditions must be
matched for theCause to be accepted.

Anymatch can be removed by clicking the ”Remove” button next to it.

Post-Event Time Settings

EachCause has ”Post-Event Settings” which allow the timing to bemodified in someway.

Pass Through
This is the default and simplymeans that any ”On”, ”Off” or ”Pulse” event is passed on immediately.

Extend End
The ”On” is triggered immediately but the ”Off” is delayed by the specified number of seconds. If a
”Pulse” event is received it is treated like Fixed Duration (see below)

Fixed Duration
When an ”On” or ”Pulse” event is received, it will be considered ”On” for the specified duration, then
”Off”.

Pulse
This turns an ”On/Off” event into a pulse. When the ”On” is received, it is triggered as a ”Pulse”, then
the ”Off” is ignored.
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Delay Start
This mode only affects ”On/Off” events. The ”On” is delayed by the specified number of seconds.
The ”Off” is passed on immediately.

Post-Event settings are configured for the Event Cause of the Event Rule, and therefore all associated
Event Actions are affected. This may not be desirable for certain kinds of Event Actions. For example, if
you have two actions, one to record video and one to send an email, the Post-Event settingmightmake
sense for the Record action but not the Send Email action, and so the behaviour might not be as ex-
pected. In this case it is sensible to create two separate rules, one for each Action.

Available Causes

Wavestore provides a built-in collection of Event Causes, but some are also conditionally added to the
list. The conditionally added Event Causes can appear for the following reasons:

• AnONVIF IP camera has sent an event of a type not in the present EventCauses. TheWavestore
server will record this event type and make it available as an Event Cause upon which an Event
Rule can be built.

• An integrationmodule has been installedwhich defines these EventCauses. These EventCauses
will pertain to types of eventwhich can come from the device the integrationmodule relates to.

Note that some well-known ONVIF event types are already mapped to built-in Wavestore types. For
example, the ONVIF event type for ”Motion” is alreadymapped to theWavestore ”Motion” event cause.

When a non-built-in EventCause is selected in an event rule, the only options available are a ”Device ID”
field and a ”Sub-Device ID” field. These fields allow specifying generic parameters and their meaning
will relate to the type of event cause, for Device ID 1 and Sub-Device ID 2might mean door 2 on door
controller 1.

The standard Event Cause types are listed below. The entries that do not have descriptions are some
common events that can be received from different cameras. Any documentation for these events
should be available either from the cameramanufacturer, or in theONVIF standard.

Alarm
This Cause occurs when an ’Alarm’ Action occurs. For example, one rule might take someCause
or combination of Causes, and use it to trigger ”Alarm 1”. Another rule can then be created where
theCause is ”Alarm 1” and some other Action is applied.

It canalsobeused toprovidehighlightingcertainevents in themainscreenLiveEventStream. For
example, if a digital input is triggered AND there is motion on a camera, youmight want to trigger
an Alarmwith some preset text for operators to see in the Live Event Stream.

The only parameter is an arbitrary Alarm ID.

Camera Movement
ThisCause isused todetectscenechange. It is triggeredwhenmotionoccursaroundall (ormost)
of theedgesof the image. Thiscanbedetectedby theCamera (byanONVIFGlobalSceneChange
event, for example) or by the Server. SeeMotion (below) for details on how to configure this.

The only parameter required is the camera.

Darkening
This Cause is used to detect when the image becomes dark, presumably due to being obscured.
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This can be detected by the Camera (by an ONVIF ImageTooDark event, for example), or by the
Server. SeeMotion (below) for details on how to configure this.

The only parameter required is the camera.

Fault
This Cause is triggered when the server enters a Fault state, meaning something is wrong. It is
required to choose a particular fault type.

Voltage problem
Only for supportedmotherboards. Check the documentation for your hardware platform.

System Over Temperature
Only for supportedmotherboards. Check the documentation for your hardware platf orm.

Generic fault
Any fault not otherwise classified.

Fan Problem
Only for supportedmotherboards. Check the documentation for your hardware platform.

Disk over Temperature
Only for direct attached storage.

Disk Failure
Adirect-attached disk has failed or amember of a direct-attached RAID array has failed. For
network attached storage thiswill only trigger if thedevice is not-contactable, rather than for
individual drives in anarray. However, for RAIDarrays, itwill trigger if amemberdiskhas failed,
even though the RAID array itselfmight still be functional due to the redundancy.

Disk SMART pre-failure
Only for direct attached storage, not including hardware RAID arrays.

Capture Card failure
For analogue capture cards.

PSU problem
Indicates a PSU fault. Not all PSUs are capable of producing this fault indication.

Input
This Cause is triggered by digital inputs. The inputs can be from:

• IP Cameras

• Configured I/ODevices (see section 6.2.11 - I/ODevices).

The parameters to select are the device (either Camera or I/O Device), and the Input number on
that device.

Login Denied
Triggeredwhen a user tries to login but is denied. No parameters are required.

Login Successful
Triggeredwhen a user successfully logs in. No parameters are required.

Manual Trigger
Manual Triggers can be used to allow event rules or their actions to be triggered from the main
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screen. The Rule name is displayed on themain screen. Ensure everymanual trigger has a unique
source id.

Note that Manual Triggers can be configuredwith a Typewhich can be ”On/Off” or ”Pulse”. ”Pulse”
types are instantaneouswhereas ”On/Off” are stateful and have a start and an end.

Motion
This Cause is triggeredwhenmotion is detected for the specified camera. Note that for IP Cam-
eras, themeans bywhich this is detected can vary depending on how the Camera Group is con-
figured. It is possible to use Server-side VMD or Camera-side VMD (see section 6.3.2 - Camera
Group Settings).

NetworkSlow
This Cause is triggeredwhen a network link froma bonded network interface goes downor a link
renegotiates to a slower speed. Note that in some cases a Fault will also be triggered in this case,
for example if the network cable for a non-bonded network interface is removed.

Recording
This Cause is triggered by recording occurring on any recording track for the specified camera.

RecordLess
This Cause is used to detectwhen recording is occurring for less than the configured duration on
the selected camera and track. It will only trigger when overwriting is occurring on the selected
track, and the recording duration is less than that configured for that track. The event cause will
remain ”on” until the configured recording duration is achieved.

Schedule
This Cause can be used to trigger based on pre-configured time schedules (see section 6.10 -
Schedules. TheCause is ”on” when the schedule is ”on” and the same for ”off”.

Normally thiswouldbeused inconjunctionwith anotherCauseand the ”AND” logical operator. For
example youmightwant the rule to trigger onlywhenmotion occurs on a particular camera AND
the schedule is on, to detectmovement out ofworking hours.

ServerStart
This Pulse-type Cause occurs when the server software process is starting. Note that this is not
exactly the same as a reboot since server process restarts can occurwithout a reboot, although a
rebootwill also trigger a ServerStart.

Video Loss
This is triggeredwhen lossofvideosignaloccurs. Foranaloguecameras, theanaloguecablemight
be removed. For IPcameras, itwouldnormallymeana lossofconnectivity to thecameraor refusal
of the camera to stream.

Note that this Cause also works for audio channels and has the same meaning, except for audio
rather than video.

Virtual Input
This Cause is like Input except it’s not required for a devicewith an input to actually physically ex-
ist. This is useful when needing to trigger some rules over the network. For example an external
programmight trigger Virtual Inputs of different numbers in order to trigger someActions. These
rules can be configuredwith Virtual Inputs as the cause.

Warning
This Pulse-typeCause is triggeredwhen certainwarnings are raised by the server.
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DynamicEventCause typeswill dependon thepresenceof thecamera, integrationmoduleor a specific
service.

Event Causeswhich are enabledwhen a Failover group is enabled are:

Failover
This Cause is triggered by a Standby serverwhen failover occurs.

StandbyFail
ThisCause is triggeredbyoneof themain serverswhen theStandbyserver in a failovergroup fails.

Dynamic events from cameras include the following. In the majority of cases the same name is used
for events fromdifferent cameras even if the camera uses slightly different terminology. (In a fewcases
slight variants have crept in, notably Tamper and Tampering). Themeaning of these eventswill be in the
camera documentation.

AbandonedObject

AdaptiveMotion

AnomalyDetected

AppearDisappear

Audio

AudioDetection

CameraSabotage

Counter

DirectionViolated

Enter

Exit

FaceDetected

ImageBlurry

ImageBright

IntruderAlarm

Intrusion

LineCrossed

LineCrossedLeft

LineCrossedRight

Loitering

LoiteringDetection

LPR

Mask

MxActivitySensor
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MxAnalytics

MxMotion

Object

ObjectCounter

ObjectCounting

ObjectCrosses

ObjectDisappears

ObjectEnterArea

ObjectInside

ObjectLeaveArea

ObjectNotPresent

ObjectPresent

ObjectPresentRepeated

ObjectRecognized

ObjectRemoval

ObjectsAppears

ObjectsInside

ObjectsLeaves

ObjectStops

PeopleCounting

PTZPresetAborted

PTZPresetInvoked

PTZPresetLeft

PTZPresetReached

EdgeRecording

Relay

Shock

SmartMotion

StoppedVehicle

Tamper

Tampering

EdgeTrack

VirtualInput
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6.12.3 Event Actions

Event Actions are the actions that the system will take when the Cause conditions are met. Multiple
actions can be triggered. The different Actions are documented in this section.

AswithCauses,Wavestoreprovidesabuilt-incollectionofEventActions, butsomearealsoconditionally
added to the list by installed integrationmodules.

Available Actions

The standard Event Action types are as follows:

Alarm
This Action triggers a newEvent Cause of type ”Alarm”with the specified Alarm ID. This can then
beusedas theCause for otherEventRules. Since theLiveEventStreamuses the ”source” param-
eter of an event as the default camera ID associated with the event, it is often sensible to choose
an Alarm number thatmatches the ID of any relevant camera.

Boost
This Action causes the recording framerate to increase to any pre-configured Boost rate on the
selected camera and recording track. These rates are configured in the Camera Groups setup
screen.

Client Action

This Action allows any pre-configuredClient Actions to be triggered (see section 6.13 -Client Ac-
tions). This can be used to trigger pop-up of cameras or saved layouts for example.

The Text field can be used to pass parameters to theClient Action.
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[CopyTrack]
Allows a CopyTrack command to be issued, typically for backing up video on event or schedule.
Place theCopyTrack parameters in the text field. SeeCopyTrack documentation for details.

DoorAccess

DoorLock

DoorUnlock
These are only visible if a door controller has been added to the system. They perform standard
door actions, seedocumentationon thedoor controller. TheAccess actionusually opens thedoor
to permit access and then locks it again after it has closed.

Email a Video Clip
This Action is used to send a video clip via email. Some steps are required before this can be used:

• An SMTP server should be properly configured (see section 6.2.6 - Email).

• One ormore potential recipients should be configured (see section 6.2.6 - Email).

• A user called ”localbackup” should be added (see section 6.1 - Users). It is not necessary to
set a password for this user, however it needs at least the following permissions: ”Playback”,
”Export”, ”Transcoding/exporting”.

The various fieldswhich can be configured are:

Recipients
The ”To” address for the email.

Channel
TheCamera (or Audio channel) fromwhich to perform the export.

Track
The recording track fromwhich to perform the export.

Subject
The subject for the email.

Message
Themessage for the email.

Pre-Event
Theduration inseconds frombefore the timeof theevent fromwhich theexportshouldstart.

Post-Event
The duration in seconds after the event forwhich the export should continue.

Container
The type of video file to create.

Note that each time this Action is triggered, the softwarewill have toperforma transcodedexport.
This is a fairly intensive operation so it’s important not to configure the system such that it’s likely
to have to perform a large number of them simultaneously as itmight affect server performance.

Configuringa ”Post-Event” timeaddsadelay to theoperation. Forexample if the ”Post-Event” time
is set to30seconds, the systemwill need towait for 30seconds after the event for the recordings
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to bemade, before they can be exported and attached to the email.

Email Config
This Action is used to send a copy of the system configuration file via email. Some steps are re-
quired before this can be used:

• An SMTP server should be properly configured (see section 6.2.6 - Email).

• One ormore potential recipients should be configured (see section 6.2.6 - Email).

The recipients of the email can be selected and the email Subject field can be specified.

Force Failover
This Action is only available if Failover is configured. It causes the current server to be put into a
”failure state”meaning that any available standby serverwill take over.

Notify
This Action can be used to send a message to specially configured client PCs. See section 6.15
- Notification Target.

Output
This Action triggers a digital output. The output can be on:

• IP Cameras

• Configured I/ODevices (see section 6.2.11 - I/ODevices).

The parameters to select are the device (eitherCamera or I/ODevice), and theOutput number on
that device.

Play Sound
The server can play a sound file (stored on the server) through a networked audio output device
that has been configured as a Talkback channel (e.g. IP camera audio output, or server mother-
board audio output).

To configure, select the Talkback device that youwant to use, and the audio file to play. New audio
files can be uploaded using the FileManager (see section 3.26 - FileManager).

PTZ Preset
This Actionmoves the specified PTZ camera to the specified PTZ Preset number.

PTZ Tour
This Action starts a PTZ Tourwith the tour number.

Record
This Action triggers recording on the specifiedCamera and Recording Track. Note that recording
is normally continuous so for this event to work, the relevant camera and track should have its
RecordingMode set to ”Event” or ”Normal + Event”. See section 6.3.2 - CameraGroup Settings.

Record Metadata
This is used to trigger recording of input data to themetadata track of the selected camera. Nor-
mally this is requiredwhen configuring integrationmodules and instructionswill be providedwith
the integrationmodule.

Send Email
This Action is used to send a plain text email. Some steps are required before this can be used:

• An SMTP server should be properly configured (see section 6.2.6 - Email).
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• One ormore potential recipients should be configured (see section 6.2.6 - Email).

The configurable parameters for this Action are:

Recipients
The ”To” address for the email.

Message
Themessage for the email.

Spot Monitor
This Action causes the specified SpotMonitor to show the specified camera. It is also possible to
specifywhether the High or Low resolution stream should be used, where available.

This action canbe used for SpotMonitor outputs on analogue capture cards, or Virtual SpotMon-
itors (see section 9.10 - Configuring Virtual SpotMonitors).

TextC
ThisAction replaces theCameraNameused in thevideodisplaysubtitleswith theconfigured text.

TextS
This Action replaces the Server Name used in the video display subtitleswith the configured text.

Configuring Complex Events
As an example, imagine that a digital output is connected to a gate and it is required that an operator can
open the gatemanually. AManual Trigger can be used in this case.

Also imagine thatwe need to allow a digital input from a camera to also trigger the gate.

Sowe need anOR condition: open the gate if either oneOR the other is true.

In this case a rule can be configured as follows:

Rule Name OpenGate

Causes Input 1.1 (Camera 1 Input 1) ORManual Trigger 1

Actions Output 1.1 (Camera 1 Output 1)

When configured like this theEvents panel on themain screenwill showanentry for ”OpenGate”which
will trigger the ”Manual Trigger 1” Cause.
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6.13 Client Actions
Note: The settings in this page apply to all servers in the server group.

TheClient Actionsmenu can be reached by themenu path Tools→Setup→Client Actions.

Thismenuallowstheconfigurationofautomatedbehaviourof theWaveViewsoftwarebaseduponserver
events. For example, it may be desirable for a saved layout of cameras to be displayedwhen a digital in-
put is triggered. The overall rule for this is configured in the Event Rules setup screen (see section 6.12 -
EventRules), however the specificbehaviour of theWaveViewclient software is configured in thisClient
Actions setup screen.

The top section of the screen allows the specifics of theClient Action to be configured.

The bottomof the screen showsConditions towhich the action is limited. Currently the only condition
isUsers. This is acomma-separated list of usernames forwhomthis actionwill be taken. If thecurrently
logged inuser is not in the list and thisClientAction is triggered, itwill be ignoredandnoaction taken. For
example a valid listwould be ”install,john,andrew”. If a user called ”roger” is logged in and the client action
is triggered, nothingwill happen.

EachClient Action is a series of stepswhichwill be taken in sequence. A namecanbe associated so that
it can be selected in the Event Rules screenwhen programming rules.

The available actions are...

308



Load Layout

Loads a saved layout onto the selectedVDA (VideoDisplayArea). If thedesiredVDA is not available, itwill
attempt to use VDA 1. Note that only shared layouts can be selected.

Play Sound

Plays the selected sound file. The sounds listed are built-in to theWaveView software.
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Show Cameras

Causesoneormoreassociatedcameras tobedisplayedon theselectedVDA (VideoDisplayArea). If the
desired VDA is not available, it will attempt to use VDA 1.

There are 2modes possible:

Add to VDA
The camera(s) will be added to any free slots in the current Video Display Area.

Best fit
Anyexistingcamerason theVDAarecleared, thegrid is set to theoptimaldimensions for thenum-
ber of cameras to be shown, then the cameras are displayed.

Remove with event ’Off’
For events that are of type ’On/Off’ (as opposed to instantaneous ’Pulse’ event types), the camera
will be added to the VDAwhen the ’On’ occurs, and removedwhen the ’Off’ occurs.

There is also an option to ”Removewith event ’Off’”. This causes the cameras triggered for this event to
be removedwhen the event cause switches to an ’Off’ state. For example, the camera are addedwhen
Motion starts, and removedwhenMotion no longer occurs. For ’Pulse’ type events, those that represent
something instantaneous, there is no ’Off’ part to the event, so the cameraswill remain.

The associated camera, or cameras, can be provided in several ways. They are attempted to be used in
the following priority order. If any is absent, the next is attempted...

The Text field of the Event Rule Action
When configuring the Event Rule (in the Event Rules setup screen), the ”Client Action” action has
a Text field. This field can be used to specify the associated cameras.

The event’s CAMERA field
This is not user configurable. It is inserted into eventswhich are provided by integrationmodules.
The integrationmodule inserts the associated cameras.

The Event Source
The event source is the parameter associatedwith the Event Cause. For example if the event rule
has a ”cause” of ”Motion onCamera 3”, the event source is 3. Therefore camera 3will be shownby
this client action. This also applieswhen the event source is not a camera. For example if ”Input 2”
is triggered, the event sourcewill be 2 and so camera 2 is shown.
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Asdescribed above, it is possible to put an entry in the Text field of the event actionwhen configuring an
event rule, which determineswhich camera(s) to show.

The Text field should beginwith a forward slash (/). Then it can have a comma-separated list of camera
IDswith ”modifiers” before each one.

Note that the ’Show Cameras’ action can only show cameras connected to the server fromwhich the
Event Cause was received. If it is required to show cameras frommultiple servers, consider using the
’Load Layout’ action. The disadvantage of the ’Load Layout’ action is that it does not have the playback
functionality of the ’Show Cameras’ action (described below). If cameras from different servers and
playback functionality is required, the ’Show Cameras’ action may be suitable, but the ’Best fit’ option
will not work. This is because each server will send an event with a list of cameras, causing the layout
to be cleared each time and only the cameras from that server to be put in the layout. The ’Add to VDA’
option shouldworkwell as long as the current layout is set to onewith enough slots for all the cameras
thatmight need to be displayed.

Themodifiers are:

p (Default)
Shows the camera in Playbackmode using the time that the eventwas triggered.

l
Shows the camera in Livemode

f
Pauses the camera at the time of the event, searching forwards if there is a gap in recordings at
the time of the event.

b
Pauses the camera at the time of the event, searching backwards if there is a gap in recordings at
the time of the event.

Text Field Examples:

/1,2
Shows cameras 1 and 2. By default thesewill Play from the time that the eventwas triggered.

/l1,l2,l3
Shows cameras 1, 2 and 3, all in Livemode.

/l3,b4,p5
Shows camera 1 in Livemode, camera 4 paused, and camera 5 playing.
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Wait

Adds a delay into the series of steps for this action. The duration is inmilliseconds and can be from zero
to 10minutes (600,000milliseconds).
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6.14 Analytics
Note: The settings in this page are independent for each server in the server group.

The Analytics setup screen can be reached by themenu path Tools→ Setup→ Analytics.

This screen allows the configuration of custom ’Event Causes’ specific to video analytics. These ’Event
Causes’ are then visible in the live event streamwhen they occur, and they can be used to trigger Event
Rules.

Note that this facility is only available for supported cameras anddevices. This is explained inmore detail
in section 9.9 - Configuring Video Analytics.

The screen consists of threemain areas:

• The camera selection list

• TheCause and Zone selection list

• The editing area

Configuring Causes

Tobegin editing, select a camera, thenclick theAdd buttonunder theCause selection list. If the camera
does not support analytics, the Add buttonwill be disabled.

In the editing area, give theCause a name.

The following characters are allowed in Event Cause names:

• 0-9

• A-Z

• a-z
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• /

• _

• Space (” ”)

• Anyunicodecharactergreater than0x80exceptunicodecharacters0x2423and0x2080to0x2089.

Therefore any Unicode (or ASCII) character under 0x80which is not in the permitted list above, is not
permitted. This includes certain punctuation characters such as these: !”#$%&’()*+,-{|}

Next, choose the type of analytics event tomatch. The options are:

Object Properties
Matches object properties such as object class, the probability of that object class, and the object
speed.

Line Crossing
Matches objects crossing in a line.

Box Entry
Matches objects entering a box.

Box Exit
Matches objects leaving a box.

Box Entry or Exit
Matches objects entering or leaving a box.

Object In Box
Matches for the duration of an object being in a box.

Object Removed
Matcheswhen an object is removed from the scene or box.

Object Idle
Matcheswhen an object becomes stationarywithin a scene or box.

Crowd
Matcheswhen a certain number of objects arewithin a scene or box.

Next, it is necessary to choose a ’Trigger’ type, either ’Pulse’ or ’On/Off’. ’Pulse’ means the eventwill be
considered instantaneous and is therefore best suited for Line Crossing, Box Entry, Box Entry or Exit,
Object Removed, and Object Idle. ’On/Off’ means the event has a duration and so is best suited for
Object Properties,Object In Box, andCrowd.

Many of the analytics types require a zone of some kind, either a box or line. If that’s the case for the
selected type and some zones already exist, onewill be selected. Otherwise a buttonwill be presented
which allows jumping straight to the zone editing part of the screen.

Stayingon the subject of creating theEventCause, variousparameterswill bepresented for the current
analytics type. Note that Object Properties are available for matching their own, or as an addition to
other analyticsmatch types.

Object Properties matches allow matching on the object speed being greater than or less than the
specified value. The units for speed can be selected from m/s (metres per second), mph (miles per
hour), or kph (kilometres per hour). Alternatively, if ’Any’ is selected, the speed is not checked in the
search.
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It is also possible tomatch on the object ’class’ and, optionally, ’subclass’. The availability of the subclass
option is dependent on the source of the analytics data for the current camera. For both class and sub-
classmatching, it is possible to provide aminimumprobability for the objectmatching that class.

If supportedbytheselectedcamera, it isalsopossible tosearchbySegmentColour. Asegment isapart
of the object, e.g. Torso, Lower. Either select a colour, or select the checkerboard to indicate no colour.
For each segment, a probability of that colour can be specified.

Line Crossingmatches require a Line type zone to be specified, alongwith a direction.

Box Entry,Box Exit,Box Entry or Exit, andObject In Box matches require a zone of type Polygon.

Object Removed,Object Idle, andCrowdmatches canhave aPolygonzoneoptionally applied, though
the default is ’Entire Scene’.

Crowd matches have a ’Count’ parameter, which is theminimum number of objects within the scene
or zone required to trigger thematch.

Configuring Zones
Each zone needs a name and a type. The name can contain almost any character. The type is either
’Line’ or ’Polygon’.

When editing a Line, the line itself can be edited as follows:

• Click and drag a circular end-point of the line tomove that point

• Click and drag on the line tomove thewhole line

• Double click the arrow to change the direction of the arrow.

When editing a Polygon, the shape can be edited as follows:

• Click and drag a circular end-point of the line tomove that point

• Double-click on an edge of the box to add another point

• Double-click a circular end-point to remove it

• Clickwithin the box and drag tomove thewhole box
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6.15 Notification Target
Note: The settings in this page are independent for each server in the server group.

Figure 6.39: Notification Target screen

TheWavestore server can be configured to sendmessage notifications, for events such aVideo Loss, to
anexternal devices (such as aPC running aPython script) using theEventRulesmenu (see section6.12
- Event Rules).

The details of the device(s) that are to receive notification must first be configured in the Notification
Targetmenu.
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Figure 6.40: Configuration of Notification Target screen

For further informationregardingmessageformat/protocolseetheknowledgebaseatkb.wavestore.com.
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6.16 Metadata Protocols
Note: The settings in this page apply to all servers in the server group.

Figure 6.41: Metadata Protocols Setup Screen

TheMetadata Protocols SetupScreen is used to configure information about tagswhichmight be cap-
tured asmetadatawhen using an integrationmodule.

It is generally not necessary to configure anything in here directly. The settings aremade automatically
when an integration module is installed. For example, the screenshot above shows the setup screen
after theMaxxess and Paxton integrationmodules have been installed.

Any changes to this configurationmight cause issueswith the integrationmodules, and so should only
be performed in special cases under the guidance ofWavestore technical staff.
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6.17 System Monitoring
Note: The settings in this page apply to all servers in the server group.

The SystemMonitoring page allows configuring the server group settings relating to:

• SNMP (Simple NetworkManagement Protocol)

• HealthMonitor - for cloud-based systemmonitoring

6.17.1 SNMP

The settings provided here are fairly standard for SNMP but an explanation is below for completeness.

Community : The ”Community” string is the password use to access the information over SNMP. This
is required.

System Location :

System Contact Name :

System Contact Email : These three fields are descriptive only. They can be useful to a user of the
SNMP information (a network engineer, for example) to know what the machine is and where it
is located.

Read-Only Subnet : This field defines the network subnet from which read-only operations can be
performed. The subnet is expressed in CIDR notation, e.g. ”192.168.0.0/16”. Restricting this to a
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subnetwithin the company or a singlemanagement stationwill enhance security.

Read-Write Subnet : It is not recommended toset aRead/Write subnet as itwill allowalterations to the
Wavestore settings. This field can be left blank to disable this feature.

Once the settings have beenmade, click on ’Save’ to confirm the changes that you havemade.

6.17.2 Health Monitor

If enabled, theWavestorewill connect to a cloud service to upload systemmonitoring information.

Thedata uploaded includes information about the status of the server itself and the registered cameras.
No personal information is included in the data. The data is retained for up to 3months.
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6.18 Security
Note: The settings in this page apply to all servers in the server group.

This setup screen allows configuration of various security related settings.

Enable User Password Policy
If enabled, a password policywill be enforced based on the other settings in this screen. Otherwise any
password other than blank can be used.

Capital If enabled, any newpasswordmust contain at least one capital letter.

Number If enabled, any newpasswordmust contain at least one number.

Special character If enabled, anynewpasswordmust contain at least one special character (not a let-
ter or number).

Passwords minimal length Theminimum length of any newpassword.

Thesesettingscauseapasswordpolicy tobeapplied for all users in the servergroup. Note that if a pass-
word policy is applied, it only affects subsequently changed passwords. Any users whose passwords
do not conform to the new policy will not automatically be forced to change their password. However
this can be done by setting the ”Force user to change password on next login” for each user in theUsers
Setup Screen (see see section 6.1 - Users formore details).

Enable Account Locking on Login Failure
Attempts permitted Thisdeterminesthenumberof failed loginsbeforetheuser’saccountwillbe locked.

Lock duration This determines the duration, in minutes, of an account lockout when the maximum
number attempts permitted has been reached.

This feature can also be disabled completely by unchecking the checkbox.
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7 Maintenance Menu

TheMaintenanceMenu is a system on theWavestore server which can be used to rescue or configure
the systemwhen theGUI is not available.

To access this menu, press CTRL + ALT + F2. This should present a command prompt. At the prompt,
login as user ”maint”. Youwill then be prompted to ”Enter Install Password”. This can be the password of
any install-level user.

Note that to return the normal GUI, you can press CTRL + ALT + F1. In the rare occurrence that this
doesn’t work, try the other Fn keys in combinationwith CTRL + ALT.

If your login is correct youwill be presentedwith theMaintenanceMenu.

The menus are navigated using the keyboard. Normally this means the arrow keys to move Up, Down,
Left and Right. The Enter key can be used to accept an option, Escape to cancel. The Tab key can be
used to highlight different buttons.

Configuration Tools
The Configuration Tools menu can be used to restore configuration backups or return to the factory
default configuration.
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Restore Configuration Backup
This option allows the user to restore the system to an earlier backed up configuration. Backups auto-
maticallyoccurweeklyandalso insomeexceptional circumstancessuchaswhenupgrading toanewer
version.

When this option is selected, a list of configuration backups is presented.

The filenames represent the dates and times of the backups, for example ”2019-06-30_04-30-54-
venusd.conf” is a backup from30th June 2019 at 04:30am.

Whenthedesiredbackup isselected, theuser isaskedforconfirmationbeforetheconfiguration is loaded.
Upon loading the configuration the server processwill automatically restart (not reboot).

Restore Default Configuration
This allows resetting the system to its factory default. Note that when this operation is performed a
backup of the existing configuration is automaticallymade.

When selected, the user is asked for confirmation of the operation. If confirmed, the user is asked if the
existing licence should be preserved.

Once the operation is complete, the server processwill automatically restart (not reboot).

VGA Configuration

Thismenu is used to configure the graphics drivers for the graphical display on theWavestore server.

View Status
Thisoptionshows informationabout thecurrentdisplayadapter and thegraphicsdrivercurrently inuse.
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Configure drivers
This option allows a specific graphics driver to be installed or removed. It is vital to install the correct
driver for the display adapter in the system. The ”ViewStatus” option can be used to check this.

Force monitor resolution
By default, the optimumdisplay resolution is automatically detected. However this option allows a spe-
cificresolutiontobeset. Onceset, thesesettingscanbeappliedbyswitchingbacktothegraphicaldesk-
top (CTRL + F1) and restarting the graphical displaywith CTRL + ALT + BACKSPACE.

Configure keyboard

This option allows the user to configure the keyboard layout for the keyboard connected to theWave-
store server. A reboot is required after selecting the desired keyboard layout for it to take effect.

Interactive Hardware Detection

TheHardwareDetectionmechanism is used to detect ”capture devices” available on the server and add
them to the server’s configuration so that they are available for use. An example of a ”capture device” is
an analogue capture card, or the onboard audio device of themotherboard.

Normally there is no need to run this processmanually. It occurs automatically on first boot, andwhen-
ever the system detects that a relevant new piece of hardware has been connected. That would be
either an audio device, or a PCI device.

One potential use of running this manually is if there are devices automatically detected which you do
notwant to be available for use. For example if the onboard audio device is detected, its channelswill be
available in theWaveViewCameras setup screen. This causes certain channel numbers to be reserved,
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whichmay not be desired. By running this detection process you can choose to not include the device.
This configuration will remain unless another relevant hardware device is added or removed, at which
point the automatic detectionwill run on boot.

Start/Stop Client or Server

This option allows either the server or client to be stopped or started. By default both are started.

It is important tonote that theprocess inquestion (serveror client)will remain in theselectedstateupon
reboot. So for example if you stop the server, it will not run on reboot until it is re-enabled in this menu.
Be careful with this option because if you disable the server, you will not be able to log in remotely via
WaveView.

SSH Tools

Thismenuallowsconfiguringandstarting/stopping theSSHservice. This servicecanbeusedbyWave-
storeGlobal support staff to provide remote technical support, andwill provide guidance on how to use
thismenu as required.
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Audio Mixer

Thisoptionpresentsanaudiomixer toallowconfiguringvolumeandmute/unmutestatusofaudio inputs
andoutputs. This shouldnot beused innormal operation, instead theoptions in theWaveViewCameras
setup screen should be used instead. Any settingsmade herewill potentially be lost on reboot.

Check installed software is same as DVD
This option is used to compare if a installed system has the same files as an installation DVD. It is rare to
need to use these options but it is left for legacy reasons.

Calibrate joystick

This option is used to calibrate a joystick so that its central point and extreme points correctly translate
to PTZ speed. Simply follow the on-screen instructions to perform the calibration.

Delete selected exports
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Since theWavestore allowsexports tobesaved to theserver, it is possible tocompletely fill theoperating
systemdisk. Insomerarecasesthismaymeanthat it isnotpossible tostart theUI,meaningthatexports
cannot be deleted to free up space.

This menu options presents a list of the exports on the system to allow them to be deleted, to free up
disk space.

Write diagnostic disc
This option collates a variety of log files and configuration files, and allows them to be written to a USB
device or directory so that they can be copied off.

By default these files are copied to the /home/dvr-user directory. On the Wavestore, it is possible to
move themouse to the top-left corner to open amenuwhich includes a file browser. This can then be
used to copy the files to a USBmemory stick.

IPMI Event Simulator

This menu option can be used to test alarms from servers which support IPMI (Intelligent Platform
Management Interface). Simply select the sensor in question to turn it into an alarm state. Remember
to turn it off again afterwards!
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8 Other Utilities

8.1 Textual User Interface
The Wavestore text user interface (Wavestore-tui) client is a basic setup program designed for use on
servermachineswhich are not intended to run, or capable of running, the full WaveView client.

It allowsbasic initial setupoperations (settingnetwork address andmachinename) tobeperformedon
theWavestoreserver itself, afterwhichaWaveViewclientcanconnect inover thenetworkandcomplete
setup of cameras and view live and recorded footage.

The mode of operation without local WaveView but with Wavestore-tui is described as ”Server Only”
mode.

Choosing Wavestore-tui or WaveView during Install
When installingWavestore using the normalmenu options:

• If it’saVirtualMachineorserverwithoutappropriategraphicshardware, ”ServerOnly” (Wavestore-
tui) mode is selected automatically

• If doing an ”unattended install”, thenWaveView is selected automatically

• Otherwise, a dialog box ”Do you want to start WaveView” will appear, and Yes will run WaveView
andNowill runWavestore-tui as themain setup client.

This is thenpermanent andwill remainunchangedover rebootunlessexplicitly changedbyacommand
(see ”Switching to Server Onlymode” below).

It is possible to switch between consolewindows:
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• Themain client, WaveView orWavestore-tui, is available onCtrl-Alt-F1

• TheWavestore-tui interface is always available onCtrl-Alt-F2

• The system log is always available onCtrl-Alt-F7

Operation
TheWavestore-tui basic setup client appears on the console (virtual console 1 or 2).

Initially it offers a Start Menu and shows some status information. Note that Status displayed is not au-
tomatically kept up to date, but anymenu operationwill update it.

Moving around the menus

• For choicemenus, use Cursor Up and Down keys to highlight the desired option and use Enter to
action it.

• For data entry forms, use Tab or Enter or cursor keys to switch fields, and the keyboard to type
changes needed. Use Enter on the final field to log in. Use ESC to exit without entering data.

Start Menu

Update Status update the server status

Login offer a login screen

Language select the language to use for the this user interface

UseCursor Up andDown keys to highlight the desired option and use Enter to action it.

Note that the status is displayedon this screenbutwill not updatewhilewaiting for a command. Select-
ing any optionwill cause the status to update.

Login Menu

Username username to log in, use ”install” initially

Password password to log in

Use Tab or Enter or Cursor keys to switch fields, and the keyboard to type changes needed. Use Enter
on the final field to log in.

Once logged in, theMainMenuwill be displayed.

Main Menu

• Logout

• Set IP address

• Set Name

• Restart

• Reboot

• Power off
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Only basic operationswhich are needed on initial setup are offered, plus oneswhich youmight want to
do on a local console such as restart and power off.

Note that all menus (other than the Start Menu) will time out after 5 minutes and will then log out and
return to the Start Menu. This prevents you accidentally leaving it logged in.

Themost basic operation is to set the initial IP address. Setting the server name is also offered to allow
it to be clearly identified. Additional setup operations and viewing of footage is not offered by this basic
client. WaveView running on another machine (such as a desktop PC) should be used to access and
continue setting up and using theWavestore server.

Choose Network Interface

IfSet IP address is selected,Wavestore-tui will prompt you to chose a network interface.

If no bond interface is available, you can set one up here, and all interfaces will automatically be set as
slaves to the bond interface.

Set IP Address (bond0)

• Slave to

• IPv4 address

• IPv4 netmask

• IPv6 address

• Gateway

• DNSServer

IfSet IP address is selected, after a network interface is chosen, thismenuwill be shown.

TheSlave to setting is only applicable for interfaceswhich have a bond interface as slave, otherwise it is
set to None.

Set IP addresses and netmask as required. Leave IPv6 address blank if using only IPv4. Set Gateway
andDNSServer if desired.

As usual, Enter on the final fieldwill save the entries. ESCwill escape and leavewithout saving.

Set Server Name

• Name

Thismenuwill allow initial naming of the serverwhichmight be useful to aid identificationwhen logging
in remotely. Enter a name and Enter to save. Note that thiswill restart the server.

Switching to Server Only mode
After install, it’s possible to switch betweenmodes.

To switch to server-onlymode:

• Go to Tools→ Execute Command and run ”server-only”.
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This disables the localWaveView client and enables the localWavestore-tui client for basic setup only.

To switch to full WaveViewmode:

• Go to Tools→ Execute Command and run ”server-and-client”.

Both operations onlywork if the relevant packages are installed, which they are by default.
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8.2 Batch Configuration Tool
Includedwithin theWaveView installer is a tool called ”Batch Configuration Tool”. This tool can be used
topushconfiguration sections or complete configuration files to a list of serverswhich is stored in aCSV
(CommaSeparatedValues) file. This is usefulwhendealingwitha largenumberof serverswhicharenot
in a Server Group.

The BatchConfiguration Tool asks for 3 file locations, 2 ofwhich aremandatory:

CSV Server List (required) This is the path to the csv file containing the list of servers, usernames, and
passwords. The format is described inmore detail below.

Configuration File (required) This is the file containing the configuration to be sent to the servers. This
is described inmore detail below.

Report Output This is an optional path to a filewhichwill bewrittenwith a report of the operation. This
is optional because the same report is output to the screen, but it can be useful to have the results
automatically saved to a file.

There are also severalmore options available:

Preserve Existing Licence The Licence configured on the destination serverwill not be overwrittenby
the uploaded configuration file.

Preserve Existing Network Settings The network settings configured on the destination server will
not be overwritten by the uploaded configuration file.

Restart Servers Each server will be restarted after the configuration is uploaded. Several settings re-
quire a server restart to take effect so this is often desirable.

Mode A choice of...
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Append Any configuration sections uploaded will be appended to the existing configuration if
theydon’t alreadyexist, or theywill replace the existing sections if theydo. For example if you
server has [User_1] and [User_2] sections, and your uploaded configuration has [User_2]
and [User_3], the [User_2] section on the serverwill be replaced and the [User_3] section
will be appended.

Replace The entire configuration on the serverwill be replacedwith the provided configuration.

CSV Server List format
TheCSV file requires a list of headings followed by entries, one for eachWavestore server, as follows:

host,username,password
192.168.0.1,install,a
192.168.0.2,install,a

The first entry on each line is an IP address or hostname of aWavestore server.

The second entry is a username which will be used to login. It is required that user be an ”install”-level
user, but it doesn’t have to be the actual user named ”install”.

The final entry is the password to use for that server. Obviously the password is stored in the CSV file in
plain text so it is important to be careful with distribution of this CSV file.

Configuration File format
Theconfigurationfilemustbeaplain textfilewithLineFeed line-endings. (Generally thismeansavoiding
use of Notepad inMicrosoftWindows, other text editors are usually fine).

In general, the configuration file of a server can be obtained using WaveView by navigating to View >
Setup > Server > Configuration, and choosingSave To File.

The format of the configuration file is a lengthy and complex subject not covered by this document.
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9 Common Setup Tasks And Concepts

9.1 Configuring IP Cameras
Wavestore servers are compatible with a wide range of IP cameras including but not limited to those
conforming to theONVIF Profile S standard.

It is generally recommended to use the Auto camera type to connect to cameras as this allows the
greatest compatibility with various camera features and requires the least manual configuration. This
should work for any ONVIF Profile S conformant device, however other mechanisms are available to
streamvideo andperformother operations if theAutomechanismdoesn’t performas required for your
device.

Configuring cameraswith Automode is described in 9.1.1 - Configuring IPCameras using AutoMode.

Configuring cameras without Auto mode is described in 9.1.2 - Configuring IP Cameras without Auto
Mode.
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9.1.1 Configuring IP Cameras using Auto Mode
Wavestore servers are compatible with a wide range of IP cameras including but not limited to those
conforming to theONVIF Profile S standard.

It is generally recommended to use the Auto camera type to connect to cameras as this allows the
greatest compatibility with various camera features and requires the least manual configuration. This
should work for any ONVIF Profile S conformant device, however other mechanisms are available to
streamvideo andperformother operations if theAutomechanismdoesn’t performas required for your
device.

IP cameras are configured in the Cameras Setup screen which can be accessed in WaveView via the
View→ Setup→ Camerasmenu.

Uponentering theCamerasSetup screen, a discovery option is performedanda list of discoveredcam-
eras is provided on the right of the screen.

To add a camera, simply drag anddrop it from the right to the left. If the device is not listed, click the plus
button to add a new column on the left, then enter its IP address.

When a camera is added, it will either be added to an existing Camera Group if one exists, or a new
groupwill be created. If a newgroup is created thenaprompt for thecamera’s usernameandpassword
is displayed.
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Once this has been provided, for most cameras it should be sufficient to simply Save the changes. By
default:

• Only the video stream is requested.

• The video stream is assigned to the default disk and set to record continuously for amaximumof
31 days (this recording duration is not guaranteed and depends on disk space available).

• The video stream is set to the optimal codec available from the device with H.265 as first pref-
erence, followed by H.264, then JPEG. If a specific codec is desired it must be manually selected
under ’Encoding’.

• The audio stream, if enabled, is set to the optimal codec available from the devicewith AACas first
preference, followed by G.711. If a specific codec is desired it must be manually selected under
’Audio Encoding’.

• The framerate and resolution are set to the maximum available from the camera but are config-
urable.

• PTZ is enabled if supported by the camera.

• Themaximumbitrate (bandwidth used) by the camera is set to 4000 kbps (kilobits per second).

Many different options can be enabled and these are described in detail in 6.3 - Cameras.

To enable audio input from the camera, simply tick the Audio checkbox. Similarly to enable Talkback
(audio output from the camera - sometimes called ”Backchannel”), simply tick the Talkback checkbox.

A secondary video streamcanbe enabled simply by ticking theStream2 checkbox and specifying any
desired settings.

Note that in all cases, theWavestore will request the desired setting from the camera but if the camera
cannot provide the precise setting, it will choose the closestmatch.
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9.1.2 Configuring IP Cameras without Auto Mode
Whilst theAutomode provided byWavestore shouldwork for the vastmajority ofmodern IP cameras,
there are othermechanisms available to connect to devices in case they are required.

ONVIF
Although theAutomodewill oftenuseONVIF, thismodecanbe forcedbyselectingONVIFmode.
Also,ONVIFmodeallowsyou toselectaProfile (collectionof settings)whichhasbeenconfigured
on the camera rather than relying onWavestore to push the settings to the camera.

ONVIF-Multicast
Used to force the capture of a multicast stream from an ONVIF camera. Note that IPv6 is not
supported formulticast.

RTSP
Allows basic streaming using the RTSP protocol.

HTTP
Allows basic streaming using the HTTP protocol.

MxPEG
Used to pull theMxPEG video format fromMobotix cameras.

Ampleye
Used to efficiently stream JPEG2000 video fromAmpleye cameras.

9.1.2.1 Configuring IP Cameras in ONVIF Mode

WhenusingONVIFcameras there aregenerally twomodesof operationwhich aredictatedbywhether
the ”Auto-configure Camera Streams” option is selected.

If the option is enabled then the camera settings aremadewithin theWaveView setup screens and the
Wavestore serverwill push the settings to the camera. This is the recommendedmode of operation.

If the option is disabled, it is necessary to use the camera’s own setup facilities to configure one ormore
”profiles”, where a ”profile” is a collection of settings. TheWavestore is then configured to use a particular
camera profile.

ThefirststepofconfiguringanONVIFcamera is toadd it to theWavestore. Thiscanbedonebydiscover-
ing thecameraon thenetworkorbyadding itmanually. The former is theeasier and recommendedway
but there are some circumstanceswhere the discovery processwon’t work, such aswhen the camera
is on a different network segment.

Toadd thecameramanually click the +button. Thecamerawill be added toanexistingCameraGroup if
one exists, otherwise a newgroup is created and a prompt for the username and password is provided.
If the camera has been added to an existing group which isn’t already set up for ONVIF mode, right-
click theGroup column for the camera and choose ”ChangeCameraGroup”, then ”Create NewGroup”
as shown below...
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Beforewe configure the group, enter the IP address of the camera in the ”IP” column.

Nowwe can configure the group by selecting the ”Camera Groups” tab and selecting the groupwe are
working on. Change the type to ”ONVIF” andwe are presentedwith the available options for this type...
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The various options presented here are described in detail in 6.3 -Cameras but the key decision, as de-
scribedearlier, iswhether toselectProfilesconfigured in thecamera, or allowWavestore topushsettings
to the camera. This is controlled by the ”Auto-configure Camera Streams” option.

If ”Auto-configure Camera Streams” is disabled, a Profile can be selected for each of the two possible
streams. Note that it may be necessary to save your changes to allow theWavestore to connect to the
camera before the Profile list is populated...

After saving the changes, theWavestorewill start streaming and recording the camerawith default set-
tings. More detail about available settings is in 6.3 - Cameras.

9.1.2.2 Configuring IP Cameras in ONVIF-Multicast Mode

To add an IP camera to theWavestore server usingONVIFMulticast, in theCamerasSetup screen click
on the + button. The camera will be added to an existingCamera Group if one exists, otherwise a new
group is created and a prompt for the username and password is provided. If the camera has been
addedtoanexistinggroupwhich isn’talreadysetupforONVIF-Multicast, right-click theGroupcolumn
for the camera and choose ”ChangeCameraGroup”, then ”Create NewGroup” as shown below...
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Beforewe configure the group, enter the IP address of the camera in the ”IP” column.

Nowwe can configure the group by selecting the ”Camera Groups” tab and selecting the groupwe are
working on. Change the type to ”ONVIF-Multicast” andwe are presentedwith the available options for
this type...

The two available methods for streaming multicast are RTSP and SOAP. Click the ”Request” row in the
table and then choose the desired from the drop-down box.

Pleasenote that toconfiguresettingssuchas the resolutionof thevideostream itwill likelybenecessary
to do this in the camera’s own setup screens via aweb browser.

After saving the changes, theWavestorewill start streaming and recording the camerawith default set-
tings. More detail about available settings is in 6.3 - Cameras.
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9.1.2.3 Configuring RTSP or HTTP Cameras

Itmay be necessary to refer to documentation suppliedwith by the cameramanufacturer, to obtain in-
formation requiredduring the IPcamerasetupon theWavestoreserver (e.g. streamtype/request string
etc.).

To add an IP camera to the Wavestore server, in the Cameras Setup screen click on the + button. The
camerawill be added to an existingCamera Group if one exists, otherwise a newgroup is created and a
prompt for the username and password is provided. If the camera has been added to an existing group
which isn’t already set up for RTSP or HTTP mode, right-click the Group column for the camera and
choose ”ChangeCameraGroup”, then ”Create NewGroup” as shown below...

Beforewe configure the group, enter the IP address of the camera in the ”IP” column.

Nowwe can configure the group by selecting the ”Camera Groups” tab and selecting the groupwe are
working on. Change the type to ”RTSP” or ”HTTP” as desired, and we are presented with the available
options for this type...
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The settings for HTTP and RTSP are practically identical. The ”Request” option is the important part. For
HTTP it is under the ”General” heading as only one stream is supported. For RTSP it is under the Stream
1 and Stream2 headings as two streams are supported.

The ”Request” string is used to determine how to request video from the camera. The string can be en-
teredmanually, but there is also a drop-down list containing the request strings forwell-knowncamera
manufacturers.

Thedocumentation fromCameramanufacturersmaydescribe how to request video in a format similar
to the below:

http://<camera-ip>/video.mjpg

In this case, the ”Request” parameter to enterwould be ”/video.mjpg”.

Pleasenote that toconfiguresettingssuchas the resolutionof thevideostream itwill likelybenecessary
to do this in the camera’s own setup screens via aweb browser.

After saving the changes, theWavestorewill start streaming and recording the camerawith default set-
tings. More detail about available settings is in 6.3 - Cameras.

9.1.2.4 Configuring MxPEG or Ampleye Cameras

ToaddanMxPEGorAmpleyecamera to theWavestore server, in theCamerasSetup screenclick on the
+ button. The camera will be added to an existingCamera Group if one exists, otherwise a new group
is created and a prompt for the username and password is provided. If the camera has been added to
anexistinggroupwhich isn’t already set up forMxPEG orAmpleyemode, right-click theGroup column
for the camera and choose ”ChangeCameraGroup”, then ”Create NewGroup” as shown below...
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Beforewe configure the group, enter the IP address of the camera in the ”IP” column.

Nowwe can configure the group by selecting the ”Camera Groups” tab and selecting the groupwe are
working on. Change the type to ”MxPEG” or ”Ampleye” as desired, andwe are presentedwith the avail-
able options for this type...

The settings forMxPEGandAmpleye are practically identical. ForMxPEG the ”Mobotix” Request preset
should be chosen and for Ampleye the ”J2KOO” Request preset should be chosen. TheMxPEG request
string can be edited to pass different settings for the stream request if desired. Documentation for this
is available fromMobotix.

Pleasenote that toconfiguresettingssuchas the resolutionof thevideostream itwill likelybenecessary
to do this in the camera’s own setup screens via aweb browser.
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After saving the changes, theWavestorewill start streaming and recording the camerawith default set-
tings. More detail about available settings is in 6.3 - Cameras.
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9.2 Configuring Multi-lens IP Cameras and Encoders
Thereareseveraldifferentwaystoaddmulti-lensIPcamerasandmulti-channelencoders toWavestore.

Using a single Camera Group of type ONVIF
This is the preferredmethod and should be compatible withmost devices. The down side to this
method is that if any non-default stream settings are required, such as framerate and resolution,
these will have to be configured in the setupmenus provided by the device, rather than inWave-
store. Setup for thismode is described in 9.2.1 -ConfiguringMulti-lens IPCameras andEncoders
in ONVIFMode below.

Using a single Camera Group of type Auto
Thismethod is known toworkwith themajority ofONVIFProfileSdevices, however a small num-
ber of devices have shown issues and the startup is slower than the alternatives. Thismethodhas
the benefit of allowing stream settings to be configured in the Wavestore setup screens rather
than having to use the device’s menus. Setup for this mode is described in 9.2.2 - Configuring
Multi-lens IPCameras and Encoders in AutoMode below.

Create one Camera Group per lens or channel on the device
This is themost laboriousmethod of setup as it requires configuring each channel or lens individ-
ually rather than through a group. Therefore it is not recommended, but possible if desired.

9.2.1 ConfiguringMulti-lens IPCameras andEncoders inONVIFMode
Camerasareconfigured in theCamerasSetupscreenwhichcanbeaccessed inWaveViewvia theView
→ Setup→ Camerasmenu.

As an example, wewill add a 4 lensmulti-lens camera but the same principle applies for multi-channel
encoders.

To set upsuchadevicewesimplyneed to add thecamera4 timesandensure that eachcamerahasdif-
ferent Subunit. The channels can be added by dragging and dropping from the ”Discovered Cameras”
panel on the rightmultiple times, inwhich case theSubunitwill be automatically incremented. Alterna-
tively the channels can be added by clicking the + icon until the desired number of channels has been
added, then entering the IP address of the device for each one. In that case the Subunit field needs to
bemanually set to unique numbers, e.g. 1 to 4 for channels 1 to 4, as shown below:
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Now that the channels have been added, switch to the ”Camera Groups” tab. Change the Type to ”ON-
VIF” and ensure that ”Auto-configure Camera Streams” feature is disabled.

Nowsimply save thechangesand theWavestorewill connect to thecamerachannels andstart stream-
ing. Thechannels canbe further configuredvia theCameraGroup in thesamewayasanormal camera.
See 6.3 - Cameras formore details.

9.2.2 Configuring Multi-lens IP Cameras and Encoders in Auto Mode
Camerasareconfigured in theCamerasSetupscreenwhichcanbeaccessed inWaveViewvia theView
→ Setup→ Camerasmenu.

As an example, wewill add a 4 lensmulti-lens camera but the same principle applies for multi-channel
encoders.

To set upsuchadevicewesimplyneed to add thecamera4 timesandensure that eachcamerahasdif-
ferent Subunit. The channels can be added by dragging and dropping from the ”Discovered Cameras”
panel on the rightmultiple times, inwhich case theSubunitwill be automatically incremented. Alterna-
tively the channels can be added by clicking the + icon until the desired number of channels has been
added, then entering the IP address of the device for each one. In that case the Subunit field needs to
bemanually set to unique numbers, e.g. 1 to 4 for channels 1 to 4, as shown below:
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Nowthat thechannelshavebeenadded, simply save thechangesand theWavestorewill connect to the
camera channels and start streaming. The channels can be further configured via theCamera Group
in the sameway as a normal camera. See 6.3 - Cameras formore details.
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9.3 Configuring Analogue Cameras
If yourWavestore contains an analogue video capture card, the cardwill be automatically detected and
its video and audio channelswill bemade available for configuration.

To configure the channels, navigate to theCameras setup screen -View→ Setup→ Cameras.

The available inputs on the capture card are automatically listed in theCameras screen. Simply click the
’Enabled’ checkbox for any required inputs, then click ’Save’ to apply the changes.

Note that for analogue channels, each one is assigned to its own ’Camera Group’.

By default the cameras will be configured to record to disk D at the maximum framerate for 31 days.
These settings can be changed as desired, the available options are described in detail in section 6.3 -
Cameras.

Each video channel has Imaging settingswhich can be applied...
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There is a Quality setting for each of the 2 available streams per channel. The higher the Quality, the
better the image, but themore bandwidth usedby the channel, whichmeansmoredisk space required.

In theCameraGroups tab theoptionspergrouparegenerally thesameas for anyother typeofcamera,
except that the analogue capture cards have some extra EncodingModes, as follows:

Constant Quality
This is the default, and recommended setting for most uses. The video encoder tries to keep the
video quality at the same level. This has the benefit of ensuring that no matter howmuch activ-
ity or detail there is in the scene, the video quality will remain. The disadvantage is that high levels
of activity or detail can cause the bitrate to increase, meaningmore storage and bandwidth is re-
quired.

Constant Bitrate
The video encoder attempts to keep the bitrate at a roughly constant level. The advantage of this
is that it makes it easier to calculate the storage and bandwidth requirements. The disadvantage
is thatwhen there is increased activity or detail in the scene, the image qualitywill actually reduce
in order to keep the data rate at the desired level.

Variable Bitrate
The video encoder allows the data rate to fluctuate around the ”Average bitrate” setting, butwhen
there is increased detail or activity, the data rate is allowed to increase up to the configured ”Max-
imum bitrate” setting. Similar to Constant Quality, this setting has the disadvantage of a varying
data rate meaning that the required storage and bandwidth varies depending on the scene con-
tent.
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9.4 Configuring a Dedicated Analogue Audio Device
SomeWavestore systemsmayhaveadedicatedanalogueaudiodevice suchasonebuilt into themoth-
erboard.

If the device is supported byWavestore, it will be present in the configuration file as a ”Capture Device”.
However thesedevices aredisabledbydefault as they are rarely usedandhaving their channels present
in the channel list can cause undesirable confusionwith camera numbering. Therefore they need to be
enabledmanually.

To check if an audio device is present and detected, navigate to View → Setup → Server → Configu-
ration Editor. Look for a section called ”[Capture_N]” where N is a number, as in the example below:

Note: if you do not see the Audio device, check if your system hardware supports it. Youmight need to
enable it in the BIOS on somemotherboards (C7P67 boards have this under Advanced → Chipset →
Southbridge). Once enabled in the BIOS, fromWaveView run Tools → System Maintenance → Run
Hardware Detection to add it to the configuration file. It is best if no cameras or camera groups exist
when Hardware Detection is run as they will need to be renumbered. Once this is run, you should see
the [Capture_N] section for Audio.

TheNumAudios andNumTalkbacks parameters here are set to zero,whichmeans that no channels are
available to the system. This is the default: hardware audio is disabled by default.

For onboard audio the number of channels available are always 2 Audios and 1 Talkback, so we need to
edit theconfiguration toset thenumberofchannelsand thefirstchannelofeach type. So inourexample
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we set:

NumAudios=2
As stated above, these devices always have 2 audio inputs.

FirstAudio=1
In our case we want the numbering to start at channel 1. We could set it to any channel num-
ber desired, assuming there isn’t already a channel with that number configured. For examplewe
mightwant to call it channel number 101.

NumTalkbacks=1
As stated above, onboard audio devices always have 1 audio output (for ”talkback”).

FirstTalkback=3
Inourcasewewant the talkbackchannels tostart atchannel3, becausechannels 1and2areused
by the audio inputs.

Afterwe save these changes, we can go to theCameras setup screen to see our channels.

Wecannowsimplyenable thedesiredchannels (asshownaboveforchannels1and3). Oncethechanges
are saved these channels will be enabled and recordingwith default settings. Further settings available
are described in 6.3 - Cameras.

To associate a camera with an audio channel, select the camera in the Cameras table, and select the
Audio channel in the ”Linked Audio” field as below.
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Note that the default is ”Auto” but this is designed for use with IP cameras which transmit video and
audio together, so the automatic link between video and audio channels is obvious. For dedicated audio
devices, asdiscussed in thissection, theAutomode isnotapplicableandsothe link fromcamera toaudio
channel has to be specified.
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9.5 Configuring Talkback (Client to Server Audio)
TheWavestore server can be configured to allow twoway audio (Talkback) between a client device (e.g.
WaveView PC) and a supported networked audio device (e.g. audio output on a supported IP cam-
era/servermotherboard audio output).

Section 3.22 - Preferences gives details of how to configure the audio input on theWaveViewclient PC.

Multiple camera channels can be mapped to a Talkback output (either an audio output on an IP cam-
era/servermotherboard audio output).

Talkback channels can also be used to play a configured sound (e.g. Warning Message/Audible Tone),
configuration for this feature is carried out in the Event Rulesmenu ( section 6.12 - Event Rules).

Note that only one audio source can be sent to a talkback device at a time. For example it is not possible
formultiple clients to talk to the same target device simultaneously.

9.5.1 Configuring Talkback using supported IP Camera Audio Output

To enable Talkback for an IP camera, simply navigate to View→ Setup→Cameras, select theCamera
Group associatedwith the cameras in question, then enable the Talkback checkbox.

Bydefault, a talkbackchannelonanIPcamera is linkedto thevideochannelof thatcamera. If it isdesired
to link a video channel to the talkback channel on a different camera, select the camera in the Cameras
table then select the Talkback channel from the Linked Talkback dropdown list:
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Save your changes, and the Talkback channel is ready to use.

9.5.2 Configuring Talkback using Server Motherboard Audio Output
To use the server motherboard audio port, these ports must first be enabled. See 9.4 - Configuring a
Dedicated Analogue Audio Device for details on how to do this.

We can then follow themenu path View→Setup→Cameras to configure the talkback channels.

Themotherboard audio channels will be displayed in the camera table with appropriate default names.
In our example these are channels 1-3with the talkback channel as channel 3.

Ensure that the channel is enabled. Then, ensure the channel is selected, switch to the Camera Group
tab to see the settings for thegroup this channel is assigned to. Inmost cases thedefaults are sufficient,
but the channel recording settings can bemodified here.

Click Save to ensure the talkback channel is enabled.

The final step is to link this talkback channel to a video channel. To do so, select the camera in the Cam-
eras table then select the Talkback channel from the Linked Talkback dropdown list:
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9.6 Configuring a File Playback Camera
It is possible to configure a ”camera”where the source is a filewhich contains video or audio. Itwill then
be played in a loop. This can be used to display promotional or warningmessages, or replay short clips.
It is not suitable for playing large files as the entire file is kept inmemory.

The supported types are somewhat limited at themoment butmoremay be added in future. The sup-
ported types are:

• WSBwith a single channel

• JPEG single image

• PCMA audio

To configure a File playback ”camera”, first it is necessary to upload the file. This can be done using the
FileManager - see section 3.26 - FileManager. Images usually appear in the ”maps” or ”misc” directory
and audio usually appears in the ”audio” directory.

Once the file is uploaded the camera can be configured.

• Go toView > Setup > Cameras > Camera Groups.

• Add a newgroup.

• Set the Type of the group to ”File”.

• Ensure that theVideoandAudiofieldsareenabledordisabledasappropriate for the typeof file you
are playing.

• Set the Capture Rate in the camera group. For audio, Rate=8 is recommended. For a still image
it’s sensible to use Rate=1. For a video file, it would usually be best to set it to the rate of the source
video.

• Switch to theCameras tab in theCameras setup screen.

• Add a camerawith the + icon and assign it to the newly created group.

• IntheIPfield, enter thefilename. Don’tenteranypathastheappropriatedirectorieswillbesearched.

• Save the changes.

Thenewlyaddedcamerashouldnowbeavailable toview in theMain screen. If thereareanyerrors, they
will be reported in the System Log.
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9.7 Configuring Motion Detect Recording
The Motion Detect Recording function allows the server to be configured to record only when Motion
Activity is detected on the viewed scene.

For analoguecameras, themotiondetection is alwaysperformedwithin theWavestore. For IP cameras
there are several ways inwhich this can be performed:

Motion Detection within Wavestore
The motion detection can be performed within the Wavestore for certain cameras. The require-
ments are the same as for Smart Search - an ONVIF Profile S compliant camera which is able to
transmit a second JPEG stream of 648x648 pixels or less. The JPEG stream is a low resolution
stream at 4 frames per second and so some extra bandwidth is used for this.

The advantage of thismethod is that it is simple to set up and can be configured in theWavestore
setup screens.

Thepotentialdisadvantage is that the in-cameramotiondetectionfacilitiesmaybemoreadvanced,
depending on the camera. Also, if using ”Auto” group type or ”ONVIF” group type with ”PullPoint”
enabled, the cameramay also sendmotion eventswhichwill be used to start and stop recording.
In that case it is recommended to disable the in-cameramotion detection system.

To enable this system, either:

• Set up the camera with the Auto camera group type and ensure the ’VMD / Smart Search’
option is enabled.

• Set up the camerawith theONVIF camera group type and ensure both the ’Auto-configure
Camera Streams’ and ’VMD / Smart Search’ options are enabled.

Motion Detection within the camera via ONVIF PullPoint
Wavestorecanreceivemotionevents fromONVIFProfileScompliantcamerasandtrigger record-
ing or other actions based on that.

As described above, it is not recommended to use this method in conjunction with the Smart
Search facility as itmeans there are two separatemotion detectionmechanisms in operation.

To enable this system, either:

• Set up the camerawith theAuto camera group type. The eventswill be pulled if available.

• Set up the camerawith theONVIF camera group type and ensure that the ’Pull Point’ option
is enabled.

Motion Detection within the camera via TCP Notification
Wavestore offers a protocol called EVENTPwhereby a camera can be configured to send ames-
sage to theWavestore whenever motion occurs. This can be used to trigger recording appropri-
ately.

Thismethod has the disadvantage of being fairly time consuming to set up and it requires config-
uration in each camera. As with the ONVIF PullPoint method, it is not recommended to use this
method in conjunction with the Smart Search facility as it means there are two separate motion
detectionmechanisms in operation.

Enabling this system is described in section 9.7.3 - Configuring Motion Detection Via TCP Notifi-
cation.
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If in doubt, Wavestore Technical Staff can provide advice on the bestmethod to use.

9.7.1 Configuring the Camera for Motion Detection Recording
Ensure thatmotiondetection is enabled for the camera as described in section9.7 -ConfiguringMotion
Detect Recording. Then navigate to the Cameras setup screen (View→ Setup→Cameras), select the
Camera Group tab, then select the relevant CameraGroup.

MotionrecordingcaneitherbesetonAllTracksoraspecificrecordingtrack. Inthescreenshotbelowwe
useTrack 1. Set the ’RecordingMode’ toMotion, then the ’PreRecord’ and ’PostMotion’ settingsbecome
available to allow setting recording durations for before and after themotion events.

Other recordingmodes are available and are detailed in section 6.3.2 - CameraGroup Settings.

Finally, click ’Save’ to confirm your changes.

9.7.2 ConfiguringSettings andMasks forMotionDetectionwithinWave-
store

Whenusing theMotionDetection systemwithinWavestore, it is possible to configuremasks to limit the
motion detection to a region of the image, aswell as sensitivity.

To configure these settings, navigate to View → Setup → Cameras, then select the desired camera
under theCameras tab. In the right hand panel, selectMask Options.
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Check the ’AdjustMask’ and ’ShowMotion’ options; the camera viewwill now show the areas active for
Motion Detection in Green, with areaswheremotion is currently being detected shown in Blue.

Configure the areas you wish to make active for Motion Detection by using the ’Fill’ and ’Clear’ buttons,
or left click anddrag using themouse to add/remove areas. Youmay alsowish to adjust the values in the
’MotionMask Properties’ section, to fine tune theMotion Sensitivity settings.

Finally, click ’Save’ to confirm your changes.
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9.7.3 Configuring Motion Detection Via TCP Notification
Certaincameras, suchas those in theAMGPanogenics, Axis, Brickcom,Mobotix andVivotek ranges, can
beconfigured tosendTCPmessageswhichcanbeusedby theWavestoreserver to triggeraconfigured
Event Rule to record, without requiring parsing to be carried out.

WhenMotion is detected by the camera, the camera needs to be configured to send a TCP notification
message for theMotion Event to theWavestore, in the format:

P<validWavestoreusername>;<validpasswordfor thatusername>;M<camera-channel-number><optional-
event-type>;

For example:

Puser;a;M6; for a Pulse (i.e. instantaneous)Motion event

Puser;a;M6+; forMotionON

Puser;a;M6-; forMotionOFF

where the server has a configured user ID: ’user’ with password: ’a’, and the camera channel is No: 6.
Note that the user also needs the ”Post events” permission.

9.7.4 Configuring Motion Detection Recording for other IP cameras
(using non standard message notification formats)

Wavestore can integratewithmany other cameras using the integrationmodule system.

Please contact theWavestore support team for further information.
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9.8 Configuring Smart Search
Wavestorehasa facility toperformapost-recordingsearchofaperiodof recordingsbaseduponmotion.

Supported Camera Types
The Smart Search facility is available for:

• Analogue cameras connected via a Stretch analogue capture card

• MostONVIFProfileScompliantcameras (specifically,ONVIFcameraswhichallowasecondJPEG
streamof 648x648 pixels or less)

For IP cameras it is necessary to ensure the ”Smart Search / VMD” setting is set such that Smart Search
shows asOn,whether using Server-side or Camera-side VMD (VideoMotionDetection). This feature is
available for the ”Auto” and ”ONVIF” group types. For the ”ONVIF” group types, it is necessary to use the
”Auto-configure Camera Streams” option.

Note that forONVIFcameras theWavestorewill requestanextra low-resolution4fpsJPEGstreamfrom
the camera. It is anONVIF Profile S requirement that all cameras support this. However some cameras
may not permit dual-streaming at the same time as taking this JPEG stream formotion analysis.

How It Works
When properly configured, the Wavestore will continually capture and record metadata relating to the
amount of motion in the video. For ONVIF network cameras, the Wavestore will pull a low-resolution,
low-framerate JPEG streamand perform analysis on that. For analogue cameras, themotion detection
is performed in the capture card hardware.

In all cases thismetadata needs to be recorded so thatmotion analysis canbeperformed at a later date.
This is done by ensuring that the Search track (Track 6) is enabled and appropriately configured. This
track is enabled by default and configured for 31 days recording so the default settings are usually suf-
ficient.

See section 4.8 - Smart Search for information on how to perform the search.
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9.9 Configuring Video Analytics
Wavestore has a facility to perform a post-recording search of a period of recordings based upon video
analyticsmetadata, and to trigger events based on real-time analysis of the video analyticsmetadata.

The analyticsmetadata can from:

• AnONVIF camerawhich supports streaming of standardONVIF AnalyticsMetadata

• A supported external analytics device

ForsupportedONVIFcameras, theanalyticsmetadatastreamwill bestartedautomatically if configured
using the Auto camera group type. It is possible to check if this is working using the Execute Com-
mand tool (Tools→ExecuteCommand). Just run ’streamsN’whereN is the camera number, for exam-
ple ’streams 3’. Ifmetadata is being received, it will be indicated as such for stream4. For example:

Live Streams from camera 3:
Stream1: H264 at 30 ips
Stream4(Metadata): Data at 1 ips
VMD/SmartSearch: bitmap 32x18 from JPEG 256x144
Total bandwidth 5190 Kbit/s (all streams)

Toperformapost-recordingsearchof theanalyticsdata, thedatamustberecorded. Thiscanbeacheived
by enabling Track 4 for the appropriate camera group (see section 6.3.2 -CameraGroupSettings). The
data can be searched using the Main screen Smart Search facility (see section 3.13 - Smart Search
Control).

Totriggereventsbasedonreal-timeanalysisof thevideoanalyticsmetadata, it isnotnecessarytorecord
thedata. However it is necessary to create EventCauses in theAnalytics setup screen (see section 6.14
- Analytics). Once the appropriate EventCauses have been created, event rules can be programmed as
usual in the Event Rules setup screen (see section 6.12 - Event Rules).

362



9.10 Configuring Virtual Spot Monitors
Virtual Spot Monitors are an innovation in Wavestore which allow video routing within the system be-
tween video channels.

Imagine a system with 4 IP cameras numbered 1 to 4. It is possible to create a channel 5 which is a
’Virtual Spot Monitor’ and assign a sequence to that channel so that it shows cameras 1 to 4 for a few
seconds each, or it could be configured to switch camera based on an event. The operator can then
view that channel 5 withinWaveView and see the camera switchwhen an event occurs or after a time
period.

Virtual Spot Monitors do not take up a licensed channel meaning that many can be created if desired.
They can route IP or analogue video channels.

Note that Virtual SpotMonitors do not currently support PrivacyMasks.

Creating Virtual SpotMonitors is simple...

• In theCamerassetupscreen (View→Setup→Cameras), click the+ icon tocreateanew ’camera’.

• We need to assign that camera to a Camera Group of type ’VirtualSpotMonitor’. Assuming you
haven’t created one already, right-click the newly added camera and choose ’Change Camera
Group→ Create New Group’.

• Whenprompted forausernameandpassword, just click ’Cancel’ aswedon’t needany logindetails
for this kind of device.

• Switch to the ’Camera Groups’ tab and ensure the newly created group is selected.

• Change theGroup Type to ’VirtualSpotMonitor’.

• Save the changes.

Subsequent Virtual Spot Monitor ’Cameras’ can be added to the previous Virtual Spot MonitorCamera
Group.

That’s all that is required for a default setup although a few tweaks might be desirable such as renam-
ing theCameraGroup to something appropriate, andpossibly disabling recording (by default the Virtual
SpotMonitorwill record, but theoriginal camerasareprobably also recording). Further settingsaredoc-
umented in section 6.3 - Cameras.

OnceaVirtualSpotMonitor ’camera’ hasbeencreated, a ’Sequence’ canbecreated for it. This isdetailed
in section 6.2.10 - Spot Monitor Sequences. Also, event rules can be created to switch certain cameras
to spotmonitorswhen events occur - see section 6.12 - Event Rules.
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9.11 Configuring Framerate Boost
Wavestorehasa facility to increase the recording framerate incertaincircumstances. Thepotential ben-
efit of the ”boost” is to reduce storage usage, although for H.264 and H.265 video streams the streams
need to be carefully configured to ensure there is benefit gained. See section 9.12 - H.264, H.265 and
Framerates for a detailed explanation.

There are twomainways to use boost:

On a Schedule
The boost can be programmed to occur at different times of theweek. This is quite simple to set
up. Firstly create a Schedule as described in section 6.10 - Schedules. Secondly, in the Cameras
setup screen, under the ’Camera Groups’ tab, set the Recording Mode to ’Framerate Boost on
Schedule’, set the normal framerate and boost framerate, then set the desired schedulet.

When an event occurs
TheWavestore Event Rules system can be programmed to trigger the boost when an event oc-
curs. This could be froma range ofEvent Causes such asMotion, digital input, or analytics trigger
from an external device.

We’ll describebelowhowtoconfigureboost tooccurwhen there ismotion. Thereareessentially3steps
to this:

Ensure that the camera is sending required events such as motion
For cameras connected via an analogue capture card in theWavestore, this is automatic.

For IP cameras there are several ways to do this depending on the camera capabilities. These are
described at the start of section 9.7 - ConfiguringMotion Detect Recording but for mostmodern
cameras configuredwith the ’Auto’ group type, itwill justworkwithout any settings needed to be
made.

Configure an event rule to trigger boost when the desired event occurs
For the secondstep it is simply necessary to configure anevent rulewhereby theCause is thede-
sired event type such as ”Motion” for the selected camera, and the Action is ”Boost recording rate
on a camera track”, selecting the desired recording track. This is described in more detail in sec-
tion 6.12 - Event Rules.

Configure the boost rate settings
The boost rate settings are found in the Cameras setup screen, under the ’Camera Groups’ tab.
There are 3 relevant settings:

Recording Rate
This is the normal recording ratewhen no events are triggered.

Boost Rate
This is the recording ratewhen the event is triggered, until it ends.

Pre Boost
Note that this is found under the ’RecordingMode’ option group. This option sets a duration
foraperiodbefore theeventwheretherecordingshouldalsooccurat the ”boosted” rate. Note
that generally only a few seconds are permitted here. If very large durations are requested
they may not be acheived. The pre-boost recording duration is also not guaranteed to be
handled precisely.
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9.12 H.264, H.265 and Framerates

9.12.1 H.264 and H.265 basics
H.264 is currently themost commonly used compression format in theCCTV industry and so this sec-
tionwill provide a simplified explanation of how itworks and the implications on variousWavestore fea-
tures. The principles described here also apply to H.265 althoughwewill generally only refer to H.264.

TheH.264compressionalgorithmandother similar compression formats suchasMPEG-4workon the
basis of not always sending complete frames. The video stream is comprised of different frame types:

i-frames
These are complete frames. In H.264 an i-frame is very similar to a full JPEG image. An i-frame on
its own is useful in that it can be decoded and displayedwithout needing any other frames.

p-frames
These are smaller frameswhich essentially contain only differences comparedwith the previous
frame. Therefore they are useless on their own. In order to view a p-frame you need all previous
frames in the streamback to the last i-frame.

b-frames
These are similar to p-frames except that they are bi-directional and can refer to frames in the
future. This has potential negative consequences inCCTV such as increased latency and somost
cameras do not output b-frames, or at least have the option to disable them. Wavestore does not
currently support b-frames.

A collection of a single i-frame followed by several p-frames is called aGroupOf Pictures - or GOP.

To keep things simplewe’ll consider a video streamwith a framerate of 5 frames per second and aGOP
size of 5. Thismeans that there is one i-frame every second, so 3 seconds of videowill look like this:

Figure 9.1: Simpified representation of H.264 streamwithGOP size of 5

The frame sizes shown are from a real 2.1megapixel camera from awell-known cameramanufacturer.
The camerawas situated in an officewith littlemovement.

As can be seen from the frame sizes in the diagram, the p-frames are generally very small compared to
the i-frames. This can have implications on the effectiveness of using settings such as ”framerate boost
onmotion”.
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9.12.2 Framerate Boost Considerations
Since each p-frame depends on the previous p-frameswe can’t just dispose of any of thembecause it
would cause corruption in the stream...

Figure 9.2: Corrupted H.264 streamdue tomissing p-frames

In the diagram above we’ve tried to reduce from 5fps to 3fps, but the stream is corrupted because
the first remaining p-frame refers to the previous p-frame which is no longer present. Wavestore has
amechanism to prevent this fromhappening.

We could potentially get rid of just the trailing p-frames in aGOP. For example like this...

Figure 9.3: Non-corrupted H.264 streamwith p-frames at start of GOP

Now this stream isn’t corrupted, however all the video is squeezed into the beginning of theGOP. In this
case every second therewill be 3/5ths of a second video, then 2/5ths of a second of frozen video.

This is exascerbated for higher framerates and GOP sizes. For example if we have 25 frames in a GOP
and 25 frames per second, if we wanted to reduce it to 5 frames per second, we’d have to keep the i-
frame and 4 subsequent p-frames, then discard the next 20 p-frames. But this means that although
we now have 5 frames per second, they are all crammed into the first 1/5th of every second! Not really
the desired effect.

For this reason, Wavestore doesn’t support doing this. Generally if you set a lower recording framerate
than the stream framerate,Wavestorewill tend to discard all p-frames to avoid corrupting the stream.

It’s still possible and fairly useful to configure boost in this case but the frequency of i-frames needs to
be considered. For example if you want to boost from 1 fps to 25 fps, ensure you have 1 i-frame every
second.
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9.12.3 Effectiveness of Framerate Boost with H.264
Staying with the 25fps example, how much storage space would we save by reducing the framerate
from25 to 1?

Ifwe use the frame sizes fromour test camera the 25fps streamwould be approximately...

110KB + (24× 6KB) = 254KB/s

...whereas a 1fps streamwould be...

110KB/s

Therefore going from25fps to 1fps reduced our storage to 43%of its normal size.

What if wewanted to go from25fps to 3fps instead? Well, as described above, youwould need to con-
figure the stream to contain 3 i-frames per second, so aGOP size of 8.

In this case the 25fps streamwould be:

(3× 110KB) + (22× 6KB) = 462KB/s

...and the 3fps streamwould be...

3× 110KB = 330KB/s

So we’ve had to significantly increase the data rate of our 25fps stream to enable the extra i-frames,
and now our 3ips stream takes evenmore space than the 25fps streamwith the GOP size of 25 in the
previous example.

So framerate boost is a useful feature for space saving, but the required configuration needs to be con-
sidered carefully as a poor configuration can end up using evenmore storage space than normal conti-
nous recording.
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9.13 Configuring Storage Devices

9.13.1 Configuring and Managing HyperRAID™
The unique HyperRAID™ architecture in Wavestore provides cost-effective redundancy in storage ar-
rays whilst performing faster than traditional RAID without requiring a traditional hardware RAID card
to operate. This technology is compatiblewith awide range ofWavestore servers.

Creating a HyperRAID™ Array

Here we will describe the process of creating a HyperRAID™ array from 4 disks. There will be 3 data
disks and 1 parity disk.

Thenumberofparitydisksdefineshowmanydisks in thearraycanfailwithoutanydata in thearraybeing
lost. So in this case, 1 disk can fail and nodata is lost. However it’s important to replace the failed disk and
give the system time to rebuild the array, otherwise if another one fails before the rebuild is complete, all
the data in the array is lost. The good news is thatWavestore offers up to N+5 redundancy, meaning up
to 5 parity disks per array.

If we have 4 unconfigured disks, the Storage setup screen (View → Setup → Server → Storage) will
show something similar to the below screenshot:

Click ’CreateDriveArray’ to open the ’ArrayGeometryEditor’. This iswhere youcanconfigure the struc-
ture of the array to be created.
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Click ’Add’ and set the desired number of data and parity disks, then click OK.

Nowwehave an ’empty’ DriveArray. Weneed to chosewhichdisks aremembers of this array. There are
twoways of doing this:

• Drag and drop the ’Unconfigured’ disks onto the arraywith the ’missing’ drives.

• Click the ’AddDrives’ buttonwithin the Drive Array and select them from the presented list.

Only local disks can be added to the drive array. You cannot build a HyperRAID array frommultiple net-
work or cloud drives.

Once the array has all the required drives assigned, we need to assign a ’Drive letter’. In this case we
assign drive letter ’D’ and click Save.
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At this point the array has been created, but is not formatted. So the final step is to select the array and
click ’Format’, then confirm the request to format.

Now the setup is complete. We have a formatted array with ’all drives present’. We can click the arrow
next to the array to see themembers of the array and their statuses as shown in the screenshot above.
We can now assign camera recording tracks to Disk D to use the array.
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9.13.2 Configuring and Managing MegaRAID
If yourWavestore serverhasaMegaRAID® hardwareRAIDcontroller card installed, theWaveViewsoft-
ware provides tools to configure andmanage those RAID arrays.

There are twomainmethods of doing so:

Managed by MegaRAID® tools
In this mode, the RAID arrays are created outside of Wavestore and simply appear to Wavestore
as a single disk. Wavestore provides the ’storcli’ command to allow remote administration as per
the manufacturer’s instructions. This can be performed with the Execute Command tool (Tools
→ Execute Command).

Creating the arrays can be done in different ways and varies by system. Sometimes it can be
done via the BIOS-like menus available on starting the system, or it can be done via the ’storcli’
command-line tool.

Managed byWavestore
WavestorecanbeusedtomanagetheRAIDarraysvia theWaveViewuser interface. Thiswill occur
if the arrays are created using theWaveView user interface.

This sectionwill focus on the casewhere the arrays aremanaged byWavestore.

Creating a MegaRAID array

When various disks are available on the RAID controller but not set up yet, theywill appear as UNCON-
FIGURED in the Storage setup screen.

To create a RAID array, click on the ’Create Drive Array’ button. This allows one or more disk groups to
be added, each ofwhich can be a RAID array. Click ’Add’ to add a disk group, and select howmany data
disks (N) and how many parity disks (P) are required. A single parity disk is called N+1 or by the RAID
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term ’RAID5’, and twoparity disks are calledN+2or ’RAID6’. Most hardwareRAIDcontrollers allowup to
2 parity disks.

Next, add the UNCONFIGUREDdisks to this RAID array. Disks can be added by dragging themonto the
array, but for large numbers of disks it’s easier to click on ”AddDrives” and then select them from the list:
click on the first drive and drag themouse over all the others to select all, then click OK.

Give the Drive Array a Drive Letter (e.g. ”D”) and click Save.

Whenfirst added, thedrivemightbe shownasMISSING.Click ”RefreshList” to refresh the list andshow
the newly created drive array. It is necessary to format it at this point, so select it and click ’Format’.

Your drive array is now ready for use.
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In current versions of the software, only two RAID arrays with different letters can be set up by this
method. If it’s necessary to configure the system in other ways, see the MegaRAID® Configuration
Commands section below.

Note: MegaRAID is a trademark or registered trademark of LSI Corporation in the United States
and/or other countries.

Deleting or Changing MegaRAID Arrays

Tochange theRAID typeornumberof drives after thearrayshavebeencreated, it is necessary todelete
and recreate them. Thiswill require reformatting andwill cause a total loss of data. If you do change the
RAID format, theWavestore serverwill not automatically delete the old RAID array.

When using Wavestore to manage the MegaRAID arrays, if you remove the array in the Storage setup
screen, the arraywill no longer bemanaged by theWavestore, however it is not actually deleted.

To explicitly delete the array it is necessary to use the ’storcli’ command-line tool. This is performed by
running commands via the ’Execute Command’ tool (Tools→ Execute Command).

To delete all volumes on the RAID controller (WARNING: doing this loses all your video footage!), ex-
ecute the following command:

storcli /call/vall del

Alternatively, it’s possible to delete a specific ”volume”. First, determine the volume ID for the desired
volume. To list all ”volumes”:

storcli /call/vall show

Thiswill show something like the following:

----------------------------------------------------------------
DG/VD TYPE State Access Consist Cache sCC Size Name
----------------------------------------------------------------
0/0 RAID5 Optl RW No RAWBD - 16.372 TB DiskArrayD
----------------------------------------------------------------

In this case the number under VD is 0which is the volume ID. Sonowwecandelete volume0... WARN-
ING: doing this loses all video footage on that volume!...

storcli /call/v0 del

Replacing a failed disk in a MegaRAID array

When a diskwithin a RAID array fails, the array itselfwill enter a DEGRADEDstate, and this is indicated in
the Disks Setup screen, aswell as the System Log.

Usually, althoughdependenton thehardware, thediskcaddy itselfwill either showa red light or no lights
at all.

Whenthediskhasbeenreplacedwithanewdisk, it isnecessarytotell theRAIDcontroller to re-incorporate
the disk. To do so:

• Go toView→ Setup→ Server→ Storage

• Select the degraded RAID array
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• Click the ’Add SwappedDrives’ button

After a short period of time, refresh the disks list and the state should change to REBUILDING. If further
information or inspection is required the ’storcli’ tool can be used.

Note that if a disk is moved from one MegaRAID system to another it will show a status of FOREIGN.
The ’Add SwappedDrives’ will remove this FOREIGN status and incorporate the disk into the degraded
array.
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9.13.3 Configuring iSCSI Storage Devices
iSCSI devices are configured in the Storage setup screen (View → Setup → Server → Storage). The
’Attach iSCSI Devices’ button opens the ’Search for iSCSI Devices’ screen:

Figure 9.4: Search for iSCSI devices screen

To attach an iSCSI device, firstwe need to find it via its IP address. So enter the IP address of the iSCSI
device, and click Search.

Figure 9.5: IP address of iSCSI device entered

If the device is successfully found, it will be listed in the ’Found’ window.
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Figure 9.6: Networked iSCSI devices located

To then connect to that device, left-click to highlight it and click ’Connect’:

Figure 9.7: Connected to iSCSI device

If the connection is successful, the devicewill appear in theConnected list.

The device can then be assigned a drive letter and formatted tomake it ready for use:
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Figure 9.8: Disks screen – new iSCSI device (Drive F) shown in list of Disks

iSCSI devices should be managed using the tools provided with the device itself. Wavestore can only
connect to the device, use it, and report any issues when communicating with it. The device will be
treated in the sameway as in individual disk.
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9.13.4 Configuring NFS Storage Devices
Wavestore can store video in files on an NFS (Network File System) target.

Note the Wavestore will need to have been installed with the version 6.16 or later to get the latest OS
packageswhich are needed for NFS; it cannot be installedwith an earlier version 6 and upgraded.

To add anNFSdevice, go toView > Setup > Server > Storage and clickAttach Network Storage. From
the Type drop-down, select ”nfs”.

Enter the required details as described below, then click Add to attach to the device. If successfully
added, assign a disk letter in the Storage screen and save the changes tomake the device usable.

As described on-screen, it is necessary to add a Network Path in the format...

nfs:<options>://<nfsserver>:/<nfspath>/<directory>.

<options> can contain a size and optionally other mount options: eg, 16GB or 2TB,noac,noatime. If
mount options are omitted then noac,noatimewill be used and usually no special options are required.
A size field is always required.

<nfsserver> is the server address, e.g. 192.168.0.1

<nfspath> is a path on the server, e.g. /home/storage

<directory> is a directory within the NFS export so more than one server can use it. Typically it is S
followed by 1..99, e.g. S1.

For example:

nfs:20GB://192.168.0.1:/home/storage/S1

Thiswillmount 192.168.0.1:/home/storage as anNFSshare, and access footagewithin theS1direc-
tory, using up to 20GB of space.
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Notes

Resizing

Currently once a size has been set, it cannot be changed due to the index structure.

Failover Notes

Normally eachserver has its own /S1or /S2directory. In futurewewill allow ”/Sn” tobeconfiguredas the
directory part, whichwill allow a Standby server to take over the correct directory replacing n by logical
server number. This will only be available in Ultimate licence, and is not yet available. If this feature is
not available, the standby should be configured to use its owndirectory, eg, /S99, and the footagewill be
available by redirection as normal after themain server has come back up.

Format Button

An NFS volume is not a disk, so ”Format” will not format it. The operation of adding the device prepares
the device appropriately.
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9.13.5 Configuring AWS Storage Devices
Wavestore can store video in files on an AWS (AmazonWebServices) target.

To add anAWS target, go toView > Setup > Server > Storage and clickAttach Network Storage. From
the Type drop-down, select ”aws”.

Enter the required details as described below, then click Add to attach to the device. If successfully
added, assign a disk letter in the Storage screen and save the changes tomake the device usable.

As described on-screen, it is necessary to add several parameters.

Size specifies the space reserved on this device: eg, 16GB or 2TB.

Region is the region as specified by your AWS account

Bucket is the name of the storage bucket as provided by AWS

Access Key is part of the authentication credentials and should be provided by AWS

Access Secret is part of the authentication credentials and should be provided by AWS

Notes

Resizing

Currently once a size has been set, it cannot be changed due to the index structure.
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9.13.6 Configuring Azure Storage Devices
Wavestore can store video in files on an Azure target.

ToaddanAzure target, go toView >Setup > Server > Storage andclickAttachNetwork Storage. From
the Type drop-down, select ”azure”.

Enter the required details as described below, then click Add to attach to the device. If successfully
added, assign a disk letter in the Storage screen and save the changes tomake the device usable.

As described on-screen, it is necessary to add several parameters.

Size specifies the space reserved on this device: eg, 16GB or 2TB.

Storage Account is the account name as provided by your Azure account

Container Name is the name of the storage container as provided by Azure

Shared Key is part of the authentication credentials and should be provided by Azure

Notes

Resizing

Currently once a size has been set, it cannot be changed due to the index structure.
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9.13.7 Configuring Sequential Recording and EcoStore®

The ’traditional’ way of configuring recording inWavestore is to set up either a single large recording vol-
ume, for example a RAID array, and record everything to that volume. Or, if there are 4 disks and 100
cameras for example, to record 25 cameras to each disk.

Version 6.14 introduced new functionality whereby recordings can occur to disks or groups of disks in
sequence. These are known as ’Disk Groups’. When suitably licensed, Wavestore can ’spin down’ these
disk groups,meaning significant reduction in power consumption.

For example, if there are four disks, s01, s02, s03, and s04, theWavestore can be configured such that
it will start recording to s01 only. Once s01 is full, it will move to s02, and so on. The disks which aren’t
currently in use can be spun down to save power.

If spindown is enabled and the user needs to access recordings which are on a spun-down disk, the
systemwill automatically spin up the disk, although this can take a few seconds. The diskwill then stay
spun up until it has been inactive for a period of time.

The same principle can be used in conjunction with the HyperRAID™ system. For example, each disk
group could be a HyperRAID™ array and the unused arrayswill be spun down.

Note that EcoStore® functionality is not compatiblewithMegaRAID disk controllers.

Configuring a Simple Sequential Array with EcoStore®

To enable sequential recording we simply need to create an array with multiple ’disk groups’. Here we
will take a fresh systemwith 4 disks and create a single sequential array with the EcoStore® spindown
mode enabled.

We start with a system that has 4 unconfigured disks...

Click ’Create Drive Array’ to open the ’Array Geometry Editor’, then click Add four times to create four
’disk groups’ eachwith oneData disk and zero Parity disks.
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The ’Spindown Drive Array’ option enables the EcoStore® functionwhere any ’disk group’ not currently
in usewill be switched into a low-powermodewhenever possible, saving energy and heat output. This
feature is only available in certain licence levels and hardware configurations.

Once the arraygemoetry hasbeenconfirmed, clickOK then set aDrive letter and save the changes. The
arraywill then be created, however itmay show asMISSING...

The final step is to Format the array, it should then show FORMATTED in green. Click the arrow next to
the array to inspect itsmembers and their status...
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The array is now available to be used for recording.
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9.13.8 How To Recover From Disk Faults or Removed Disks
If a disk has a fault or is accidentally removed, it will show as FAULT or MISSING in the Storage setup
screen. Somedisk faultswill cause thedisk toshowasMISSINGrather thanFAULTbecause it has failed
in such away that it is not possible to detect the disk at all; both states are treated in a similarway by the
software.

If a HyperRAID array has a diskwith a disk fault, it is necessary to replace the faulty diskwith a newone
and click the ”AddSwappedDrives” button to force the system to recognise the changed disk. After the
failure the array will show as DEGRADED until this replacement occurs, and REBUILDING after the re-
placement (after a few seconds). After the rebuild has completed it will show as FORMATTED. It should
be usable throughout this time and no data will be lost. The same applies if a disk was accidentally re-
moved and reinserted.

If a single disk has a disk fault, data might be lost. It will usually be necessary to replace by a new disk
and reformat it before it startsworking again. Thiswill result in loss of footage on the failed disk.

If a single disk was accidentally removed, and is replaced while the power is still on, it will still show as
FAULT orMISSING. If the ”Add Swapped Drives” button does not force it to be recognised, the recom-
mended technique is to change the disk drive letter to another letter (eg, Z) and Save, then change it
back to the desired letter (eg, D) and Save. This configuration changewill cause the Disk subsystem for
that disk to reset and forget it was faulty. It will probably show as UNFORMATTED at first (to encourage
formatting of any newly added drive), and the ”Add Swapped Drives” will then re-read it and show it as
GOOD (providing there is no other fault).

Ifmovingadisk (or entire array) fromonemachine toanother, itwill behave in a similarway. Itwill usually
showasUNFORMATTEDat first (to encourage formattingof anynewlyaddeddrive), and ”AddSwapped
Drives” will then re-read it and show it as GOOD (providing there is no other fault).
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9.14 Accessing Wavestore Server from Client PC

9.14.1 PC Requirements

Minimum

• 4thGeneration Intel® Core™ i3-4170 or better

• 2GB of RAMor better

• 80GB hard drive forWindowsOS andWaveView

• Integrated graphics card

• 100Mbps Ethernet network interface card

Recommended

• 4thGeneration Intel® Core™ i5-4670 or better

• 4GB of RAMor better

• 64-bit operating system

• 120GBSolid State Drive forWindowsOS andWaveView

• GbE network interface card

• NVIDIA®GT 730 2GB video card

High performance (Video intensive configuration)

• 5thGeneration Intel® Core™ i7-5820K or better

• 16GB of RAMor better

• 64-bit operating system

• 120GBSolid State Drive forWindowsOS andWaveView

• GbE network interface card

• NVIDIA®GeForce®GTX 970 4GB video card

9.14.2 WaveView Client Software installation process on a Windows
PC

WaveView allows all user functions, and most installer configuration functions to be carried out from a
PC.

The WaveView installer is provided on the installation DVD but is also available from our website. The
installer for Windows is only provided in a 64-bit version, named ’WaveView-6.xx.xx-win64.exe’, where
the ”xx” can vary depending on the version.

It is recommended to use the same base version of WaveView client as the server, or higher. By ”base
version”wemean thefirst twonumbers, for example thebaseversionof ”6.14.51” is ”6.14”. So for example
if the server is running version 6.16, theWaveView client version should be 6.16 or higher.
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TheWaveView installer is similar to those formostWindows applicationswith a few installation options
which are detailed below:

• SystemPath - theWaveView installer also includes some command-line tools. If youwish to use
these it is recommendedtoaddtheWaveViewinstallationdirectory to thesystempath. Thisoption
will do so if selected, but it can also be donemanually later if desired.

• Create Desktop icon forWaveView

In the ’Choose Install Location’ screen, select the destination folder for theWaveView installation.

Once the installation process has completed, click on ’Finish’ to close the Install Wizard.

Figure 9.9: WaveViewDesktop shortcut icon

To connect to your server, click on the desktop shortcut to launch the program; the WaveView screen
will appear as below.

Figure 9.10: WaveView launch screen

To connect to your server, enter the following details in the login screen:

Server: IP address of server

User Name: valid user logon ID – default is ’install’
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Password: valid user password – default is ’a’
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9.15 Server Group Configuration Conflict Resolution
When accessing a setup screen which pertains to a server group, if there are inconsistencies between
the configuration on different servers within the group, a Conflict Resolution Tool will appear asking for
the operator to choose the serverwith the correct configuration.

Notethat this toolonlypertains tothecurrentsetupscreen. Theremaybeotherconflicts inotherscreens.
If there is a conflict on one screen (e.g. ’Users’) it is advisable to check all the other setup screens in case
they also have conflicts.

To resolve the conflict, simply select the server with the correct configuration from the list on the left,
thenclickOK.Theconfiguration for thisserverwill thenbesynchronisedtotheotherservers in thegroup.

If there is uncertainty aboutwhich server is correct, or why there is an inconsistency, the Conflict Res-
olution Tool provides some facilities to help understand.

For example, in the screenshots below, we click on each of the server names and see the relevant con-
figuration sections for each of the servers.

It’s fairly apparent here that the first server has 4 users, and the second server has 3 users.

If it’s still not clear what the difference is, we can click ’Advanced Comparison’ to compare the con-
figuration in a different way. As we select different servers, the centre of the UIwill either show awhite
equals sign (’=’) if both servers have identical configuration, or a red questionmark (’?’) if they do not.
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Here we can see clearly that the [User_4] section is present on the server on the left, but not on the
server on the right, as indicated by the red questionmark between the two configurations.

The drop-downmenus at the top allow servers to be selected, so that any serverswithin the group can
be compared.

Once the issue is understood, back in themain Conflict Resolution Tool window, select the server with
the correct configuration, and click OK.
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9.16 Reinstalling Wavestore Server Software
In the event that theWavestore software needs to be reinstalled on the server, this can be easily carried
out, either by using theWavestore DVD suppliedwith each newWavestore server, or by creating a new
DVD or bootable USBmemory stick.

To obtain the latestWavestore installer, contact theWavestore Support Teamwho can provide a down-
load link for the ISO image of the software.

If choosing to do the re-installation byDVD, download the ISO image file and burn to aDVD. Onmodern
versions of MicrosoftWindows (8.1 and later) this can be performed by right-clicking the ISO file name
and selecting ’Burn Disc Image’. Alternatively, DVDwriter software such as Nero or Roxio can be used.

To install or upgradeWavestore from a USBmemory stick it is necessary to extract the ISO to the USB
stick. ThewaytodothisdependsontheOperatingSystem. MostcommonlyMicrosoftWindows isused,
inwhich case the Rufus program is recommended.

Assuming the installation ISO has already been obtained, the process is as follows:

• OnWindows, download Rufus from http://rufus.akeo.ie

• Run Rufus.

• Plug in the USB stick. Rufus should recognise the USB and populate the ”Device” box.

• On Rufus: ”Format Options”/”Create a bootable disk using” and select ”ISO Image”.

• On Rufus: click the icon to the right of the above text and select the ISO.

• On Rufus: click [Start] to start thewrite to USB.

• Select ”Write in ISO Imagemode (recommended)” and click OK if Rufus asks about deleting files
on the USB stick.

• It’ll take a fewminutes to create the bootable USB.

9.16.1 Reinstallation Preparation
Note: UEFI/EFImode is not currently supported. Manymotherboards use this as the default so it may
be necessary to change your BIOS settings to use ”Legacy”mode rather than UEFI/EFI.

Inaddition to the installmedia (DVDorbootableUSBstick), youwill also requireaUSBdevicewithasaved
copy of the current server configuration file (see section 6.2.14 - ).

It is also advisable tomake a note of the server Licence andMachine ID,whether you saved the config-
uration or not.

9.16.2 Reinstallation Procedure
Before starting the installation it is necessary to decidewhether to record video to the operating system
disk. This is generally discouraged, particularly if the operating systemdisk is an SSD.

It is usually only advisable to record to theoperatingsystemdisk if there arenootherdisks in thesystem.
The default installation option assumes that you will not record to the operating system disk. It is not
possible to change this after installation so re-installationwill be necessary to change it.

• Connect a keyboard andmouse to the server.
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• Shut down the server (menu path View→Setup→Server→General→ShutdownSystem)

• If installing fromUSB, insert the USB stick and power up.

• If installing fromDVD, power up the server and insert the installation disc in the DVD drive.

• The system should nowboot from the DVD or USB device, and display the installationmenu.

There are now several choices of installation type:

Install Wavestore from DVD This will begin a default installation from the DVD drive. No
video storage partitionwill be created on the operating system disk so all recording
will be to separate disks.

Install Wavestore from USB This will begin a default installation from the USB drive. No
video storage partitionwill be created on the operating system disk so all recording
will be to separate disks.

Advanced Options Thisopensanothermenuwith further, lesscommon, installationmodes.

The AdvancedOptionsmenu presents further installationmodes as described below:

Install Wavestore from DVDwith data partition Thiswill beginan installation fromDVD
with a video storage partition configured.

Install Wavestore from USBwith data partition Thiswill begin an installation fromUSB
with a video storage partition configured.

Unattended Wavestore Install from DVD This will begin a default installation from the
DVDdrive. Novideostoragepartitionwill becreatedon theoperatingsystemdisk so
all recording will be to separate disks. No warning messages will be offered before
overwriting the operating systemdisk.

Unattended Wavestore Install from USB This will begin a default installation from the
USB drive. No video storage partition will be created on the operating system disk
so all recording will be to separate disks. No warning messages will be offered be-
fore overwriting the operating systemdisk.

Rescue installed system This isaspecialmodeusedtorecovera faultysystemandshould
only be used under guidance fromWavestore support staff.

Memory test This performs a test of the systemmemory to check for faults.

Once the installation procedure has completed, remove the ejected install DVD or USB stick, and select
Reboot

The systemwill restart andexamine the server hardware. During start up, youwill be prompted to select
theGraphics Card configuration (press Enter), and the unit will then reboot once again.

Once the server has restarted, login using the following details:

Server: localhost

Username: install

Password: a
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Tocompletethe installation, either loadthepreviouslysavedconfigurationfileasdescribed in section6.2.14
- , ormanually enter the server licence details as described in section 6.2.3 - Licensing.
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9.17 Accessing a USB disk on the Wavestore server
It is often useful to access a USBmemory stick or hard disk, for example tomake exports or save con-
figuration files. Doing so is a little different on aWavestore serverwhen comparedwith aWindows PC.

Upon inserting a USB device, the file browser should open automatically with the contents shown. If
not, move the mouse to the top-left corner and click the filing cabinet icon, as shown below, to launch
the file browser.

Figure 9.11: Opening the file browser

Onceopen, select theUSBdevice in the left-panel to view thecontents. This is knownas ”mounting” the
USB device.

From inside theWaveView application, navigating to the USB device is as follows:
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Figure 9.12: Accessing the USB device fromWaveView

First, click ”Computer” in the left panel. We now want to navigate to the path /run/media/dvr-user/.
This is done as follows:

• Double-click ”/”

• Double-click ”run”

• Double-click ”media”

• Double-click ”dvr-user”

Finally you should now see the name of the USB device. Double-click it to view the files.

Whenfinishedwith theUSBdevice andprior to removal, it is strongly advised to ”unmount” it. This is akin
to the ”safely remove” procedure onWindows.

To do so, access the Caja file browser as described before, then select the eject icon next to the USB
device name in the left panel.
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Figure 9.13: Viewing the USB device in the file browser
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9.18 Central Event Server
The Central Event Server (CES) is a powerful and extensible feature of Wavestore which allows all (or
some)events fromtheLiveEvent streamonanumberofWavestoreservers tobe forwarded toacentral
server which we call the ”Central Event Server” or ”CES”, which can process the events. The feature is
available from version 6.20.

The actual Central Event Server itself is just one of theWavestore servers, it does not require any special
hardware.

For example: consider a systemwith 5 Wavestore servers all in one Server Group. Server 1 can be set
as the Central Event Server, and this will pull events from the other servers in the group automatically
(providing the CES has been enabled). That server can then be programmedwith Event Rules relating
to all servers in the group.

This feature is disabled by default but can be enabled in the ServerGroup setup screen. See section 6.8
- .

When the CES feature is enabled, the first server in the group, Server 1, will be the CES, and the other
serverswill share their eventswith theCES.

NormallywhenconfiguringEventRules, theCausesandActionspertainonly to thecurrentserver. How-
ever, when CES is enabled and Server 1 is being configured, the Event Rules screen allows the specific
server to be selected for Causes and Actions. For example, Motion on Camera 3 of Server 2 could be
used to trigger Output 1 on Server 3.
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9.19 Failover
Wavestore systems support Failover, so if a recorder fails then another can take over.

To get a number ofWavestore servers to support Failover, weneedone (ormore) extramachineswhich
will act asStandby servers. The concept is simple and is a typeof virtualization: wehave ”logical servers”
which do the recording and they are always up, and these run on ”physical servers” which are the real
hardware. Each physical server has its own IP address, so each physical server has a physical server IP
address sowe canmonitor it.

In addition, each logical server usually has an IP address, and these are the ones to which the client
and other devices connect to as part of the DVR operation so when it switches hardware it changes
seamlessly. So when logical server 1 (LS1) is running on physical server 1 (S1) then that hardware has
two IP addresses. This is optional: it is possible to have failoverwhere youmanually connect to Server 1
or to theStandby server if Server 1 is down, but adding logical addressesmakes this seamless for a user
who does not need to know if failover has occurred butmerelywants to view the footage.

We needmore physical servers than logical servers, these extras are the standby servers.

Pure virtualization techniques only virtualize the processor, but theWavestore is primarily a storage unit.
Different techniques are needed tomake storage failover work efficiently from standard processor vir-
tualization, andbecauseWavestore Failover has beendesigned for just this purpose, it is ideally suited to
it.

So if we have 3 servers plus one standby, we need 4 physical servers in total, and servers 1, 2 and 3will
be configured to run as logical servers 1, 2 and 3. Server 4will be configured as a standby.

Figure 9.14: Failover logical and physical devices

Remember we need 7 IP addresses for these 4 servers, since each logical server has a different IP ad-
dress. This logical IP address is a secondary IP address on the network adapter.

When a server fails, the standby server takes over the role of the logical server:
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Figure 9.15: Failover logical and physical devices after failure

The Standby server (or servers) monitor the logical servers and take over if any one fails. This leads to
a brief interruption in recording, only a few seconds, and the recordingwhile the original server is down
is done on the standby server. When the original server comes back up, it takes over recording again,
and the system redirects the footage recorded by the standbymachine so it instantly appears onto the
original server, so it’s all in the same place as far as the user is concerned.

The Standbymachinemust be similar hardware to themachines which it will take over from, including
thenamesof network interfaces in use, andnumber of disk volumesand their disk letters. Failover is not
supported on machines which are not very similar, but some small variations are allowed: typically the
Standbymachine is a smaller version of themain servers.

Do not configure cameras or events on the Standby machines. The camera and event configurations
will be copied from the logical servers and usedwhen one of those physical servers fails. One exception
to this is described below.

9.19.1 What counts as Failed?
A number of conditions are considered to be Failed for Failover purposes:

• The server loses power or stopsworking and vanishes from the network

• The server reboots or restarts

• If a network interface or bond group goes down. This could be because a cable has been discon-
nected. Note: if a single link of a bond group goes down this does not count as failed, all links of a
bond group need to be down. See configuration options below.

• If adiskordisk array fails, sonodatacanbewritten to thediskordisk array. Note: if a singlediskof a
disk array goes down and redundant disksmean it continues towork then this does not count as
failed, only if the array is no longer functionalwill it count as failed. Seeconfigurationoptionsbelow.

• If a Failover event action is performed. This event action allows the user to configure an event
which can trigger the server to be treated as failed.
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• A force-failover command has been executed. This allows the user to force failover for mainte-
nance purposes.

In the case of a reboot or restart, or network or disk failure, the server will be counted asworking again
once the reboot/restart/failure has been resolved. In the case of a Failover event action or force-failover
command, it will be necessary to restart the server to recover from the condition.

Network Interface and Disk Array failure condition checks can be disabled by configuration options.
These need to bemanually applied into the configuration file if needed.

9.19.2 Identical Hardware for Failover
The server hardware should be identical in the following respects:

• all must have the same number of disk letters.

• each camera must have the same tracks recorded to the same disk letters (consistent across all
servers).

• all must have the same network interface names.

• all must be running the same software version.

A number of differences are permitted:

• TheStandbyservercanhavesmallerdisks (or fewerdisks inadiskarray), but itmusthave thesame
numberofdiskvolumeswith thesamedisk letters. Forexample, themainserversmighteachhave
24disks in a RAIDvolumecalledDiskD. TheStandbymight be a smaller version of thiswith only 8
disks in a RAID volume called Disk D. But since both have a single volume called Disk D thatwould
suffice as ”identical”.

Network interfaces with IP addresses assigned must have identical names, but if the names of
the physical network interfaces do not match, use bonding and assign the network interfaces to
be slavesof thebonded interface ”bond0”; assign the IPaddress tobond0 insteadof the individual
network ports. Now the interface name is identical on all machines, it’s always called ”bond0”, the
slave names are irrelevant. This can be extended tomultiple bonddevices ifmultiple IP addresses
are required.

Note that any number of normal or bonded slave network interfaces will be kept on failover, up
to the first secondary network address (i.e. DEVICE with ”:” in the device name). That secondary
and all subsequent network interfaceswill be taken from the logical server. This will work inmost
cases, providing bonding is set up before any secondary network addresses are added.

• TheWavestore serversmay have different numbers of cameras, or different tracks configured for
each camera, but when one is configured it should have the same disk letter as any other cam-
era/track as the other Wavestore servers. And it’s useful to configure all of them on the Standby
server or they can’t be seen later. For example a 2+1 server systemmight have 12 cameras on the
first logical server and 11 on the second, but the standby is configured for all 12.

• The casemight be a different size, and number of disksmight differ, so long as the disk letters are
identical. So aV-series server canbe a standby for anX-series, and anX-series canbe standby for
a Petablok.

• During software upgrades the servers in a failover groupwill not all have the same version, as one
server is upgraded first and another is yet to be upgraded. Thiswill not normally cause a problem,
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but for reliable operation all should be on the sameversion once the upgradehas been completed.
It is usually best to upgrade the Standby server(s) last.

• Note that things which are not used don’t need to be identical, so an additional disk which is not
configuredwith a disk letter is not a problem.

Historical note: FromV6.24 the requirement to have identical numbers of network interfaces on the two
machineshasbeen removed, and there is no longer a requirement to createdummynetwork interfaces.
It’sacceptable foreither themainorstandbyservers tohavemorenetwork interfacesso longas theyare
bondedasdescribedabove. Thesechangeshavebeenmade tomake it easier to replace failedhardware
evenwhen an identical replacement is no longer available.

When one ormore servers in the failover group contains an analogue capture card, the channels on this
card cannot be failed over since they are physically connected to the original server. Special configura-
tion is required on the standby server to ignore the capture cardwhen failover occurs.

9.19.3 Failover Group Size
Very large failovergroupsshouldbeavoided: themonitoringoverheadandnetwork traffic increasessig-
nificantlywith largegroups. It is recommended that a single failovergroupshouldhavenomore than20
to 30 logical serverswith one ormore standby servers. Themaximumpermitted is 40 physical servers
(ie, logical servers plus standby servers) per failover group.

Note that large server groups can be split into multiple failover groups, as server groups (which make
viewing easier) and failover groups (which copewith server failure) can be configured independently.

9.19.4 Setting up Failover: Preparation
Connect the servers to the network, and useWaveView to configure the physical IP addresses. Do not
put these servers into a server group at this time.

AddLogicalnetworkaddressesassecondaryaddressestothephysicalmachines, excludingtheStandby
server, to allow WaveView to follow the logical server even when it fails over. Use WaveView Network
Setup to do this using the ”Add Secondary” button to the first network interface. This is an optional step
but itmakes the system very easy to use. See section 6.2.2 - formore information.

Note that it is essential that any logical (secondary) network interfaceor interfaces are addedafter all the
physical (primary) network interfaces, otherwise itwill not function correctly on failover. It should show
as the last tab (or tabs) in theWaveViewNetwork Setup screen.

Note that interfaces used for failover need to be configured with manually configured (static) IP ad-
dresses. Automatically obtained (DHCP) network addresses can only be used on interfaces which are
notusedbyFailover. All thenetwork interfacesusebyFailover (primaryandsecondary)shoulduseman-
ually configured (static) IP addresses. If any interfaces are configured for DHCP, it is recommended
that they are placed after the primary interfaces used for Failover. Bonding can be used to reorder them
if needed, so bond0 is the Failover Primary and bond1 can use used for automatic (DHCP) addresses.
Secondary addresses always go after all primary addresses.

Set all servers to synchronise time to anNTPserver. Itworkswell for all to synchronise to logical server 1,
except logical server 1 itself which should get time from another NTP server or bemanually configured.

Log into thesemachines and configure camera and audio channels as as normal. You can do this using
either the physical or logical network addresses. It’s a good idea to do much of the setup now, before
Failover is started, but it can be done after failover has started if required.
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Log into the Standbymachine using the Physical address and set up camera and audio channels using
a ”Backup” type to create dummy channels, primarily to configure which disk is used for storage to al-
low access to any previously recorded footage when the Standby is in Standby mode. The number of
channels configured should be such that it includes the channel numbers used by all the servers. For
example if there is one serverwith 25 channels and anotherwith 30, the standby server should be con-
figured with 30 channels. Or, another example, if one server has channels 1, 2, and 4, and another has
channels 3, 4, and 5, the standby server should have at least 1, 2, 3, 4 and 5. This is so that these chan-
nels can be viewed on the Standby server if needed andmatch the original channel numbers. It is not
necessary to configure the channel names (leave them as default camera 1, 2, etc) but make sure the
desired recording tracks are enabled and assigned to the samedisk letter for the same length of time as
the equivalent track in the logical servers.

To create the Backup camera types (which will be used when the machine is behaving as a ”standby”
machine):

• Go to ’Setup→Cameras’

• Choose ’CameraGroup’ tab

• Add a newgroup (name this ’Backup’ tomake it clearwhat it is for)

• Select the type ’Backup’ (which is a type used to make this camera available without doing any
new recording)

• Select the correct Disk, recording tracks, and recording duration

• Choose ’Cameras’ tab

• Click ’+’ iconmultiple times to add the number of desired channels, irrespective of whether audio
or video, on the other servers. They should all be put in the ’Backup’ group if that’s the only one
configured

• If the cameras are not all in the correct group, highlight them (click-drag over all those to change)
and right-click and select ’ChangeCameraGroup’ and select the correct group

• Save the changes

Note that if the cameras are assigned todifferent disksor recordingdurations are required, thenmultiple
groups should be created; the above procedure can be used to add cameras their respective groups.

If any of the physical servers are using Event Stream Recording, ensure that the standby server also
hasEvent Stream Recording enabled.

To ensure that anymap images, integrationmodules, or customsound files are available on theStandby
server, log in to the main server group and use the File Manager to download all files. Then connect to
the Standby server and upload those files. This ensures that any custom files will be available if/when
the standby server takes over from a failed server. See section 3.26 - FileManager.

Note that if you are using any licensed integrationmodules, the standby serverwill also need to be suit-
ably licensed such that it can run them if it takes over from a failed server.

It is a good idea to complete these preparation steps before adding the servers to the Failover group
(see below), because you don’t want failover happeningwhile doing the initial setup.

9.19.5 Setting up Failover: Failover Group
After the preparation has been completed, it is necessary to add all the servers to the failover group.
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Log intoonePhysical server andconfigure the list of Physical serversusing theView→Setup→Failover
screen. Add the main servers first (the ones which are already configured as logical servers) and add
the standby server (or servers) last. Configure the correct number of logical servers. It is best to leave
failover disabled until all servers are set up.

When adding these physical IP addresses, note the following:

• The physical IP addresses should be the first physical network interface on eachmachine.

• Ifusingnetworkbondingforall interfaces, thenthisshouldbethefirstbond interface, bond0. Con-
figure bonding before configuring any failover group or secondary addresses.

• Thephysical IPaddressesenteredhereneed tobeaccessible fromtheclientPCused toadd them
becauseWaveViewneeds tosend theconfiguration to theWavestoreserversvia theseaddresses.

Finally: enable failover and save.

Now failover is set up; the serverswill automatically restart if needed and failoverwill beworking.

If desired, add all the logical servers to a server group as described in section 6.8 - Server Group. If
you use the logical (secondary) IP addressees then, when failover occurs, the client will automatically
connect to the standby server.

Log into this server group to view all the servers.

Normally,make sure nothing is set to record on theStandby server (eg, noEVENT recording)when it’s in
standbymode. There is a special flagwhich allows recording and events to occur early on the Standby
machine, at the cost of longer failover times (it takes a few seconds longer): in this case youwill need to
add Prestart=y to the Failover configuration section.

Finally:

• Restart all the servers to ensure they read the failover settings correctly

• Check in the system log that theStandby server is reporting that it is a PRIMARYSTANDBY server.

• Check there are no issues in the system logs of the other servers.

When failover occurs and the standby server takes over, WaveViewmight report an error on login, stat-
ing ”Theserver’s identityhaschanged”. Thismechanism isused toprevent ”man-in-the-middle” attacks
and iswarningthat the real serverat theIPaddressyouused isn’t thesameserveras last time. Ofcourse,
when failover occurs this is expected. If WaveView is connected to a server groupwhen a server goes
offlineand failover occurs,WaveViewmay fail to automatically reconnect to the server due to thismech-
anism. Themechanism can be disabled inWaveViewby navigating to ”Tools→ Preferences→Security
→Check server public keywhen connecting”.

Failovercanbe triggeredquitequicklywhenaserver isdown, evenbriefly. Forexample, ifmakingconfig-
uration changes to a server, itmight benecessary to performasoftware restart (called ”Restart process”
inWaveView). Failover can trigger in this case, butwill revert to the original server once it is back up.

Note: Prior to V6.20, it was necessary to add a user called ”failoverserver” to all DVRs. This is no longer
required, and any such user is just a normal user now. On existing systems, you can keep this user if you
prefer or youmaydelete the user if theWavestore servers is onV6.20or later. For newsystems installed
with V6.20 or later, this user is not required, whichmakes it quicker to set up.
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9.19.6 Setting up Failover with IPv6
If only IPv6 addresses are configured for the Wavestore, then it’s necessary to use them for Failover.
Remember to use square brackets around the IPv6 addresses when setting up the Failover group. eg
[fd01::918].

If there isa ”dual stack”withbothIPv4andIPv6addresseson theWavestore, then it’snecessary tocon-
figure theFailover groupwith IPv4 addresses as thesewill be the ”primary” addresses of theWavestore.

9.19.7 Stopping Failover
If you have a server which was part of a failover group but now isn’t, especially a standby server, it’s
sometimeshard to disable failover becausewhen it has failed over to the other server configuration, any
edits are edits to the logical configuration, not the Standby server’s configuration.

There is an command to deal with this case (see Tools→ Execute Command):

• ifailover-disable

disables thefailoverconfigurationfromtheservereven if ithascurrently takenoveranother logicalserver’s
configuration. It also deletes any resources and saved configuration files cached on this server.

Typically use this when you need to repurpose a server and remove it from the failover group, but it can
alsobeused todisable failoveron theStandbyserver tocomplete theconfigurationof theStandbywith-
out it taking over another server.

9.19.8 Licences for Failover
All physical servers, including the standby server, should have their own licence for themaximumnum-
ber of channels on that server. Each licence should be of a sufficient level to support the Failover feature.
There is also a special ”standby licence” which can be used to specifically license a standby server, usu-
ally at a lower cost than a full licence. The ”standby licence” allows the standby server to take over from
a failed server in the group, but not to record itself independently when there is no failure in the group.
Note that a standby licence is not required, a normal licence with the appropriate number of channels
will alsowork.

Forexample, if thereare two logical servers, normallyonServer 1 and2with25and30channels respec-
tively, and a standby on Server 3: then Servers 1 and 2will need a normal licence for 25 or 30 channels
respectively andServer 3will need a licence for 30 channels so it can take over fromeither Server 1 or 2.
Licences are specific to the physical server, not to the logical server.

9.19.9 Failover on Event
Whilst failoverwill occurbydefaultwhenaserver in the failovergroupfailscompletely, it is alsopossible to
configure failover to occur on specific conditions, e.g. disk fault, using theWavestore event rules system
(see section 6.12 - Event Rules).

Simply configure a rule with an appropriate cause, such as ”Fault > Disk failure”, and set the Action to
”Force Failover”. Note, this only needs to be configured on the logical servers, not the standby server(s).

Note that if the rule is configured to trigger failoverwhena ”Fault” occurs, clearing theFault on the logical
server will return the server to its ”good” status, but the systemwill not automatically fail back. The pre-
viously failed serverwill need a restart to trigger that (Setup >Server > select the relevant server > Restart
Process).
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9.19.10 Network Failover
Network interfaces can be designed to fail over if a network interface or cable fails by grouping them
together using Bonding.

In the View→ Setup→Network screen, Add Bond Interface. Give this an IP address, and assignmul-
tiple physical network interfaces to be slaves of this logical device.
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9.20 Licensing and Machine ID and Virtual Machines
A Wavestore is licensed to use various features with a licence string which only works on one specific
machine. Eachmachine has aMachine ID, which looks like ABCD-EFGH-JKLM.

MostmachineshaveaSystemMachineID,which isdependanton thehardwareof thesystem. A licence
is specific to that machines. However, Virtual Machines (VMs) do not have a System Machine ID, and
therefore aHardwareDonglemustbeusedor aNetworkMachine IDgenerated, otherwise themachine
IDwill appear as ?!?!.

9.20.1 Hardware Dongle
To use aHardwareDongle, youmust first obtain one of the tiny USBDongles fromyourWavestore sup-
plier. Whenyou insert it into themachine, theMachine IDchanges to theMachine ID fromtheHardware
Dongle.

If you are adding the Dongle to a VM, it is usually necessary to tell the host system to connect the USB
dongle to the VM. A typical procedure (this is for VMWare ESXi) looks like:

• Insert the USBHardware dongle.

• Log into the VM console.

• Right click theWavestore VM and select ”Edit settings”

• Under the hardware tab click the ”add” button

• Add the USB controller ”UHCI + EHCI”

• Add the USB device ”Unikey HID”

Notes:

• You can’t share one Hardware Dongle with multiple Wavestore VMs on the same machine, but a
single Wavestore VM can do all the work needed so there is little point in having more than one.
The limitations are mostly network and disk throughput, and they won’t be improved by adding
VMs.

• It is, of course, possible to have other non-Wavestore VMs running on the same VMhost.

• Hardware Dongles can be used on any machine, not just a VM. They can be useful if you want to
move the licence fromonemachine to another.

Once the Hardware Dongle is inserted and connected, and the Machine ID obtained, a licence can be
obtained for thatMachine ID in the usual way.

9.20.2 Network Machine ID
An alternative to using a Hardware Dongle is a NetworkMachine ID.

To obtain a Network Machine ID (MID), the Wavestore will need to have access to the Internet and a
valid DNS and gateway configured. TheWavestore should also have the clock set to a timewithin a few
seconds of the correct time (typically with NTP). Once these conditions are met, if no other Machine
ID is available, then the network Machine ID will be generated automatically. Once the system has a
confirmed Network MID, it will attempt to continue with the sameMID providing it’s never considered
to be a duplicate.
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If a VM is cloned with identical parameters, the Network Machine ID will be cloned as well, and the re-
mote serverswill indicate one or other is a duplicate. There is a command ”newmid” which can be used
to force generation of a newMachine IDononeor othermachine if needed. This is rarely neededunless
the VMmachines are identical.

If a machine is replaced or reinstalled, the network machine id will remain the same. This can now be
determined immediately.

OnceaWavestore is givenaNetworkMachine ID, itwill attempt touse the sameMachine ID forever and
will poll the NetworkMID servers once an hour to check the validity. These checksmerely ensure there
arenoduplicateMachine IDs tominimiseany issuesofdowntime. Inadditionyougetup to5daysgrace
when your network goes down. The period your network can be down is increased by an hour for each
hour it’s beenup, to amaximumof5days, anddecreasedbyhour for eachhour thenetwork is down. So
if it was up for 3 days, then down for 12 hours, then up for an hour, you still have 2.5 days left before the
licence times out. If theNetworkMachine ID validity cannot be confirmed after this period then licence
will time out. Faultmessageswill be produced towarn of this issue.

If youneedaVMwithaMachine IDwhichdoesnot require anetwork, thenuseaUSBHardwareDongle.
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9.21 Sort IDs
Sort IDs are used to give a unique number for every channel within a server group.

For example, imagine youhave2 servers in a groupandeachonehas50channels. Bydefault, the chan-
nels 1 to 50 on both serverswill have Sort IDs 1 to 50.

The recommendedway to set it up is to change theSort IDs for server 2 so that they become51 to 100.

This is useful for many reasons, one example being when using a PTZ joystick to call up cameras. With
uniqueSort IDsacross thegroup, in our examplegroupabove, if youcall upchannel 61 you’ll get channel
10 on server 2.

Another reason forSort IDs is that in our experience, existing installationsoftenhave anexisting camera
numbering scheme, but technical issues mean that the channel numbers on the Wavestores can be
forced. For example, if an installationhas 12analoguecamerasand4IPcameras, a 16-channel analogue
capture card is required. The system will then end up with channels 1-12 and 33-36 (because 1 to 16
are the analogue cameras and 17-32 the analogue audio channels). But the customermight prefer the
cameras to just be numbered 1 to 16. Sort IDs allow this.

Note: Sort IDs are generally only used for presentation to the user in the user interface. Internally, the
real ”Channel IDs” are generally used. For example, if you are configuring linked audio - to link a video
channel to an audio channel - the real channel number is supplied in theCameras Setup screen.
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9.22 Working With Joysticks
Wavestoreprovidessupport for anumberof joystick/keyboardcontrollerdevices. TheWavestoreGlobal
Sales Teamcan provide advice on the currently supported products.

Usually the joystickwillbeautomaticallydetectedandenabledbyWaveView,however thiscanbechecked
and edited in the Tools > Preferences > System Settingsmenu of WaveView. It may be necessary to
restartWaveView after changing this setting.

9.22.1 Loading Layouts
The Wavestore system has the concept of per-user layouts and shared (system-wide) layouts. Each
layout has an ID number, so for example you might have layout 1 for your user, and a shared layout 1.
Therefore, to open a shared layout, the layout ID should be prefixedwith a zero.

For example:

• To load personal layout 5, the operator presses ”Layout Selection”, 5 and thenOK.

• To load shared layout 5, the operator presses ”Layout Selection”, 0, 5 and thenOK.
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10 Technical Support

10.1 Introduction
TheWavestorewebsite http://www.wavestore.com contains technical information and FAQ sections.

For further technical assistance, please email support@wavestore.com, or call theWavestore Technical
Support line in the UK (+44 1895 527 127, Monday-Friday 0900-1730).

BeforecontactingWavestoreTechnicalSupport, pleasenote theserial numberofyourWavestoreserver
(Wxxxx). This is normally located on awhite label on the front or rear panel of the server. Please also take
a note of the server software currently installed (menu path View→Setup→Server→ Version).

In order to resolve certain issues, it may be necessary for Wavestore staff to log into the Wavestore
servers remotely via an external internet connection.

10.2 Frequently Asked Questions
I connect and power up theWavestore server, but nothing is displayed on the monitor.

Does theWavestore server ’beep’ shortly after it is powered up? If not then there ismay be a hardware
failurewithin the graphics card or themotherboard.

I connect my monitor to the Wavestore server and watch the server boot normally, but the final
screen is not viewable i.e. either a blank or noisy picture.

Once the server has completed booting up, press CTRL + ALT + BACKSPACE to reconfigure the output
resolution.

Cannot login using theWaveView client on the server box itself, using server name ’localhost’?

This can be caused by the configured IP address on the server clashingwith the IP address of another
deviceon thenetwork. In the ’Server’ fieldon theLoginDialogbox, replace ’localhost’with theIPaddress
127.0.0.1, and you will now be able to login. Section 6.2.2 - Network describes how to reconfigure the
server IP address if required.

Why can’t I connect to myWavestore server from a remote client Windows PC?

Firstly, trying pinging the Wavestore server from your PC (Start Menu → Command Prompt → ping
[Wavestore server IP address]). You can confirm the Wavestore server IP address settings by follow-
ing themenu path View→ Setup→Network. If the server does not return the ping, there is likely to be
network connectivity issue between the PC and the server.
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To check the server, configure a fixed IP address on your PC that is in the same address range as the
server, connect the PC to the server using a crossover cable, then try pinging the server once again.

If the server returns the ping, then the problem lies on the network connection between the client PC
and the server.

If the server does not return the ping, the faultmay liewith the server itself.

I havemultipleWavestore servers networked together and I’mviewingcameras on a remote client
PC. The screen textdisplays25ips, but sometimes the actual displayed rate seems tobe lower than
this?

This is likely to be due to network bandwidth limitations, if several remote clients are connected to the
Wavestore server. As a consequence, the camera images displayed by the remote clients are refreshed
less frequently. A user can select to view a lower resolution video stream for that camera, by selecting
this from the Video Display Toolbox, as described in section 3.6.2- Video Display Toolbox.

In addition, each user of the system can be configured with a bandwidth limit; to set this up, follow the
menu path View→ Setup→ Users screen, highlight the user that you wish to configure, and then re-
configure theMaximumBandwidth setting.
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11 Appendix A - Technical Glossary

ADMINISTRATOR Systemoperatorwho can allocate restrictions and passwords to other operators

BANDWIDTH Quantity of datawhich can be carried in a given time period

BNC Standard connector used to connecting aWavestore server to coaxial cable (e.g. analogue cam-
era)

CAPTURE DEVICE Ameansof capturing video andother data fromaphysical capture card or over the
network

CLIENT A remote device connecting to theWavestore server

COMPRESSION RATIO The level of compression to be applied

CROSSOVER CABLE Anetwork cablewith the TX pin at one end connected to the RXpin on the other
end, and vice versa

DHCP Dynamic Host Configuration Protocol; enablesmanagement and automation of IP address as-
signment in an IP network

DIGITAL INPUT Incoming digital signal from external equipment

EVENT An occurrencewhich is detected by theWavestore server

GATEWAY A network point that acts as an entrance to another network

GPU TheGraphics Processor Unit component of a PC

GOP Used in H.264 and H.265 compression; Group of Pictures is the number of ’P’ frames referring to
an ’I’ frame.

HTTP HyperText Transfer Protocol; amethod of delivering data over a TCP/IP network

IMAGE CLIP Recorded activitywith specific start and stop times

INSTALLER A special, high-level operator; permitted to performmaintenance tasks

IPS Images per second

IP ADDRESS Address of a PC/server on a network; the device address is unique on that network

ISDN Standard for digital transmission over telephone lines

LAN Local Area Network (normally 100Mbps)

LOCAL Activity at theWavestore server itself

MASK A specific area of an image protected frommodification
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MJPEG Motion JPEG, a streamof individual JPEG images

MOTHERBOARD Themain board in a computer that contains the computer’s basic circuitry and com-
ponents

NTSC Analogue television/CCTV video standard used in the USA, Far East and other areas

NTP Network Time Protocol; synchronizes the time of devices on a network

OPENGL A technology used byWaveView for improving graphical performance by utilising the graph-
ics card (GPU)

OPERATOR Auser, administrator or installerwith associatedpassword, permitted touse theWavestore
system

PAL Analogue television/CCTV video standard used in Europe and Australasia

PCI A type of expansion slot found onmostmodernmotherboards

PRESET A set positionwhich is stored in a dome camera for quick recall

PTZ Pan/Tilt/Zoom; refers to remotely controlled dome cameras

RAID AcronymforRedundantArrayof IndependentDisks; a standard fordata storage;Wavestoreuses
RAID to enable high volumes of data storage

RELAY OUTPUT Outgoing digital signal to external equipment

REMOTE Activity at the client PCwhen networked to theWavestore server

RESOLUTION The number of pixels in an image; higher resolutionmeans amore detailed image

SATA Standard electronic interface between a motherboard’s data paths or bus and the computer’s
disk storage devices

SCHEDULE Adescription ofwhether certain features should be active or inactive during a certain time
period

SCSI Interface that enables communicationwith peripherals including disk drives

SERVER Network term for aWavestore digital video recorder

SPOTMONITOR Analogue CCTV display, connected to a dedicated output separate from the main
VGA output

STORAGEMEDIUM Device used for storage of data, e.g. CD-R, DVD-R, hard disk, USB device

SUBNET MASK Related to IP address, gives information about server locations on a network

TCP/IP TransmissionControlProtocol/InternetProtocol; thebasiccommunication languageof theIn-
ternet

TOUR A series of presets and timing information, to cause a dome camera to follow a set path

USER The lowest level of operator, with limited permissions

VGA/SVGA Display resolution standards formonitors

VMD Visual Motion Detection
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12 Appendix B - System Log Messages

Startup Messages
S Disk<X>: Recover successful: master index fully recovered

Successmessageafteradiskhasbeenrecoveredand isnowoperatingnormally. Thestatusof the
diskwill be shownasGOOD.Normally thismessage is only output after a type3 recover operation
(after a serious loss of data required specific attention to recover).

S Disk<X>: Recover successful: master index mostly recovered (<N>/<T>)
Successmessage after disk recoverywhich had only partial success.

SMirror: connected to mirror <M>
TheWavestore ismirroring some of the disks to another device. This is an obsolete function.

S Power off on user request
TheWavestore is switching itself off in response to a user request.

S Rebooting on user request
TheWavestore is rebooting in response to a user request.

S Restart after disk shutdown
Ashutdownandrestartwasdetectedby thedisksubsystem,but thiswasonly thedisksubsystem
not the entireWavestore. Typically this is because the disks have been reconfigured or formatted.

S Shutdown
TheWavestore server shutdown by an unknown reason at this time. This message is generated
on startup based on the timeof last activity, so the timestamp is usually earlier than the position of
themessage in the log.

S Shutdown by system (<REASON>)
The Wavestore server shutdown and restart for a system reason. There are a variety of reasons
which cause automatic restarts, includingNetwork Licencingwhen the licence beomes valid and
Failoverwhen it switches back to standby.

S Shutdown by user <USER>
TheWavestore server shutdownunder user request, possibly because it is rebooting after an up-
grade.

SWavestore Server v<VERSION> starting
TheWavestore server started.

S <DEVICE>: Streaming images from ’<IP>’ port <PORT> rate <RATE> ips (approx)
Acameraor similar device started streamingover thenetwork from<IP>:<PORT>. The rate is com-

414



puted as <RATE> images per second based on the rate the images arrive, whichmight not neces-
sarily be the same as the ratewhich is configured: see the camera documentation for details.

Information Messages
I Applying settings to RAID card <CARD>

A configuration change is occurring to a RAID card.

I Camera <C>: Firmware upgrade succeeded: firmware version <VERSION>
The upgrade to the firmware on the camera appears to have succeeded.

I Camera <C>: User <USER> controlling PTZ
Information that a user has moved a Pan/Tilt/Zoom camera. Each camera is logged separately.
Any subsequent operations within the time period (5 minutes) will be treated as the same oper-
ation unless a different user starts using the camera PTZ. After the time period has expired, any
subsequentmovementswill be logged again.

I Closing all disks on user request
Before a disk configuration change, all disks are closed down and reopened.

I Configuration deleted
When uploading a configuration file, the old one is completely deleted first.

I Configuration edited in <APPLICATIONNAME> Configuration screen
Thismessage indicates that the subsequent configuration changewas performed in theConfig-
uration setup screen of <APPLICATIONNAME>

I Configuration file loaded from <APPLICATIONNAME>
This message indicates that the subsequent configuration change was performed by loading a
configuration file using <APPLICATIONNAME>

I DiskArray<DISK>: HyperRAID rebuild complete
In a HyperRAID array, after a failed disk has been replaced, a rebuild will start. This message is
outputwhen it completes and the disk array is no longer degraded.

I DiskArray<DISK>: HyperRAID rebuild of <DISK><N> starting
In a HyperRAID array, after a failed disk has been replaced, a rebuildwill start.

I DiskArray<DISK>: HyperRAID rebuild <DISK><N> continuing
In a HyperRAID array, if a power cycle or restart occurs during a rebuild, it will restart when the
Wavestore restarts.

I DiskArray<DISK> is degraded
In aHyperRAIDarray, if a disk has failed, the array is no longer considered ”good”, but is ”degraded”.
It is still fully usable and no data is lost, but the failed disk should be replaced as soon as possible.

I Disk<DISK>: iSCSI: Target remounted and opened ok
The remote ISCSI diskwasmounted and isworking ok.

I Distro <DISTRO>
The version of theWavestore operating systemdistribution

I Email: Email to <Recipient> sent successfully
If Email has been configured, it has been sent
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I Error flag cleared by user <USER>
Once an error has been reported, the Error flag (usually a red blob on the bottom of the screen) is
shown until it’s explicitly cleared. Thismessage is outputwhen it’s cleared.

I Event match table <NAME> loaded
Events can now match against a file of entries, this informs the user that such a table has been
loaded. Use the filemanager to load and delete these tables.

I Failover group with <N> physical servers and <M> logical servers
Onstartup, the sizeof the failovergroup is reported. Normally there aremorephysical servers than
logical ones, and these extra ones are the standby servers.

I Failover: taking role of logical server <N> (<NAME>)
When amachine fails, and a standby server is available, it will take over the role of one of the logical
servers. Thismessage is outputwhen this happens.

I Failover: this server is an AUXILIARY STANDBYmachine (physical server <N> is PRIMARY STANDBY)

If there is more than one standby servers in a failover group, then we want just one to be ready
to take the place of a failed machine and all the others will wait their turn. These others are called
AUXILIARY STANDBYmachines and one will become primary standby if the primary standby ei-
ther fails or is becomes another logical server.

I Failover: this server is PRIMARY STANDBYmachine
This is themain standby server in a failover group.

I File: Limited to <MAX> cameras
The File playback device is limited to <MAX> cameras.

I Finished Native Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

ANative (WSB) export has completed.

I Finished Pass-through Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

A pass-through export has completed. This is when the original video data is simply written to
file.

I Finished Transcoded Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

A transcoded (e.g. AVI, MP4) export has completed.

I Hard Delete of all disks complete
If you have run the hard delete command, thismessagewill be outputwhen it completes.

I Hard Delete of <DISK> complete
If you have run the hard delete command, thismessagewill be outputwhen it completes.

I Hard Delete of <DISK> starting
If you have run the hard delete command, thismessagewill be outputwhen it starts.

I IP address <IP>
Information aboutwhich IP addresses are available on interfaces on thisWavestore.

I Last shutdown occurred around <TIME>
TheWavestoreservershutdownbyanunknownreasonat this time. Thismessage is timestamped
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at startup but contains a secondary timestamp of the last shutdown time.

I Licence: <FLAGS>
This logmessages shows the licence flags (showing the number of channels licensed).

I Licence: unlicensed
TheWavestore is not licensed, eitherbecause it’s newandyouhavenot enteredone in theLicence
screenorbecause ithadatime limited licencewhichhasrunout. Ifyouareusinganetwork licence
then youmight need to enter the ”oldmid” or ”newmid” commands to restore an oldMachine IDor
create a newone, see the network licence documentation.

I MegaRAID: Creating new RAID volume DiskArray<DISK>: <UNFO>
RAID volume creationmessage

I MegaRAID: DiskArray<DISK>: Deleting array
The array has been deleted by a user altering the configuration. Normally this can be recovered by
recreating the array.

I MegaRAID: Disk <DISK> being reincorporated
RAID volume reincorporationmessage: SeeMegaRAID documents for details.

I Mirror: disconnecting from <M>
Mirroringmessage. Obsolete.

I Mirror: lost connection to mirror <M>
Mirroringmessage. Obsolete.

I Native Export: <USERNAME>@<IPADDRESS> - <FILEPATH>
This is a status message which is reported after an export starts or finishes, to document the file
path.

I Network address <IP> (interface <IF>) mac <MAC> speed <SPEED> Mb/s
Information about the network link: this shows the IP address and MAC address for a specific
interface and the current speed negotiated for this link. If it’s a bond interface, the speed is the
aggregate of all the slave linkswhich are currently up.

I Network Link (<IF>): speed was <OLDSPEED> now <NEWSPEED>
Shows the network link speed changed; usually this is because a bond has lost a slave link, but it
might be because a cable or connector is inadequate and a lower speed has been negotiated.

I Network slave (interface <IF>) master <MASTER> mac <MAC> speed <SPEED> Mb/s
Information about the network link for interface <IF> which is a slave interface to master <MAS-
TER>. Shows theMAC and the link SPEED of this link alone.

I Notify<N>: protocol=<PROTOCOL>, type=<TYPE>, client=<CLIENT>, dialout=<DIALOUT>, password <PASSWORD> chars long

Notification setup logmessage.

I NTP: Changed NTP server to ’<IP>’
The configuration of the NTP server used has been changed to the specified server.

I Pass-through Export: <USERNAME>@<IPADDRESS> - <FILEPATH>
This is a status message which is reported after an export starts or finishes, to document the file
path.

I PTZFIdleAction=<A> unrecognised in section <SEC>
The configuration contains a corrupt parameter.
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I PTZF idleTimeout increased to 5 seconds
The configuration contains an idle periodwhichwas too short and has been increased.

I Reboot required to complete configuration changes
After amajor configuration change it is necessary to reboot the computer. Thismessage is logged
as information only in the casewhen this occurs.

I Reloading Stretch driver
The ”Stretch” AnalogCamera card is reloading, usually because it stopped.

I Restart required to complete configuration changes
TheWavestore sometimes requires a restart to complete a configuration change. This message
is output if a restart is needed.

I <DEVICE> Camera <N> IP=’<IP>’
Camera startupmessage.

I <DEVICE>: Capture device started ok
Camera or device startupmessage.

I <DEVICE>: Connected to ’<IP>’ port <PORT>
Camera or device connectionmessage.

I NTP: Slewing time by <N> seconds (stratum <ST>)
It’s important to have correct time on a Wavestore so images are correctly timestamped, but it’s
even more important to keep time ticking forwards and not have it jump forward or backward.
When NTP is enabled, any time errors are slewed gradually until the time is correct. For errors of
around a second, a slew rate 1:60 is used (1 second corrected eachminute).

I <DEVICE>: <N> virtual spot monitors enabled
Spotmonitors have been enabled on a virtual spotmonitor device.

I Starting Native Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

A native (WSB) export has started.

I Starting Pass-through Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

A pass-through export has started. This iswhen the original video data is simplywritten to file.

I Starting Transcoded Export: <USERNAME>@<IPADDRESS>, start:<STARTDATETIME>, end:<ENDDATETIME>, (<CAMERANUMBER>.<TRACKNUMBER>) ’<CAMERANAME>’

A transcoded (e.g. AVI, MP4) export has started.

I NTP: Time synchronised (stratum <ST>)
WhenNTP is enabled, and there is nosignificant error, then the time is said tobesynchronised. The
clock rate is adjusted fractionally to ensure it remains correct.

I Temporary network IP disabled
Thismessage is outputwhen the temporary IP address (set by arp-ping) is no longer available.

I Temporary network IP <IP>
When setting up aWavestore, a temporary IP address can be set using the arp-pingmethod.

I Time slew completed
NTP indicating time slew has completed. See ”Slewing time” above
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I Time will slew by <N> minutes
NTP indicating a rapid time slew has started.

I Time will slew slowly by <N> milliseconds
NTP indicating a slow time slew has started.

I Time will slew slowly by <N> seconds
NTP indicating a normal time slew has started.

I Transcoded Export: <USERNAME>@<IPADDRESS> - <FILEPATH>
This is a status message which is reported after an export starts or finishes, to document the file
path.

I Upgrade: delete package: <PACKAGE>
Upgraded information: a package is being deleted

I Upgraded: <PACKAGE>
Upgraded information: a software package has been upgraded

I Upgrading NVIDIA graphics driver as previous driver was automatically removed via upgrade
After an upgrade, if an old version of the proprietary NVIDIA driverwas installed and had to be re-
moved to complete the upgrade, the newonewill be installed automatically. This log line indicates
that the new installation is in progress.

I User <USER> FORMATTED Disk<DISK>(<PATH>)
A disk or disk array has been formatted or reformatted by the specified user.

I User <USER>: Rebooting server
The user has requested a reboot.

I User <USER>: Restarting server after update or on request
The user has requested a restart or an upgrade has completed (which causes a restart). Occa-
sionally thiswill result in a reboot aswell if major changes have beenmade.

I User <USER>: Shutdown server
The user has requested that theWavestore is shut down.

I Video Authentication: Signing enabled, <N> bit key
Video Authentication is enabled.

Fault Messages
F Analytics<DEV>: Analytics from camera <C> failed to stream

When using an analytics device, the device will stream video from theWavestore and the Wave-
storewill then streamanalyticsmetadata from the analytics device. This indicates that theWave-
store cannot streamdue to an error.

F Analytics<DEV>: failed to connect
this indicates that theWavestore cannot stream from an analytics device as it cannot connect to
the device.

F Analytics<DEV>: please upgrade analytics to latest version
This indicates that theWavestore cannot streamfromananalyticsdevicebecausea softwareup-
grade is required.
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F Authentication: Key and Certificate do not match
Anerror occurredwhen loading a key/certificate, probably because the keywas regenerated after
the certificate request was generated or the wrong certificate loaded. If it cannot be resolved by
loading the correct certificate, regenerate the key/certificate request pair again (exactly once) and
get the new key (certificate request) signed.

F Cannot allocate buffer! Buffer pool fully used
An internal errorwhichusually causedby toomanychannels in use on amachinewith inadequate
RAM. Contact technical support if this persists.

F Cannot downgrade OS to this version as UEFI is not supported
Indicates that thecurrentsystemisusingUEFIandcannotbedowngradedto the requestedolder
version, since UEFIwas not supported in that version.

F Clock has jumped backwards by a large amount!
It is possible for theWavestorebattery-backedhardwareclock tomalfunctionwhen it is rebooted
or powered off. To prevent the loss of footage in this case a fault is raised. The correct action is to
reset the clock to the correct time and then it should be ok. If it continues to show this after any
power cycle, then it is likely to be a hardware issue: probably a flat battery.

F Configuration file uses X PullPoint event cause in event rules
Recommended course of action: Go to ”Setup | Event Rules” and find any rules where the event
cause starts with X. Delete these rules and reprogram them since theywill no longer work. If the
desired event cause cannot be found in the list, contactWavestore support. Background: In ver-
sion 6.8 if PullPoint was enabled for an ONVIF camera and the camera sent an event type which
wasunknown toWavestore (whichmostwere), theywould be passed throughby the serverwith
an ”X” prefix andwould be available in the Event Rules screen for users to program rules with. For
example, if aCanoncamerasent ”LineCrossing”, theWavestorewould look itup in thedevicedatabase,
fail to find it, but thenmake it available as an Event Cause called ”XLineCrossing”. Usersmay have
programmed event rules based upon this. For many cameras known event causes have now
been added, so ”LineCrossing” now gets passed through as ”LineCrossing”, or something simi-
lar. Any unknown event causes from the cameras are discarded by default fromversion 6.10. This
is the desired behaviour, to actively add known event causes to the device database and ensure
they’re consistent. For example, some camerasmight send ”LineCrossed”, so theWavestore de-
vice databasewill map it to ”LineCrossing”, so all different cameras show upwith the same terms
when setting up the event rules. In v6.10 there is a new ”flag” <A> for the Camera request string to
force the old behaviour of letting all event causes through, with the X prefix if not known. Adding
this flag is an alternative course of action if the recommended course of action above is not desir-
able for some reason

F CopyTrack: no matching source found for server ’<SERVER>’: not copying
The copytrack has failed due to the parameters being entered incorrectly.

F DiskArray<X> has failed
A disk array has failed. It is not recoverable and the data is lost.

F DiskArray<X>: Too Many Failed Disks
Toomany disks in a RAID array have failed, for example if 2 disks out of an N+1 (RAID5) array both
fail at the same time, then it is not possible to recover any data and a reformat is needed.

F Disk<X>: Another program is accessing the database
If the Wavestore server believes another program is accessing the same disk, it will output this
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message. In very rare cases this is seen on a sudden restart. Normally itwould indicate a configu-
ration error.

F Disk<X>: Another program is writing to this disk; aborting
Thismessage is produceed if twoWavestores arewriting to the samedisk, or if two programs are
running on oneWavestore. Writes to the disk could cause corruptuon, sowrites are not allowed.

F Disk<X>: Attempting to record to missing disk
This is caused by a configuration error of the removal of a diskwhich the system is recording to.

F Disk<X>: Authentication error
For network or cloud disk storage, this indicates authentication errors occurredwhen attempting
to access the remote disk.

F Disk<X>: disk array DEGRADED
The disk array specified has a fault with one of the disks: the array is operating in a fully functional
but degraded state. The faulty disk should be removed and replaced as soon as possible when it
will enter a REBUILDING state. See also the knowledge base article: ”Why do newdisks fail?”.

F Disk<X>: disk or disk array not present
Disk array does not appear to be present. This is typically seen when using MegaRaid or simular
disk arrays, possiblywhich have been set up in an unexpectedway by an external tool, and the re-
sult is that thearraydoesnot appear tobepresent toWavestore. Thesolution is usually toexamine
the disk array using the tools it was originally set up using, or delete the array and useWavestore
to set up the array.

F Disk<X>: disk <X><PATH> appears bad; not using
Diskhasshownerrors. Sometimes this is seenwhensettingup, because thediskhasnotyetbeen
setting up. Sometimes this is seenwhen inserting a new disk, because the disk has not yet been
fully inserted. In both cases the solutiion is to complete setup and/or click Add SwappedDrives.

F Disk<X>: disk <PATH><XX> is too small (<N>KB when <M>KB needed); not using
Use a bigger disk. Themessagewill tell you howmuch is needed.

F Disk<X>: Error mounting nfs://<PATH> as <XX> (code <NN>; <MSG>)
Errormounting an NFS disk.

F Disk<X>: Error mounting <PATH> as <XX> (code <NN>; <MSG>)
Errormounting a disk.

F Disk<X>: Error mounting smb:<PATH> as <XX> (code <NN>; <MSG>)
Errormounting an SMB (Window share) disk

F Disk<X> is corrupt: autorecover started
Auto recovery ofmaster indexes has started.

F Disk<X>: Last recording was in the future!
To prevent the loss of footage in this case a fault is raised if the footage appears to be in the future.
See ”Clock has jumped backwards by a large amount” above.

F Disk<X>: Maximum number of channels on one disk volume exceeded
The old MTable3 has a maximum number of 511 channels on one disk volume. This includes any
channels which have been set up even if no images have been written, and typically 4 channels
per camera are set automatically by thedefault camera group. Solutions is to disable the channels
which are not required in the camera group, and restart the server, or distribute cameras over a
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number of disk volumes. Each disk letter corresponds to a disk volume. The newerMTable4 stor-
age systemhas no such limit but this is not the default storage system in this version.

F Disk<X>: Maximum number of channels on one volume exceeded
The old MTable3 has a maximum number of 511 channels on one disk volume. This includes any
channels which have been set up even if no images have been written, and typically 4 channels
per camera are set automatically by thedefault camera group. Solutions is to disable the channels
which are not required in the camera group, and restart the server, or distribute cameras over a
number of disk volumes. Each disk letter corresponds to a disk volume. The newerMTable4 stor-
age systemhas no such limit but this is not the default storage system in this version.

F Disk<X> not formatted or corrupt
A disk is not used because it is not formatted or corrupt. Normally the solution is to format it.

F Disk%s: Path ’%s’ did not match a valid disk type
The disk setup string is invalid and begins with an invalid prefix; this might be seen when down-
grading to earlier softwarewhich does not support the feature.

F Disk<X>(<PATH>): disk failed
A disk has failed. This should be replaced and the replacement formatted.

F Disk<X><N>(<PATH>): disk failed
Adiskhas failed. If this is aunitof adiskarray, then thediskarraybecomes ”degraded” andwill con-
tinue to function normally if there are still adequate redundant disks. It is recommended the disk
is replaced as soon as possible. If a Hot Spare or Warm Spare is available, then the replacement
will automatically occur immediately (but youmightwant to replace the spare).

F Disk<X><N>:(<PATH>) is about to fail and should be replaced
A disk has failed it’s SMART tests and is considered to be likely to fail.

F Disk<X><N>:(<PATH>) is too hot (<DEGREES>C)
A disk has got very hot. The temperature reported by SMART is shown.

F Disk<X>: Transfer error
An errorwas seenwhen transfering data from an external disk-like system.

F Email sending script failed to run correctly. Check debug log messages.
This suggests theremay be a problemwith the softwarewhich sends out emails. Please capture
the System Log including Debugmessages and report it to theWavestore support team.

F Encryption disabled because invalid [Encrypt_1 key]
Pleaseensure that theencryption keyentered into theconfiguruation file is valid; haveyouentered
thewrongtypeofkey? Until the issuewith thekey is resolved, theencryptionhasbeentemporarily
disabled.

F Error in configuration file
The configuration contains an unspecified error, probably because it was edited manually. If this
proves to be a problem, restore an old configuration andmake any required changes again.

F Failover: Could not take over server <N> because configuration file not available
Ina failovergroup, theStandbyservercollectsdetailsofall theworkingserversso itcantakeover in
case of failure. If it detects a failure for a serverwhich it has not been able to load the configuration
details from, then it will not be able to take over. This will only occur on configuring the Failover
group, probably because the failed server failed immediately or prior to the configuration of the
Failover group.
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F Failover disabled due to configuration error
If Failover is enabled but the configuration is incorrect, the entire failover systemwill be disabled
and this errorwill be produced.This is preferable to it behaving in a confusinglymanner becauseof
themisconfiguration. More detail about the issuewill be found in the Failover log.

F Failover: Disk FAULT: enter FAILURE state
The failure of an entire disk array or a single disk not in an arraywill trigger failover; this failuremes-
sage is producedwhen this is triggered. Note that a single disk in a redundant arraywill not trigger
failover providing the array is still usable.

F Failover: Event triggered FAILURE condition
It is possible to configure an event to trigger failover; this failuremessage is producedwhen such
an event is triggered.

F Failover: physical server <N> failure while in standby
A faultmessage produced by a primarywavestorewhen a standby has failed.

F Failover: physical server <N> (<IP>) has failed
A faultmessage produced by a standbywavestorewhen a primarywavestore has failed.

F Failover: This server’s IP address (<IP>) not in Failover server list
The failover system is badly configured. Refer to themanual for restrictions on IP addresses used
for configuration: in short, the first interface which has an IP address on each Wavestore will be
used for Failover and this should be the address configured in the Failover list.

F Failover: Time difference on servers in failover group: <SECONDS>s
Indication that the time is not synchronised between servers in a failover group. This will lead to
confusing results and footage recorded at different times on different servers when failover oc-
curs. Configure NTP to ensure all are synchronised.

F Inadequate main memory: at least <N>MB of RAM required
More RAM is required.

F Invalid Protocol string (Protocol=%s)
The Protocol= line in the configuration file is incorrect

F iSCSI: Failed to connect to iSCSI target
The system will attempt to connect to any iSCSI drives when it first starts up. This message is
given if it fails. Check the iSCSIdriveor drives are functional and thenetworkconnectivity to them
is good.

F Jumping time immediately in this exceptional case
Normally the serverwill slew the time slowly if it iswrong, so no jumps occur but it’s brought back
to being correct as soon as possible, but it is possible to get it to jump if the gap is too great to
slew and the user explicitly requests a jump. This message will be output if it jumps. It’s a FAULT
message to indicate normal operation did not occur at this point.

F Kernel crash dump exists in /var/crash
Indicates that a serious issue has occurred in the operating system. This is usually indicative of
faulty or unsupported hardware.

F Kernel: Out of memory: restarting process
There is an issuewithmemory and a process has been restarted. No immediate action is needed
as the systemwill continue to operate as normal after the restart. This is rare, but usually indicates
a problem, so it should be reported to support@wavestore.com for investigation.
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F Licence expired
The licencewas a subscription or time limited licence and it has nowexpired. Youwill need to pur-
chase a new licence.

F Licence: OPLP incompatible with Network Licensing
If you are using an On-premise licence proxy (OPLP), you cannot configure network licensing
which requires access to the central licence server to confirm the licence. Network licensing is
mandatory for virtualmachines.

F Licence: This version is newer than AUD permits: upgrade licence or downgrade software
Theupgradebundles arenowcontrolledusingdates (”AUD”) andyouhaveupgraded toonewhich
ismore recent than you are permitted.

F MachineID rejected (Server returns FAIL)
A network-validatedMachine ID has been rejected by the licence server. This probably indicates
you have cloned a virtual machine and not reset themachine id using ”newmid” command. Con-
tact technical support if you are not on a virtualmachine.

F MegaRAID: Manual action required
The old MegaRAID cards can get into states where manual action is required with storcli com-
mand: seeMegaRAID documentation in theWavestoremanual.

F MegaRAID: Manual action required to delete old RAID array - THISWILL LOSE DATA
The old MegaRAID cards can get into states where manual action is required with storcli com-
mand: seeMegaRAID documentation in theWavestoremanual.

F NASDisk<DISK>(<PATH>): disk failed
ANetwork Disk has failed or the link to it is down.

F Network: failed: check cables connected and disable unused interfaces
The network checking code has detected a failure on one of the network interfaces. Probably this
is due to an unused interface being enabled. A typical case is that a network interface is enabled
and set to obtain an IP address automatically, but not connected to a networkwith aDHCPserver,
so it fails to obtain an address. The solution is to disable any unused interface or configure an IP
address manually. An alternative to disabling unused interfaces is make them all slaves to a bond
interface and only configure the IP address on the bond interface.

F Network Link (<IF>) Down: speed was <OLDSPEED> now <NEWSPEED>
Shows the network link has gone now down and is no longer working; usually this is because a
cable has been removed.

F OPLP enabled but no [SysMonitor S1 address configured]
To use an On-premise licence proxy (OPLP), youwill need to configure it’s address as S1which is
the same server as theOn-premise healthmonitoring server.

F Out of memory: Cannot allocate data buffers
This should never occur and if it does contact technical support.

F Restarting server to recover from recording problem
Veryrarely theWavestoreserverwill encounteraproblemwhichcanbestberesolvedbyrestarting
or rebooting to reset the hardware, and a restart or reboot will automatically occur to resolve the
issue. Thismessagewill be produced.

F %s: Camera dropped out, check the connection
Normally if a cameradropsout, the serverwill attempt to reconnect to it. If it reconnectspromptly
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andthengoesonworkingwithoutneeding intervention, no fault is raised, butmessagesare logged
in the camera-specific log file if this happens.

F %s: Camera dropped out several times, check the connection
Normally if a cameradropsout, the serverwill attempt to reconnect to it. If it reconnectspromptly
andthengoesonworkingwithoutneeding intervention, no fault is raised, butmessagesare logged
in the camera-specific log file if this happens. If the camera drops out more than would be ex-
pected, to theextent thecameraornetworkmighrbe faulty andneedattention, this faultmessage
is produced.

F %s: Camera returned Unauthorized: username or password is wrong
The username or password used to access a network camera has been rejected by the camera.

F <DEVICE>: Camera type is incorrect (NTSC or PAL)
On analog cameras, the type should be set to the same as the camera. Usually this is set for the
entiremachine.

F <DEVICE>: Cannot connect to board (<ID>)
Hardware issue. Contact technical support.

F <DEVICE>: Cannot create channel <ID> (<INFO>)
A channel cannot be created on amultichannel device (typically an analog camera); if this persists
attempt to restart the server and if still a problem contact technical support.

F <X>: Cannot create DECODE channel <C> (chan_num <N>) (<D>)
Decode error for an Analog VideoOut device. Obsolete.

F <DEVICE>: cannot have more audio channels than video
Usually shown by amisconfigured device. If it persists, contact technical support.

F <DEVICE>: Cannot load firmware ’<FILE>’ (<INFO>)
Usually shown by amisconfigured device. If it persists, contact technical support.

F <DEVICE>: Cannot open audio OUT device <DEVICE2> (<INFO>)
Usually shown by amisconfigured device. If it persists, contact technical support.

F <DEVICE>: Capture card failure
Indicates a capture card is notworking. If it persists, contact technical support.

F <DEVICE>: Capture card not working properly
Indicates a capture card is notworking. If it persists, contact technical support.

F %s: Could not connect to camera
A network connection cannot be made to the camera. Check the camera is functioning and the
network connectivity is good.

F <DISK>: Disk is too slow (<RATE> MB/s): data lost
There is an issuewith the disk or disk volume and data is being lost. This might be because there
is too much being recorded to this disk or because the disk has become faulty. This message is
onlyoutput if thediskappears tobeslower thanexpected, and therefore thedisk (ordisk interface)
might be the problem. See also ”Toomany cameras streaming to this disk” for the casewhere the
disk seems to be ok but the data rate seems too high.

F Sensors: <X> = <Y> <Z> triggered alarm
TheWavestore supports Sensors for temperature, voltage and fan speed on standardWavestore
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servers and enclosures. If one of the sensors indicates a problem, this alarm message will be
raised. Check the hardware and replace any failed item.

F Sensors: <SENSOR> triggered <E>
One of the system sensors triggered an issue. Usually this is a Fan, Temperature, or PSU problem.

F <DEVICE>: error enabling DECODER for channel <CHANNEL> (<INFO>)
Unspecifiederrorwhenenablingadecoderchannel (usuallyonananalogcapturedevice). Contact
technical support if it persists.

F <DEVICE>: error enabling encoder for channel <CHANNEL> (<INFO>)
Unspecified errorwhen enabling an encoder channel (usually on an analog capture device). Con-
tact technical support if it persists.

F <DEVICE>: error enabling encoder for SECONDARY channel <CHANNEL> (<INFO>)
Unspecified errorwhen enabling a secondary encoder channel (usually on an analog capture de-
vice). Contact technical support if it persists.

F <DEVICE>: error enabling SECONDARY channel <CHANNEL> (<INFO>)
Unspecifiederrorwhenenablingasecondarychannel (usually onananalogcapturedevice). Con-
tact technical support if it persists.

F <DEVICE>: ERROR in configuration file: too few cameras specified, using NumCameras=1
Thismight be seen in amanually edited configuration file: fix the configurationmanually or restore
an oldworking one.

F <DEVICE>: ERROR in configuration file: too many cameras plus decode channels specified (<N>) - disabling decode channels

Thismight be seen in amanually edited configuration file: fix the configurationmanually or restore
an oldworking one.

F <DEVICE>: ERROR in configuration file: too many cameras specified, using NumCameras=<N>
Thismight be seen in amanually edited configuration file: fix the configurationmanually or restore
an oldworking one.

F <DEVICE>: error setting parameters for channel <CHANNEL> (<INFO>)
Unspecified error when setting parameters on a channel (usually on an analog capture device).
Contact technical support if it persists.

F <DEVICE>: error setting parameters for SECONDARY channel <CHANNEL> (<INFO>)
Unspecified error when setting parameters on a channel (usually on an analog capture device).
Contact technical support if it persists.

F <DEVICE>: Failed to obtain Events from camera
A device (typically a camera) failed to stream events. Often these are conveyed by a separate
mechanism from the video stream, for exampleONVIFPullpoint, and this is the streamwhich has
failed. Events from a cameramight include Darkening andMotion.

F <DEVICE>: Failed to Pull Metadata
Metadata (events or analytics) could not be pulled from the camera.

F <DEVICE>: Failed to stream images
A device (typically a camera) failed to stream images. This message is only given if a connection
has been established to the device and authentication has succeeded, but the stream has then
failed to start for some reason. Any additional information is in the camera-specific log file.
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F <DEVICE>: Multicast failed from this camera
Multicast is notworking from the specified camera

F <DEVICE>: No VIDEO available from this stream
There isnoVIDEOstreamconfigured fromthiscameraandavideostreamwas requested; usually
this is because it is disabled in theGUI or in anONVIF profile. If it’s expected that there is no video
from this device, disable the video stream in the camera group.

F <DEVICE>: Problem: Error connecting to camera ’<IP>’ port <PORT>
For an IP camera: theWavestore could not connect to the camera. Ping the camera to check if it
actually exists on that IP address.

F <DEVICE>: PTZ Request failed
The camera or PTZ device gave an errorwhen a PTZ requestwas sent.

F <DEVICE>: PTZ Request unauthorised
ThecameraorPTZdevicecomplainedabout theusernameorpasswordwhenaPTZ requestwas
sent.

F SSD: System drive about to fail
The systemdisk, which is an SSD, has reported that it is about to fail (via SMART parameters).

F %s: Server not licensed for this camera
The server licence typically has inadequate channels for this camera. The recommended solution
is to disable excess cameras and restart the server, or obtain a licencewithmore channels.

F <DEVICE>: Sound device disabled due to setup errors
Sound device is notworking correctly.

F <X>: Talkback is not supported by this camera
Audio talkback (audio from theUser or Server to theCamera or Network Audio device) is not sup-
ported by the Camera or Network device. This might be because it uses another protocol from
the one it is configured to use. It should be noted that ONVIF Profile S does not include talkback
(ONVIF Profile T is required) but some cameraswill support audio talkback by othermeans.

F NTP: Time change is unexpectedly large (<N> minutes), ignored
Small time changes will slew, but large ones are assumed to be errors and will be ignored unless
manual steps are taken. It would not be approprate to slew by a large amount because it would
take too long.

F <DISK>: Too many cameras streaming to this disk (<RATE> MB/s): data lost
There is an issue with too much data being written to a disk or disk volume, hence data is being
lost because the disk cannot keep up. This appears to be because too many cameras are being
recorded to this disk, or because the data rate from each camera is too high. Thismessage is only
output if the disk appears to have too much being recorded to it, and therefore the configuration
might be a problem. See also ”Disk is too slow: data lost” message for the casewhere the config-
uration seems ok but the disk seems faulty.

F <N>: To perform a large time change, disable NTP and enter time change manually
Small time changes will slew, but large ones are assumed to be errors and will be ignored unless
manual steps are taken.

F Stretch: Cannot initialise Stretch SDK (<INFO>)
Hardware error. Contact technical support.
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F Stretch: invalid board number (<N>)
Hardware error. Contact technical support.

F <DEVICE>: Unrecognised file type (<TYPE>)
Afile (whichwasuploadedby the installer) hadanunrecognised typeand thereforewill be ignored.

F <CAMERA>: VMD stream ’Profile3’ not found or blank in the config!
VMDhas been enabled, andmanual profiles selected, but there’s noVMDprofile (Profile3=) config-
ured.

F System needs reboot as new graphics driver has been installed
Graphics drivers require a reboot immediately after installation. This message is shown once a
graphics driver installation has been performed.

F Time jump completed
Informationmessage after an exceptional time jump. This is a FAULTmessage because the sys-
tem is not behaving normally and footage recordedwill show a gap or a jump.

F Time Set: Exceptional time change encountered: please check the time and timezone
Small time changes will slew, but large ones are assumed to be errors and will be ignored unless
manual stepsare taken. It is recommendedyoucheck thatyou’veset thecorrect timezonebefore
changing the time.

F Time Set: Exceptional time change rejected
Attempt to change time by large amount has been rejected. See above.

F Time Set: Failed to change time
Attempt to change time failed.

F Time Set: Footage will be lost if this time change is made
If you jump the time backwards, footage ”in the future” will be deleted because the footage is in-
dexed by time and it does not allow footage after the current time. This is a warning that you are
going to do something very serious.

F Time Set: To perform a large time change, use slewtimefast or jumptime commands
Small time changes will slew, but large ones are assumed to be errors and will be ignored unless
manual steps are taken. This is a summary of the commands you can use, after you have checked
the timezone is correct.

F Time wrong: manual action required
The timeon theWavestore iswronganda licencecannot thereforebeobtainedautomatically. The
best solution is to correct the time on theWavestore.

F Too many cameras configured for this system (<N> maximum); memory upgrade required
Wavestore servers have minimum memory requirements for various number of cameras in or-
der to function correctly. Ifmore cameras than permitted for a specificmemory size are installed,
this fault will be logged. The solution is to reduce the number of cameras or upgrade the server
memory.

F Upgrade failed
An upgrade failed. See the Upgrade log formore details.

F Upgrade failed: package unsigned: <PACKAGE>
An upgrade failed because a packagewas unsigned. Often a package appears unsigned because
itwas only partially uploaded and corrupted by a network dropout and another attemptwill work.
See the Upgrade log formore details.
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F Upgrade finds <N> duplicate packages: reinstall is recommended
After upgrading a package, a consistency check is performed to ensure there are no duplicate
packages which can cause issues. Sometimes these issues are caused by a network or power
failureduring theupgrade. A command ”remove-dup” canbeexecuted (byExecuteCommandon
WaveView) to remove duplicates, after which it is recommended that the upgrade be attempted
again toensurethecorrectpackagesare installed. If this isunsuccessful, reinstallmightbeneeded.

F Upgrade: previous upgrade/downgrade did not complete correctly: reinstall is recommended
After upgrading a package, a consistency check is performed to ensure there are not ”broken” or
half-completedupgrades (whichmight occur for example if you restart theWavestore in themid-
dle of an upgrade). This is awarning that you have an unstable system and a reinstall is needed.

Warning Messages
WBad disk2 name ’<NAME>’ in config section ’<SECTION>’

Corrupt configuration. Fix it or restore aworking configuration file.

WBad disk name ’<NAME>’ in config section ’<SECTION>’
Corrupt configuration. Fix it or restore aworking configuration file.

WCamera out of range in channel <N> in <SECTION>
Corrupt configuration. Fix it or restore aworking configuration file.

WCamera <N>: Invalid Resolution=<RESO>
Corrupt configuration. Fix it or restore aworking configuration file.

WCannot allocate any disks
Usually this indicates that no disks are specified in the disk setup screen, or that those set up have
been removed.

WCannot open configuration: creating dummywith no cameras
If the configuration has been deleted but no other uploaded, the server will create a default con-
figuration to ensure the system is usable. Usually the correct action in this case is to restore an old
configuration file.

WC<CAMERA>: Audio encoder option AAC Not supported by this device.
The camera or device is not correctly configured.

WC<CAMERA>: Audio encoder option Not supported by this device.
The camera or device is not correctly configured.

WC<CAMERA>: GOP size too large (<N>)
Wavestore systems are specified to handle GOP sizes up to 64 frames; above that playback per-
formance can be severly reduced. The GOP size is the size of the ”Group of pictures” which start
withanI-frame (initial frame) (alsocalled IDRor IRAP frame)and thencontainother frameswhich
rely on the first frame to be decoded properly. If you start to play back some footage, or switch to
view a different camera, theWaveView client will need to get all frames from the last I-frame and
decode from there to the desired frame. This has been optimised for up to 64 frames. If GOP
sizes are larger than this, it might become slow or jumpy. There is a way to disable this warning if
youmust have larger GOPs, but it is not recommended.

WDisk<DISK> is too large
Warning that a disk is too large. Obsolete, as very large disks permitted in current software.
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WDisks set to READ ONLYmode: recording is turned off
Warningthat thediskswereset to read-onlybyan installer, andtherefore therewill benorecording.
This option is found on the disk setup screen.

WDisk<DISK><N>:(<DISKPATH>) is too cold (<DEGREES>C)
Warning that thedisks are rather cold;with luck theywill go onworkingbut action should be taken
to ensure the server doesnot get too cold.

WDwell out of range in Dwell=<D>
The dwell time specified is not in the valid range. This is caused bymisconfiguration.

WEmail: All recipients were refused and nobody got the mail
Recommended course of action: Check all settings in ”Setup | Email” including the Recipient list,
as they are likely to be incorrect for your email server.

WEmail: Connection unexpectedly closed - possibly username and password issue
Recommendedcourseofaction: Checkall settings in ”Setup |Email”, primarilyusernameandpass-
word.

WEmail: No suitable authentication method was found
Recommended course of action: Check the settings in ”Setup | Email” as they are likely to be in-
correct for your email server. Background: Thiswarningsuggests that theconfiguredemail server
didn’t allowus to login. Consider checkingusernameandpassword. Alsoconsider enablingordis-
abling the ”Use SSL” option.

WEmail: SSL/TLS support is not available to your Python interpreter
This shouldn’t ever happen. If it does, please contactWavestore support.

WEmail: The server didn’t accept the from address
Recommended course of action: Check the ”Sender” setting in ”Setup | Email” as the email server
complained about this.

WEmail: The server didn’t accept the username/password combination
Recommended course of action: Check the settings in ”Setup | Email” as they are likely to be in-
correct for your email server.

WEmail: The server didn’t reply properly to the HELO greeting
Recommended course of action: Check the settings in ”Setup | Email” as they are likely to be in-
correct for your email server. Background: Thiswarningsuggests that theconfiguredemail server
didn’t respond to us properly, somost likely a problemwith the email server settings.

WEmail: The server does not support the STARTTLS extension
Recommended course of action: Check the settings in ”Setup | Email” as they are likely to be in-
correct for your email server. Background: Thiswarningsuggests that theconfiguredemail server
didn’t respond to us properly, somost likely a problemwith the email server settings. Try enabling
or disabling the ”Use SSL” option.

WEmail: The server replied with an unexpected error code
Recommended course of action: Check all settings in ”Setup | Email”. Failing that, consider talking
to the administrator of your email server as it is sending unexpected responses.

WERROR: failed to start nginx as reverse proxy to access cameras
The system uses nginx for camera gateway proxy (also known as a reverse proxy) if it is enabled
in the configuration. This message indicates some error prevented it starting. Contact technical
support for assistance.
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WERROR: failed to stop nginx
See previous entry. This message indicates some error prevented it stopping. Rebooting should
fix this.

WFailed to send alert email. Recipients setting is missing.
Recommended course of action: Check that the ”Recipients” settings in ”Setup | Email” have been
completed correctly. Background: This warning suggests that email alerts have been configured
in the ”Setup | Event Rules” screen but no potential recipients for email have been configured in
”Setup | Email”.

WFailed to send alert email. SMTP setting is missing.
Recommended course of action: Check that the settings in ”Setup | Email” have been completed
correctly. Background: Thiswarningsuggests thatemail alertshavebeenconfigured in the ”Setup
| Event Rules” screen but the email server settings have not been set up in ”Setup | Email”.

WHoliday: unrecognised day <DAY>
In the configuration file, a bad daywas specified

WHoliday: unrecognised month <MONTH>
In the configuration file, a badmonthwas specified

W Invalid findmeta textual match syntax: <MATCH>
A metadata match, often in the configuration file for an event rule, has a corrupt match syntax.
Probably due to amanual edit.

WKey generation failed
RSA key generation (for authentication or encryption) has failed. Contact technical support.

W Licence: <N> analogue <TYPE> configured when only <N> permitted
You have allocatedmore analogue cameras than permitted by your licence. Upgrade your licence.

W Licence: <N> EMS <TYPE> configured when only <N> permitted
You have allocated more EMS encoders or multisensor cameras than permitted by your licence.
Upgrade your licence.

W Licence: <N> IP <TYPE> configured when only <N> permitted
You have allocatedmore IP cameras than permitted by your licence. Upgrade your licence.

W Licence: Storage over <N>TB not permitted on this licence; Skipping disk <DISK>
Youhave allocatedmore storage than is permitted on this licence. Upgrade your licence. Note that
all V6 licences currently allow unlimited so you should not see this.

WMalformed event line in <F>:<N>
Corrupt configuration. Fix it or restore aworking configuration file.

WMatch file: <NAME> failed to load
An event rule match table is referenced in the configuration file but the table file does not appear
to exist. Upload the table again or change thematch rule.

WMirror: failed to connect to mirror <M>
Mirroringmessage. Obsolete.

WMirror: failed to login to mirror <M> as user <UU>
Mirroringmessage. Obsolete.

WMissing Licence - please enter licence
Please enter a licence string.
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WNetworkThread: cannot bind to port, retrying
The server port is not available. Unlikely. Contact technical support.

WNotifier <N>: no such notifier
A request to notify using notifer <N> has been made in an event rule but no such notifier exists.
Correct the notifier number or add the correct one.

WNotify<N>: Failed to notify event for over 2 minutes: check IP (<X>) <Y> <Z>
A notifier cannot connect to the target.

WNotify: unsupported protocol=<PROTO>
The configured protocol does not exist

WNTP: Cannot get time from server ’<SERVER>’
When NTP is configured, the NTP service cannot contact the specified server and get the time
from it.

WNTP: Upstream server ’<SERVER>’ is unsynchronized
NTPhas failed to synchonize because the <SERVER> it is configured to pull the time from (the ’up-
stream server’) is not correct (’unsynchonized’). Usually that upstream server should be synchro-
nised to another NTP source. It is possible to synchronise time from aWavestorewhere the time
has beenmanually set, but themanual time configuration should have been performed recently,
if not thismessagewill be shown.

WOnly <N> GB RAM available: performance will be reduced
Wavestore servers are generally shippedwith adequateRAM for the load they are specified. How-
ever old serverswhichhavebeenupgradedandother systemsmightnothaveadequateRAMand
thereforebufferingandother itemswill be reducedasneeded, thiswarningshowsthat this reduc-
tion occurred.

WPrerecord buffer limited to maximum permitted (%s seconds)
A fixedmaximum limit has been exceeded. Use a smaller value.

WPreset out of range in Preset=%s
<PRESET> A ptz preset number is invalid.

W <ID>: bad On/Off entry: <TEXT>
Corrupt configuration. Fix it or restore aworking configuration file.

W <DEVICE>: Could not open port <PORT>
Adevice (typicallyan iodevice)cannotopenaspecific ioport. Usually this isduetomisconfiguation
of the port.

WSection out of range in channel <N> in <SECTION>
Corrupt configuration. Fix it or restore aworking configuration file.

WSerialAlarm: Baud=<BAUD> is not a recognised value
The baud rate is invalid. This is due tomisconfigurtion.

W <DEVICE>: ERROR in configuration file: too many cameras specified, using NumCameras=<N>
Corrupt configuration. Fix it or restore aworking configuration file.

W <FEATURE> feature not licensed
The specified <FEATURE> is not licensed. Upgrade your licence.

W%s: Limited Video Encoders, requested streamsmay not be possible.
The camera has limited resources. Check camera documentation and reconfigure.
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WSpeed out of range in Speed=<SPEED>
The configured speed for a PTZF operation is invalid. This is due tomisconfiguration.

W <DEVICE>: Problem: Error connecting to camera <N> port <PORT>

W <DEVICE>: Rebooting the camera to resolve streaming issues
An attempt to reboot to camera has beenmade after a camerawas not streaming for some time.
This is only done as a last resort, usually after anhour of inactivity andmultiple attempts to recover
it in otherways. Note that this is just a camera reboot, not aWavestore server reboot. The camera
reboot can be controlled using various parameters in theCameraGroup configuration.

W <DEVICE>: Requested encoding <X> is not supported by this camera, choosing <Y> instead
The encoding requested by the user (eg, H265) is supported by the camera so another encoding
(eg, H264) is used instead.

WSSD: System drive wearing out too fast
TheWavestore uses SSD system drives for speed and reliability. They are very reliable so long as
they don’t get overused. Occasionally something is accidentally configured which writes heavily
to the SSD, hence theWavestoremonitors this andwarns if it seems to bewearing out fast. Note
that it’s rate ofwearwhich ismonitored, so thiswarningmight be issued even if the SSD has 99%
of usable live left simply because it ran though the 1% faster than expected. This checkmeanswe
can recify the issue before it becomes a problem.

W <SECTION>: unrecognised day <X>
A corrupt configuration file.

W <SECTION>: unrecognised hour <X>
A corrupt configuration file.

W <SECTION>: unrecognised minute <X>
A corrupt configuration file.

WSystemwill reboot in 5 mins unless FAULT flag is cleared
Some serious problems will force a reboot unless the user deliberately stops it. This message is
given in this case.

WSystemwill reboot to recover from error
Some serious problemswill force a reboot. Thismessage is givenwhen this occurs.

WTalkback clip ’<NAME>’ not found
When configuring an event to send a talkback audio clip, if thewrong audio clip name is given this
messagewill appear.

WTalkback failure on device <X>.<Y>
Talkback (audio output from the user or server to the camera or audio device) has failed for device
X.Y

WThis is a beta-test software release
Thismessage is producedwhenusingearly pre-release software. It cangenerally be ignored, but
please do remember to upgrade to the release softwarewhen it released.

WTour out of range in <DEV>
A tour ismisconfigured.
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W tw_cli is not installed - cannot make required settings to RAID card
This is unlikely to happen and suggests an installation problem. The message suggests that the
Wavestore has a 3Ware RAID card installed but the required utilities to interactwith it aremissing.

W type=<TYPE> unrecognised in section <SECTION>
A corrupt configuration file.

WUnrecognised network command: <CMD>
Usually caused by corruption on the network connection; reconecting is recommended.

WUPGRADE Early file termination (<X>) (expected <N> bytes)
Usually caused by corruption on the network connection, try again.

WUser <USER> login from <IP> failed: SECURE=y set and insecure login attempted
A user used the old V4 client to connect and that uses a less secure mode which is no longer al-
lowed.

WWarning: event rule matches on missing table ’<NAME>’
An event rule match table is referenced in the configuration file but the table file does not appear
to exist. Upload the table again or change thematch rule.

Configuration Messages
C Failover: and <N> custom sections: <DETAILS>

Informationmessage, the final part of a Failover changedmessage (only used if custom sections
exist)

C Failover: configuration changed to logical server <LS> (<NAME>)
Informationmessage showing the Standby has taken over the logical server <LS> when they are
bothpartof aFailovergroup. Usually thisoccurswhen thephysical serverwhichhadbeen running
as logical server <LS> has failed.

C Failover: except for <N> network interfaces, disks, system and licence
Second part of Failover changed the configurationmessage.

C Reset <SECTION> as maintenance mode for camera <N> has expired
Indicates the configuration has been updated automatically to removemaintenancemode from
a camera since the time period selected has now expired. Note that thismessage only occurs if it
has expired, it can also be removed by normal configuration changes.

C System has moved <N> local users to [%PWSAFEL section]
A configuration file upgrade occurred

C User <USER> configuration ’<FILE>’
Message indicates that a configuration file has been loaded.

C User <USER> has changed password
Messagewhen a user sets own password

C User <USER> reset ’<CONFIG>’
Messagewhen a configuration section is cleared (ie, set to nothing). See ’set’ below.

C User ’<USER>’ set a password for ’<USER2>’
Messagewhen an administrator sets another user password
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C User <USER> set ’<CONFIG>’
Message when a configuration section is set. The configuration is shown in the internal format
which can be viewed in the advanced configuration editor. This might continue over several lines
if needed.

C User <ADMINUSER> setting password for <SECTION> user <USER>
Messagewhen ADMINUSER sets password for another user, USER.

C User ’<USER>’ updated Password Safe
Messagewhen an administrator setsmultiple passwords (probably by uploading a file)

Login Messages
L Logging in using group ’<GROUP>’

When LDAP/Active Directory login is configured, a login occurredwith the specified <GROUP> be-
cause theuserwasauthenticatedby theLDAP/ActiveDirectorypasswordserverandwasamem-
ber of <GROUP> on that password server, and that <GROUP> exists as a user group on theWave-
store. Permissions are granted by the user <GROUP> on theWavestore.

L Login failed because no DVR group was found on this password server
If LDAP/ActiveDirectory login is configured, aDVRgroupmustbepresent on thepasswordserver
(ie, the Active Directory server) and the user must be a member of that group. DVR groups are
groupwith names beginning DVR (eg DVRuser for normal user level login).

L User <USER> from <IP> disconnected on timeout
User whose login name is <USER> who had connected from <IP> ip address was disconnected
from the server by a server timeout. This canbe adisconnect on idle or because theywere logged
in too long or on a schedule.

L User <USER> from <IP> disconnecting
User whose login name is <USER> who had connected from <IP> ip address disconnected from
the server.

L User <USER> logged in from <IP>; permission level <LEVEL>
A login occurred from username <USER> from IP address <IP> at permission level <LEVEL> (in-
stall/admin/user).

L User ’<USER>’ was authenticated by password server ’<SERVER>’
WhenLDAP/ActiveDirectory login isconfigured, theuser<USER>wasauthenticatedbytheLDAP/Active
Directory password server <SERVER>, and the authentication passed successfully.

L WARNING: multiple groups match (<GROUP1>,<GROUP2>)
When LDAP/Active Directory login is configured, the user could not log in because they were a
member ofmore than one DVR group.
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13 Appendix C - WaveView Launch Op-
tions

--autoLogin=<server>[:<port>],<user>,<password>[,sg]
Login to the the given server automatically. <server>, <user> and <password> are required. <server>
can be a hostname or IP address. <port> is optional and defaults to 8601. The last optional argu-
ment (”sg”) indicates whether to connect to the server group. If not present, only the specified
serverwill be connected to, rather than the group.

--fullscreen
Forces the video display area to be displayed in fullscreen.

--maximize
Forces themainwindow to bemaximized.

--screen=<screen_number>
Forces themainwindow to be displayed on the screen corresponding to <screen_number>.

--useDesktopOpenGL
Force to use DesktopOpenGL driver, instead of auto-detecting.

--useSoftwareOpenGL
Force to useOpenGL software rendering, instead of auto-detecting.

Examples

--autoLogin=10.1.2.3,joe,a,sg
Logs in toserver 10.1.2.3withusername ”joe” andpassword ”a”. Connects toall servers in thegroup.

--autoLogin=10.1.2.3:8602,joe,a --maximize --screen=1
Logs in to server 10.1.2.3 on port 8602 with username ”joe” and password ”a”. Does not connect
to all servers in the group, only server 10.1.2.3. Opens the client on screen 1 and maximizes the
window.

Adding Shortcut Options onWindows®

The launch options documented above can be used onMicrosoftWindows®. Oneway is simply to run
WaveView fromaCommandPrompt, but this isn’t very convenient. Themost commonway is to create
and edit a shortcut toWaveViewwith the appropriate options set.

Depending on the options chosen when installing WaveView, there might already be a shortcut on the
Desktop. If not, there are several ways to create a new shortcut. One way is to use Windows Explorer
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to navigate to the installation directory. By default this is C:\Program Files\WaveView\bin. The exe-
cutable file is calledwaveview.exe although the ”.exe” extensionmay be hidden.

Right-click the executable and choose ”Send to > Desktop (create shortcut)”.

Now the shortcut on the desktop can be edited by right-clicking and choosing ”Properties”.

Thedesired launchoptions canbeaddedbyadding themat theendof theTarget field. Ensure that they
go outside the quotationmarks.
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14 AppendixD -Writing an ISOwithRu-
fus

To install or upgradeWavestore from a USBmemory stick it is necessary to extract the ISO to the USB
stick. ThewaytodothisdependsontheOperatingSystem. MostcommonlyMicrosoftWindows isused,
inwhich case the Rufus program is recommended.

Assuming the installation ISO has already been obtained, the process is as follows:

• OnWindows, download Rufus from http://rufus.akeo.ie

• Run Rufus.

• Plug in the USB stick. Rufus should recognise the USB and populate the ”Device” box.

• On Rufus: ”Format Options”/”Create a bootable disk using” and select ”ISO Image”.

• On Rufus: click the icon to the right of the above text and select the ISO.

• On Rufus: click [Start] to start thewrite to USB.

• Select ”Write in ISO Imagemode (recommended)” and click OK if Rufus asks about deleting files
on the USB stick.

• It’ll take a fewminutes to create the bootable USB.
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15 Appendix E - Camera Statuses

There are 4 camera status categories, each represented by an icon. Within each category, there are var-
ious possible statuses which are shown within a tooltip by hovering over the icon. The statuses and
status categories are described below:

Category: Unknown

Unknown The status of the camera is not yet known

Not Enabled The camera is not enabled so its status cannot be queried

Category: Ok

Not Recording The camera is not configured to record but is otherwiseworking correctly

Recording The camera isworking correctly and recording

Category: Warning

Darkening The image from the camera is unusually dark andmight indicate tampering

Camera Movement Thecamerahasbeenmoved from itspreviousposition, i.e. the scenehaschanged

Initializing The camera is about to be set up

Configuring Settings are being pushed to the camera

Connecting TheWavestore server is connecting to the camera

Connected And Starting TheWavestoreserverhasconnectedtothecameraand isstartingstreaming
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Category: Maintenance

Maintenance The camera is inmaintenancemode andwill not report faults as F faults into the system
log norwill it set FAULT on the status indicator or remotemonitor

Category: Error

Not Permitted The current user is not permitted to view this camera

Not Licensed The system is not licensed to use this camera

Video Loss No video is being received from the camera

Unauthorized TheWavestore serverdoesnothavepermission toaccess thecamera, normally indicat-
ing incorrect credentials in the camera setup

Could Not Connect TheWavestoreservercouldnotconnect to thecamera, normally indicatingacon-
figuration or network issue

Failed To Stream TheWavestore server connected to the camera but was unable to initialise stream-
ing, normally indicating a configuration issue or problemwith the camera

Server Awaiting Restart TheWavestore requires a software restart before full operation can continue

Check System Log Some issue occurredwhich is detailed in the System Log

Network Problem TheWavestore has detected a problemwith network

No Live It has not been possible to perform live streaming from the camera
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